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P R E F A C E

Math Writer™ was created to make the writing of mathematics-laden 
scientific and technical manuscripts less daunting. Traditional word 
processors do not provide tools that are powerful enough to provide a 
seamless, visual integration of mathematics as text within a manuscript but 
also intuitive and simple enough not to interfere with the writing process.

MathWriter is an author-centered writing tool. Its creation is a response to 
the needs exposed by twenty-five years of struggle with composing papers, 
tedious transcription using inadequate tools, the tracking of the inevitable 
revisions and retyping, and the agony of the equally inevitable task of 
correcting flaws introduced in galley proofs. MathWriter was designed to 
simplify that process. By composing at the keyboard (and mouse), the au
thor retains greater fluidity in the creative process and avoids the tran
scription process. By creating camera-ready copy, an additional step can be 
sometimes be saved, as was done with this manual, which we prepared and 
printed using MathWriter.

MathWriter's feature innovations include its "what-you-see-is-what-you- 
get" handling of mathematics, automatic numbering, revision tracking, 
interactive library, ease of handling frequent typeface changes, and modu
larity for customized expansion of functionality.

MathWriter 2.0 evolved from our mathematical expression editor over a 
three-year period of intense effort. We are grateful for the invaluable 
assistance we received from our friends—new and old. Leonard Gillman 
freely shared his insights and professional experience; more important, he 
provided the encouragement that flows when someone believes in the im
portance of your task and in your ability to make a meaningful contribution. 
Morven Gentleman's kind letter first planted the idea for expanding our 
efforts to create a technical authoring environment, and Richard Palais's 
wise words on the subject in the Notices of the AMS convinced us to under
take this massive effort. Robert Perl provided competent and dependable 
support on many tasks.

Some of the features in MathWriter followed directly from specific sugges
tions. For example, Len Gillman suggested auto-italicizing; Jerrold Mars- 
den, the library for typing built-up mathematical expressions; Mike Axel
rod, the check for repeated words; Dick Szymanski, the table feature; and 
Steve Erde, the file name variable.

Some individuals performed specific tasks of particular importance: Nancy 
Cooke "translated" the manual into English and with Richard Cooke wrote



a primer for students, "Writing a Paper Using MathWriter"; John Cooke 
programmed the HyperCard demo stack "About MathWriter™ 2.0"; Gary 
Wernsing wrote the utility for translating files to and from the data inter
change format (RTF); Julia Noblitt prepared the math-science-engineering 
dictionary with the assistance of Sandra Bates, Sam Lenke, Moss Sweedler, 
and Keith Dennis; Douglas Davenport provided expert PostScript® consul
tation; Gideon Shaanan provided the earliest and most challenging debug
ging. Many were involved in testing during an extended period: Loren Arga- 
bright, Chris Borkowski, Leonard Gillman, David Gries, James Hurley, 
Linda Iroff, Steve Lantz, Benton Leong, Jerrold Marsden, Philip McDun- 
nough, Wendy Nelson, Robert Pucel, Larry Riddle, Tom Scavo, James Tasi, 
Shrinivasa Upadhyaya, and George Wolga. We are grateful for the 
review comments from Peter J. Bickel, Leo Breiman, Javier Cabrera, David 
Eisenbud, Peter Eklund, Susan Franklin, Daniel J. Friedman, Edward I. 
George, Greg Kearney, Benton Leong, Marvin Marcus, Thomas R. Scavo, 
Raymond F. Smith, Gerald L. Thompson, and Esther L. Zack.

Others provided advice and encouragement during some phase of this pro
ject: Claire Berman, Lisa Blessing, Burt Cummings, Kenneth King, M. Stuart 
Lynn, Philip McDunnough, Tim Mount, John Noon, Richard Rand, Gerald 
Rehkugler, Patti Sobel, Anita Szewczak, Dick Szymanski, Cary Tengler, 
Paul Velleman, Daryl Wiener, and the many users of our mathematical 
expression editor who encouraged us by their kind words, including Emmet 
F. Low, Jr., Bruce Finlayson, and Tom McMahon.

One could not hope for a more supportive editor than John Kimmel. Marlene 
Thom was our capable and effective Production Coordinator and the talent
ed Phyllis Larimore was Copyeditor.

Finally, we are indebted to all those brave souls who helped us with any 
phase of the testing, including Ashim Datta, Jesus Dumagan, Debbi Lewis, 
Janet Mathews, and John Wiesenfeld. The picture of an open stomate used 
in the advertising and on the box cover was taken from the Ph.D. disserta
tion of Jae Young Lee, whose manuscript provided compelling evidence of 
the need for MathWriter™  2.0. Cornell University, true to its tradition, 
provided an open and supportive environment in which this non- 
traditional form of scholarship could be undertaken. We thank especially 
our spouses for their support and forbearance during our extended 
preoccupation with the creation of our magnum opus.

If MathWriter has contributed significantly to your productivity or if you 
have suggestions for improving the next version or ideas for modules, please 
write to us in care of Brooks/Cole Publishing Company.

J. Robert Cooke 
E. Ted Sobel
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C H A P  T E R

1  Overview

MathWriter™  is a completely new, full-featured word processor that 
facilitates the demanding requirements of technical writing. In addition to 
text and graphics, technical writing often includes mathematical 
expressions. Math Writer allows authors to compose equations and text at 
the keyboard as easily as prose writers compose with an ordinary word 
processor.

Virtually every traditional word processing feature has been made more 
general in MathWriter. The program updates the screen with each 
keystroke and provides visual clues whenever feasible. It lets you see what 
you are doing to your manuscript and improves on the description "What 
you see is what you get." For example, MathWriter  continually displays 
the actual page layout, contents, and numbering. For deferred action page 
and document formatting commands, miniature portraits show the 
consequences of your choices.

You need not memorize a bewildering collection of keyboard commands to 
use MathWriter. You can combine convenient and visually prompted mouse 
control with rapid keyboard input to match your preferences and level of 
experience.

Because each user has different needs, MathWriter provides a broad range 
of settings to accommodate these needs. For example, you may hide the 
mathematical tools when you are not using them. By using default files you 
will have quick access to an initial writing environment that includes 
specific selections of typeface, page layout, text, and graphics you use 
repeatedly.

With tools designed specifically for technical writing, MathWriter helps 
you produce scientific manuscripts more quickly and easily than with other 
word processors. A library of user-defined glossaries provides for rapid 
entry of repeatedly used, built-up mathematical expressions; you type your 
own abbreviations and MathWriter substitutes the library entry of text, 
graphics, or mathematics. An automatic numbering feature is provided for 
equations, figures, tables, theorems, and footnotes and cross-references to
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them. MathWriter automatically updates these numbers when you use Cut 
and Paste. You may type and edit headers, footers, footnotes, sidebars, and 
mathematical expressions without moving into separate, isolated 
windows. In addition, the Find and Replace facility applies to 
mathematical expressions, as well as to text and style changes.

MathWriter's signature feature is the full integration of mathematical 
expressions into the text. No longer will you be required to compose 
mathematical expressions using memorized, embedded commands that are 
later transformed into conventional mathematical notation. Nor will you 
need to compose mathematical expressions in a separate environment and 
paste them into the document as graphics.

You create equations as part of the text and in the document window. 
MathWriter automatically handles mathematical typesetting conven
tions. It reformats expressions with each keystroke or mouse input sequence 
for maximum visual feedback.

It handles frequent changes in font, font size, font style, and two- 
dimensional character placements with ease and often automatically. 
Common mathematical structures such as fractions, brackets, matrices, and 
tables dynamically resize as you type. Line spacing automatically adjusts 
to accommodate lines of different heights, common in mathematical 
expressions.

Special Features for Technical Writers
Technical writing is an evolutionary and collaborative process. Frequently, 
you must track possible and actual changes to a manuscript, either as 
personal reminders of your own revisions or as communications among 
multiple authors. Hidden text windows allow you to place memos in your 
manuscript without disrupting the formatting. MathWriter also allows you 
to identify additions and deletions with distinctive typefaces such as 
boxing and strikeout. You may review these changes using style-sensitive 
Search and Replace. To "unrevise" individual changes remove text or the 
identifying style and then MathWriter can automatically incorporate the 
remaining changes.

MathWriter supports PostScript® output for high-quality printed docu
ments.
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Design and Features in Brief
Math Writer includes a number of unique and convenient features including 
the following.

• Treats mathematical expressions as text, rather than as graphics, 
providing greater formatting control, Search and Replace for 
mathematical expressions, and editing of mathematical expressions in 
context.
• Extends the meaning of "What you see is what you get". MathWriter's 
in-context word processing lets you edit headers, footers, sidebars, and 
equations without switching into a separate window; lets you edit when 
text is in multiple columns; provides automatic pagination and immediate 
substitution of glossary items; automatically formats equations with each 
keystroke; and provides on-screen line numbering.

• Provides visual clues whenever possible.

• Provides powerful, visual revision tracking with automatic typeface 
changes to display additions and deletions in context.

• Supports hidden windows for margin notes without disrupting the page 
layout.

• Supports user-defined glossaries for easy entry of repeated text, 
mathematical expressions, and graphics with both mouse and keyboard 
controls.

• Automatically formats tables and mathematical expressions.

• Automatically numbers equations, figures, paragraphs, footnotes, etc., 
including cross-references within the text, and automatically updates them 
as you edit.

• Automatically italicizes variables in equations, omitting such exceptions 
as function names.

• Automatically numbers lines of text on screen, as well as on the printed 
copy.

• Supports editable, multiple column text and sidebars—minidocuments 
within documents.
• Provides hyphenation, thesaurus support, and spell-checking; includes an 
exclusive science-mathematics-engineering dictionary.

• Provides borders and background patterns for highlighting important 
paragraphs and equations.

• Provides file transfer capabilities, as well as automatic extraction of 
equations and graphics, for use in page layout programs.
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The MathWriter Screen
6  File Edit Format Palettes Diac Style Windows
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The process of one-dimensional water transfer in unsaturated soil can be 
described by the well-known Fokker-Planck equation:

t - s M S - H
or Richards (1931) equation:

c(9)i r s { K(8> [iH }l
where 9 is the volumetric water content (L3 I L3) ; z is depth (L) positive 
downwards; t is time (T); K is hydraulic conductivity (L/T), a function of 9.
D is diffusivity (L2/T) defined by D (9) = K (9) dh / d9, where h is soil water 
suction (L) relative to atmospheric pressure; and C is the capacity (1/L) 
defined by C (9) = -d9/dh.
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Figure 1.1 MathWriter screen

To better utilize limited screen space, MathWriter  uses floating windows 
that you can reposition or remove if desired. (See Figure 1.1.) Unless you 
hide the ruler, a single thin ruler remains at the top of the window and 
displays information corresponding to the paragraph that contains the 
blinking insertion point.

MathWriter provides templates for common mathematical structures, 
which format automatically. The Palettes floating window is a typing aid 
that contains the Greek alphabet and user-selected character groups. The 
Tools floating window provides access to editing tools: I-beam to edit text, 
split I-beam to edit within mathematical structures, cross-hair for 
sidebars, and arrow for character placement. The superscript and subscript 
tools in the Tools window automatically adjust the position of the insertion 
point and the font size.

When used with a screen projector, MathWriter doubles as an overhead 
projector.

We see MathWriter as the centerpiece of a new family of elegant writing 
tools which we hope will allow you to focus your energy on your work, 
rather than on your word processor!
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How to Begin

This User's Guide provides two parallel introductions to MathWriter. 
Chapter 2 is a self-guided tour of MathWriter features to be studied while 
at the Macintosh keyboard. Chapters 3 and 4 provide a detailed, step-by- 
step, task-oriented introduction to nontechnical and technical word 
processing respectively. Chapter 5 is a very brief, quick-start alternative 
for more experienced Macintosh users. Chapter 6 is a command-oriented 
description of all features. The appendix includes an interface refresher for 
novice users, a description of Math Writer files, and a summary of advanced 
keyboard commands.

Typographic conventions

• The names of special keys on the keyboard (return, enter, delete, 
option,Si, shift, and tab) are displayed in lowercase italics.

• Lists of ordered steps are numbered; lists of nonordered items or optional 
steps are identified by • or ♦.

• The full path for menu commands is indicated by the menu name / menu 
command / submenu (e.g., Windows/Tools/Math Editor) and this is often 
followed by a keyboard equivalent (Si shift ; ) where the space separator 
is not part of the command.
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2 Guided Tour

As its name implies, MathWriter's  signature feature is its ability to write 
mathematics. We increased the scope of nearly every feature of traditional 
word processors and, in addition, invented many new tools for this task. In 
this guided tour, we provide a task-oriented, rather than feature-oriented, 
introduction to Math Writer. This tutorial assumes that you have limited 
experience using the Macintosh. In the exercises we provide step-by-step 
instructions for completing a progression of increasingly more sophisticated 
tasks. Each exercise builds on and assumes a knowledge of the techniques 
presented in previous exercises.

Because many users may not routinely need to write mathematics, the 
initial examples demonstrate that M athWriter’s more technical features 
can be made completely unobtrusive. Later examples illustrate special 
mathematical capabilities.

Preliminaries

Software and hardware requirements

To use MathWriter we recommend that you have:

1. A Macintosh SE/30 or Macintosh II with 2 megabytes of RAM and a 
hard disk. We do not recommend using the professional version with less 
powerful Macintoshes, such as an SE. MathWriter is a computation
intensive program so its performance is sluggish on a 68000-based 
Macintosh. Because documents are RAM-resident, document size must be 
restricted if you have only 1 megabyte of RAM. Use the reduced-feature 
education version if you are limited to a Macintosh Plus with 1 megabyte of 
RAM and two floppy drives.

2. The most recent operating system compatible with your hardware (e.g. 
System 4.0 and Finder 6.0 or more recent systems that support hierarchical 
menus). MathWriter is MultiFinder® compatible. However, if you have 
only 1 megabyte of RAM, use MathWriter with Finder.
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To change from MultiFinder to Finder or vice versa, use the Set Startup- 
selection in the Special menu at the desktop and then select Restart, also in 
the Special menu.

3. Times and Symbol fonts must be available for MathWriter to function.

4. The education version of MathWriter  can be used with two 800K disk 
drives as minimal support, but a hard disk is recommended so spell
checking can be used conveniently. Math Writer uses overlays, which means 
that only those portions of MathWriter code currently in use are RAM- 
resident. This leaves more memory for your documents. Because the 
computer must access theMath Writer disk as you use the program, the disk 
should remain in the drive. With a hard disk you can keep MathWriter, 
the dictionaries, help files, etc., available for immediate use.

Make a backup
Before installing MathWriter, make a backup of the master disks as 
described here.

First, write-protect each master disk to guard against accidental erasure: 
Position the plastic corner tab such that you can see through the square 
hole on the comer of the disk. Then follow the instructions in your 
Macintosh Owner's Manual to make a working copy of each disk before 
storing the originals in a safe place. If a working copy becomes unusable, 
you will be able to make a new one from the originals.

Install MathWriter
If you are using a hard disk, create and name a MathWriter folder on the 
hard disk, successively place each working copy in the floppy disk drive, 
double-click its icon, and then drag the file icons into the new folder on the 
hard disk. If you are using the education version with two disk drives, 
place Math Writer and your documents on one disk and the operating system 
on the other.

Remove unnecessary files, fonts, INITS, and desk accessories to conserve 
disk space. The Times and Symbol fonts must be available for MathWriter 
to operate. The modified version1 of the Symbol font distributed with 
MathWriter should be used. Remove the Apple-supplied Symbol screen 
font and then replace it with the supplied version using the Font/DA 
Mover received with your current operating system.

When activated by double-clicking its icon, MathWriter  automatically 
creates and places a file with configuration information in the system 
folder.

1 The extremities of the stretchable brackets and braces of the Apple-supplied version of the Symbol font do not 
display correctly on the screen and boldface style is not enabled.
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About the Exercises
The exercises that follow present step-by-step instructions for completing 
various common tasks. Some of the steps are numbered and are essential to 
completing the task. Others are simply suggestions for practice and are 
indicated with a diamond ♦ at the left text margin.

Again, do not begin until you have made a working copy and have safely 
stored the master disks. You should have already installed the Symbol 
font. If you wish to print MathWriter files, you must also install the 
appropriate print driver, select the driver using Chooser, and connect and 
prepare the printer for printing.

Exercise 1: Reviewing a Short Memo

This first exercise describes the startup process, how to open an existing 
file, navigating through a document, exploring the interface, printing the 
document, and quitting.

Starting MathWriter
1. Complete the usual Macintosh startup process.

2. Double-click on the MathWriter icon. MathWriter will automatically 
open a new document file named Untitled 1.

To examine an existing file:

1. Select Open... on the File menu.

The file selection dialog window opens.

2. Select the drive that contains the MathWriter file named Exercise 1.

3. Select the folder that contains the desired file. The File Type should 
read All known types or MathWriter™ 2.0. If not, drag to select one of 
these from the pop-up menu list. Only folders and the files that match this 
file type appear in the window.

4. Select the file Exercise 1 and click on the Open button. Note: As a 
shortcut, you can double-click on the file name to eliminate use of the Open 
button.

This exercise asks you to read through and work on the following 
hypothetical memorandum from the authors to new MathWriter users. As 
you move through the memorandum, which is the same in the manual and 
on the screen, the text will tell you what to do.
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MEMORANDUM

Date: Nov. 15,1990

To: MathWriter New Users

From: The Authors

Subject: MathWriter basic features—a first glimpse

We assume that you have a basic familiarity with the Macintosh 
interface as described in the materials supplied with your computer. 
Consequently, this first glimpse will describe the basic features you need to 
perform simple tasks with MathWriter—moving around within a 
document, formatting paragraphs, identifying typefaces, moving text, 
adding memo notes, saving and printing a document, and ending a session.

Basic features

Move around within a document

After reading this paragraph, repeatedly drag and release te l the 
vertical scroll box to examine the entire document and then return here. The 
number in the scroll box identifies the page that appears in the document 
window when you release the mouse button. More precisely, it is the page 
visible at the top of the document window! MathWriter displays 
documents as "sheets of paper" and automatically paginates them.

Click immediately above or below the scroll box to scroll one complete 
screen vertically up or down.

Click in the scroll arrows 151 to move a few lines, or press option when you 
click the scroll arrow to scroll a single line.

The boundary lines of the margins, the header, and the footer are visible 
because Show Layout in the Format menu has been selected (as a result, the 
menu choice now reads Hide Layout). The cursor changes shape when you 
move it from one work space where the blinking insertion point is located to 
another. If you move into the header, click, and then return to the main 
body, the cursor changes to and then back to

Examine the ruler

Observe that the positions of the left margin marker ^ (together with a 
left tab it looks like and first line indent marker 1 on the Ruler change 
when you place the cursor first within this paragraph and then within the 
paragraph that precedes, "Examine the Ruler." In this paragraph the first
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line "indent" is to the left of the paragraph margin and produces a 
"hanging indent" to make the paragraph conspicuous.

Notice that the ruler does not scroll from view; it always displays the 
particular conditions of the paragraph that contains the blinking insertion 
point. When you press return, MathWriter creates a new paragraph that 
inherits the ruler conditions of the previous paragraph. If you change the 
Ruler, a ruler icon Din) appears in the gray left border unless you select Hide 
Messages on the Format menu.

<— ruler icon in the gray area (in the screen version)

Examine paragraph alignment

Click within this paragraph and then select each of the four paragraph 
alignment symbols just above the vertical scroll bar. As you click each 
symbol, the text of this paragraph changes alignment from left w-, to right 
—w, to aligned left and right m-m, and to centered i *  i .

To place horizontal tabs on the ruler, drag them from the supply above the 
paragraph alignment icons. To remove a tab from the ruler, drag it past the 
right margin marker on the Ruler. Drag to reposition a tab or double-click 
the tab on the ruler to add a leader (see example below) or change the type 
of leader. Click on the next blank line (paragraph) to see O  ♦  O on the 
ruler.

a tab leader

Examine the status bar

Click inside the following words: "Click Here." Notice that the status bar 
at the foot of the window indicates the typeface, in this case bold. Also, 
observe that MathWriter reports in the status bar the line number 
(measured from the beginning of the document) and character position 
(measured from the first character on that line) of the blinking insertion 
point.

Edit a footer in-context

Scroll if necessary and look at the contents of the footer. In the right corner 
find the word "(more)" and click between left parenthesis and the word 
"more." Then type "Continue for" to see how footers are edited. Backspace 
to correct any typing errors. If you backspace too far, the word "(more)" may 
jump to the beginning of the line. With the cursor placed right before the 
"m" in "more" press tab to restore the word to its original position.
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Cut, Copy, and Paste
To observe editing with Cut, Copy, and Paste in the Edit menu, follow the 
instructions to change the sentence below from "Please move this word" to 
"Move this word, please."

"Please move this word."

Select Please using the mouse or using the arrow keys and shift key. With 
96 X cut it from the text and with 96 V paste it after word (or use the Cut 
and Paste selections in the Edit menu). Then complete the editing by 
changing capitalization and punctuation.

Select Clipboard from the Windows menu to see a copy of the word Please 
placed there by the cut command. Click the Clipboard close-box (top-left 
comer) to close it.

Create nonprinting messages

Double-click the note icon Q  to the left of this line 2 to see a hidden memo. 
Click its close-box to close it.

To create a memo, place the insertion point anywhere within this sentence. 
Then select Insert Memo from the Format menu. Type a message and then 
close the note window.

Save the document

If this file were not locked, you could use Save on the File menu to save your 
note. However, you can rename the file and save a copy of the entire 
exercise, including your note, in Math Writer format if you select Save As... 
from the File menu.

Examine multiple pages of the document

For an overview of the appearance of this multipage document, select 
Overview from the File menu. Drag the small square "handle" at the 
bottom-right comer of the first portrait to make the portraits larger or 
smaller. If you cannot view all pages at once, use the scroll bar to bring 
others into view. Click the square close-box in the top-left corner of the 
window to close this window.

Print a copy of this document

To print the document, click on the Chooser command in the fk (Apple) 
menu. The name of your printer should appear in the box User Name. If not, 
select Print from the File menu, make the selections necessary, and click OK 
in the print dialog box.

2 If the icon is not visible, select Show Messages on the Format menu.
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Summary

So far you have learned to:

• Scroll within a document and move the insertion point

• Locate headers and footers and edit them

• Create and format paragraphs (first line indent, tabs, leaders, and 
paragraph alignment)

• Locate the position of the insertion point and identify the typeface of 
the adjacent character to the left

• Cut, copy, and paste text

• Create and review hidden memo notes

• Save and print a document 

To continue this guided tour:

1. Select Close on the File menu.

2. Open the "Exercise 2" file to continue the tutorial.

To end this and other MathWriter sessions, select Quit from the File menu.

The Exercise 1 file is write-protected, so exit without saving when 
prompted.

Exercise 2: Reviewing a Manuscript
Word processors contribute a great deal to the task of perfecting a 
manuscript. In fact, this may be the important contribution a word processor 
makes to the writing process. In Exercise 1 you learned to make additions 
and deletions by retyping and by moving text selections from one place to 
another. In this exercise you learn to check spelling using the MathWriter 
dictionary, to use the thesaurus to improve word choice, and to search for a 
specific word in a document. As was the case in Exercise 1, the text of the 
exercise file will tell you what to do.

Because serious writing always requires revisions and frequently requires 
collaboration in editing or revising, MathWriter provides both revision 
tracking, a way of keeping track of additions and deletions to a document, 
and dynamic, in-context line numbering for quick and easy reference to 
passages.
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Spell-checker, thesaurus, and hyphenation

The spell-checker includes a supplementary word list of math, science, and 
engineering terms. It will, at your request, suggest options for misspelled 
words, skip words in all capitals, and locate repeated words. The thesaurus 
suggests synonyms for selected words and hyphenation tool automatically 
splits words between syllables to achieve a less ragged right margin.

Find/Replace: locating text or a type style

The Find/Replace feature can locate any string of text whether it is an 
embedded substring or a whole word. Furthermore, a search can ignore the 
actual text and search for a particular type such as font, size, or style. 
MathWriter can also locate hidden formatting characters such as the end- 
of-paragraph symbol or a tab marker. You can even specify a search direc
tion. For example, when composing a document, you often need to search 
backward from the insertion point.

To search backward from the end of this sentence to find the words 
"tab marker," follow these steps:

1. Place the insertion point at the end of this sentence.

2. Select Find/Replace from the Edit menu.

3. Press on the word Direction of the Find/Replace window and drag to 
Backward.

4. Type the word tab marker in the Find box.

5. Click the Find button or type Si G to locate each occurrence.

You can replace the located text with the contents of the Replace With box 
using the Replace (Si H) command or you can replace and resume searching 
using the Replace, then Find command. The Replace All command cannot be 
undone so you should always make a backup of the file before using this 
command.

Notice that you can search for mathematical expressions, as well as for 
typeface characteristics and text sequences.

Revision tracking
Math Writer uses a marker in the margin to alert you to a revision made to 
the original document, and displays both additions and deletions in 
context. You select distinctive styles to mark additions and deletions. In 
the following example, Abraham Lincoln could have used this feature to 
annotate the revisions he made before delivering his famous address at 
Gettysburg. In the example, strikeout style text identifies deletions and box 
style text marks additions he made to his first draft.
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Scroll through the example.

Gettysburg Address

(Lincoln’s first draft as annotated)

Four score and seven years ago our fathers brought forth, upon this continent, a new nation, 
conceived in Liberty, and dedicated to the proposition that all men are created equal.

Now we are engaged in a great civil war, testing whether that nation, or any nation, so 
conceived, and so dedicated, can long endure. We are met here on a great battle-field of that war. 
We arc motjhave cornel to dedicate a portion of it as the§ final resting place otjfoil those who here gave 
their lives that that nation might live. It is altogether fitting and proper that we should do this.

But in a larger sense we can not dedicate — we can not consecrate — we can not hallow this 
ground. The brave men, living and dead, who struggled here, have consecrated it far above our 
|poor|power to add or detract. The world will little note, nor long remember, what we say here, but 
can never forget what they did here. It is for us, the living, rather to be dedicated here to the 
unfinished | work) which they have, thus far, so nobly carried on. It is rather for us to be here 
dedicated to the great task remaining before 0  — that for these honored dead we take increased 
devotion to the|that) cause for which they here gave gave the last full measure of devotion — that we 
here highly resolve that these dead shall have not died in vain; that this nation shall have a new 
birth of freedom; and that this government of the people, by the people, for the people, shall not perish 
from the earth.

Because the additions and deletions are displayed in the document the 
changes are readily apparent.

♦  To annotate changes, enable revision tracking by typing S€ option R. The 
typeface indicator on the status bar at the bottom of the document window 
is enclosed in square brackets when this feature is active.

♦  To accept the changes, disable revision tracking (also 96 option R), click 
within a paragraph, and select Revise Paragraph from the Edit menu or 
type 36 M. Do that now.

Line numbering
Math Writer can supply line numbers on printed copies of documents as well 
as on the screen to expedite the editing process. You can number lines from 
the beginning of the document or from the top of each page. In the latter 
case, you should remember to supply page numbering in the header using the 
Palettes menu (last line).

♦ To enable the line numbering feature, select Line Numbers from Doc 
Preferences... (File menu).

You can select line numbering at any time, and Math Writer automatically 
renumbers the lines during editing. Since MathWriter  automatically 
supplies the line number in the document status bar as an aid for referring to



specific passages in a printed document, you probably will not enable this 
feature until you are ready to print the document.

• Enable and then disable the line numbering feature.

Summary

MathWriter provides the following document review tools:

• Spelling checker that includes vocabulary from math, science, and 
engineering

• Thesaurus for synonyms

• Generalized find and replace capability

• Revision tracking for in-context marking of additions and deletions

• Automatic line numbering to expedite editing the printed copy

This completes Exercise 2. In Exercise 3, you will examine some text entry 
and formatting tools.
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Exercise 3: Input Tools
Math Writer supports both mouse and keyboard input for most commands. 
By pointing and clicking the mouse, the novice or infrequent user can easily 
and quickly use MathWriter without having to memorize commands. On 
the other hand, the experienced or power user will appreciate the speed 
afforded by keyboard commands. Whatever your level of experience, you 
can mix these approaches as you wish.

O nline help

We hope that MathWriter's interface is sufficiently intuitive that you can 
work with minimal prompting. For those times when prompts would be 
useful, use the Help window as described here.

1. Select Help from the Windows menu ?).

The Help window presents a scrollable list of topics, including general 
information, step-by-step instructions for performing common tasks, and a 
menu/command summary. Select a topic from the list, scrolling if necessary, 
and click on the Help button or double-click on the topic. Use the « or » 
buttons to scroll to adjacent help screens, click Topics to return to the list of 
topics, click in your document window to return to it while leaving the Help 
window open, or click in the Help window close-box to put it away.
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2. If the Help window is still open, click the close-box in the upper left 
corner of the window to put the Help window away.

Keyboard commands for type style changes

MathWriter has an extensive set of keyboard commands. Those that 
control type style changes are listed here.

Font Selection
Toggles between the current font and the Symbol 
font (which contains the Greek alphabet and 
other mathematical symbols)
Font Size Selection
Next larger font size on size submenu 
Increase font size by one point 
Next smaller font size on size submenu 
Decrease font size by one point 
Font Style
Plain (and removes all other style attributes)
Bold 
Italic 
Underline
Other styles (access to numerous other styles)
Font, Size, Style, Justification, Alignment 
Revert to immediately previous style 
Style 1 of user-selected attributes 
Style 2 of user-selected attributes

Use Doc Preferences... in the File menu to 
assign user-selected attributes.

Transfer of paragraph form atting

Each new paragraph automatically inherits the formatting of the 
preceding paragraph.

To transfer the Ruler, Format, Ruler & Format, and Style information from 
one paragraph to another:

1. Click within the originating paragraph

2. Make a copy of the desired information using Edit/Copy Other

3. Click within the destination paragraph

4. Paste the information using Edit/Paste Other

Si spacebar

Si+
Si option + 
Si-
Si option -

SiP 
SiB 
Si l
siu
SiY  

Si \
si<
si>
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Using default documents

Many documents such as memos contain repeatedly used formats for 
letterheads, logos, etc. You might have a preferred font for these 
documents, depending upon esthetics or printer availability. To speed the 
creation of such documents, create and use skeletal default files as follows.

1. Use the New command from the File menu (not a New submenu even if 
one is present) to open a blank, generic document.

2. Assign all global properties of this default (template) document. 
Change the existing defaults as desired. Some options are:

• Use File/Page Layout to set the choice of printer, printer options, number 
of columns, space for binding, margin sizes, header and footer sizes, and 
whether to use facing pages format.

• Use File/Doc Layout to assign the placement of headers, footers, and 
footnotes within the document.

• Use File/Doc Preferences... to set font, font size, font style, paragraph 
alignment, and line spacing combinations for revision tracking, and for 
styles 1 & 2, footnotes, and italicization (used with Auto Math) if they are 
applicable to your template document.

• If relevant, use the Format menu to assign ruler options, line spacing, 
matrix formats, and formats for the variables such as date, time, etc.

• Use the Style menu to set the font, size, and style for the body of the 
document. You can also define User Styles on the Style menu to facilitate 
rapid and consistent assignment of typeface combinations for various 
headings and captions.

• Supply any text or graphics that you wish to appear in the default file.

3. Use Save As... on the File menu to turn your document into a default file; 
select MW Default File from the pop-up menu as the file type. Save the 
file in the same folder with MathWriter or in the system folder so that 
MathWriter can immediately add this name to the New submenu list.3

To use copies of this template in future sessions you need only select it from 
the New submenu. When you select a default file from New, MathWriter 
automatically uses the defaults contained in that file. Next, we show you 
how to create this primary startup file.

•  Before going on, for practice, create a default file.

3 If no default files are present, the New command will not contain a submenu.
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D efault settings and the startup file

Another way to reduce the number of commands and the time needed to 
create a document is to customize the MathWriter configuration to match 
your needs. The startup configuration pertains to Math Writer, rather than 
to a specific document, and is stored in the MathWriter Prefs file that 
MathWriter automatically creates in the system folder when you first use 
MathWriter.

The configuration includes your preferred combination of: the four floating 
windows, Template, Palettes, Tools, Font Table; libraries of repeatedly 
used input; choice of symbols and variables displayed in the Palettes 
window; and the name of the primary startup default file. The frequency 
with which you type mathematical expressions will probably guide your 
choices.

♦  To establish your configuration preferences, use the Preferences... 
command in the File menu to record your choices.

The significance of some of these choices may not be apparent until you 
have completed Exercise 5, which describes MathWriter's  mathematical 
tools. Here is a brief description.

The four floating windows can remain active and on-screen in a convenient 
location while your document is active. Scrolling will be faster if your 
screen is large enough to avoid an overlap of the floating windows with 
the active document window. The Templates window provides mouse access 
to the auto-formatting mathematical constructs such as fractions, roots, etc. 
The Palettes window provides mouse access to the Greek alphabet and to 
your choice of symbols and variables duplicated from the Palettes menu. 
The Tools window provides mouse access to the four editors (text, math, 
sidebar, and character) and to subscript and superscript commands. The Font 
Table window provides mouse "typing" for every character in every font 
available to the system, which is especially convenient for entering 
infrequently used special characters. The Library window provides mouse 
access to all entries in open libraries such as text, graphics, and 
mathematical expressions.

You can create a default file here or use the Save As... command discussed in 
step 3 of the previous section to create one. Then, select one of the default 
files as the startup file in Preferences... The name of the designated startup 
file appears at the top of the Preferences dialog and is the file Math- 
Writer automatically opens when you next initiate a MathWriter session.

Create and designate a startup file now. If you prefer to revert to the 
original startup configuration, put the MathWriter Prefs file in the trash 
when you return to the Finder or MultiFinder. This causes MathWriter to 
re-create the original Prefs file the next time the program is launched.
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Palettes and Diac menus

The Palettes and Diacriticals menus are always available. Palettes 
provides mouse access to the characters of the Symbol font (except the 
Greek alphabet, which is available from the Palettes window), a few 
special characters, and the Variables. As you drag the cursor over the 
Palettes menu, your current choice appears on the bottom row.

The Variables include the following: creation date, current date (which 
you can use in a default file to obtain the current date automatically), 
creation time, current time, page number and total number of pages (which 
can appear only in headers and footers), footnotes and cross-references to 
footnotes, equation numbers, subequation numbers, textual cross-reference to 
an equation, an arbitrary number of sets of user-defined variables analogous 
to equation numbering, and document file name. You can use these to 
dynamically number figures, tables, paragraphs, etc. The file name 
variable allows you to insert the name of the file into the text 
automatically so you can more easily maintain the correspondence between 
printed output and the MathWriter file used to print it.

MathWriter  treats a dynamic variable as a single, uneditable entity 
whose format and style are set with Variables Format... on the Format 
menu. (The name of the user-defined variable and its starting number are 
also set using Variables Format... .) MathWriter  automatically updates 
existing variables as you insert, delete, cut, and paste them. The print 
dialog box also provides an option to ensure that the date variables are 
current.

The Diac menu supplies mouse access to the diacritical marks when the 
insertion point is immediately to the right of some alphabetic character. 
The horizontal grouping symbols are available only when you have 
selected one or more characters. If you must repeatedly adjust the vertical 
positioning, set it once and place it in the library. To edit within a 
horizontal grouping, press the option key to obtain the split I-beam cursor.

Floating windows: Tem plates, Palettes, Tools, and Font Table

The properties common to all five of MathWriter's  floating windows are 
discussed here (Library is discussed in the next section); refer to Exercise 5 
for more detail.

1. Select each of the four windows (Templates, Palettes, Tools, Font Table), 
and Library) from the Windows menu.

2. Place the cursor in the gray region adjacent to the close-box of each and 
move to a convenient location.

3. Explore each menu. Click on the I-beam in the Tools window to be sure 
that you are in text editing mode when you complete this.



Guided Tour 21

4. Remove the floating windows by reselecting them in the Windows menu 
or clicking in their close-boxes.

Library

The Library provides rapid entry by mouse or by keyboard of repeatedly 
used material. Library entries can be up to 32K in size and may consist of 
text, graphics, or mathematical expressions. You may create specialized 
libraries for various tasks and have MathWriter search multiple open 
libraries. Double-click on an entry to select it using the mouse or using the 
keyboard type the abbreviated name followed by a space for immediate 
substitution. The substitution is immediate. A type-ahead buffer permits 
continuous input.

Suppose you wish to produce a customized document in which you select 
some of the components from a library. The steps to take would be:

1. Select Library Window from the Window menu.

2. Use Open... on the Library submenu of the Windows menu to gain access 
to Exercise 3.Lib. This displays the Library window that can float above 
and remain available to your document.

3. To quickly create a custom letter, place the insertion point in the 
rectangular box (i.e., the sidebar).

4. Type each abbreviated name (which is case-sensitive, e.g., ra is not the 
same as RA) followed by a space or double-click on the entries in the 
Library window. As you type each library entry name followed by a space, 
the Library immediately replaces the abbreviation with its content from 
the library. Press return as needed to format the letter.



22 Chapter 2

Remember, place the insertion in the practice 
box at the right. Type the abbreviation and 
space.

ra -> XYZ
Company
Anytown, State, Zip

da —> Thur. Nov. 15, 1990 (current date)

gr —> Dear

pal—> This is paragraph 1.

pa5—> This is paragraph 5.

pa3—> This is paragraph 3.

cl -*  Yours truly,

J. Dough, President

User-defined style attributes

Usually when typing a technical manuscript, you need to change style 
attributes frequently. To make this simpler, MathWriter  allows you to 
define two typeface combinations using the Doc Preferences command on the 
File menu. You can access these combinations with mouse or keyboard and, 
thereby, rapidly change font, font size, font style, alignment, and line 
spacing or any combination of these attributes.

To demonstrate the existing definitions:

• Select Style 1 on Style menu (or type 96 <) and type a few characters.

• Select Last Style on the Style menu (or type 96 \) to restore the original 
typeface.

User styles

User Styles on the Style menu allow for rapid formatting and ensures 
consistency of style among the various levels of headings, figures, captions,
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etc. The idea is to assign names to typeface combinations you intend to use in 
your document. You can assign these named typefaces, which are listed at 
the end of the Style menu, either as you type or after you have entered all 
the text. If you subsequently modify the definitions, MathWriter 
automatically implements the changes throughout the document.

♦  Select this sentence using the mouse and assign to it the figure caption 
style from the Style menu.

A convenient way to utilize your favorite User Styles is to define them and 
then store them in your default files.

Auto save

We recommend that you set the automatic file saving feature on Doc 
Preferences... of the File menu as insurance against file loss. The minor 
delay caused by Auto save can offset the inconvenience of retyping. The 
Auto backup command, also enabled on Doc Preferences..., preserves the 
immediate past copy of your document for even better protection.

We STRONGLY recommend that you use these protection features when 
composing original material at the keyboard.

Summary

In this exercise you have learned to use input aids to:

• use online help

• change typeface characteristics

• transfer rulers and other formatting from one paragraph to another

• create reusable default or template files (stationery)

• configure MathWriter for your particular needs

• use the floating windows

• create and use library entries for repeatedly used expressions

• create and use user-defined and user style combinations

• enable the Auto save feature to protect your files.



24 Chapter 2

Exercise 4: Graphics and Sidebars
MathWriter supports the mixing of graphics such as pictures and figures 
with text. It can also import mathematical expressions as graphics, but a 
far more powerful approach to writing mathematics is described in 
Exercise 5. In addition to handling traditional bitmapped and PICT file 
types such as those created by MacPaint® and MacDraw®, MathWriter  
can also handle encapsulated PostScript files such as those created by 
Adobe Illustrator® or Mathematica®. It reads these graphics files 
directly as well as by using the usual transfer via the Clipboard.

Figure 2.1 A M athem atica-created picture

MathWriter can resize, crop, and position these graphics. It treats a 
graphic as a tall character within a line of text or isolates it from the text 
in a sidebar so that you can place multiple lines of text adjacent to it. A 
graphic can become a background picture on any or all pages. Sidebars can 
become, in effect, isolated minidocuments within the main document and 
can still be fully formatted. You can also apply various border designs and 
background patterns to sidebars.

1. To move a copy of the MathWriter icon from the above line, select it 
using the I-beam cursor and copy it to the Clipboard using Copy on the Edit 
menu or Si C. (You could also use the Scrapbook or another application to 
place the graphic on the Clipboard.)

2. Place the insertion point at the destination location, somewhere in the 
document.

y = f  [x ]

X

Place a graphic in a line of text

3. Use Paste Picture from the Edit menu to transfer the picture into the 
active MathWriter document.
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4. Select the Character Editor by either clicking the arrow tool in the 
Tools window, selecting it from the Tools submenu of the Windows menu, or 
typing Si shift [. The cursor will change into an arrow.

5. Click on the graphic to select it. A rectangular frame with square 
"handles" at the corners forms around the graphic.

6. To resize the selected graphic, use Scale Picture... in the Edit menu (now 
changed because the Character Editor tool was chosen) or drag one of the 
handles. To preserve the width-to-height ratio, press the option key 
while dragging a handle.

7. To crop the selected graphic, press Si while dragging a handle. To crop 
all sides proportionally, press both option and Si while dragging a handle.

8. To reposition the graphic vertically, select it, release the mouse button, 
and then drag it.

To adjust the vertical position of any text character use the Character 
Editor as described in step 8.

Picture sidebar

A picture sidebar is a construct containing a graphic that is 
isolated from the body of the main text but attached to and 
floating with a paragraph in the main text. Words in the main 
text flow around the sidebar. You can resize and crop sidebars just 
as you can a graphic within a line of text. Picture sidebars can have borders 
and a background pattern, and they can be positioned horizontally (on 
either side of the left or right margin).

To create a picture sidebar:

1. Place a graphic on the Clipboard. For purposes of this exercise, scroll 
back to the MathWriter icon in the previous section, select the graphic, and 
copy it to the Clipboard.

2. Click to position the cursor within the destination paragraph—in this 
paragraph, for instance.

3. Select the Sidebar Editor either by clicking the "+" icon on the Tools 
window or by selecting it from the Tools submenu on the Windows menu.

4. Select New Picture Sidebar from the changed (because the Sidebar was 
selected) Edit menu, MathWriter will create a sidebar containing the 
picture on the Clipboard positioned flush with the left margin. While 
selected, the sidebar has handles just as described above for a graphic 
within a line of text. You can resize and crop the sidebar just as you did the 
graphics above. Use either the sidebar Edit menu commands or the mouse in
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combination with the 98 and option keys. A prompt in the typeface box of 
the status bar indicates which operation is enabled.

♦  For more practice with picture sidebars, do the following exercises: You 
can reposition the sidebar using the sidebar Edit menu at the left or right 
margins and, if space permits, just outside either margin. You can supply 
borders, shading, and whitespace around the sidebar using the sidebar Edit 
menu if the sidebar is selected. You can cut, copy, paste, and clear 
individual sidebars only while the Sidebar Editor is active.

Background picture

Text can be superimposed over a picture. The process of creating a 
background picture is similar to the steps for creating a picture sidebar. The 
background picture, however, is attached to the page, rather than the 
paragraph, and does not move when you edit the text. You might, for 
example, use this feature to place a logo in the header of the first page of a 
letter.

To create a background picture:

1. Copy a graphic to the Clipboard.

2. Select the Sidebar Editor using the Tools window.

3. Select New Background Picture from the sidebar Edit menu.

The graphic appears at the center of the page listed in the vertical scroll 
bar (you may have to scroll to locate the picture). You can assign the picture 
to appear on this page, on all pages, on all left pages, or on all right pages.

Right pages are the odd-numbered pages.

You can drag the picture to any position in the main body of the page while 
the sidebar editor is active.

♦  Practice by moving the background picture you have just placed. First, 
click and release the mouse button to select it and then drag it.

You can resize and crop a background picture using the procedures described 
for a single picture. And, as with sidebars, you can use the Borders option on 
the sidebar Edit menu to assign borders, the type of border, and even 
background patterns.



Guided Tour 17

A text sidebar is an isolated minidocu
ment within a document that is attached 
to and floats with the paragraph of text.
The main body of text wraps around the 
sidebar. You can resize and crop sidebars 
just as you can a graphic within a line of 
text. Text sidebars can have borders and a 
background pattern.

To create a text sidebar:

1. Position the insertion point at the desired location of the sidebar. For 
example, place the insertion point in this paragraph.

2. Select the Sidebar Editor either by clicking the "+" on the Tools 
window, selecting the Sidebar Editor on the Tools submenu, or typing 36 
shift ]. A new Edit menu will appear.

3. Choose New Text Sidebar on the Edit menu to create a default sidebar. 
Text in the document adjusts to its size and position.

4. With the sidebar still selected, drag one of the "handles" to resize it.

Text sidebar

Even after text has been added, you can resize the sidebar, and 
MathWriter automatically handles wordwrap.

A text sidebar can contain 
pictures and mathematics.

5. If desired, use the Edit menu to reposition the sidebar and modify the 
borders.

Cut, Copy, Paste, and Clear apply to sidebars while the Sidebar Editor is 
active. You can copy the picture from a picture sidebar if the Sidebar Editor 
is active, the sidebar is selected and you press and hold option as you use 
the Edit menu.

6. Click the I-beam tool to leave the Sidebar Editor and click within the 
sidebar. The cursor changes when you change regions.

7. Practice entering text.

MathWriter edits in the sidebar without leaving the document window for 
extended "What-you-see-is-what-you-get" performance.
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Summary

In this exercise you mixed graphics and text within a document, and you 
learned:

• To place graphics within a line of text inside a rectangular sidebar 
isolated from the text, and that text in the main document automatically 
flows around the sidebars.

• To resize and crop graphics and graphic sidebars.

• To place a graphic in the background and have text flow through the 
graphic.

• To create a text sidebar, which is a minidocument within a document and 
to specify borders and background patterns for sidebars.

MathWriter extends the meaning of "WYSIWYG" display by supporting 
editing of text sidebars without leaving the document window. It also 
allows you to import graphics directly from a file, including high 
resolution, encapsulated PostScript files.

For a discussion of Math Writer’s treatment of mathematical expressions, 
continue on to Exercise 5.

Exercise 5: Mathematics
In this exercise you learn to type two-dimensional mathematical 
expressions, to number equations automatically, and to use MathWriter's 
interactive library to type repeatedly used, built-up expression fragments.

Part 1: M athem atical expression editor

Preparing to write mathematics

Before we examine math writing features, you need to configure the 
MathWriter  environment for these activities. If the Templates, Palettes, 
and Tools floating windows are not visible, select them from the Windows 
menu and drag them to a convenient working location.

The Templates window behaves as if it were a vertical menu bar; press on a 
template category and drag to select a specific template. Alternatively, 
you may type command (98 ) and the row number followed by the column 
number of a specific template. For example, 98 2 and 1 selects the square 
root. If you pause before typing the column number, the selection menu pops 
out to prompt you. Typing other than one of the valid numerals aborts the 
command.
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E x e rc is e s

Use the following instructions to explore the auto-formatting templates 
that were used to create the equation that follows step 4. Use the box that 
follows the equation as a place to experiment without disturbing this 
document.

1. Position the insertion point in the box. When you want to move from the 
body of the document into the sidebar containing the equation, click within 
the box to change the cursor into an I-beam.

2. Select the root template by mouse (from the Templates pop-out menu) or 
by keyboard (961 and 1) from the Templates window. The insertion point is 
positioned to receive the argument.

3. Type "(1 + sin x)". The root symbol expands automatically.

4. Press enter (not return) to exit the root.

Create this \/(T + sin ■*) in the box.

Type here:

Notice that you can type in the sidebar without moving into a separate 
window.

If you make a mistake or wish to modify the expression, press option to 
obtain the split I-beam cursor A to edit within the auto-formatting 
structure and click within the expression. You could also select the split I- 
beam from the Tools window or Tools submenu (Windows menu).

Suppose you wanted to square the sine term. Edit the expression in the box 
below.

5. Click within the rectangle. The insertion point indicator on the status 
bar is changed to "sidebar" and the cursor shape again becomes an I-beam. 
(You may have to click in the gray shaded area of the Palettes window to 
move it and see the status bar.)



E d it  th is  V (1  +  sin x)  to  o b ta in  th is  V (1  +  sin2 x)

Edit this expression. V O  + sin x)

6. Option-click within the mathematical expression immediately after 
"sin." This positions the insertion point in the square root structure.

7. Press 96 ] or click on the arrow [ 3  in the Tools window (Windows menu) 
pointing diagonally upwards (just below the I-beam tool) to create a 
superscript. This changes the vertical position of the insertion point and 
decreases the font size.

8. Type the exponent and press enter (not return).

9. Press enter to terminate the superscript entry.

Because this superscript structure is nested within the square root structure, 
you must press enter again to reach the baseline and recover the I-beam 
cursor of the text editor. Alternatively, you could press return at any point 
to reach the baseline immediately. This use of nested operations illustrates 
the general procedure for constructing a mathematical expression of 
arbitrary complexity.

Suppose you wish to attach a superscript to a superscript as in the next 
equation. 1

y =

1. Position the insertion point after the equals sign.

2. Type "e".

3. Press 96 ] or click [a ] and type "x".

4. Press 96 ] again and type "2".

Observe that the leftmost display in the document status bar uses two up 
arrows f  t  to indicate that the insertion point is two levels removed from 
the baseline.
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5. Observe the status bar as you press enter twice.

How would you type a subscript to a superscript, as in the next equation?

yi =

1. Click to the right of the equals sign and add a space.

2. Type "e".

3. Press 36 ] and type "x".

4. Press 36 ] again and type "2".

5. Press enter once to return to the level of the "x".
(Now there is only one up arrow in the status bar.)

6. Press 36 apostrophe  or click on the arrow pointing downward [ST] in the 
Tools window for a subscript.

7. Type 1 and press enter to return to the superscript level.

8. Press enter again to return to the baseline.

MathWriter reformats the expression after each keystroke so you need not 
count spaces before typing even the most complicated expression. Nesting to 
any depth is supported.

Remember to option click to place the insertion point within the expression.



Suppose you wish to type the error function that appears frequently in 
probability theory and heat conduction problems:

erf (x) =
2

\fn

erf (x) =

Since in every example you must click inside the sidebar to position the 
insertion point, we assume that step hereafter.

1. To create a fraction, choose the first fraction template (96 1 followed by 1 
for the first template row and the second template column, or use the 
mouse). The second fraction template automatically reduces the font size.

2. Type "2" for the numerator and press enter to move to the denominator.

Always supply the numerator before the denominator. By using nesting, you 
can create numerators and denominators of arbitrary complexity.

3. Select the square root symbol (96 2 and 2).

4. Click on n in the Palettes window.

Use the mouse to select "jt" from the Palettes window or type 96 spacebar to 
toggle to the Greek alphabet, now noted in the status bar; type p to get pi; 
and then type 96 spacebar to toggle back to the previous font. The Greek 
alphabet is taken from the Symbol font; the characters have a mnemonic 
arrangement, "a" for a, "b" for p, etc. But if you cannot locate a character, 
use the Key Caps desk accessory or the Font Table window.

5. Press enter once to leave the root template and a second time to reach the 
baseline. To avoid your having to scroll, the sidebar is repeated here.
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9 rx 2
erf (x ) = - 7 =- e-1’ d<̂

V n J o

2  rx
erf (x) = —j =

V 71 JO

1. Select the single integral template with the mouse or type 36 5 and 1.

2. Type "0", the lower limit of integration. (It could be any arbitrary 
expression.)

3. Press enter to move to the upper limit of integration and type "x".

4. Press enter to return to the baseline.

Use option click if you need to edit either limit.

5. Complete the integrand as in the previous example. If you need a 
reminder of what it was, click on the memo icon D  in the margin here. (You 
may have to click in the gray, shaded portion of the Templates window to 
see the memo icon in the margin.) Click the memo's close-box to close again.

Close this file and open the file "Exercise 5b" to continue.

Here is another practice example.

V =
4M>

K
n =  0

1
(2/1+1)

exp [-K(2«+l)27t2f / L z] sin
(2n+\) n x

[ 1 ]

As with the integral example in the previous example, use enter to move 
from the lower to the upper limit. The down-scaled infinity symbol is an 
idiosyncrasy of the Symbol font; use option click to select it with the split 
I-beam and increase its font size with + or Text Size on the Style menu.



Try the next example with the special functions that have an argument 
centered below them. Use S i 7  or click on / the Templates floating window to 
access the limit template. Get the from the Palettes menu.

1 -  cos x sin x  cos xlim ----------- = lim -r —  = lim
jc-»0 j j -2 n O  x 0 2 2 [2]

The Cut and Paste operations on the Edit menu apply to mathematical 
expressions, even when you use the Math Editor cursor. In this way you can 
frequently avoid retyping built-up expressions such as If you
repeatedly use a large number of built-up expressions, a Library facility 
lets you store and copy them into text using abbreviations or by double 
clicking on the entry when the Library window is open.

MathWriter automatically groups rows of expressions with a stretchable 
symbol as in the following exercise. Use the Palettes menu (or S i 8  and 2) 
and the Greek alphabet on the Palettes window (Windows menu) for the 
special symbols. Use return to create a new row.

y = M
j  x ,  jc >  0  

| - jc, jc <  0
[3]

If you are using the Apple, rather than the Adobe, version of the Symbol 
screen font, the large brace in the above expression will be truncated, but it 
will print correctly in LaserWriter output. (Use Calc Prev J or I Size or S i D  

to size the absolute value symbol from the Palettes menu to fit an 
expression; use the Character Editor to stretch it to an arbitrary size.)
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MathWriter automatically formats matrices and other two-dimensional 
arrays. In order to create self-sizing parentheses for a tall fraction:

1. Pull down the Style menu to Auto Math Options... and release the mouse. 
A pop-out menu appears.

2. Click on Auto-bracket sizing if it is not checked and click OK. (This 
includes the auto-sizing feature in the set to be enabled in step 3.)

3. Now click on Auto Math in the Style menu (or press $6 E). This activates 
those items you have checked in the Auto Math Options window.

In general, activate Auto Math only while you are typing an equation and 
then toggle this feature off with ^  £ to reduce the computational load.

[D] = f E  1 [4]
1 - p 2

Type [4] here—>[D] =

4. To complete equation [4], type an ordinary left parenthesis, select the 
fraction template (3T1 and 1), supply the numerator, press enter, type the 
denominator, press enter, and then type ")".

5. Complete the expression below by adding the matrix.

[D] =
(  E  A

1 -  p :
V r

1 |i 0

p 1 0

o 0 E it t
[5]



6. To construct an array of any number of rows and columns just select the 
appropriate construct from the Templates window, in this case vectors and 
matrices (the next to last row on the Templates window), and create the 
elements. The first element corresponds to row one, column one.

7. Press tab to move to the next column (or to create the next column) in the 
same row.

8. Press return to move to the next row (or to create the next row) in the 
same column.

9. To move into an existing cell, use option click with the mouse or shift 
with the arrow keys.

MathWriter reformats the array as you type. Use Matrix Format... in the 
Format menu to set placement, line type, justification, and spacing of cells.

Pull down the Format menu to Matrix Format and release the mouse to view 
the formatting possibilities.

Any changes made in the Matrix Format when a matrix is selected apply to 
that matrix only; any changes made when no matrix is selected apply to all 
future matrix input.
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As a final exercise, reproduce the following table.

a \\ 123.456 l U w i 2)

/ l+x 
1 l - x 2 Text

1. Place the blinking insertion cursor in the sidebar.

2. Use 36 0 and 2 to activate the table template. Create rows and columns 
just as in the matrix example. Use "0" for row "10".

The cells of a table can contain numbers, text, graphics, or mathematical 
expressions. Use Matrix Format... in the Format menu to change the 
defaults. When the insertion point is within a cell, you can insert or delete 
a row or column using Insert and Delete on the Edit menu.

Remember, option dick to edit within a cell. The status bar indicates the 
row and column of the insertion point.
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Part 2: Technical support

In addition to the need for writing equations, technical writing places other 
special demands on a word processor. Automatic revision tracking, hidden 
memo notes, and automatic line numbering address the collaborative nature 
of scientific writing and were discussed in Exercise 2. The increased 
complexity of input due to the enlarged set of fonts and symbols, font sizes, 
and font styles was discussed in Exercise 3. Now we will explain several 
other features of special importance.

Numbering equations and cross referencing them in the text is an important 
feature for writing math. Suppose you decide to assign a number to the first 
equation in the sidebar below. Equation [1] then would become equation [2]. 
Without MathWriter's  automatic numbering, you would have to find and 
increase all succeeding equation numbers and all cross-references to them in 
the text and elsewhere. MathWriter handles this task automatically. 
Even if you use cut and paste operations to edit your manuscript, 
MathWriter updates the numbering and linkages correctly. This assumes, of 
course, that you move both an equation and its associated equation number 
together.

Warning: If you remove an equation number which is linked to a cross- 
reference variable, the cross-reference number is no longer meaningful and is 
changed to a "?".

Observe that /(z) is analytic for all values of z such that 1 < Izl < 3. 
We may find the o '̂s of [6] by using the following device. [Pennisi, et 
al., Elements of Complex Variables]

Automatic numbering

/U) = Xr=^>o a„(z -  z0f ,  r, < I z -  z0 I < r2

where

[6]

and the integral along C is taken in the positive direction.

Find the Laurent series expansion, in powers of z, for the function

To add the equation number to the first equation, follow these steps:

1. Place the insertion point in the first equation and drag a centering tab ♦  
to the middle of the ruler. This centers the equation.
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2. Drag a right tab 4 near the right margin.

3. Place the insertion point immediately to the right of the first equation, 
verify that you placed a tab near the right margin, and inspect the ruler. If 
necessary, add a right tab.

We centered the equation at the ruler position set by a center tab, rather 
than with centered paragraph alignment. To avoid a contradiction, 
NEVER use centered paragraph alignment and a tab to number equations. 4

4. Press tab to position the insertion point at the right margin, and select 
equation number [i>] from the last row of the Palettes menu. (As you drag 
the cursor over each icon its name appears on the bottom row of the menu.) 
When you release the mouse button, Math Writer automatically calculates 
and assigns the equation number.

The new equation becomes number [1], the 
original equation [1] becomes number [2], 
and MathWriter updates the cross- 
reference to the original equation in the 
last paragraph of text, too.

The program handles subequation number
ing in an analogous manner. It numbers 
multiple parts of any equation, but you 
have to identify the linked variable by 
number, by relative number, or by pointing.

With Variables Format... in the Format 
menu you can assign such things as the variable style, format, and style of 
enclosing brackets for equation numbers.

MathWriter automatically updates all variables of this type throughout 
the document if you change any of the choices in Variables Format... 
(Format menu). You cannot edit these variables placed within the 
document as you would other character strings; you can only make changes 
using Variables Format... .

♦  Select Show Invisibles from the Format menu to locate the dynamic 
variables identified by dotted boxes and Hide Invisibles to conceal them.

Automatic numbering of other entities such as figures, tables, theorems, 
paragraphs, etc. is also possible. In addition, you can define sets of 
dynamic variables for other items, and MathWriter  will automatically 
track them.

y = x 2 no #

y = a x 2 + bx [1]
Reference to eq 1

y = x 2 [1]

y = a x 2 + bx [2]
Reference to eq 2
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To create a "figures" user-defined category, follow these steps:

1. Select Variables Format... in the Format menu, and click New.

2. Assign a variable style and select it in the scrolling window.

3. Select a numbering scheme; decide on enclosing brackets, if any; assign a 
starting number and category label (e.g., "Fig. " including the trailing 
space). Click OK. MathWriter adds this name to the icon.

4. Drag the mouse over the user-defined category on the Palettes menu to 
verify that the program has assigned the new name.

Mathematical libraries

MathWriter allows you to type simple abbreviations in place of complex 
expressions using libraries. Mathematical derivations often use difficult- 
to-create built-up expressions. To type boldface notation for vectors, 
overbars for complex conjugates, and difference notations in finite 
difference methods you ordinarily need multiple keystrokes. MathWriter 
lets you type a simple abbreviation instead of a complex expression. 
Alternatively, if you become burdened with too many abbreviations, you 
can simply point and click in a library list to insert a built-up expression at 
the insertion point.

An example of the Runge-Kutta method for a system of two first-order, 
ordinary differential equations follows:

* o  =  hf(yn>yZ)’
k i =  hf{yxn + y„2 + \k % ) ,

k2 = + 1* 1. yn + \ k\)i
*3  = hf<Jn + k2 ’ yn + kb >

1. Display the Library window and open the file Exercise 5.Lib on the 
Windows menu. To do this, select Library from Windows menu. Then select 
Open from the Library submenu in Windows and open the library file.

2. Place the equations within the rectangle by typing the keyboard 
abbreviations or by pointing and clicking. Start by clicking to place the 
insertion point. Then type klO; =; h; f; (; y in ; , ;  y2n;), return and so forth, or
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double-click on the Library items. Do not type the semicolons used for 
punctuation.

These substitution methods should increase your speed and, we hope, let 
you concentrate on content rather than typing. The extent that variables 
with subscripts and superscripts are repeated in mathematical material 
would become clear, if for example, the complete set of equations above 
were typed character by character. (Consider typing an entire book that 
way!)

A way to compartmentalize your mathematical expressions is to build 
libraries specific to your discipline. Since multiple open libraries are 
searched automatically, you could produce specialized libraries and use 
them in various combinations rather than having to merge them into a 
single file.

Since an abbreviation for an expression in the library might appear 
naturally in your text, MathWriter only recognizes library abbreviations 
when they are followed with a space. If you need to use a series of letters 
that constitute a library abbreviation but don't want the abbreviation 
made, you could type an extra character, and use delete  (or backspace) to 
remove the extra character. As indicated in the Windows menu, Library 
submenu Preferences... dialog, you can also use option L to enable and 
disable the library feature as you wish.
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\J Nontechnical Writing

Online Help
MathWriter offers more than fifty online Help screens. To use this resource 
you must have placed the MathWriter Help file in the System folder of 
your Macintosh or in the folder containing MathWriter before activating 
MathWriter. If disk space is too limited or if you are an experienced Math- 
Writer user, you may forego the convenience of online help. To access 
MathWriter's Help screen, follow these steps:

1. Type 96 ? (in other words, while depressing the command key type a 
question mark)1 or select Windows/Help1 2 to open the scrolling index (see 
Figure 3.1). The Help window has a fixed size, but you can reposition it on 
the screen by dragging its title bar.

□ Help

[Printing T5I
Rulers/Tabs
Screen Display 

Key Commands 
Moving Around 
Scrolling
Speed Enhancements 
Status Bar 

Search 

Find /Replace 

Shortcuts /Key board 

Cmds/1 -4  
Keyboard/1-4 

Sidebars 
Styles 

Styles Menu 
Typefaces
User styles________

Select help by double-clicking 
in a topic; or click in Help for 
the currently selected topic.

Figure 3.1 Help index

1 Ignore space separators in commands. See the end of Chapter 1 for a summary of conventions.
2 This notation means select the Help command in the Windows menu.
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2. Scroll to locate the relevant topic.

3. Double-click on a topic in the list or click on the topic and then click the 
Help button.

Figure 3.2 Rulers and Tabs help screen

Figure 3.2 displays the relevant Help message (Rulers & Tabs subheading 
under Paragraph). The Help button becomes the Topics button while 
messages are displayed and provides a return link to the Help index. Two 
adjacent buttons « and » appear and provide scrolling forward and 
backward through the various screens related to this topic. In this case, 
there is only one relevant screen, so when you click on Topics, you will return 
immediately to the list of Help topics.

Either select another topic, drag the Help window aside, or click the close- 
box at the top-left corner of the Help window to remove it.

Producing a Nontechnical Document
MathWriter  provides you with more than technical writing capabilities. 
It is a word processor that enables you to capture your ideas with words or 
symbols, supplies formatting that enhances the reader's comprehension, 
allows you to correct errors and rearrange wording to improve precision of 
expression, preserves a computer-readable copy for use in future sessions, 
and produces a printed copy of your document. In short, it allows you to 
produce a printed document efficiently.
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Entering text

In the previous chapter you learned to install MathWriter. If necessary, 
repeat that process now and double-click the MathWriter icon to activate 
the application. In this chapter we will discuss the techniques you will 
need to create a nontechnical document; the more specialized techniques 
associated with technical writing will be discussed in the following 
chapter.

127 |3i | i |
3/H.3

~l47TT~□ I

VI

n

i

c
u
T

M
§

i i i i 16. 1 . I m u

TageTS ]

♦  Steps in  producing a nontechnical document

Basically, your word processor should enable you to capture your ideas with 
jwords or symbols, supply formatting to facilitate the readers comprehension, 
allow you to correct errors and rearrange the warding to improve precision of 

êxpression, preserve a computer-readable copy for use in future sessions, and 
iproduce a printed copy of your document, In short, the basic purpose is to 
.efficiently produce a printed document, Let's look at the steps to perform these 
Itasks.

Figure 3.3 Document window with text
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Figure 3.3 displays a document window with text. If you are not familiar 
with the basics of the Macintosh human interfaces, refer to the tutorial 
materials supplied with your Macintosh. If you only need a simple 
refresher, refer to appendix 1 of this manual for a quick review.

Opening a document

There are three ways you can open a MathWriter document:

• Use the document window and the one-page, blank workspace 
MathWriter presents at startup, unless you have customized it to present a 
default or template document using Preferences (on the File menu).

• Select a submenu of the New command (on File menu) to obtain a copy of a 
document template you created previously.
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• Open an existing document using File/Open... (3€ O).

Math Writer's screen display of a document closely resembles the document 
you eventually print. This important, productivity-enhancing attribute is 
widely known as "What you see is what you get" or WYSIWYG 
(pronounced"whizzy-wig"). The closer the correspondence, the easier you 
can produce the desired printed document. Many of Math Writer's features 
help you visualize the end results as if you were working with a sheet of 
paper.

Creating text

If you have a Macintosh with a small screen, only a portion of the document 
page will be visible at one time. The blinking vertical bar |, known as the 
insertion point, identifies your position within the document. Characters 
you type appear at the location of the insertion point, and the insertion 
point advances as you type.

Unlike a traditional typewriter, a word processor supplies extensive 
formatting support. For example, when your line of typed text reaches the 
right margin, any whole word that does not fit on the line moves to the next 
line. This is called "wordwrap."

Do not press return until you reach the end of the paragraph. If you must 
force a new line within a paragraph, use shift return.

When you fill a page, MathWriter  automatically creates and numbers a 
second page. The vertical scroll box Ip̂ J always displays the number of the

page currently visible at the top of the document window, even if a portion 
of the next page is also visible on the screen.

MathWriter uses a few normally invisible characters to control screen 
formatting. Use the command Format/Show Invisibles to display the end- 
of-paragraph marker <H; other invisible characters include space (shown by 
a dot below the line), tab ♦, line break P, column break Si, and page break
O. Page numbering variables in the header or footer are displayed within a 
dotted box when invisible characters are showing. To make all these 
characters invisible again, use the same menu command, which now reads 
Hide Invisibles.

Document organization

The basic elements of a document are paragraphs, sentences, words, 
characters. We organized MathWriter with that in mind. The paragraph 
is the basic organizing unit of a document. As mentioned above, you use the 
return key to delimit paragraphs. Said differently, a paragraph is the 
material enclosed by pairs of invisible paragraph markers.
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Navigating within a document

Because typed text appears in the document at the insertion point, you must 
be able to position the insertion point at different places in a document. And 
because the document is usually larger than Math Writer can display on the 
screen at once, you must be able to select parts for viewing and modification. 
Mouse and keyboard controls are available for navigating.

You can position the insertion point anywhere within existing text. In order 
for Math Writer to format a document automatically, text fragments cannot 
be allowed to dangle arbitrarily within the document, and that would be 
the case if the insertion point could be positioned without any relation to 
existing text. Consequently, you can add text within or on the boundaries of 
existing text. Use Format/Show Invisibles and Show Layout to view these 
boundaries.

Mouse navigation The gray scroll bars are the primary, mouse-controlled 
tools for bringing other portions of the document into view. Separate scroll 
bars control horizontal and vertical motion.

The white scroll boxes indicate the relative location of the current view of 
the document in its scroll range. The vertical scroll box displays the page 
number of the page in view at the top of the active document window.

There are a number of ways to scroll using the mouse.

• To scroll in discrete steps of approximately eight lines, click the cursor in 
one of the arrows at either end of the scroll bar. Because mathematical 
expressions are frequently taller than ordinary lines of text and because 
larger screens are more common now, larger movements are made easier by 
this convention. To scroll a smaller amount (approximately one line), press 
the option key while clicking the scroll arrow.

• To scroll one windowful, click in the scroll bar above or below the scroll 
box. The actual scroll distance depends upon the current size of the active 
document window.

• To scroll an arbitrary amount (especially useful for long documents), drag 
the scroll box with the mouse. You can scroll directly to a specific page in a 
single try because the scroll box immediately reports the destination page 
number even before you release the mouse button. The number in the scroll 
box corresponds to the page which is visible at the top of the document 
window. •

• To scroll to a header, footer, footnote, or back 
to the previous location of the insertion point 
within the body of the text, use the pop-up menu 
associated with the insertion point position 
locator in the status bar. To practice using the insertion point pop-up menu:

Body

O  Header -  Every page 

C l Footer -  Every page



1. Select a region, such as the Header, from the pop-up menu. M a t h W r i t e r  
automatically scrolls that region into view for editing.

2. Select Body from the pop-up menu to scroll to the original location of the 
insertion point.

The scrolling options listed above provide the control you normally 
require for editing a document. However, additional choices, described 
below, make M a t h W r i t e r  a convenient substitute for a slide projector for 
presentations.

• To scroll the page boundary separator of the next or the previous page to 
the top of the document window, 9$  c l i c k  in the scroll bar below or above the 
scroll box, respectively.

• To scroll the header of the next or previous page to the top of the 
document window, o p t io n  c l i c k  in the scroll bar below or above the scroll 
box, respectively.

• To scroll the text body of the next or previous page to the top of the 
document window, 96  o p t io n  c l i c k  in the scroll bar below or above the scroll 
box, respectively.

If you group your material into screen segments (for the presentation screen 
size ) each segment can be sequentially positioned at the top of the screen. 
M a t h W r i t e r  allows you to easily and quickly scroll through your presenta
tion. For very rapid scroll speeds, scroll through your document before your 
presentation to allow M a t h W r i t e r  to build lookup tables, or save the file
with the "Compact file" option disabled using File/Doc Preferences.

•

When you scroll, the position of the insertion point relative to the text does 
not change. To quickly scroll back to the location of the insertion point, 
either type a character or use the mouse to perform the menu command 
Edit/Show Selection. To reposition the insertion point, just click the I-beam 
point at the desired location, possibly after scrolling. As discussed later, 
when you are selecting text and drag past the top or bottom of the window, 
the screen scrolls automatically.

If you must work with documents wider than the screen (or window), such as 
a landscape orientation view [see File/Page Layout/Page Setup], then you 
can use the horizontal scroll bar to view a hidden portion of the document. 
M a t h W r i t e r  supports automatic left and right scrolling to keep the inser
tion point in view. M o s t  o p e r a t io n s  in  M a t h W r i t e r  c a n  be  p e r fo r m e d  u s in g  
e i t h e r  th e  m o u s e  o r  th e  k e y b o a rd . Consider now the keyboard alternatives 
for navigating.

Keyboard navigation The arrow keys (<—, —>, T ,i) move the insertion point 
around within text and mathematical expressions.
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• The arrow keys move the insertion point one character to the left or right 
or one line up or down. As with the other keys, keeping an arrow key 
depressed causes it to repeat at a rate set in the Apple/Control Panel. If 
necessary, M a t h W r i t e r  automatically scrolls the screen horizontally or 
vertically to keep the insertion point in view. Because M a t h W r i t e r  
supports variable character widths, vertical scrolling does not move in a 
straight line, but along a path that maintains a constant character count 
(reported in the status bar) from the left margin in the paragraph in which 
the movement begins. The insertion point then moves to the left margin in 
succeeding paragraphs. Repeated use of the right arrow moves the insertion 
point through the text along the path used when reading. The left arrow 
does the opposite.

• Using the o p t i o n  key simultaneously with an arrow key, magnifies the 
movement of the insertion point. O p t io n  le f t  a r r o w  or r i g h t  a r r o w  moves the 
insertion point immediately to the left or the right end of the current line, 
respectively. O p t io n  u p  a r r o w  or d o w n  a r r o w  initially moves the cursor to 
the top or bottom of the active window and if pressed again (or if held 
down) the insertion point scrolls to the top or bottom, respectively, of the 
document.

• Using 9 6  simultaneously with the up or down arrow scrolls the window a 
large amount (approx. 8 lines).

• Using 96  and o p t i o n  simultaneously with the up or down arrow scrolls the 
window a small amount (approx. 1 line).

T o  m a k e  th e s e  k e y  c o m b in a t io n s  e a s ie r  t o  r e m e m b e r ,  n o t e  t h a t  i n  g e n e r a l :

•  p r e s s in g  96 c h a n g e s  th e  m e a n in g ,
•  p r e s s in g  o p tio n  m o d i f ie s  th e  s c a le ,  a n d
•  p r e s s in g  sh ift  e x te n d s  th e  r a n g e .

Selecting text
I n  g e n e r a l ,  y o u  m u s t  e x p l i c i t l y  i d e n t i f y  th e  o b je c t  o f  a  c o m m a n d  b y  s e le c t in g  
i t  b e fo r e  y o u  g iv e  a  c o m m a n d .  Selected text is displayed with the black and 
white colors reversed. Rather than black text on a white background, 
selected text is displayed as white letters on a black background. We refer 
to this as "highlighted text."

Colors can be used for this purpose if you have a color display, but the use of 
color slows the program considerably. For this reason we recommend using 
the Apple/Control Panel/Monitor to disable color output.

You can use either the mouse or the keyboard to make selections. Using the 
mouse, you have the following options: •

• To select a word, click twice at the same position within the word.



When a word is selected by double-clicking (rather than by dragging, for 
example), a space character immediately preceding the word is 
automatically added to the selection if you then use Edit/Cut.

• To select a line of text, click three times at the same position within the 
line.

• To select a paragraph, click four times at the same position within the 
paragraph.

• To select the entire document, use Edit/Select All.

• To undo a selection, single-click anywhere in the document.

To select an arbitrary contiguous string of characters, drag the cursor over 
the text.

1. Position the cursor in the text at either the beginning or end of the 
substring you wish to select.

2. Drag (press and hold the mouse button down while you move the mouse) 
to the other end of the substring and release the mouse button.

If you drag past the top or bottom of the window, the document 
automatically scrolls to make the additional selected text visible. Observe 
that the highlighted text continually changes as you drag the mouse but 
always includes the text substring between the insertion point and the 
current cursor position.

For somewhat longer selections you may prefer to use the shift click 
method.

1. Position the insertion point by clicking the cursor in the text at the 
beginning or end of a substring you wish to select.

2. Scroll to the other end of the text string and press the sh ift  key as you 
click the mouse. (Shift serves as an extender.)

To select text using the keyboard, follow these steps:

1. Using the arrow keys, position the insertion point within, not 
necessarily at one end of, the substring you wish to select. Recall that using 
the option key in combination with the arrow keys produces larger insertion 
point movements—at the beginning or end of a line, top or bottom of the 
window, and top or bottom of the document.

2. To complete the selection process, press sh ift  and use the arrow keys to 
"grow" the selection about the insertion point.

Using option with shift arrow changes the scale. Option shift with left or 
right arrow selects the current line to the left or to the right of the insertion
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point. So if the insertion point is not at the left or right end of the line, use 
both commands to select the entire line. Option shift with up or down 
arrows selects from the insertion point to the top or bottom of the window, 
respectively. Use the same option shift arrow command twice to select from 
the insertion point to the top or bottom of the document.

Basic editing

Simple editing techniques for adding, deleting, moving, and copying text 
are useful when creating a document.

• To add text you simply position the insertion point where you want to 
add text and type.

• To overwrite text, first select or highlight the text and then type the 
replacement text.

• To delete a character, position the insertion point to the immediate right 
of the character and press delete. Repeatedly press delete or hold it down 
to remove additional characters to the left.

• To delete large selections, select or highlight the text and press delete 
once. Alternatively, use Edit/Cut (96 X) or Edit/Clear to remove the 
highlighted selection.

The Cut command makes a temporary copy of the selection on the 
Clipboard for subsequent "pasting" into the document when the insertion 
point is at another location. The Clear command does not save a copy on the 
Clipboard, but Edit/Undo restores the removed text if used as your next 
command. Clear is especially useful when you are deleting a large selection 
because no Clipboard copy is made.

• To move text from one location in the document to another using the mouse 
or keyboard:

1. Select the text.

2. Copy the text to the Clipboard using Edit/Cut or 96 X.

3. Position the insertion point at the intended destination.

4. Paste the Clipboard contents into the text using Edit/Paste Text or 96 V.

• To duplicate, rather than remove, text from one place to use elsewhere, 
use the procedure described above replacing Edit/Cut (or 96 X) with Edit / 
Copy or 96 C.

The command keyboard equivalents appear on the pull-down menus as 
reminders. By convention and for clarity, uppercase letters are shown; 
however, you must use the lowercase letter to execute the command.
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During text entry you may need a few additional, basic editing commands:

• Undo The Edit/Undo (or $8 Z) command allows you to undo the effects of 
the immediately preceding command in most cases. A few global commands 
such as Replace All, of Edit/Find/Replace, cannot be undone with this 
command. If you must use Replace All, save a protective backup copy of the 
document just before you use it, perhaps using File/Save A Copy.

• Invisibles The Format/Show Invisibles command allows you to display 
the otherwise invisible formatting characters in the text. Although you 
need not see a marker to delete a formatting character, seeing them allows 
you to locate them more easily. To hide these markers, use Format/Hide 
Invisibles, as this command is now named.

• D elete Recall that a new paragraph is created when you press r e t u r n .  
Therefore, to join two paragraphs, remove the separating paragraph 
marker. Do this by placing the insertion point at the beginning of the 
second paragraph, not at the end of the first, and press d e le te .

Similarly, if you ihanually create a new page using Format/Insert Page 
Break and later wish to remove that marker, place the insertion point at 
the beginning of the second page (NOT at the end of the first page) and 
press d e le te .  This same pattern applies to column breaks, tabs etc.

Note that e n t e r  and r e t u r n  have distinct purposes in M a t h W r i t e r .  As you 
will see later, the e n t e r  key plays a role in creating mathematical 
expressions analogous to r e t u r n  in creating paragraphs in ordinary text.

Space betw een paragraphs Although you can add space between 
paragraphs by pressing r e t u r n  to create empty paragraphs, we recommend 
that you use Format/Paragraph Format to assign extra spacing before or 
after paragraphs. Just as the first line indent of a paragraph eliminates a 
t a b  key command, this command eliminates one or more r e t u r n  keys. In 
addition, you can quickly change the spacing between paragraphs in pixel 
increments at any time using Edit/Select All and Format/Paragraph 
Format. Also, this prevents the paragraph count in File/Doc Info from being 
inflated.

Numerous input techniques—the Palettes menu, the Windows menu 
(Palettes Window, the Font Table, and Library)—will be discussed in the 
next chapter.

Formatting
M a t h W r i t e r  provides users with an especially rich set of formatting 
capabilities. A rather modest and quickly learned subset of these should be 
sufficient for nontechnical writing. Depending upon personal preference, you 
can apply formatting to the text as you enter it or apply the formatting 
later. If you are a speed typist or are opening an unformatted text file, you



Nontechnical Writing 53

Document formatting

might supply formatting after you finish entering the text. In most cases, 
however, you should anticipate the general design of your document and 
make tentative choices before entering the text. Otherwise, changes at the 
document level, such as margins, affect formatting at the paragraph level, 
such as line length. The side effects of the changes become more bothersome 
when advanced structures, such as mathematical expressions and sidebars, 
are involved.

Document formatting has three levels: global formatting, which applies to 
the entire document (page size, page orientation, margins, columns, 
headers, footers, and footnote placement etc.), which you set using the File 
menu,paragraph specific formatting (tab settings, alignment, line spacing, 
borders, etc.) which you set using the Format menu, and character 
formatting (font, size, style, etc.), which you set using the Style menu. The 
design process normally proceeds from the general to the specific. This is 
also reflected in the left-to-right ordering of MathWriter menus.

To format a simple document you need consider only the choice of printer, 
which you assign using Apple/Chooser, and two commands on the File 
menu—Page Layout and Doc Layout.

Chooser Although you can route any existing document to an ImageWriter, 
to a LaserWriter, or to an even higher resolution device, some differences 
besides printer resolution do exist. The usually subtle differences between 
screen display and printer output might affect your choices in order to get 
optimal output. For example, if you intend to use a LaserWriter, you 
probably will elect to use LaserWriter fonts throughout your document. In 
M athW riter's Text Font menu the names of built-in laser fonts are 
underlined. Because font dimensions vary among font families of the same 
font size, substituting fonts automatically when you print can lead to 
undesirable spacing.

Page Layout To set up the Page Layout for your documents:

1. Click on File/Page Layout to examine the choices (see Figure 3.4).

2. Click the Page Setup button first because your choice of paper size and 
orientation will affect your other page layout choices such as margins (see 
Figure 3.4 and Figure 3.6). Paper size choices are listed in Table 3.1.
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Page Layout. Columns (D 1 O 2 O 3 O 4

Header height: 

Footer height:

□  Gutter

^  Facing pages

0.000 in

0.305 in
Page w idth: 6.50 in. Page height: 8.19 in.

Cancel [— — 1

Figure 3.4 Page Layout dialog

LaserWriter Page Setup 5.2

Paper: <§) US Letter O H4 Letter O Tabloid 
O US Legal O B5 Letter

Printer Effects:

L _ ok

[ Cancel

Reduce or 
Enlarge:

Orientation

%

Ts>

□  Font Substitution?
^  Tent Smoothing?
^  Graphics Smoothing?
^  Faster Bitmap Printing?

Options]

Help

Figure 3.5 Page setup window for LaserWriter

If you must switch printer types to print a document, remember that even if 
you make no changes, you need to open the Page Setup dialog and click on 
OK. This causes M athW riter to implement any necessary formatting 
changes. Proofread your document to verify that no unanticipated changes 
have been made by MathWriter.
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Portrait, the default page orientation, is taller than it is wide. The 
landscape orientation is a portrait-size page rotated 90° producing pages 
that are wider than they are tall. Size reductions, the various printer 
effects, and options are examined in detail in the discussion of printing 
later in this chapter.

ImageWriter v2.7 |( OK )\
Paper: (i) US Letter O 04 Letter

O US Legal 
O Computer Paper

O  International Fanfold [ Cancel ]

Orient
I k C I

atior Special Effects: □  Tall Adjusted
□  50 % Reduction

■ K ill □  No Gaps Between Pages

Figure 3.6 ImageW riter page setup window

Table 3.1 Paper sizes

Paper Width, in. Height, in.

US Letter 8.5 11.0

US Legal 8.5 14.0

A4 Letter 8.25 11.7

B5 Letter 6.9 10.8

Tabloid ' 11.0 17.0

Computer Paper 14.0 11.0

International Fanfold 8.25 12.0

3. After making your page layout choices, click OK to return to the Page 
Layout dialog box.

4. If you require the largest possible print area, click on Max.

5. If you require more standard margins, click on Std and adjust the default 
margin sizes as necessary. The outer rectangle on the right half of the 
dialog box represents the physical boundaries of the paper. The enclosed 
rectangle including shaded portions corresponds to the printable area. The 
margin sizes are measured from the physical boundaries of the paper, 
rather than from the print boundaries. This accounts for the existence of a 
set of minimum acceptable values. Out-of-range values are rejected and a 
"?" is posted just outside the box. You cannot proceed until you supply an



allowable value. The default units, inches, in, centimeters, cm, and points, 
pt, match the current Ruler units discussed below, but you can use any 
combination of compatible units and values. The dimensions of the usable 
print area appear below the miniature portrait of the page.

6. If you wish to reserve any additional space for a binding margin, check 
the Gutter box and supply a measurement (value and unit). With the Gutter 
box checked, the distance from the page boundary to the print area is the 
sum of the values for the gutter and the adjacent margin.

7. If you wish to have the gutter appear on the left of odd-numbered pages 
and on the right of even-numbered pages, check the Facing pages box.

When you use facing pages, the odd-numbered pages are on the right and 
the even-numbered are on the left.
The Print dialog box also provides for printing on the front and back of
pages.

8. Optionally, adjust the size of the headers and the footers. Headers and 
footers are the reserved portions of the printable area at the top and 
bottom of the page, respectively. As discussed below, the contents of these 
can appear on every page throughout the document, differ from a standard 
on the first and/or last pages, or differ on left and right pages. If you wish 
to remove a header or footer, set its size to zero; as you do with margins, 
specify a value and its units. The header and footer sizes are constant 
throughout the document. These spaces are frequently used for posting page 
numbers, creation date, print date, creation time, print time, file name, 
letterheads, and other identifying notations. After you leave this dialog 
box and after you make the choices on the distribution of the headers and 
footers throughout the document, you can place text, graphics, 
mathematical expressions, or the variables just mentioned in the headers or 
footers.

9. Ordinarily in simple documents, multiple columns are not required. But if 
you wish to use multiple columns of equal size, select the number at the top 
of the dialog box. The text snakes from the end of one column to the top of 
the adjacent column and is fully editable. Position the insertion point and 
use Format/Insert Column Break to manually force the beginning of a new 
column. The use and purpose is analogous to Format/Insert Page Break.

10. Click OK to accept any changes you have made. Otherwise, click on 
Cancel to retain the values that existed when you opened this dialog box.

Doc Layout Consider next the placement of headers, footers, and footnotes 
among the pages of the document. The document layout dialog box 
(Figure 3.7) presents the choices visually.
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1. In the first column, click on an icon either to place the header on every 
page, to skip the first page, to skip the last page, or to skip the first and 
last pages.

2. In the second column, make a similar designation for footers.

3. In the third column, make two choices. Click to select left-right facing 
pages or same on all pages and then click "First page different" off/on. 
After you return to the document window, the pop-up window associated 
with the insertion point locator in the status bar provides rapid scrolling to 
the headers and footers. You can place parenthetical materials in 
automatically numbered footnotes located either at the end of the 
document or at the bottom of the page that contains the reference to the 
footnote. Space for the footnote is automatically liberated from the space 
normally allocated to text in the main body of the page. You can make four 
choices relative to footnotes:

• At the bottom left corner of the dialog box, click to select placement at the 
bottom of the page or at the end of the document.

• At the right, choose one of the three icons (no line, dotted line, or solid 
line) for the separation of the footnotes from the body of the text. •

• Set the spacing before footnotes (in pixels) using the scroll bar.
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Paragraph formatting

• Set the spacing between footnotes using the scroll bar.

4. Click OK to accept any changes you have made. Otherwise, click Cancel 
to retain the values that existed when you opened this dialog.

To access the header or footer areas, simply click inside them, without 
opening a separate window, and begin typing. Throughout M athW riter, 
you can edit within the various structures, such as headers, footers, 
footnotes, sidebars, mathematical expressions, etc., without opening 
special windows. The formatting tools available in the body of the text are 
available for these structures, too. Refer to the section on headers and 
footers later in this chapter for additional details.

To create a footnote:

1. Position the insertion point in the text where you want the footnote 
marker.

2. Select the footnote icon from the bottom row of the Palettes menu.

3. Either scroll to the footnote area or select the footnote region from the 
pop-up menu at the insertion point locator in the document status bar.

4. Type the contents of the footnote.

5. Either scroll back to the body of the text or select Body from the same 
pop-up menu.

Having established the global environment in which to place your ideas, 
you can now consider the next most important formatting issues—how to 
present paragraphs. Since the paragraph is the basic modular unit of 
composition, Math Writer makes it a primary design focus. As you shall 
see, understanding paragraph formatting is central to using M athW riter 
effectively.

Paragraph formatting commands apply to entire paragraphs. You need only 
place the insertion point within the paragraph to select it. To select 
multiple paragraphs you must use the usual selection technique.

The Ruler Math Writer's paragraph ruler (see Figure 3.8) serves the dual 
role of reporting paragraph formatting choices for the paragraph that 
contains the insertion point and providing a visual dialog for making new 
choices of margins, first-line indent tabs for character alignment, and vari
ous horizontal alignment options.

Figure 3.8 The Ruler
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The Ruler occupies a prime and predictable location across the top of the 
window with an additional portion in the right border of the window 
above the vertical scroll bar. You can hide the Ruler to obtain a better 
view:

♦  Use Format/Hide Ruler or #£

To view the Ruler again:

♦  Use Format/Show Ruler, which toggles with Hide Ruler (or $6 ')•

When the Ruler is visible, only one copy is on the screen; it does not scroll 
out of view and it corresponds to the paragraph that currently contains the 
insertion point. Each paragraph in a document has a ruler that contains its 
formatting information. Because the vertical dimension of the screen is 
especially critical when viewing displayed equations, we have designed 
the portion of the Ruler across the top of the window for a minimum depth 
by placing the tab wells and alignment controls on the right side of the 
window.

When you press return to create a new paragraph, M athW riter copies the 
ruler of the previous paragraph to the new paragraph as the default ruler.

Unique ruler icon If you modify the ruler of any paragraph, M athW riter 
flags the paragraph formatting change by placing a ruler change icon OZl in 
the left margin of the document. Use Format/Hide Message to hide these 
margin notes and its toggled version, Show Messages, to restore them.

The Ruler can be used with three units of measure—inch, centimeter, and 
point (or pixel), which is 1 / 72 inch.

Ruler units To select a unit of measure use the Ruler Options submenu of the 
Format menu to make a selection.

The fourth submenu option, Page Ruler, which toggles as Column Ruler, 
allows you to have the ruler span all columns of the entire page or begin 
anew in each column.

Ruler icons The gray shading on each end of the ruler (see Figure 3.8) 
depicts the boundaries of the working text area you established using the 
File/Page Layout command. You can work with narrower, but not wider, 
paragraph margins.

Paragraph margins You may have to scroll horizontally to set the left and 
right paragraph margins.

The paragraph margin settings allow you to create special effects easily. 
You can place tightly fitting borders around narrow paragraphs or 
equations by changing the margins. Quoted material is often single-spaced



with a reduced paragraph width. Using the paragraph margins can allow 
you to place sidebars, which are discussed in the next chapter, on the page 
outside the margin.

First line indent To emphasize a paragraph break you might wish to start 
its first line to the right or left of the rest of the paragraph. Of course this 
effect could be achieved using tab ►, but using the first line indent marker 1 
is a better way.

For a first line indent drag the first line indent marker to the right of the 
left margin paragraph marker. M athW riter immediately repositions any 
existing text to conform to the new setting.

For a flush first line drag the first line indent marker to the same position 
as the left margin paragraph marker. If you move the left margin 
paragraph marker in either of these cases, the first line indent marker is 
coupled with it and moves the same distance to preserve the magnitude of 
the indent.

For a hanging indent (or "outdent") drag the first line marker to the left of 
the left margin paragraph marker. If the left margin marker is flush with 
the left border of the text area, you must first move the left margin 
paragraph marker to the right before you can make a hanging indent. To 
decouple the first line indent and the left margin markers to create a 
hanging indent, press the 36 key when you drag the left margin marker.

A hanging indent is especially useful if you wish to have a single line 
(words or the number of an item in a list) extend to the left of the remainder 
of the paragraph. To place multiple lines of text or pictures in the left (or 
right) margin, consider using sidebars, discussed in the next chapter.

Tab alignm ent of characters The horizontal alignment of characters —  
within a line of text is facilitated by four types of tabs—left align ►, ^  
right align 4, center align ♦ , and character (decimal) align 0 . Because ^ 
M athW riter supports variable-width characters, accurate horizon- I—  
tal alignment would be difficult, if not impossible, without 
them. Figure 3.8 provides an example of each type.

Added text aligned with left-aligned tabs advances to the right, keeping 
the left end anchored. When right-aligned, added text advances to the 
left. When center-aligned, added text advances the string to the left and 
right simultaneously, keeping the center of the string anchored on the tab. 
Do not use center-aligned tabs with fully justified alignment (due to the 
implied contradiction discussed next). When decimal-aligned, added text 
advances the string to the left and right simultaneously, keeping the 
decimal point in the string anchored on the tab. The decimal tab is most 
frequently used to align a column of decimal numbers. ( See the next section, 
for a discussion of creating tables automatically without tabs.)
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To position a tab on the ruler, drag a tab from the tab well (located above 
the vertical scroll bar at the right of the window) and place it on the ruler 
just below the horizontal scale and between the left and right paragraph 
margin markers. To make horizontal alignment with existing characters 
easier, you can drag a tab down into the text to the horizontal position you 
want it in the paragraph; when released, it snaps onto the ruler.

To reposition a tab, drag it to its new location (and take text aligned on the 
tab with it), but beware of the complexity and potential confusion if you 
drag it past another tab. Use option -drag for a smoother drag and finer 
control of tab spacing.

To remove a tab drag it past the right margin on the ruler. JHiyil

To align text on a tab, use the tab key either before or after you place text on 
the line. If you become confused about your results, use Format/Show 
Invisibles to display identifying markers. To again hide the markers, use 
Hide Invisibles, which toggles with Show Invisibles.

To change the type of an existing tab without removing the existing tab, 
double-click on the tab already on the ruler to gain access to the tab dialog 
box (Figure 3.9) and select the preferred type.

Tab type Tab leaders

► (i) Left <•) None
♦ O Center O Solid
i O  Right O Gray
0 O Align on: O Other

(•) keyboard symbol
O |>ale He symbol

Cancel | OK

Figure 3.9 Tab dialog box

The tab dialog box provides access to two additional features—user 
designated character alignment and tab leader.

Alignment on a user-designated character: In a mathematical derivation, 
alignment on the equals sign or some other operator is required by 
typographical convention. When no character appears to the left of the 
equals sign, the usual left-aligned tab is adequate. However, when the 
expression on the left side changes in size, the align-on tab behaves as a 
decimal alignment tab would; but in place of the decimal point, a user-



designated alignment character allows text to expand on both of its sides. 
T a b  le a d e rs : To align text rows that would otherwise contain numerous 
blank spaces, you can replace the spaces with space-filling characters. A 
common application is the alignment of headings and page citations in a 
table of contents. M a t h W r i t e r  provides solid and gray leaders as well as 
user-selected characters (Figure 3.9). When you align on a tab having a 
defined leader character, M a t h W r i t e r  fills the gap with the designated 
character. If you move the tab or change the text, the gap is refilled 
automatically.

I i 12, |I i 1 . |

F ix e d  ta b s :  If you require evenly spaced tabs across the ruler, double-click 
on the ruler anywhere, except on an existing tab, to obtain the Tab Options 
dialog box (see Figure 3.10). In the Tab Options box you can specify fixed 
tabs and the interval spacing.

Tab Options...

O Fined tabs

<•) Uariable (user-defined) tabs 

[ Cancel

Figure 3.10 Tab options

Paragraph alignm ent Using automatic wordwrap, M a t h W r i t e r  strings the 
characters you type together into lines of text that form paragraphs. You 
can influence the placement of line breaks in several ways. Changing the 
left and right paragraph margins can produce different results with 
wordwrap. To override the automatic wordwrap algorithm you can press 
r e t u r n  to end a line and the paragraph, or press s h i f t  r e t u r n  to start a new 
line without beginning a new paragraph. Adjacent words can be connected 
by nonbreaking spaces (o p t io n  s p a c e b a r) to force them to wrap together as a 
unit.

i* i

Lines of text are frequently aligned flush on the left boundary of the 
paragraph, allowing lines of text of variable length to form an 
uneven right end. This is called left-aligned text, corresponding to 
the first of the alignment icons in the right border of the document 
window just above the vertical scroll bar. All lines of text within a 
paragraph share the same alignment. There are four types of alignment:

1. L e f t  a l i g n e d :  w- (Described above.)

2. R ig h t  a l ig n e d :  —w This is the mirror image of left-aligned with
alignment flush along the right end of the paragraph.
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3. Double aligned: w-h This is also referred to as full justification. The text 
is simultaneously aligned on both ends of the paragraph in newspaper 
style. Warning: 1) Hyphenation [see Edit/Hyphenate] becomes increasing
ly important with shorter lines. 2) Do not use this alignment and center tabs 
together.

4. Center aligned: i* i All text on a line is automatically centered. Use this 
command to center titles on the page. Warning: The first line indent tab 
(rather than the left margin tab) forms the left boundary of the centering 
area and can produce an unexpected shift in the first line of the centered 
paragraph if the first line is set for an indent or outdent.

To change the paragraph alignment of existing text:

1. Select the paragraph by placing the insertion point within it. Use the 
customary selection techniques for multiple paragraphs.

2. Click on the appropriate alignment icon.

Paragraph attributes for each new paragraph, including alignment, are 
inherited from the immediately previous paragraph. You can also use the 
Edit/Copy Other, Style/Style 1, Style/Style 2, and Style/User Styles 
commands to transfer or to assign paragraph formatting.

Paragraph spacing and placem ent Paragraph spacing on the page (not to be 
confused with line spacing) affects visual appeal and readability. 
MathWriter provides a dialog box for paragraph attributes (Figure 3.11), 
which controls the placement of paragraphs.

Paragraph format... 
.............. Spacing

Before SI
After SI IQ 111 j

Borders

0

3  8

............Attributes ..............
□  Link to nent SI
□  Column break before
□  Page break before
□  Can't split ouer page break

Whitespace E >1 6

Click above for thickness and pattern
Cancel L d c J I

Figure 3.11 Paragraph format dialog box

Spacing between paragraphs: Using Format/Paragraph Format, you can 
specify the spacing before and after paragraphs in pixel units. Just as the 
first line indent eliminates extra keystrokes, this command also eliminates 
the empty paragraphs that you must otherwise place between paragraphs



of text to produce whitespace. In addition to keystroke economy, this fea
ture provides an easy way to globally change the spacing between para
graphs.

To adjust the spacing between paragraphs:

1. Select the paragraphs to be affected.

2. Select Format/Paragraph Format (or 9$ J ).

3. Drag the scroll box in the scroll bars to set the spacing.

4. Click OK.

S p a c in g  p a r a g r a p h s  o n  th e  p a g e : The placement of paragraphs with 
respect to the top and bottom of the page can affect readability. Several 
controls for this are available in M a t h W r i t e r .

The menu commands that force a paragraph to appear at the top of a page 
or, in other words, to force a column or page break after the preceding 
paragraph are Format/Insert Column Break and Format/Insert Page Break. 
To use these, position the insertion point in the text and select the command 
from the menu. These commands insert nondisplayed, formatting 
characters, which you can locate using Format/Show Invisibles. Use 
Format/Hide Invisibles, which toggles with Show Invisibles, to remove 
them from the display. These markers remain associated with a particular 
paragraph even if further editing makes them inappropriate. To remove a 
paragraph command in such instances, move the insertion point to the 
beginning (the top and leftmost position) of the next column or page and 
press d e le t e .

O t h e r  p a g e  b re a k  c o n t r o ls :  The selection Link to next 1 causes the current 
and next paragraph to appear and print on the same page. To link multiple 
paragraphs, select all paragraphs except the last before using this 
command. If you want linked paragraphs to appear on the same page, 
M a t h W r i t e r  can move them to one page, provided they actually will fit on 
a single page. Use this feature to assure that a heading is not separated 
from the next paragraph by a page break.

The Column break before and Page break before selections assure that the 
paragraph will appear at the top of the page. These commands serve the 
same purpose as Insert Column Break and Insert Page Break on the Format 
menu, but remain associated with the paragraph when the paragraph 
format is transferred using the Copy Other (Edit) command. Use this 
command when you want a paragraph to begin on the first line of a page. 
There is no icon that indicates a paragraph carries this attribute. If an 
unexpected gap appears at the bottom of a page during editing, check for 
this command by clicking in the paragraph and examining the Paragraph 
Format dialog box.
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The Can't split over page break option assures that the entire paragraph is 
kept on the same page. If insufficient space remains on the page to display 
that entire paragraph, as with graphics, MathWriter moves the 
paragraph to the next page. * 1

Paragraph Borders Use borders to highlight or emphasize paragraphs 
or groups of paragraphs. As you shall see in the next chapter, mathe
matical expressions are also paragraphs, so you can use borders to 
emphasize important results.

M athW riter provides many variations on a theme. For example, the box 
above was formed with a single, one-pixel-wide, solid line on each of the 
four sides of the paragraph, a two-pixel border, and a 1% gray scale 
background. In general, you can apply borders to any combination of sides, 
including a single border on the left or borders above and below a 
paragraph. To group several contiguous paragraphs with a single border, 
select them and enable the Treat paragraphs as a group option which then 
appears (Figure 3.11) below the whitespace scroll bar.

M athW riter places a border at the paragraph's extremities, but you can 
change the extremities of a paragraph using the left and right paragraph 
margins to obtain borders which do not extend the full width of the print 
area. You control the whitespace between the paragraph and the border, 
and between borders if two border lines are used. Numerous line thickness 
and line pattern choices are available. You have 38 choices or any gray 
scale shading (1-100%) for the background pattern.

To assign paragraph borders:

1. Select a paragraph. You need only place the insertion point within a 
paragraph to identify a paragraph because the command inherently 
applies to the whole paragraph. Drag the mouse or shift click to select 
multiple paragraphs that share a common ruler. Recall that a unique ruler 
icon identifies paragraphs that do not share the paragraph formatting of 
the immediately previous paragraph; you may need to use Format/Show 
Messages to see them.

2. Select Format/Paragraph Format (or 96 J ) to access the dialog box.

3. Select which sides need borders. To select all sides simply click on the 
paragraph icon at the bottom-left corner of the dialog box. To select (or 
deselect) individual sides, click on the relevant icon border or the arrows as 
shown in Figure 3.11. A miniature portrait adjacent to the icon illustrates 
your choices.

4. Click in the space identified in Figure 3.11 by "Click above for thickness 
and pattern" to obtain another dialog box (see Figure 3.12).



Select thickness and pattern... 
... Outer border....................

Thickness [ 
Pattern

...  Inner border

Thickness
Pattern | Grag scale") [Q |ljf

...Background pattern........

Pattern

Space between borders |Q|[

Cancel

@ 5  %

Figure 3.12 Paragraph borders line thickness and pattern dialog box

5. Assign border attributes and a background pattern. To assign these 
attributes, click in the area identified by "Click above for thickness and 
pattern" and which displays your choices. Use the four pop-up menus to 
select line thickness and line pattern for the outer border and, if you elect to 
have one, an inner border. A solid black pattern is the default and a solid 
white pattern hides the border. A hairline border can only be printed 
properly if you have a PostScript printer; it defaults to one pixel width on 
an ImageWriter. If you select "gray" in the bottom-right comer of the pat
tern palette, M athW riter supplies a scroll bar for you to set a percentage 
level. You can also assign a background pattern for the paragraph using a 
similar pop-up menu. If you elect to have two border lines, specify the spac
ing between the two lines here. For setting the space between the para
graph contents and the borders, see the previous discussion (Figure 3.11).

6. Click OK to accept the choices you just made, or click Cancel to abandon 
your changes in favor of previous settings. Either choice returns you to the 
Paragraph format dialog box. Make any final corrections there.

7. Click OK to accept the choices you just made in the two dialog boxes, or 
click Cancel to abandon your changes in favor of previous settings.

Line spacing Because M athW riter must adjust the line spacing when 
mathematical expressions of variable height are present, the line spacing 
options are more complicated and, therefore, are accessed from a dialog box 
(Figure 3.13) using Format/Line Spacing (or $6 K), rather than from the 
Ruler.



Nontechnical Writing 67

Fixed ascent

a  14
Displayed equation adjustment

m M 6
Fixed descent + leading

a 4
Cancel [[----- OK------

Figure 3.13 Line spacing dialog box

Our discussion of line spacing re
quires some definitions first 
(Figure 3.14). The baseline is the 
line on which the text rests. The 
ascent and descent are the 
distances above and below the 
baseline, respectively, which together determine the line height. 
Automatic spacing allows M athW riter to adjust line spacing to 
accommodate height variations in characters, graphics, and mathematical 
expressions. Math Writer uses the maximum of the ascents and descents on a 
line as the line ascent and descent, respectively. At the other extreme, 
Fixed spacing ascent and descent are set in the dialog box (Figure 3.13). This 
assures a constant line spacing even if some characters overlap in the 
output. Between these extremes is Mostly fixed, a combination of automatic 
and fixed. The text and mathematical expressions embedded within a line 
are treated as fixed, but expressions displayed on a separate line perhaps 
with an equation number are treated as automatic.

Ascent..... .......................

_  O llX L p JL S ..  Baseline
Descent............... Jl...........

Figure 3.14 Line spacing definitions

Line spacing varies with font size, of course. Furthermore, the line spacing 
provides space between lines for the ascenders and descenders of the 
individual characters. In contrast with ordinary word processors, 
M athW riter's Mostly fixed option allows inline expressions (i.e., 
expressions embedded within a line of text such as subscripts and 
superscripts) to protrude into the leading (pronounced 'Tedding") or white- 
space between the lines. This avoids the unsightly fluctuation in line 
spacing ordinary word processors produce. Mostly fixed also allows you to
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assign whitespace around equations that occupy a separate display line 
and which are referred to as displayed equations.

Mostly fixed and Fixed both support the standard line spacings of single, 
1 !/g and double (6, 4, and 3 lines per inch, respectively). The Other 
spacing option allows you to specify separately the ascent and the descent 
plus leading.

Ordinarily, you compose your manuscript using automatic line spacing and 
then, if desired, reassign as either Mostly fixed or Fixed to achieve a 
uniform spacing throughout the paragraph or document.

To set line spacing:

1. Select the text.

2. Access the line spacing dialog using Format/Line Spacing (or 38 K).

3. Select one of the alternatives (Automatic, Mostly fixed, or Fixed) by 
clicking.

4. If you choose Mostly fixed or Fixed, select a standard spacing or assign a 
custom spacing (Other).

5. If you choose custom spacing, assign ascent and descent values using the 
scroll bars.

6. Finally, if you chose Mostly fixed, set the Displayed equation 
adjustment.

7. Click OK to accept your choices, or click Cancel to abandon your changes 
in favor of previous settings.

Character formatting
Having discussed document level and paragraph level formatting, we can 
now turn our attention to the third level of formatting—character 
formatting. Character formatting applies to individual characters and to 
any combination of characters in the document. Character formatting in 
M athW riter centers largely on the Style menu (Text Fonts, Text Sizes, and 
Text Styles) and alternative or shortcut ways to execute combinations of 
those commands.

Typeface: Fonts, Sizes, Styles Character formatting involves three main 
choices—font, size, and style. The first three menu commands on the Style 
menu present these options in submenus.

The Style menus for Text Fonts, Text Sizes, and Text Style use a ✓  to 
indicate that the checked item applies to the entire text selection, while • 
means that it is used in part of the range.
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F o n t s :  A font is a family of characters having a similarity or family 
resemblance. You should be aware of three typeface categories. The first 
category deals with traditional categories typefaces fall into based on 
design characteristics. Those typefaces such as Times and Courier that 
contain fancy ends for the main strokes are called serif type and those 
without, such as Helvetica and Geneva are called sans serif type. A second 
classification of typeface is according to character spacing—proportional, 
such as Times and Helvetica, and nonproportional, such as Courier. The 
characters in a nonproportional font have a uniform width and are said to 
be monospaced. The third classification is one that arises from technology, 
and its significance is expected to diminish substantially with the release 
of the Macintosh System Version 7.0. The bitmapped screen displays in the 
past have been optimized for 72 dots per inch while the LaserWriter and 
other printer devices support 300 or more dots per inch. Smoothly scalable 
screen fonts will significantly improve the screen displays. The names of 
the built-in LaserWriter fonts are identified with underlines on the Text 
Fonts menu. If you press and hold o p t i o n  before and while you select the 
Text Fonts submenu, each font name appears in its particular typeface.

If you intend to print a document with a LaserWriter, we strongly recom
mend that you use laser fonts when writing the document. If you enable font 
substitution (using Page Setup on the Page Layout command of the File 
menu), printing may take longer, especially with mathematical expres
sions, and you may not like the modified spacing. So, although M a t h -  
W r i t e r  supports the complete mixing of fonts (and font sizes and font styles) 
within a document we recommend restraint in the use of this capability.

S iz e s :  M a t h W r i t e r  supports the use of all font sizes, from 4 point through 
128 points, with each font. A point corresponds closely with a pixel which 
is V/2 inch on the Macintosh screen. The sizes that appear most clearly on 
the screen and in Image Writer output are listed in outline style letters in 
the menu.

S ty le s :  M a t h W r i t e r  provides an extended set of styles to modify all 
characters from all fonts. Plain, Bold, Italic, Underline, Outline, and 
Shadow are the most widely used styles. Strikeout, Overbar, Box, Low 
Underline, Underline pattern, Underline weight, and Gray scale are useful 
in writing technical documents. Certain other style listings, such as not 
applying the style attributes to space characters, reducing or expanding the 
space between characters, changing the case of words without retyping 
them, and providing a background pattern, are available. Background color 
and character color are supported but impose a substantial computational 
load on M a t h W r i t e r  with only modest benefit.

A s s i g n in g  c h a r a c te r  f o r m a t t i n g :  In most instances you will select favorite 
font, size, and style before writing a document and will have quick access to 
them via your custom-made default files. A default file is a file to which 
the program automatically reverts unless you instruct it otherwise; thus
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• M a t h W r i t e r  can automatically call up your favorite selections. When you 
click the cursor in existing text, M a t h W r i t e r  automatically ascertains the 
typeface of the character immediately preceding the insertion point and 
applies that combination of font, size, and style to the text you enter. Al
ternatively, you can assign a font, size, and style to the insertion point and 
have those attributes apply to text you enter. To change the typeface of 
existing text, you must first select the portion of text to be affected and then 
assign font, size, and style.

Specifically, the steps to take to change the format of existing text are:

1. Select the text (refer to text selection techniques above).

2. Select the attributes from the Style menu.

To insert text with the same typeface as surrounding text:

1. Position the insertion point using the mouse or arrow keys.

2. Enter text using the keyboard or using the mouse if text is from the 
Palettes menu or the Font Table. The font, font size, and font style of the 
entered text will be taken from context, i.e., will match the attributes of 
the text immediately to the left of the initial insertion point position.

To insert text with a different format:

1. Position the insertion point using the mouse or arrow keys.

2. Assign the desired font, size, and style to the insertion point.

3. Enter text using the keyboard or using the mouse if text is from the 
Palettes menu or the Font Table.

Using the Style menu The Style menu has a few unique features that merit a 
brief discussion. The font, size, and style choices are made with submenus. 
M a t h W r i t e r ' s  list of fonts must always include those fonts that are 
required by the operating system and, in addition, the Times and Symbol 
fonts. There are slight differences between the Symbol font as distributed 
by Apple and by Adobe that affect the stretchable brackets, parentheses, 
and braces. M a t h W r i t e r  has been tuned for the Adobe fonts, which are 
supplied on the distribution disk. In addition, the supplied version has 
been modified to allow boldface Greek letters to retain that attribute when 
printed with a LaserWriter. Use the Font/DA Mover 3 to make these fonts 
available to M a t h W r i t e r .

M a t h W r i t e r  supports all user-installed fonts4 that are compatible with 
the Macintosh system. In addition to commercial fonts, commercial 
utilities allow you to create your own specialized laser fonts. You should

3 or a utility such as Suitcase II
4 including Adobe Type Manager



Nontechnical Writing 71

remove unneeded fonts to increase the RAM available to RAM-resident 
documents.

Ruant Garde A v a n f  G a r d e
Bookman Bookman
Chicago Chicago
Courier Courier

✓  Geneua ✓  G e n e v a
Heluetica H e lv e tic a
Monaco Monaco
N Heluetica Narrow N Helvetica Narrow
New Centurg Schlbk Hew Century Schlbk
Palatino Palatino
Sgmbol 2fp(3oA
Times Times
Zapf ( ham erg Z apf Chancery
Zapf Dingbats •ociit; + * a * o o T A

Figure 3.15 Text fonts submenu

T h e  T e x t  F o n t s  s u b m e n u :  (Figure 3.15) To see the font names listed in their 
own fonts, press o p t i o n  before you drag the submenu. If only one font is 
included in a section of text you selected, a check mark appears adjacent to 
the font's name. If multiple fonts are included in a selection, a bullet 
appears next to the names of the fonts included in that selection.

If File Warnings on the File/Preferences... dialog box has been enabled, you 
will be warned if fonts used in the document are not available in your 
computer. This M a t h W r i t e r  feature is especially important for technical 
documents because the content may change as a result of an unintended, 
automatic font substitution. While the alphabetical characters have 
standard locations in a font, regardless of the font, this is not true for other 
special symbols. Because inadvertent font substitution is not simply a 
matter of style, M a t h W r i t e r  takes special steps to assure that the 
document has the same appearance and content on any Macintosh.5

T h e  T e x t  S iz e s  s u b m e n u :  (Figure 3.16) Frequently used font sizes are listed on 
the Text Sizes submenu. Those sizes that have screen bitmaps available to 
the system are identified by outline style type. To use any size between 4 
and 128 (inclusive) not on the list, click the Other command and supply the 
desired size. These generated sizes will appear ragged on the screen and on 
ImageWriter output, but will print smoothly on a PostScript device.

technical note: MathWriter stores in each document file a table of the local internal font identification numbers 
and the corresponding font names. When the document is opened with a different Macintosh, MathWriter uses 
the font names to match the fonts with the new local font identification numbers, thereby assuring unchanged 
content.
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Figure 3.16 Text sizes submenu

The Text Style submenu: (Figure 3.17) Eight character styles are listed on 
the submenu; four of these can be selected by either mouse or keyboard. The 
remaining four require use of the mouse.

✓  Plain
Bold
Ita lic 9€l
Underline MU
(DtQdDOms
SQKDiOCDEJ
Condense
Extend
Other Styles... 3§Y

Figure 3.17 Text Style submenu

Style/Other Styles... (or 96 Y) activates a dialog box with additional 
choices (Figure 3.18). Except for Plain, any combination of the styles with 
check boxes beside them can be used simultaneously. Plain has the special 
characteristic of automatically overriding all other style attributes. If 
only one style attribute is represented in a selection, a check mark 
identifies that choice in the dialog box. If two or more attributes are 
included within the selection, a bullet appears next to the attributes 
included.

Certain styles are mutually exclusive choices. For example, you can change 
the displayed case of text to UPPERCASE, lowercase, or Cap. First without 
retyping the selection, but you can select only one of these alternatives at a 
time. When you deselect these styles, M athW riter restores the original 
case used when you entered the text. When exporting such text in TEXT 
format, the displayed, not the original case, is sent to the file.

Select font size...

Cancel L ^ c J )



Nontechnical Writing 73

Other styles...
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Figure 3.18 Other styles dialog box

Likewise, you may either Condense or Extend text to remove or to add 
pixels between characters. The mutually exclusive choices for Underline 
pattern and Underline weight can be applied if and only if at least one of 
the underline attributes has been chosen also.

The Underline and Low underline attributes can be used concurrently to 
obtain double underlines. Words only and Underline used together produce 
underlines for the words, but not the spaces between the words. Box and 
Strikeout are frequently used for revision tracking. Subscripts and 
superscripts are handled using the Tools window, and are not included here 
as a style.

M athW riter will reformat paragraph lines automatically if typeface 
changes require it. No hidden text style is included because that capability 
is handled more conveniently using hideable memos (See Format/Insert 
Memo). As mentioned previously, M athW riter supports color attributes for 
text and text background, but this slows the program considerably.

Using formatting shortcuts: Mathematical manuscripts make extensive use 
of typeface changes to convey information, especially in mathematical 
expressions. M athW riter supports technical typing by handling many 
typeface changes automatically and making manual changes more 
convenient. As discussed in the next chapter, automatic formatting is 
especially important when entering mathematical expressions. For 
example, when typing superscripts, the cursor changes position and the font 
size adjusts automatically. The typeface of the character located to the 
immediate left of the insertion point is described in the document status bar 
at the bottom right corner of the document window.



G r e e k  f o n t  s e le c t io n  s h o r t c u t :  Because the Greek alphabet is used frequent
ly, there is a shortcut for toggling between it and your current font.

♦  Press 96 s p a c e b a r  to toggle to and from Greek.

The Greek letter assignments have a mnemonic relationship to the 
keyboard. Use the first letter of the name of the Greek letter (a for alpha, b 
for beta, etc.), except to avoid ambiguity (h —> r|, j —> (p, y —» y, and w —» co) 
in four instances. To review the keyboard layout, use the Key Caps desk 
accessory on the Apple menu and select the Symbol font from the Key Caps 
menu that appears to the right of M a t h W r i t e r ' s  Windows menu. 
Alternatively, you can "type" the Greek letters from the Palettes Window 
(Windows menu) or the Font Table (Windows menu) if you have selected 
the Symbol font from its font pop-up menu.

S y m b o l f o n t  s e le c t io n  s h o r t c u ts :  You can "type" all other characters in the 
Symbol font from the pull-down Palettes menu. [The Greek characters are a 
subset of the Symbol font.] As you drag across a symbol in the Palettes pull
down menu, its name appears on the last line of the menu. In contrast with 
entries made from the keyboard, the font choice for subsequently entered 
text is not affected by this font change. Even more convenient access to 
repeatedly used characters from the Palettes pull-down menu is possible by 
assigning a row of the Palettes menu characters to the Palettes Window 
displayed using the Windows menu.

A s s i g n i n g  c h a r a c t e r s  t o  t h e  P a le t t e s  W i n d o w :

1. Select Windows / Palettes Window to display the floating Palettes 
Window.

2. Drag to select the name of a row of characters in the Palettes pull-down 
menu. Add other names as desired. Selected rows have a check mark to the 
left of the row name. Reselect a row to remove it from the Palettes Window.

3. Drag the Palettes window to a convenient location using the gray region 
below the window's close-box. If you are using two monitors, you can even 
drag the floating window to the second screen.

You can also enter any of these characters at the insertion point using the 
Font Table. In fact, the Font Table provides mouse access to every character 
available to the system.

U s i n g  th e  F o n t  T a b le :

1. Select Font Table from the Windows menu.

2. If you are using two screens, you can drag the floating window to the 
second screen using its title bar, or,

3. If screen space is limited, adjust the size of the floating window using
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the grow box at the bottom-right corner of the window and use the 
horizontal and vertical scroll bars to bring the characters of interest into 
view. If you have reduced the font table size, you can use the zoom box at 
the top-right corner to expand the Font Table quickly to its original full 
size.

4. If the desired font is not currently displayed, place the cursor on the 
name of the current font and select the desired font from the pop-up menu.

5. Press on the desired character until it appears at the insertion point.

6. To remove the Font Table, click in its close-box or reselect Font Table 
Window from the Windows menu.

Any of these mouse-selected characters can also be typed from the keyboard 
using the Library, which is described in the next chapter.

Changing font size:

1. Select the text.

2. Select Larger Size or Smaller Size from the Style menu or use the 
keyboard equivalents (88 plus or 88 minus using plus and minus on the top row 
of the keyboard, with or without the sh ift key). This command selects the 
next larger or smaller size on the Font Size menu. If you press the option key 
when using this command with the keyboard or mouse, the size changes by 
one point.

Changing font style: Eight popular styles are listed on the Text Style 
submenu; but numerous additional styles are available from the Other 
Styles submenu command. For more convenient access, the Other Styles 
(Figure 3.18) dialog box can be accessed directly using 88 Y. The usual list 
has been expanded to provide revision tracking styles and other special 
purpose styles.

Changing combinations of attributes: Often you need to change several 
attributes simultaneously. M athW riter provides quick access (using 88 < 
and£f >) to combinations of font, size, style, line justification and line 
spacing (called Style 1 and Style 2) and another command to restore the 
Last Style (or 88 \). In the next chapter you will be introduced to "User 
Styles", which perform an analogous role but also remain linked to the text 
such that a change in the definition at any time changes all the text 
throughout the document having this user-style.

Using Style 1 and Style 2:

1. Select Doc Preferences... on the File menu. These are document specific 
definitions. To use the same definitions in other documents you will find it 
convenient to define template documents using MW Default File Type using



Save As... on the File menu.

2. Click either the Style 1 or Style 2 button (see Figure 3.19).

Style 1...

Style 2...

Figure 3.19 Style buttons on Doc Preferences dialog

3. Assign the attribute combinations (Figure 3.20) that you desire.

Set style number 1...

E  Font | Palatino |

^  Size r m  

M  Style [select style...

S  Justification [Left |

□  Line spacing t spaung,,.

Style number 1 will appear like this, Justification is 
affected.

—
Cancel

t 0li JJ
Figure 3.20 Style dialog box

Only the categories with check boxes selected will be applied when this 
style combination is selected. Make font, size, and line justification choices 
using pop-up menus. The style and line spacing choices lead to other dialog 
boxes. Your choices are illustrated in the window.

4. To abandon your choices, click Cancel. To accept your choices, click OK.

5. If desired, assign Style 2.

6. Click OK to close the Doc Preferences dialog.

To use Style 1 or Style 2 to apply a style combination to existing text:

1. Select the text.

2. Press 96 < or 96 > for Style 1 or Style 2, respectively.



Nontechnical Writing 77

To use Style 1 or Style 2 to apply a style combination to new text:

Press < or > for Style 1 or Style 2, respectively, or use the menu 
commands Style/Style 1 or Style 2.

To resume use of the immediately previous style:

Press Si \ or select Last Style.

Editing

We now supplement our earlier discussion of elementary editing techniques 
to include additional cut and paste operations, find and replace, 
hyphenation, spell-checking, and looking up synonyms in a thesaurus. A 
brief discussion of editing automatically formatted tables is included in 
this chapter, but we defer a discussion of M athW riter's extensive, 
mathematical expression editing features until the next chapter.

Moving text

The ease with which you can rearrange and perfect the contents of a 
document is probably the most compelling reason for replacing a typewriter 
with a word processor. M athW riter supports the Macintosh metaphor for 
cutting and copying text onto a Clipboard, a temporary holding area, for 
subsequent pasting (transfer) to another location within the document, or 
even into another application. You can, for example, create a picture in one 
application and paste it into M athW riter via the Clipboard. In addition, 
you can read certain standard file types directly without activating the 
generating application.

To transfer text and graphics treated as characters:

1. Select the text (and graphics) by mouse or by keyboard. (The Cut, Copy, 
and Clear commands remain dimmed until you select text.)

2. Use Edit/Copy (or Si C) if you want to transfer a duplicate of the select
ed text onto the Clipboard and leave the original intact. Another option is 
to Edit/Cut (or Si X) to transfer the selected text onto the Clipboard and 
remove the original selection.

3. Optional: To examine the contents of the Clipboard, select Windows / 
Clipboard. Reselect it to hide the Clipboard.

4. Using the mouse or keyboard, position the insertion point where you 
want the Clipboard material placed.

5. Use Edit/Paste (or Si V) to transfer an exact copy of the Clipboard 
contents into the active document at the insertion point. If you want a copy 
of the Clipboard contents to assume the typeface (font, size, style) of the 
character to the immediate left of the insertion point rather than retain its 
original typeface, use Edit/Paste Other/Paste in Context (or Si shift V).



The Clipboard remains unaltered when you paste, when you switch among 
applications, or even when you shut down the program. It can be pasted 
repeatedly. The name of the Paste command changes to reflect the current 
contents of the Clipboard. If the Clipboard contains text (or mathematics 
treated as text), it reads Paste Text. If the Clipboard contains a 
mathematical expression stored in PICT format which can be transformed 
back into an editable expression, it reads Paste Math. If the Clipboard 
contains a picture, the paste command reads Paste Picture.

6. Use Edit/Undo (or 96 Z) to reverse the immediately preceding operation. 
Undo applies to most operations, not just to editing procedures.

The Edit/Clear command removes selected text, but does not place a copy on 
the Clipboard. If you must delete large text selections, use Clear, rather 
than Cut, to minimize temporary storage demands.

To immediately scroll to the location of the insertion point during an 
editing operation, use Edit/Show Selection.

The Cut/Copy/Paste operations apply to mathematical expressions if the 
transfer remains within M athW riter documents. Because other word 
processors do not support the enhanced data structure of M athW riter for 
editable mathematical expressions, you must instruct M athW riter to 
transform such expressions into PICT graphics form when placed on the 
Clipboard if you intend to subsequently paste the expression into the more 
limited formats. To do this use Edit/Copy Other/Copy as Picture, not the 
usual Copy command. See Figure 3.21 for a view of the Copy Other 
menu.

You can replace text (delete old text, insert new) during a paste operation if 
the text to be replaced is selected before the paste operation is executed. To 
do this:

1. Place text on the Clipboard as previously described.

2. Select the text to be replaced using the mouse or keyboard.

3. Use Edit/Paste to replace the selection with the Clipboard contents.

In addition to the more advanced techniques for assuring format uniformity 
such as User Styles and Styles 1 and 2 on the Style menu, M athW riter 
supports an extended copy feature, Edit/Copy Other, for this purpose 
(Figure 3.21).
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Copy Ruler 3€OR
Copy Format 3€t>F
Copy Ruler & Format
Copy Style
Copy Memo 9€OM
Copy Rs Picture C

Figure 3.21 Copy Other menu

Paragraph formatting is stored in two part—in the Ruler and in all the 
other paragraph attributes—and can be copied separately or together. The 
Ruler stores the paragraph unit of measure, paragraph margins, all tab 
settings, and paragraph line alignment; in brief, that is the displayed 
information that is hidden by Format/Hide Ruler (Si shift R). Copy Format 
(Si shift F) saves all other paragraph formatting information, such as 
spacing before and after paragraphs, borders, and such attributes as the 
ways paragraphs are linked, etc. (See Format/Paragraph Format.) Both 
types of information can be copied at the same time using Copy Ruler and 
Format (Si shift A). Recall that when you press return to create a new para
graph, the new paragraph assumes the format of the preceding paragraph 
unless you change it. You do not need to use the Copy Other commands as 
often.

To transfer paragraph formatting, the steps are:

1. Identify the originating paragraph by clicking the cursor anywhere 
within it; you need not highlight the paragraph.

2. Use the appropriate Edit/Copy Other command (either Copy Ruler, 
Copy Format, or Copy Ruler and Format) by mouse or keyboard.

3. Click inside the destination paragraph to select it. You can also select 
several contiguous destination paragraphs.

4. Use the companion Edit/Paste Other command (either Paste Ruler, 
Paste Format, or Paste Ruler and Format) by mouse or keyboard.

5. Repeat steps 3 and 4 as often as needed.

Ordinary copy and paste commands can be intermixed with paragraph 
copy and paste commands without disturbing the paragraph formatting 
information.

You can transfer character formatting (font, size, and style, but not the 
actual character) from one character to others you have selected. Use of 
this command is analogous to use of the paragraph command, although you 
will usually wish to select several contiguous destination characters at 
once. The steps are:



1. Placet the insertion point to the immediate right of a character having 
the typeface (font, size, style) you wish to transfer.

2. Use Edit/Copy Other/Copy Style (or Si shift S) to make a copy of the 
character formatting information.

3. Select the text that is to be assigned this typeface.

4. Use Edit/Paste Other/Paste Style (or Si shift D) to transfer the charac
ter formatting.

The Copy Other commands use a mnemonic letter for ruler (R), format (F), 
all (A), and style (S); the Paste Other commands use an adjacent letter on 
the keyboard that is to the right of the corresponding copy letter, except for 
A whose neighbor (S) is already used.

The ordinary copy and paste commands can also transfer an embedded 
memo along with the surrounding text. A separate command allows you to 
transfer just the memo. To make these transfers:

1. If the memo icon □  in the left margin is not visible, use Show Messages 
(Format) to display it. Show Messages toggles with Hide Messages.

2. Click to select the memo icon in the left margin.

3. Click Copy Other/Copy Memo (Edit) to make a copy.

4. Optional: While the memo is still selected, you could use delete  to 
remove it.

5. Position the insertion point where you wish to relocate the memo.

6. Click Edit/Paste Other/Paste Memo to transfer a copy of the memo.

The Clipboard is the temporary storage (buffer) for material being copied 
from your document of another application or file and pasted into your 
document. During a complicated set of manipulations it may be useful to 
examine its contents:

♦  Select Windows/Clipboard to display the floating Clipboard window.

No editing can be performed directly in this window—it is a display only. 
It does respond to other window controls. It has a title bar with which you 
can reposition the window, a zoom box to toggle the size of the window, a 
grow box to change the width and height of the window, a status display 
bar just below the title bar that allows you to choose which type of 
Clipboard contents to display, and a close-box.

♦  Click the close-box on the Clipboard window or reselect Clipboard on 
the Windows menu to hide the Clipboard.
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To use the Scrapbook:

Unlike the Clipboard, the Scrapbook is a permanent, online storage 
location for text, graphics, and mathematical expressions. Individually 
selected items can be stored here for recovery and use by any standard 
Macintosh application. The actual file is stored in the System folder with 
the name Scrapbook File. Only one Scrapbook file6 can be stored there.

To place material in the Scrapbook:

1. Select and copy material to the Clipboard.

2. Select the Scrapbook from the Apple menu.

3. Use the Scrapbook scroll bar to select an entry, which the new entry will 
precede.

4. Use Edit/Paste to transfer a copy of the Clipboard to the Scrapbook.

5. Optional: Close the Scrapbook or make another window the active 
window by clicking in it or selecting it from the Windows menu.

The lasso paint tool allows extraneous whitespace to be trimmed from 
graphics stored in the Scrapbook, thereby avoiding the need for cropping.

To recover material from the Scrapbook:

1. Select the Scrapbook from the Apple menu.

2. Use the Scrapbook scroll bar to select an entry.

3. Use Edit/Copy to transfer an item to the Clipboard. Use Cut or Clear to 
remove an item from the Scrapbook.

4. Use the customary paste procedure to transfer the item from the 
Clipboard into the document at the location of the insertion point.

If you wish to create multiple scrapbooks, you can assign a new name to the 
Scrapbook file in the System folder and the system creates a new file 
having the name "Scrapbook file". To recover material from the renamed 
file, you must assign a new name to the current scrapbook file and rename 
the older file with the reserved name "Scrapbook file". A commercially 
available utility6 provides a more elegant approach to this process.

Other advanced editing features such as revision tracking will be discussed 
in the next chapter.

6 SmartScrap allows multiple named scrapbooks to be used.
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The Find and Replace commands

MathWriter's  find and replace commands allow you to locate and change 
text and mathematical expressions in a document. For example, you might 
locate a particular string of characters embedded somewhere in a document 
that you wish to examine or modify. Optionally, you can use these com
mands to replace a string with another string or replace all such located 
strings automatically. You can qualify a search by looking for only upper
case letters or only whole words rather than embedded strings. Numerous 
and powerful extensions to these traditional search and replace features 
are reviewed in the next chapter.

= e=

Match flffec
~ 1 -  Find/Replace 1---------
t Wildcards Special Direction i--------------------\------- 1

Find:
Tent |

Replace with:
Tent

( Find 9€G ] ( Replace, then Find [Replace §§H] ( Replace Rll ]

Figure 3.22 Find/Replace dialog

To find text (and to navigate through a document):

1. Place the insertion point in the document at the starting point of the 
search.

2. Open the Find/Replace dialog box (Figure 3.22) using Edit/Find/ 
Replace (or 86 F).

3. Supply the text to be found in the upper box where the insertion point is 
flashing. The search will be for the characters you typed in the upper box 
and will proceed from the insertion point until a match is found or the end 
of the document is reached, whichever comes first.

4. Use Edit/Find Next, Find in the Find/Replace window, or type 8$ G or 
return to initiate the search. The search can be directed by mouse from the 
dialog box or by keyboard if you pressed return to remove the dialog box and 
initiate the search. The latter has the advantage of a larger document 
word area and not requiring you to switch repeatedly between the dialog 
box and the document, as the active window, when making changes.
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5. MathWriter continues to find matches as you use Edit/Find Next or press 
Si G until the search reaches the end of the document.

6. To modify the document when using a mouse-directed search, you must 
make the document the active window by clicking in it or by clicking in the 
close-box of the Find/Replace dialog box.

In addition to locating text, this feature also allows you to replace the 
located text:

1. Perform steps 1 - 3  above.

2. Supply replacement text in the lower box of the Find/Replace dialog 
box.

3. Use Edit/Find Next, Find in the Find/Replace window, or type Si G or 
return to initiate the search.

4. Once a match has been found, four options are available:

• By keyboard: Alternate between Si H  (Replace Selection) and Si G (Find 
Next) to sequentially find and make changes.

• By mouse: a) Alternate between Replace and Find to sequentially find 
and make changes; b) Repeatedly use Replace, then Find to reduce the 
number of keystrokes needed to individually approve each substitution; c) 
Use Replace All.

Warning Replace All cannot be undone so make a precautionary backup 
before using this command.

You can paste ordinary text into the Find/Replace dialog box, but not 
mathematical expressions, although they can be typed directly into the 
oversized boxes.

5. Until the end of the document has been reached, you can repeatedly find 
matches using Edit/Find Next (or Si G).

6. Click in the close-box to close the dialog box.

Find:
Tent |

Replace with: 
Tent ~]

Find:
✓ Tent

Style 
Reuision 
Rdded Tent 
Deleted Tent 
Style Change

Replace with:
✓  Tent

Style
UnMark

Figure 3.23 Find/Replace pop-up menus
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The primary search categories on the Find/Replace (Figure 3.22) dialog 
box are Find: and Replace with: (Figure 3.23). These pop-up menus deter
mine whether you are searching and replacing text or style attributes of the 
text. The preceding exercise illustrated a text search, the conventional use 
of Find/Replace.

To change a specified typeface to another typeface without altering the 
text, follow these steps:

=n — 1 = F i n r l / R p p l a r p  ......... i

Match flffec Ulildcards Special Direction i i i

Find:

New Century Schlbk 12Style

Replace with: Select Font, Size, and Style from the Style Menu 

Palatmo 10“ Styli |

[ Find §6G ) [ Replace, then Find ] (Replace 86H Replace fill]

Figure 3.24 Finding and changing the typeface

When text contains a mixture of fonts, sizes, and styles, manually changing 
these attributes, such as when producing a reduced version for camera- 
ready copy, can be tedious.

1. Select Style in both the Find: and Replace with: pop-up menus 
(Figure 3.24 and Figure 3.25). To be unambiguous you must further qualify 
the meaning of style (Figure 3.24).

Text

✓  Style 
Reuision 
Rdded Tent 
Deleted Text 
Style Change

Text

✓  Style 
UnMark

Figure 3.25 Style search
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Match
Text Only

✓  Font
✓  Size
✓  Style

i. ilSii
SiJords

fiffect
Text Only

✓  Font
✓  Size
✓  Style

Figure 3.26 M atch and A ffect attributes

2. Select the combination of attribute classes, such as Font, Size, and Style, 
from the Match and Affect pop-down menus (Figure 3.26) to identify the 
specific meaning of "style." In Figure 3.26 a "match" will occur when text 
having the font, size, and style assigned in the next step is located. In this 
same example, the located text will be assigned the font, size, and style 
assigned in step 4. The typeface, but not actual text, will be changed.

3. Click in the box to the right of Find: (Figure 3.22) to select it and use the 
Style menu to assign a specific choice for each attribute selected.

Select Font, Size, and Style from the Style Menu

Geneva 12 * •

Figure 3.27 Assign specific values for attributes

4. Click in the box to the right of Replace with: (Figure 3.22) and use the 
Style menu to assign a specific choice for each attribute selected.

5. Perform the search and replace as described above for ordinary text re
placement.

The Find/Replace feature has a set of five pull-down menus that allow you 
to customize searches.

• The Match menu identifies attributes of text in the find box that need to 
be matched in the search. These attributes, font, size, style, case, or whole 
words, are in addition to matches with the actual characters typed. A case 
match requires that each character match the corresponding case (upper or 
lower) as the text in the find box. A whole word match excludes matches on 
portions of words.

The final four Find: choices (Revision, Added Text, Deleted Text, and 
Style Change) and the modified Match submenu apply to revision 
tracking, which will be discussed in Chapter 4.

• The last entry, Affect, also pertains to revision tracking and is discussed 
in Chapter 4.
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Spell-checking

• The Word and Symbol selections on the Wildcards menu allow you to find 
matches on a character string when a leading or trailing string of characters 
(Word) is immaterial or when an individual character (Symbol) is

word!" to find "run"immaterial. For example, use the Word option "run 
"running'', or any word that begins with "run". Use the Symbol option " 
i? r  to find "cat" and "car". [?i represents exactly one character. T 
remaining three options apply to mathematical expressions and 
discussed in Chapter 4.

and
ca

The
are

• The Special menu allows you to locate (and replace) the invisible 
formatting characters—tabs, line breaks, column breaks, page breaks, or 
any character you identify by its ASCII number. Use the mouse to "type" 
these characters in the Find/Replace dialog box from the pull-down menu. 
See the appendix for an ASCII list. The most common use of the Character 
Code option is to clean up imported files.

• The Direction menu controls the search direction and range. With the 
arrows you can search forward from the position of the blinking insertion 
point or backward to the end of the document (only), or search the entire 
document.

The advanced topics chapter, Chapter 4, discusses revision tracking and 
mathematical expressions, including use of Find/Replace.

MathWriter can compare each word in your document with a vocabulary 
list and identify the words that are not found in the vocabulary list. A 
supplementary list of words from math, science, and engineering is 
provided. You can add new words to the supplementary list or remove 
unwanted words. If you wish, MathWriter  presents a list of alternative 
spellings for words not found in the dictionary. Words in uppercase often are 
acronyms and can be excluded from the suspect list automatically. Repeated 
words can also be flagged and removed with MathWriter.

The word lists Because the system files and MathWriter  each nearly fill a 
disk, spell-checking is practical only if you are using a hard disk. The word 
lists, also called dictionaries, must be accessible to MathWriter. If the 
word lists are placed in the System folder or in the same folder as Math- 
Writer, the program automatically locates the main MathWriter diction
ary and the supplementary dictionary at startup. Otherwise, to locate 
them and access a dialog box, you must use the two buttons Main Dictionary 
and User Dictionary on the Check Spelling dialog box. Only one user dic
tionary can be active, but you can manually switch to other word lists.
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iD  ~ 1 Spell Finder® from Microlytics™

[ Main Dictionary: ] MathWriter Dictionary 

[ User Dictionary: ] Mill User Dictionary

Findiny alternate spellings...
Alternate?]

E3 Skip words in All Caps [x] Check for repeated words

Change to:

Check Replace Skip Learn Cancel

Figure 3.28 Spell-checking dialog

Spell-checking your documents To find and correct misspelled words, follow 
these steps:

1. Position the insertion point in the document where checking is to begin.

2. Select Edit/Check Spelling to access the spell-checking dialog box 
(Figure 3.28).

3. If the names of the main dictionary and the user dictionary do not ap
pear in the dialog box adjacent to the Main Dictionary and User Dictionary 
buttons, click on those buttons to locate them.

MathWriter locates them automatically at startup if they are in the 
folder with MathWriter or in the system folder. The path to these files is 
stored in the Prefs file so this process need not be repeated.

4. Click in the check boxes to select which of the following options you 
prefer:

• Alternatives. If the suspect word shown in the "Status" box is either 
misspelled or not in the dictionary, MathWriter  can provide an optional 
pop-up list of alternatives.

If feasible, MathWriter  places a "bestguess" alternative in the Change To: 
box;otherwise, it places the suspect word there. If Math Writer finds other 
alternatives, the list appears in the pop-up menu. When you select an entry 
from the pop-up menu, MathWriter transfers the word to the Change To: 
box.

When you recognize that the suspect word is correct, you can terminate the 
search for alternatives prematurely by pressing period or by clicking the 
mouse. If the desired word is not located, type it in the Change to: box.



• Skip words in All Caps. This option excludes acronyms.

• Click on Check for repeated words to locate contiguous, repeated words. 
This option locates and removes duplicate words. When contiguous, 
repeated words such as "very very" are found, the dialog reports "Status: 
Repeated word." Click on Replace to remove it and a space or on Check to 
resume checking without making a change.

5. Click on Check to begin checking. The progression of the search
is reported just above the Alternates pop

up menu. The triangle ▼ indicates the relative position of the start of 
checking.

When a suspect word is found, you have three options:

• Supply the correctly spelled word in the Change to: box if it is not 
already provided by the Alternatives option and click Replace.

• Click on Skip to bypass the word, leaving it unchanged.

• Click on Learn to add the word to the user dictionary, thereby avoiding 
manual verification of this word later.

6. Optional: Click on <Edit to review the list of words in the active user 
dictionary and to remove any that you wish to exclude. (See Figure 3.29 for 
a view of the Edit User Dictionary dialog box.)

Edit User Dictionary... 
Rcta
additiuity 
Rdolphe 
anisotropically 
Bezier 
boneheaded 
bop
Brooktondale 
calculational 
capillarity

Figure 3.29 Edit User D ictionary

• To remove a word, select it and press Delete Word.

7. When the spell-checker reaches the end of the document, it asks you 
whether it should continue checking from the beginning of the document. 
Click Stop Checking to terminate the search or Continue Checking to 
resume checking.

Beieie lUord

O l  °K J
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8. Click on Cancel to terminate checking.

Caution: Always read your document carefully. Spell-checking does not 
assure that you have used words correctly.

Thesaurus

During the editing process you can use the Thesaurus command to obtain 
suggestions for alternative, more precise words. The Math Writer Thesaurus 
file must be accessible and the conditions for word lists apply here too.

To find a synonym:

1. Select a single word:

• Click to place the insertion point within the word,

• Drag to select the word, or

• Use the arrow and shift key with left or right arrow.

Suppose, for this exercise, you select the word "use" in the previous line.

2. Use the Edit/Thesaurus command to access the thesaurus dialog.

3. Scroll to the verbs.

4. Alternative 1: If you prefer the word "utilize," double-click on it to 
replace the original word and leave the Thesaurus.

Alternative 2: To search even further, click on "utilize" and then click 
Lookup to access another list. If you find a preferable word, double-click on 
it to replace the original word and leave the Thesaurus.

To return to a previous word list, click on Last Word.

Alternative 3: If you can think of a still more appropriate word, type it in 
the Find: box and click Lookup to examine its list of synonyms, or click 
Replace to substitute it in the document.

5. To abandon your search for an alternative word, click Cancel or the 
close-box.

Hyphenation

The hyphenation feature splits long words at the end of a line of text to 
reduce the raggedness sometimes created by automatic wordwrap and left- 
aligned text. This feature becomes increasingly important as the column 
width becomes shorter. MathWriter hyphenates the entire document or 
selected portions of text.
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To hyphenate text:

1. Select the text to be hyphenated using the mouse or the keyboard. If no 
text is selected, MathWriter hyphenates the entire document.

2. Select the Hyphenate Selection submenu of the Edit/Hyphenate 
command to hyphenate the selection.

MathWriter places so-called "soft hyphens" or temporary hyphens in the 
text. If subsequent editing moves a softly hyphenated word away from the 
end of the line of text, MathWriter automatically removes the hyphen.

You can also explicitly unhyphenate text using Unhyphenate Document in 
step two above.

Printing

This section describes the final step in producing a document—printing. 
MathWriter supports output to the ImageWriter and the LaserWriter with 
the customary options for multiple copies, range of pages, etc. Enhancements 
allow you to select page ranges based on the page variable numbers; print 
markers for memos, ruler changes, and revisions; collate multiple copies; 
print on both sides of the paper; and print pages in normal or reverse order.

Installing the print driver

Consult your Macintosh user's guide for hardware installation instructions 
and placement of the appropriate print drivers in the System folder.

Although you can change printers at any time, we recommend selecting the 
printer type before you create the document because page sizes, margins, and 
placement of some mathematical expressions are affected by the printer 
choice.

To route output to a particular printer:

1. Select Chooser from the Apple menu.

2. Click on the icon of the desired printer type (Figure 3.30).

3. Select a specific printer:
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Chooser

Select a LaserWriter:
LaserWriter Plus <>

<>

Background Printing: ©  On O Off

User Name:

AppleTalk ®  Active 
O Inactive

3.5

Figure 3.30 Chooser dialog box

ImageW riter To print with an ImageWriter, you must specify a specific 
printer port by clicking on the icon that corresponds to the printer connection 
on the back of your Macintosh. Supply your user name if you wish. Click on 
the close-box.

LaserW riter To print with a LaserWriter you must click on the name of a 
particular "online" LaserWriter. Only the names of active printers avail
able on your AppleTalk network appear in the list. If the Print Monitor is 
present in the System folder, you can select background printing, which 
means that the file will be printed to disk and then sent to the printer, 
freeing your Macintosh for other tasks. Supply your user name if you intend 
to print an identifying cover page. Click on the close-box.

In general, you should have decided the type of printer before creating your 
document because this decision can affect your choice of fonts, and, 
therefore, can alter the page layout. If your document layout is critical, 
explicitly make your own font selections rather than using the "Font 
Substitution" option under Page Setup on the File/Page Layout menu. Select 
the "Tall A djusted" option for proper ImageWriter output of mathematical 
expressions. Other factors such as paper size are dependent on printer 
choice, too. (In mathematical expressions the choice of printer affects the 
horizontal placement of superscripts.)
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Selecting a document

The document you want to print must be in the active window.

To select a document, open it, if necessary, using the File/Open command. 
The document opens at the location of the insertion point when last saved. 
To have the document open at a specific page, position the insertion point 
on that page before you save the file.

If the document is open but not in the front window, either click in a portion 
of the document window or select its name from the Windows menu to bring 
it to the front.

Using the print dialog boxes

The File/Print command activates a dialog box with the output options, 
which are different for the ImageWriter and LaserWriter. See Figures 3.30 
and 3.31 for a glimpse of these two dialog boxes. Note that you may use the 
mouse or the tab key to move among the input boxes.

ImageWriter__________________________________
Quality: O Best (§) Faster O Draft
Page Range: (S) fill Q  From: | [ To: [~
Copies: |l
Paper Feed: ®  Rutomatic O  Hand Feed

□  Page Range Refers To Page Uariable Numbers 
Print Markers For:

□  Memos Q  □  Ruler Changes ra □  Reuisions |
Print Multiple Copies: (•) Uncollated O Collated
□  Print Both Sides □  Reuerse order * •

Figure 3.31 ImageW riter Print dialog box

The ImageWriter-specific options are:

• Quality: These options let you balance speed and print quality. "Best" is 
the slowest option and uses the highest density of dots. "Faster" preserves 
the font and style information but speeds up delivery. "Draft" is the 
fastest, but does not preserve the character formatting information.

• Paper Feed: Use "Automatic" for fanfold, tractor-fed paper and "Hand 
Feed" for individual sheets of paper.

[ Cancel)
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LaserWriter “LaserWriter 11 NT” 5.2

Copies: Pages:® fill OFrom: To:

Couer Page: ®  No O  First Page O  Last Page

Paper Source: ®  Paper Cassette O Manual Feed
□  Page Range Refers To Page Uariable Numbers 
Print Markers For:

□  Memos Q  □  Ruler Changes ra □  Reuisions
Print Multiple Copies: (•) Uncollated O  Collated
□  Print Both Sides □  Reuerse order 
Paper Motion Configuration:

L ^ J
[ Cancel ] 

Help

I

Figure 3.32 LaserW riter controls

The options common to ImageWriters and LaserWriters are:

• Page Range: Use “A ll," the default, to print the entire document, 
regardless of the number of pages. Otherwise, supply the beginning and 
ending page numbers in the "From" and "To" boxes; leave the "To:" box 
blank to print to the end of the document. You can use either the physical 
page numbers, which correspond to the scroll box in the vertical scroll bar, 
or page numbers as they appear in the header or footer, in which case you 
would click on "Page Range Refers To Page Variable Numbers." These 
numbers will be the same, of course, unless you supply a starting page 
number [Format/Variables Format] different from "1," which you might do 
if the current file were a continuation of a previous file. To print a single 
page, assign the same page number to the "From:" and "To:" boxes.

• Copies: Type the number of copies you wish to print here.

• Page Range Refers To Page Variable Numbers: See Page Range above.

• Print Markers For: This command prints the locating tags for memos, ruler 
changes, and revisions on draft copies. Use Format/Show Messages to 
display these markers in the left margin on the screen. Memos are hidden 
"Hypertext" minidocuments. Paragraph format changes are identified by 
"unique rulers." Markers in the left margin identify lines that contain 
revision additions and deletions, which are marked by distinctive style 
changes in the text line.

• Print Multiple Copies: This command lets you control the order of 
printing. "Uncollated" is faster and prints all copies of a particular page
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before moving to the next page. "Collated" prints all pages of a document 
before beginning another copy of a document.

• Print Both Sides: This command prints the odd and even pages separately 
and provides instructions for changing the paper. For a LaserWriter you 
must identify the paper motion configuration discussed below.

• Reverse Order: This command automatically adjusts the printing order. If 
Reverse is not checked, the pages print in normal reading order. For a 
LaserWriter you must identify the paper motion configuration discussed in 
the next list.

The LaserWriter-specific options are:

• Cover Page: Use this option to identify your output when you are sharing 
a LaserWriter with others. This identifying page can precede or follow 
your document.

• Paper Source: The LaserWriter can automatically feed sheets of paper 
from a paper cassette (tray) or receive hand supplied sheets. If you choose 
manual feed, you will be prompted by a screen message to insert the pages.

• Paper Motion Configuration: The path of the paper through the 
LaserWriter depends on the model and paper source. Click on one of the 
icons to select the printer type.

LaserWriter LaserWriter II

Other printing options

For additional printing options refer to the discussion earlier in this 
chapter about the Page Setup dialog box available via the File/Page 
Layout command. (See Figure 3.33 and Figure 3.34) Tall adjusted, 50% 
reduction, and no gaps between pages are available for ImageWriters. 
Options for the LaserWriter include reducing and enlarging the page image, 
font substitution, text and graphics smoothing, faster bitmap printing, 
fractional widths, flip horizontal, flip vertical, invert image, precision 
bitmap alignment, larger print area, and unlimited downloadable fonts in a 
document.

Selecting Tall Adjusted is necessary when using the Image Writer for the 
output to look like the screen.



Nontechnical Writing 95

ImageWriter v2.7 |( OK ]|
Paper <§) US Letter O R4 Letter

O US Legal O  International Fanfold [ Cancel ]
O Computer Paper

Orientation Special Effects: □  Tall Rdjusted
n j i Fv^i □  50 % Reduction
BUM □  No Gaps Between Pages

Figure 3.33 ImageW riter Page Setup dialog box

LaserWriter Page Setup
Paper: ®  US Letter O R4 Letter OTabloid 

O  US Legal O  B5 Letter

Reduce or 
Enlarge:

Orientation

Printer Effects:
□  Font Substitution?
^  Teut Smoothing?
^  Graphics Smoothing?
S  Faster Bitmap Printing?

[ Cancel] 

[ Options ]

t He|P 1

Figure 3.34 LaserW riter Page Setup dialog box

Printing at the Finder level

You can select and print multiple files from the Finder level, as well as 
with the Print Monitor under MultiFinder as follows:

1. Use the usual selection techniques to select the icons of one or more files 
from a folder.

2. Choose Print from the File menu to initiate printing.

Summary
In this chapter you have examined the techniques used to create, edit, 
format, and print a nontechnical document. Most steps can be performed by 
mouse and by keyboard. Math Writer provides immediate visual feedback 
throughout—from defining the page characteristics and creating fully 
formatted "sheets of paper" with automatic pagination to typing special 
characters and designating the type of LaserWriter you're using. Most 
operations performed by traditional word processors have been included.

The next chapter covers the features required for more specialized 
applications, including MathWriter's  unique capability for creating, 
editing, and numbering mathematical expressions in a document.
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The techniques for creating, editing, formatting, and printing general, non
technical documents are described in the previous chapter. In this chapter 
we extend that discussion to include techniques for enhanced document lay
out, such as creating headers, footnotes, columns, and sidebars, and ad
vanced typing aids, such as the font table, user styles, and libraries. Our 
primary focus, however, is the presentation of tools and techniques for com
posing a mathematics-laden document at the keyboard.

Mathematical expressions contain a larger assortment of fonts, font sizes, 
font styles, and special characters, as well as more frequent changes in 
these attributes than is typical of ordinary writing. Furthermore, the 
special positioning of these characters produces a two-dimensional, rather 
than a one-dimensional, stream of characters governed by an extensive set 
of formatting conventions. To the extent feasible, MathWriter handles 
these formatting tasks for you.

Technical writing is typically a collaborative and iterative process having 
precision and clarity as its goal. In this chapter you will learn to use 
MathWriter's contextual display of tentative revisions and the automated 
process for responding to these proposed changes. Line numbering and 
hidden memos complement the communication process among multiple 
authors, or even with oneself, during the evolutionary process of writing.

The chapter closes with a discussion of customization to reduce repetitive 
setup tasks, sharing data among applications, and an important modulari
zation technique for extending the scope of tasks handled by MathWriter.

Formatting Revisited
A few general formatting techniques not covered in Chapter 3 will be 
reviewed here.
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Document formatting

Ruler options

Because mathematical expressions usually require more vertical space 
than a line of ordinary text, the vertical dimension of the screen becomes an 
important issue. Hiding the ruler provides a larger work space.

♦  To hide the Ruler, select Format/Hide Ruler to remove the tab setting 
scale across the top of the document window.

The tab wells and paragraph alignment icons displayed above the vertical 
scroll bar are also removed at the same time. Hiding the Ruler is also useful 
when you use MathWriter for a video presentation of "slides." In the 
previous chapter we discussed the techniques for rapid, top-of-the-page 
scrolling.

♦  To show the Ruler, Select Format/Show Ruler (or 98' ) to display the 
Ruler.

♦  To change the unit of measure, drag to select inches, centimeters, or 
points on the Ruler Options command of the Format menu.

The abbreviations for these units in the File/Page Layout dialog are: in, 
cm, pt (without a period). Recall that the Ruler has an intentional and 
convenient "coarseness" (for matching tab settings at one sixteenth inch 
increments) that you can override by pressing option while dragging a tab.

The zero point of the Ruler can correspond to either the actual left 
boundary of the page or to the left edge of the text area. If you select 
multiple columns [File/Page Layout], the ruler measures the distance from 
the left edge of the column that presently contains the insertion point.

♦  To change the horizontal position of the Ruler, drag to select 
Format/Ruler Options/Page Ruler or Format/Ruler Options/Column Ruler 
to toggle to the other.

Columns

MathWriter supports formatting and editing of up to four columns of equal 
width. If selected, these columns apply throughout the document, except in 
the headers and footers which cover the full width of the text area. You 
can specify the space between columns and a binding margin or gutter that 
MathWriter automatically places on odd and even (facing) pages.



Technical Writing 99

Page Layout... Columns O 1 <§) 2 O 3 O 4

[ Man ] [ Std ]

Margins:
left
right

top

bottom

Header height: 
Footer height:

^  Gutter 

Column gap:

□  Facing pages

Page Setup...

1.250 in
1.250 in

0.430 in

0.430 in

0.500 in
0.305 in

1.000 in

0.250 in
Cancel [[----- OK----- 1]

Figure 4.1 Page Layout dialog box

To create a multicolumn format:

1. Select File/Page Layout to access the appropriate dialog box 
(Figure 4.1).

2. Click to select the number of columns. MathWriter reformats the off
screen portions of an existing text document in the background while you 
perform other tasks. A banner in the status bar indicates the proportion of 
formatting completed. Graphics, sidebars, and mathematical equations 
that are wider than the new columns present a potential problem.

We strongly advise you to make a layout decision on the number of columns 
before you create a document.

3. Input the desired measure of the Column gap box. (Include the units 
without a trailing period.) When you select more than a single column, you 
must specify the width of the gap between columns. The remaining 
document width is divided into equal columns.

♦  To assign an enlarged margin for binding, click on the word "Gutter" or on 
its check-box and supply a value and unit. The gutter is space in addition to 
the margin you specified above in the left and right margin dialog box.

If you intend to print your document on the front and back of pages [See 
File/Print] and have assigned a binding margin or gutter above, you can
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have MathWriter  place the binding margin alternately on the left and 
right borders of the pages.

♦  To create facing pages, click Facing pages to set this option.

Note: If you use the Facing pages option, you will probably also elect to 
make your headers and footers differ on alternate pages [see File/Doc 
Layout "Left/Right Pages"].

Sidebars, an additional page layout feature, are associated with 
paragraphs. Adjacent text flows around them. We discuss them more fully 
later in this chapter.

Paragraph form atting

Line spacing

Appropriate spacing of lines of text in a paragraph makes documents easier 
to read. Straight prose requires fewer formatting options than technical 
writing. With the usual word-processor choices of single, 1-V2 , and double 
spacing, you can double space a printed draft of prose to allow space 
between the lines for editing and then single space the final document 
without retyping. However, in the case of simple mathematical 
expressions, such as exponents, embedded or in-line constructs produce 
uneven line spacings.

Figure 4.2 Line Spacing dialog box
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MathWriter provides additional controls for line spacing (Figure4.2). The 
Automatic selection allows you to create mathematical expressions of 
arbitrary complexity without concern for the required line spacing. If the 
resulting text has a distracting unevenness, you can select the offending 
paragraph or paragraphs and assign to it one of the other two spacing 
options.

Fixed spacing allows you to specify a line spacing that will be maintained, 
even if portions of the line must be clipped. The ascent and descent settings, 
not just the leading, can be set separately (Figure 4.3). The Mostly fixed 
option allows some mathematical structures, such as superscripts and 
subscripts, to protrude into the whitespace that already exists between the 
lines of text. Mostly fixed automatically switches to Automatic for 
mathematical expressions which occupy a separate line (but not for 
expressions embedded within a line of text).

default

adjusted

Figure 4.3 Ascent and descent are separately adjustable

The Automatic spacing default settings for the ascent and descent are 9 and 
3 (Figure 4.4) for the minimum ascent and minimum descent plus leading. 
Figure 4.3 shows these and the spacing of 30 (top) and 20 (bottom).

Mostly fixed spacing (Figure 4.4) lets you choose from three standard line 
spacings and a user-defined fourth. You can add extra whitespace above 
and below displayed equations (equations on a separate line, not embedded 
within a line of text).

Simple ...text Hiie...:(24 .̂.p^..

Simple text line (24 pt)..



Line spacing...
O Automatic
(D Mostly fined 
O Fined

Fixed ascent

Figure 4.4 M ostly fixed spacing 

Table 4.1 D efault line settings

Setting: Single 1-1/2 Double Other

Lines / inch 6 4 3 na

Min. Ascent 9 14 18 user

Min. Descent + Leading 3 4 6 user

MO
Fixed descent + leading

s. a

i S in g le  (6 lines/inch) 

| 1 -1  / 2  (4 lines/inch)

j Double (3 lines/inch) 

I Other...

9

3

Displayed equation adjustment

Cancel G O

To change the spacing of existing text:

1. Select the text to be affected. Line settings apply to an entire paragraph. 
Recall that to identify a single paragraph, you need only place the 
insertion point within the paragraph. You can also select a portion of text 
within the paragraph to identify it. To select several contiguous 
paragraphs, place the blinking cursor somewhere in the first paragraph 
and, with the shift key depressed, click somewhere in the last paragraph.

2. Select Format/Line Spacing and assign values for line spacing, dis
played equation adjustment, and ascent and descent by clicking or dragging.

When you create a new paragraph by pressing return, it inherits the line 
spacing of the previous paragraph, but not its border information. You can 
also assign the line spacing for a paragraph any time, including 
immediately after you create it and before you type any characters.
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Paragraph borders

MathWriter applies various borders and background patterns to 
paragraphs. You can place a border on any combination of sides of an 
existing paragraph. The border can consist of one or two lines of user- 
selected thickness, pattern, and spacing (between lines and between the 
border and the paragraph). The paragraph itself can have a background 
pattern or a gray-scale on a PostScript printer.

One or more contiguous paragraphs can have borders, but borders must be 
assigned explicitly to existing paragraphs rather than being passed 
automatically with the ruler. If you choose borders on all four sides and 
select two or more paragraphs, the common boundaries will be deleted 
automatically. Since an equation can also constitute a paragraph, this 
provides a means for highlighting the important result of a derivation.

To assign paragraph borders:

1. Select the paragraph.

2. Select Format/Paragraph Format. (See Figure 4.5.)

Paragraph format.. 
.............. Spacing

Before SI
fifter SI Id 111 I

Borders

r ^ ~ ~

............ Attributes ----------- --
□  Link to newt SI
□  Column break before
□  Page break before
□  Can't split ouer page break

Whitespace IQliiil I 0 6

Click above for thickness and pattern
Cancel I1— ^ — I)

Figure 4.5 Paragraph Format dialog box

3. Click on the sides of the paragraph icon at the left (Figure 4.6) to 
designate the sides to be assigned a border. Click in the middle of the icon 
to select four sides at once.

4. To assign the number of lines (1 or 2), line thickness and pattern, or 
background pattern, click in the space to the right of the paragraph icon.
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...........Borders
♦ =

0 m m
♦

Click above for thickness and pattern 

Figure 4.6 Assign sides and line characteristics

5. Make choices regarding number of lines, line thickness and pattern, and 
background pattern using the pop-up menus (Figure 4.7).

6. Use the scroll bar to assign the whitespace (in pixels or points) between 
the paragraph and the borders.

Character form atting

Diacritical marks

Select thickness and pattern... 
—  Outer border-------------------

Thickness 
Pattern

...  Inner border

Thickness hairline 

Pattern

...Background pattern •••

Pattern | |

Space between borders IQ |||

Figure 4.7 Assign border styles

7. Click OK to accept the choices and close the dialog box.

A number of Math Writer's numerous techniques for quickly assigning the 
typeface information to text were discussed in Chapter 3. A few mathe
matically related techniques are discussed here.

Many Macintosh fonts include characters that contain diacritical marks. 
You can use the Windows/Font Table to type them and the Key Caps desk 
accessory to locate them on the keyboard. The Diac menu supplements this 
and also provides various horizontal groupings (over and under bars).
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1. Place the insertion point immediately to the right of a character to be 
assigned a diacritic. Once you have selected a character in this manner, 
the previously dimmed diacritic marks become available.

2. Select a character using the mouse.

The diacritics in the Diac menu, but not those that are part of the font 
character sets, are bypassed by the spell-checker.

3. If necessary, adjust the height of the diacritic using the Raise or Lower 
commands (or their keyboard equivalents 38 R  and 38  L) on the Diac menu. If 
the default settings do not serve your purposes, use the Windows/Library 
command to save the perfected combination of retrievable characters. This 
command also includes several overbar and underbar symbols, which also 
apply to a single character.

Multiple levels of characters above or below a character

To place multiple lines above a character:

1. Place the insertion point to the immediate right of a character, which 
optionally might already have a diacritic mark.

2. Click [ t ]  on the Tools menu or press 38  [ and supply one or more characters 
to be centered above the base character.

3. Optionally: Choose the matrix template with no separating lines as the 
ninth icon (column) on the ninth icon (row) of the Templates window or use 
38 9  and 9  (if typed rapidly and the Template is not visible) when you must 
stack an arbitrary number of rows above a character.

Use the special functions templates on row seven, rather than center below 
for limits, etc., where irregular spacing around the base character must be 
avoided.

Horizontal grouping of characters

Twelve, stretchable, grouping symbols become available when you select a 
string of contiguous characters to represent complex conjugates, vectors, and 
soon.

Note: Boldface Greek letters (often used to denote vectors) will not print 
properly on a LaserWriter unless you use the Adobe Symbol font licensed 
for use with MathWriter.

To supply horizontal grouping symbols for multiple characters:

1. Select two or more characters.

2. Select the desired symbol from the Diac menu. After a slight pause, 
MathWriter places the symbol over or under the characters.

s
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3. If necessary, you can use the split I-beam math cursor (obtained by 
pressing option anytime the regular text cursor is present) to edit within the 
group of characters.

Headers and Footers
Size

To set the size of the header and footer:

1. Select File/Page Layout.
The outer rectangle of the page 
diagram (Figure 4.8) corre
sponds to the physical bound
ary of the paper; the outer 
rectangle of the area with the 
darkest shading identifies the 
maximum LaserWriter print 
area. The margins (top, bot
tom, left, and right), measured 
from the page boundaries, 
allow you to exclude addi
tional print areas.

2. If necessary, adjust the 
margins by typing new values.
The interior of the remaining 
rectangular portion of the 
page contains the body of the 
document and the headers and 
footers. The headers and foot
ers extend across the page, even if multiple columns are used.

3. Type the vertical dimension of the header and footer in the dialog box 
(Figure 4.9). Supply dimensions with units (in, cm, or pt without a period). 
To eliminate a header or footer, set its dimension to zero. Out-of-range 
values will not be accepted.

4. Click OK to accept your choices.

Only text that fits in the header will be displayed. You can resize the 
vertical dimension if necessary.

Paper boundary
Top
margin

Header

Footer
Bottom
margin

Left
margin

Right
margin

Figure 4.8 Page layout schematic
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Page Layout... Columns O 1 ®  2 O  3 O  4

( Man ] [ Std Page Setup.
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left

right

top
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Header height: 

Footer height:

0  Gutter 
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□  Facing pages
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1.250 in
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Cancel OK

Figure 4.9 Page Layout dialog box

Layout of headers, footers, and footnote/endnotes...

Sam e  fo r  all pages

E v e rg  page 

S k ip  f i r s t  page 

S k ip  la st  page 

S k ip  f i r s t  &  la st  pages

m

iliiiiil
jiiliSii

ill :£rzr

lid ; i
! i 

i i

KA

r---

|
 i i

! i
:1

!

pi!
; iiiii I —

— L

~

A

2~

bx

3“

A-----

4~

Le ft/R igh t pages

F ir s t  page d iffe rent

Footnotes Endnotes

----1.A ---- ----ts.A ----
T
2

space before  space  between

b u .......1CH 5 m . £ | 2  l Cancel L— gg— )1

Figure 4.10 Doc Layout dialog box
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Placement
To place the headers and footers on pages throughout the document:

1. Select File/Doc Layout (Figure 4.10).

2. Click to make your choices for placement of headers and footers that can 
appear on every page, skip the first page, skip the last page, or skip the 
first and last page. An enclosing border identifies your choices for headers 
and footers. Additional choices remain. Four sets of alternatives are 
provided for headers and footers—three sets are comparable, in their 
actions, to radio buttons and the fourth is comparable to a check-box. (For a 
complete description of these features, see Chapter 3.)

3. Click to select either "Same for all pages" or "Left/Right pages." By 
convention, left pages are even-numbered and right pages are odd- 
numbered. If you choose "Left/Right pages," you must specify the 
placement of the contents of the headers and footers on both odd and even 
pages. If you have not yet supplied any text, you can use Format/Insert 
Column Break to make the second page appear. If you selected facing pages 
using File/Page Layout, then MathWriter  prints the pages as mirror 
images with binding margins preserved.

4. Click to toggle "First page different" if you wish the first page headers 
and footers to differ from the rest. This option is useful, for instance, if you 
wish to create stationery that has a letterhead only on the first page or if 
you wish to place page numbers on all pages except the first.

5. Click OK when you are satisfied with your choices.

If you wish to create "stationery" with page numbering that begins on the 
second page, temporarily add a second page using Format/Insert Page 
Break, add the page number by clicking on the Palettes menu, format it 
with "Page #" on Format/Variables Format, and remove the temporary 
second page by placing the insertion point at the top left of the text of the 
temporary page and pressing delete.

Editing headers and footers

To edit existing headers and footers:

1. Click within the header or footer to position the insertion point. Your 
choices in the previous section may have created several different headers 
or footers so remember to verify that you are editing the correct one.

2. Supply text, graphics, or mathematical expressions as if you were 
working within the body of the text. Sidebars cannot be placed in the 
header or footer, but background pictures can.

Select All, Cut, Copy and Paste (all on the Edit menu) apply to headers 
and footers, as do Format/Paragraph Formatting and Format/Line Spacing.
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3. Click within the body of the text to leave the header or footer.

Footnotes and Endnotes
Supplementary or parenthetical information is sometimes placed at the 
end of the page (as a footnote) or at the end of the document (as an endnote) 
with a unique symbol assigned to text and to the note to establish a visual 
linkage. MathWriter dynamically numbers footnotes using a user-selected 
format and reformats the page to make space for them. When you supply 
footnote text that exceeds the allocated space, MathWriter  automatically 
moves body text from that page to the following page to make room for the 
footnote. If you cut from a document a portion of text that contains a footnote 
or endnote reference and paste that material elsewhere in the document, 
MathWriter automatically renumbers the notes, preserving the linkage to 
the content of the footnote, and displaying the note in its proper location. If 
you remove a footnote that is cross-referenced by a footnote re-reference 
variable, that linkage is broken.

Footnote (and endnote) placement
To choose footnotes or endnotes:

Creating footnotes

1. Select File/Doc Layout. (See Figure 4.10.) Normally, you decide where 
you want parenthetical material placed (at the foot of the current page or 
at the end of the document) before you create the document. If you forget, 
however, MathWriter can reformat the document.

2. Click on either the Footnotes or Endnotes icon (Figure 4.10).

3. Select one of the three separation formats (no divider, dotted, or solid).

4. Use the scroll bars to set a) the space before the first footnote and b) the 
space between footnotes, measured in pixels (or points).

5. Click OK to accept the choices and leave the Doc Layout dialog box, or 
click Cancel to abandon your choices when you leave the box.

To create a new footnote (or endnote), follow these steps.

1. Place the insertion point in the text where the footnote reference is to be 
placed.

2. Drag to the footnote icon on the Variables row of icons of the Palettes 
menu and release the mouse button. Math Writer automatically assigns a 
footnote number using the default format. The name of the icon appears on 
the bottom row of the Palette menu as you drag across the icons in the 
Palette.
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If you must select a Variables icon frequently, speed enhancements are 
available to you. First, type $6 option F. Then add the footnote variable to 
a Library using one of the following methods:

• Place the row of variable icons on the floating Palettes window for 
convenient mouse access without using a pull-down menu. To do this, select 
Windows/Palettes Window to place the Greek palette on-screen and then 
select the name "Variables" on the Palettes pull-down menu.

• Place the dynamic variable in the Library for both keyboard and mouse 
access. To do this, click on the variable from the Palettes menu to place it in 
your document. Then select the variable and surrounding text, if desired, to 
go in a library using the procedures discussed in the section on Libraries 
later in this chapter. Then you can place the auto-numbering variable in 
the text by typing its abbreviation or by double-clicking it in the Library 
window.

3. Select the footnote number in the pop-up menu of the insertion point 
locator box in the status bar at the bottom of the page (see Figure 4.11) to 
scroll to the footnote. You can also use standard scrolling techniques. The 
window scrolls to the footnote/endnote area with the insertion point 
positioned for text entry.

©Body
D  Header -  Every page 

©  Footer -  Every page 

©Footnote 1 

©Footnote 2 

©  no ehing*________
Figure 4.11 Pop-up locator menu

4. Supply the footnote content. The footnote area increases as necessary, 
displacing lines from the body of the text and automatically moving them 
to the next page as needed. The technique of setting global formatting 
attributes for footnotes is described later in this section.

5. Click Body in the pop-up menu (Figure 4.11) in the insertion point locator 
box of the status bar to scroll back to the location of the insertion point in 
the body of the text. You can also use the standard mouse and keyboard 
scroll techniques to return to the text.

Cutting and pasting footnotes (or endnotes)

When you cut and then paste text that includes footnote references, 
MathWriter automatically renumbers and re-positions them. Do not cut 
and paste the contents of the footnotes separately as that is handled 
automatically.
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To cut and paste a footnote (or endnote):

1. Select the text that includes the footnote reference. Note that the 
footnote number is a discrete character that you can cut and paste separate
ly-

2. Cut the text with its footnote reference. MathWriter  automatically 
renumbers the remaining footnotes and updates the linkage to the actual 
footnote.

The link to a footnote re-reference (i.e., a cross-reference to an existing foot
note) is necessarily broken when the footnote is removed, even temporarily, 
and must be reestablished manually. A question mark replaces the cross- 
reference number when the link is broken.

3. Indicate the destination of the text and footnote reference by reposition
ing the insertion point.

4. Paste the text and footnote reference back into the document.

MathWriter automatically renumbers the footnotes; moves the text of the 
footnote to a new page, if appropriate; and places the footnotes in the 
proper order.

Formatting footnotes and endnotes

MathWriter supports five standard formats for consecutive numbering of 
footnotes and a set of six user-selected symbols for non-numeric referencing. 
To change the default format of footnote numbers, follow these steps:

1. Select Format/Variables Format.

2. Scroll to and click on footnote/endnote. (See Figure 4.12.)

3. Click on one of the numerical formats or the "use symbols" category

4. If you chose to use symbols, you can edit the six characters, which are 
listed in sequential order.

5. Edit the "starting at" box in the Footnote dialog box to set the lowest 
footnote number if this is a continuation document.

Complete steps 6 - 8 if you do not want to take the style from context.

6. Optional: To assign a style, click the Variable Style button.

7. Optional: Click the check-boxes or the category names to enable Font, 
Size, Style, Justification, or Line spacing categories. Font, Size, and Justifi
cation lead to pop-up menus and Style and Line spacing lead to dialog boxes 
for those more complex choices.
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8. Optional: Make style selections, verify the output, and click OK.

Figure 4.12 Footnote format choices

Uariable Style...

®  example* 1 Starting Rt
d llO example 

O example1'1'1 

O examplell ] 

O example! 1)

1|

O Use Symbols

* * * * * * t ft •

Cancel
0 3

Uariables Format...

Q] creation date K>
[7] current date 

jig creation time 

0  current time 

0  page #
[fS # of pages in document
i footnote/endnote
i *  re-reference footnote/endnote

New.. Renam e.

Example

9. Click OK (Figure 4.12) to accept your choices and leave the Variables 
Format dialog box, or click Cancel to abandon your choices when you leave 
the dialog box.

Variables format is a global command so the format of all footnote numbers 
will assume the format you assign there.

To change the default style of the text of footnotes:

1. Select File/Doc Preferences.

2. Click the Footnote/Endnote style button [ Footnote/Endnote ~) to access the 
Footnote/Endnote style dialog box (see Figure 4.13).

3. Click the check-boxes or the category names to enable the Font, Size, 
Style, Justification, or Line spacing categories. Font, Size, and Justification 
lead to pop-up menus which list the available choices. Style and Line 
spacing lead to dialog boxes for those more complex choices.

4. Make selections, verify the output, and either 1) click Apply to 
implement the changes throughout the document, or 2) click OK to affect 
the next one.
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Set style for footnote/endnote uariable...

S  | Heluetica] 

Size CO
13 Style f select style...

| Justification 1 Centerl

□  Line spacing t spa< ing,„

The footnote/endnote variable appears like this. Justification is 

affected.

—
Cancel

L j i l J

Figure 4.13 Footnote Style

5. Click OK to accept the choices and leave the Variables Format dialog 
box, or click Cancel to abandon your choices when you leave the box.

User Styles
To promote consistency of style throughout a document and to separate 
content and style considerations, MathWriter supports named typeface 
combinations. These user-named styles or "User Styles" appear on the 
Style menu. Definitions of User Styles remain linked to the text to which 
you assigned them such that subsequent changes in the definitions affect 
that complete document. For example, if you decide that figure captions 
should be displayed in 10 point, rather than 12 point Helvetica, simply 
change the definition and all figure captions in the entire document change 
accordingly.

D efine a user style

1. Select Style/User Styles.

2. Click the New Style button.

3. Supply a User Style name that will remind you of its intended use or 
action or otherwise characterize its content.

4. Click on the check-boxes or names of the categories (Font, Size, Style, 
Justification, Line spacing) you wish to define. Unselected categories 
assume the attributes of the text surrounding them.
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5. Use the pop-up menus of the checked attributes to select among the 
allowable alternatives for Font, Size, and Justification.

6. Use the dialog boxes to make Style and Line spacing choices. The 
display box presents a sample of the choices you made.

7. Click OK to accept the choices you made or Cancel to abandon your 
choices.

MathWriter adds this User Style name to the end of the Styles menu. To 
apply a style, select the text and then choose the user-defined style from 
the Style menu.

Edit a user style definition

To change the attributes of an already existing User Style definition, 
follow these steps:

1. Select Style/User Styles.

2. Click on the name of the User Style to be edited.

3. Click on Edit Style to access the dialog box used to define User Styles.

4. Make the desired changes to the name or attributes.

5. Click OK to accept the choices you made or Cancel to abandon your 
choices. If you click OK, MathWriter  applies the definition throughout 
the document.

D elete a user style definition

To delete a User Style:

1. Select Style/User Styles.

2. Click on the name of the User Style to be deleted.

3. Click on Delete Style to remove the selected User Style from the Styles 
menu.

4. Click OK to accept the choices you made or Cancel to abandon your 
choices.

The linkage is deleted and the name removed from the list. The text 
assigned this User Style style retains its assigned typeface even after its 
link to the definition is broken.

Remove a user style assignment

1. Select text.

2. Assign another style attribute.
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To remove a user style assigned to a paragraph, click four times in the 
paragraph to select it, and then assign an attribute, such as a common text 
size. If you must hyphenate a paragraph that has been assigned a user 
style, remove the user style first, and then use the Edit/Hyphenate 
command. If desired, reassign the user style, but verify that any words 
previously excluded from the style run are again excluded.

Typing Tools (Revisited)
Technical word processing typically uses an enlarged character set. 
Without special typing aids, learning to type these extra characters would 
take longer. MathWriter's  typing tools reduce the learning time and 
facilitate font changes. Among these tools are the Palettes menu, 
Diacritics menu, and Font Table, which place visual prompts in front of the 
typist. Two other important typing aids, Windows/Library and Style/Auto 
Math, are discussed separately (see sections later in this chapter).

Palettes menu
The Palettes menu contains rows of special symbols taken largely from the 
Symbol font. To use the Palettes menu:

1. Position the insertion point in the text to specify the destination of the 
character.

2. As you drag the cursor over the symbols in the Palettes menu, the name of 
the symbol appears in the last row. Release the mouse button when the 
desired character is located by the cursor to "type" the character.

The | and || symbols have special stretch properties. To modify these 
characters:

1. Click on Character Editor in the Tools submenu , type 96 shift [, or click 
the arrow tool on the Tools floating window.

2. Select a character previously placed in the text. A "character" can also 
be a built-up mathematical expression that extends to the baseline.

3. Press option and, with the cursor, drag either end of the selected 
character to stretch it. Click at the middle of the symbol to restore its 
original size.
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JL I
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V

stretch

After step 3, the bottom portion of the Tools window, which 
formerly contained the subscript and superscript icons, now contains 
arrows for moving the selected character vertically in one pixel 
increments. The square in the middle is a reset button; you can click 
on the middle of the selected character to restore its original size.

The symbols in the last row, called Variables, have special 
characteristics. These are the numbering and linkage variables 
that automatically supply values. They include: creation date, current 
date, creation time, current time, page number, number of pages in a 
document, footnote/endnote, re-reference footnote/endnote, equation 
number, subequation number, equation reference number, user-category, user- 
subcategory, user category reference number, and file name. The typing and 
formatting of these variables are handled separately. See the section on 
automatic numbering later in this chapter for details.

When variables are placed in a document, they behave as an indivisible 
unit, even when composed of several characters. You can edit the entire unit 
but not its components. You can change its style and cut, paste, and delete it.

Diac menu

Most Macintosh fonts contain characters with accents and other special 
markings required for foreign languages. You can identify the key 
combinations to type them using Apple/Key Caps. The next section 
describesMath Writer's Font Table for mouse access to any character in any 
font, including the characters that already incorporate a diacritic. The 
Diac menu provides additional diacritical marks that you can raise and 
lower as well as symbols for grouping characters together horizontally.

Diacritical marks

The symbols on the first row of the Diac menu and two 
symbols from row two and two from row four are 
available when the insertion point is placed to the 
immediate right of an alphabetic character. To type a 
diacritic: 1

1. Place the insertion point adjacent to a character, on 
its right side.

2. Select a symbol from the first row of the Diac menu.

3. If necessary, use Raise, Lower, or Remove from that menu.

If more than one level of symbols is needed, consider using the center above 
and center below tools on the Tools window in addition to the Diac menu. If 
more than two levels are required, consider using the two-dimensional 
array on the Templates window, row 9, column 9. (Access these by mouse or 
by using 98 9 and then 9.)

n n nn n n n n
■  ■ I - 'I
W. m ■ HR ■ HR ■ hr

■  ■ I - 'I i - 'I
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Horizontal groupings

Font Table

To type a horizontal grouping symbol:

1. Select two or more adjacent characters of text.

2. Click on one of the symbols from rows two, three, or 
four of the Diac menu.

If you press the option key to obtain the Math Editor, 
you can edit inside the text string of the group; the grouping symbol length 
adjusts automatically. Horizontal grouping symbols cannot be raised or 
lowered.

To remove a horizontal grouping symbol:

1. Select the grouped characters.

2. Select Remove from the Diac menu.

Because technical typing uses many special symbols, MathWriter  provides 
a Font Table containing every character in every font available to the 
system.

To "type" a character with the mouse:

1. Position the insertion point within the text.

2. If the floating Font Table window (Figure 4.14) is not visible, select it 
from the Windows menu.

□ Font Table m e ]
Chicago

6 0 @ P \

p R e t oo i  o
! 1 fl Q a q ft e O + i
n 2 B R b r P j <t < ->

♦ # 3 C S c s E i £ > v  i ll
« $ 4 D T d t N T $ ¥
□ % 5 E U e u 0 i • p
□ & 6 F U f u (J n SI d A I I
□ i 7 G UJ q til a 6 f l 1 «  : ; |
□ ( 8 H H h H a b ® TT »
□ ) 9 1 V i q a o © TT • ••

□ * ; J Z i z a o T M
1

□ +
J K I k { a 5 / a H I I

S i
< L \ 1 ±

Oa u 0 R O

Figure 4.14 Font Table



118 Chapter 4

3. If necessary, click on the font name that appears on the Font Table to 
select a font from the pop-up menu.

4. Press (don't just click) on a character to select it.

If desired, you can drag the Font Table window by its title bar to position it 
more conveniently, perhaps even to a second display monitor. If you require 
access to only a portion of the table, use the grow box in the bottom-right 
corner of the floating window to shrink it and use the vertical and 
horizontal scroll bars to adjust the visible portion of the window. The zoom 
box in the top-right corner of the floating window quickly expands the 
table to full size. Use the close-box in the top-left corner of the floating 
window or reselect the Font Table on the Windows menu to hide it.

Library
The Library utility enables you to insert repeatedly used text, graphics, 
and mathematical expressions into your document quickly and 
conveniently. When you type the name of a library entry (usually an 
abbreviation or mnemonic) followed by a space character or double-click on 
the abbreviation or actual entry in the Library window, MathWriter 
immediately substitutes the full entry at the insertion point.

You can invent your own shorthand to increase your typing speed. For exam
ple, you might use your return mailing address and phone number as two 
library entries. You might quickly compose individualized letters by se
lecting paragraphs from a library of stock paragraphs. Different contracts 
often contain identical paragraphs. In writing mathematical documents you 
might create a library of macros to assign equation and figure numbers, giv
ing you keyboard as well as mouse access to these automatic numbering 
variables. Repeatedly used, built-up expressions appear often in mathe
matical derivations; you could select these from a library by mouse.

Several libraries can be open simultaneously so you can segment your 
abbreviations. For example, you might create a library of finite difference 
expressions separate from other libraries and open it in combination with 
other libraries.

Getting to and from a library

To open a library:

1. Select Library Window on the Windows menu. (See Figure 4.15.)

The library window floats above open document windows and remains 
active regardless of which document window is active. Use the title bar to
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drag the window to a convenient location. If you are using two screens you 
can drag the Library window to the second screen. The zoom box in the top- 
right corner toggles the window size between the size you set using the grow 
box in the bottom-right corner and its maximum size. If the window is 
shorter than the list, a vertical scroll bar is enabled.

If no library was opened as a default, startup file the message "No 
Libraries Open" appears just below the title bar of the window.

Startup files are created and selected using Preferences on the File menu.

2. Use the Open command on the Windows/Library submenu to select a 
library file.

For convenience, the names of these files often begin with "LIB." or end 
with ".LIB". Library files have a set of books as an icon. The name of the 
most recently opened library appears in a pop-up menu just below the 
Library window title bar. When you open more than one library file, use 
this pop-up menu to select the specific library to appear in the Library 
window.

Figure 4.15 Library window

Closing a library file and closing the Library window are two distinct 
operations because library entries can remain accessible by keyboard even 
when the library window is not open.

To close a library file:

1. Use the pop-up menu in the library window to bring the file you wish to 
close into view.

2. Select Close on the Windows/Library submenu.
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Creating a library

To close the Library window, click in the close-box of the Library window or 
select Windows/Library Window again to hide the window and remove 
the check mark adjacent to the menu command.

Even if you close the library window, MathWriter replaces the abbrevia
tions that you type with their library expression, unless you disable the 
library by typing 96 option L.

To create a Library file:

1. Optional: If the Library window is not visible, select Windows/Library 
Window. (You can create and name a library file even if the Library 
window is not displayed.)

2. Select New on the Windows/Library submenu to create a new file, acti
vating the File dialog box (See Figure 4.16).

Figure 4.16 File dialog box

3. Supply a file name and destination drive and folder. Optionally append 
"LIB." to the beginning of the file name to easily locate all libraries using 
View/By Name from the Finder. Alternatively, use ".LIB" as a suffix to 
distinguish it from other file types in the open dialog box.

4. Click the Save button to create an empty file or Cancel to abort the 
process.

Now you need to create entries for the file. To create library entries, follow 
these steps:

1. To add entries to a library, the library file must be open, even if not 
displayed. If a library is not open, either open an existing file or create a 
new file as previously described.
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2. Library entries are created from text, mathematics, or graphics placed 
on the Clipboard or from a selection made within a Math Writer document. 
To create an entry, choose one of these options to get to the Macro dialog 
box.

• Place the contents of the library's new entry on the Clipboard using the 
Scrapbook or another application such as a graphics program, and select 
New Entry from the Clipboard on the Windows/Library submenu.

• Create the text or mathematical expression in a Math Writer document,, 
select or highlight it, and choose New Entry from Selection in the 
Windows/Library submenu (or use 96 N).

The macro: /name 

Description:
reminder of contents]

Enter/create sub-structure after pasting

®E OE O0 O0 OH
c Cancel ) H ^ J l

Figure 4.17 Macro dialog box

3. With the macro dialog box (Figure 4.17) open, supply a name for the 
Library entry. The name should be a mnemonic that suggests the content of 
the entry and one that will not ordinarily appear within your document. 
Making the first or last letter of the name a special character, such as slash 
or backslash will assure a distinctive name. Otherwise, a word that uses 
the same ending can be transformed unintentionally. On the other hand, 
carefully chosen names can reduce the number of keystrokes required to 
make a substitution.

4. Optional: Supply a brief description of the entry.

The last entry on the Library submenu, Show Descriptions/Show Macros 
allows you to toggle between the brief word description you entered here 
and the contents of the entry. In the Library window opposite the name of 
the library file name displayed on the pop-up menu is a button that lets you 
toggle between these choices, [5] and [FT].

5. Optional: Check the box and click the button that causes the macro to 
enter or create a substructure after pasting the library entry.
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6. Click OK to accept the entry or Cancel to abandon the entry.

Repeat these steps to create additional library entries.

Remember to check the font, size, and style boxes on the bottom edge of the 
Library window, if appropriate. For example, if you are using characters, 
such as the circled numbers, from Zapf Dingbats, you have to use that font 
(rather than switching to the font of the neighboring character) to get the 
correct results. Taking the font from context produces unexpected results.

Making changes
To delete a library entry:

1. The library window must be open. If not open, use the steps described 
previously to open it.

2. Scroll to the library entry, if necessary, and click (not double-click) to 
select it. This enables the Delete Entry command on the Library submenu.

3. Click Delete Entry to remove the library entry.

4. Optional: Move or close the library window.

If the contents of a library entry must be changed, delete the existing entry 
as described above and create a new entry. To change the name, description, 
or substructure of an entry:

1. The library window must be open. If not open, use the steps described 
previously to open it.

2. Scroll to the library entry, if necessary, and click (not double-click) to 
select it. This enables the Edit command on the Library submenu.

3. Click Edit to access the Macro dialog box described above and modify 
the name, description, or substructure option.

4. Click OK to accept the entry or Cancel to abandon the entry.

5. Optional: Move or close the library window.

Library preferences

To set operational preferences for the Library:

• You can temporarily suspend or enable use of the Library by pressing 
S€ option L or by using the Preferences option on the Library submenu 
command (see Figure 4.18).

• You can change the default for context-sensitive expansion of a macro, 
i.e., have the pasted text assume the font, size, and style of the character 
which immediately precedes the inserted text. You can specify whether 
you must press the shift  key to obtain a context-sensitive replacement. This
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dialog box allows you to reverse the effect of the shift  key on context- 
sensitive expansions.

Library preferences 

L E3 Library enable 

Macro expansion...

O  is context sensitiue if <Shift> pressed
(§) is context sensitiue if <Shift> is not pressed

—
Cancel

Figure 4.18 Library Preferences dialog box

Dynamic variables

You can automatically assign equation numbers to text using the Palettes 
menu or type Si option E. The Library complements this with keyboard 
access.

To assign equation numbers and other dynamic variables:

1. Press on the equation number variable in the Variables row of the 
Palettes menu to place this automatic numbering variable in the document 
at the insertion point.

2. Optional: Set the format and starting value of the equation variable 
using Format/Variables Format.

3. Select the variable (and perhaps the space character after the vari
able), press Si N, and assign an abbreviation.

4. Click OK or press return to accept the entry or Cancel to abandon the 
entry.

Remember to check the font, size, and style boxes on the bottom edge of the 
Library window if appropriate.

When the equation number variable is supplied by the library, Math- 
Writer automatically updates its value based upon its placement in the 
document.

Using the library

To use the library, the library file must be open and the Library enabled. 
Then when you type the name of a library entry (usually an abbreviation or
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mnemonic) followed by a space character, or double-click on the 
abbreviation or the actual entry in the Library window, MathWriter 
immediately makes the substitution at the insertion point. The particular 
steps to follow to use the Library, are:

1. Open a library as described above using the Windows/Library submenu. 
Several libraries can be open simultaneously.

2. Enable the library as previously described using the Preferences 
command on the Library submenu. (Si option L toggles it on and off.)

3. Type the library entry's abbreviation followed by a space, or double
click on the entry, to make the substitution at the insertion point 
immediately.

"Type-ahead" and "mouse-ahead" movements are supported by Math- 
Writer, so you need not pause for the substitution of long entries. Note that 
MathWriter provides this interactive support for "WYSIWYG" display. 
You need not fill your document with abbreviations that are subsequently 
replaced using a find and replace command.

Automatic Numbering
Technical writers extensively cross-reference pages, footnotes, equations, 
figures, tables, theorems, and so on. When editing, updating the numbers 
for these items and the references to them can be daunting.

MathWriter offers a broad automatic numbering capability, one example 
of which is automatic-numbering of footnotes, discussed earlier in this 
chapter. This section concentrates on equation numbering, which plays a 
special role in technical writing because of its importance. An unlimited 
supply of user-defined variables in MathWriter  also provides numbering 
for other entities and will be covered next.

Numbering equations

Various numbering schemes can be used to identify the equations in a 
document. In MathWriter, equation numbers are user-controlled and appear 
before or after the equation. Proximity is the only link between the 
equation and the equation number. Thus you have to cut and paste both the 
equation and its number together. You number the starting equation and 
MathWriter automatically numbers subsequent ones.

Automatic numbering allows you to use equation numbering variables in the 
Library, as discussed in the previous section.
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You also have a number of options for styling and formatting equation 
numbers in MathWriter. In the following example, the equations have been 
created in a paragraph with automatic line spacing, Format/Line Spacing, 
the paragraph is left aligned w—, the equation is centered using a center tab 
♦ , and the equation number is aligned at the right margin 4 .

References in the text to equations [1] and [2] are linked to the actual 
equation numbers such that the references are automatically updated when 
the equation numbers are changed. In this example the equation numbers are 
bracketed, but many other possibilities exist.

1. To format equation numbering, using Format/Variables Format, scroll to 
equation number 2 * , select it, and define the format options. There are 
seven numbering schemes (1, 5.1, 5-1, A, a,I, and i), four bracketing options 
(none, (1), [1], and user-selected characters), a starting number (an Arabic 
number), and text label (such as chapter and section number). The font, size, 
and style of the variable is the same as the text surrounding the equation 
unless you assign different ones using the Variable Style button.

Subequation numbers are handled the same way but you select among six 
numbering styles (a, A, 1, I, i) and three separators (no space, dash, and 
period); for equation reference, the same options as equation numbering are 
available. Note that the format of the equation reference variable need not 
be the same as the equation variable.

The variable format choices you make for your first equation numbers 
apply throughout the document and remain linked such that a redefinition 
is immediately and automatically applied throughout the document.

♦  Establish the paragraph ruler tabs for displayed equations (i.e., 
equations that occupy a separate line). If the ruler for a displayed equation 
is to be different from the text ruler, you can copy the ruler by clicking 
Edit/Copy Other/Copy Ruler. Then, if you want all displayed equations to 
have the same paragraph ruler, click Edit/Paste Other/Paste Ruler to 
place that ruler in your document. If you wish to establish the paragraph 
alignment, etc., you can copy and paste both the Ruler and Format at the 
same time.

To create a displayed equation and equation number:

1. Establish the paragraph formatting, perhaps using Edit/Paste Other 
/Paste Ruler & Format (or 38 shift Z), as just discussed, tab to the center tab, 
and enter the equation.

a x2 + b x + c = 0 [1]

has two roots

2 a
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■y*L

2. Tab to the position for the equation number and select l±_l, the equation
number variable, from the Variables row of the Palettes menu to insert the 
equation number. You can identify the icon easily because as you drag across 
a variable icon its name appears on the last row of the menu. You can also 
use the Palettes floating window or type % option E. Another technique for 
keyboard access was described in the previous section on Libraries (see page 
118).

Apply subequation numbers[2] using the same technique to show a grouping 
relationship such as 5.a, 5.b, 5.c.

Cross-references
To create a cross-reference to an equation:

text references toUsing the MathWriter cross-references command 
equations can be dynamically linked to the automatically numbered 
equation variables such that if the number of the equation cited updates 
automatically, so does the reference to it. There are three ways to provide 
this linkage after you insert the variable.

□
Type an equation number that this reference points to 

or type a relative number:
or '<n' = previous or previous /?th 

■ >', or '>n' = next or next /7th 
or click on an equation number in the document.

Cancel ]  C OK

Figure 4.19 Equation reference dialog

• Supply the current value of the equation number being cited by typing it in 
the dialog box (see Figure 4.19).

• Supply the equation number being cited by typing in the dialog box the 
relative equation number (< means the immediately previous equation, <2 
means the second previous equation, >2 means the second higher equation).

• Scroll to and click on the equation number being cited and MathWriter  
will calculate the linkage.

If you must move a numbered equation, cut and paste both  the equation and 
its number. This maintains the proper linkage and automatically renumbers 
all equation variables affected by the move except when a cross-reference 
variable is linked to it. The linkage of a cross-reference variable is 
maintained if only a cross-reference variable is moved.
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However, if you cut or delete, even temporarily, an equation numbering 
variable that has a linked cross-reference variable, the linkage becomes 
meaningless and a question mark replaces the cross-reference equation 
number to identify the broken link. You must remove the cross-reference or 
manually reestablish the linkage.

MathWriter was created as an authoring tool, not just a transcription or 
desktop publishing tool for completed technical manuscripts. The equation 
numbering variable epitomizes the difference between these two tasks. 
Without MathWriter, an author can incur a heavy penalty for adding or 
deleting numbered equations or figures. Design choices for this version 
emphasize operational simplicity for the author, rather than transcription 
typing speed or the handling of large documents.

User-Defined Variables
In addition to footnotes and equations, various other entities are frequently 
referenced by number in technical manuscripts—figures, tables, paragraphs, 
theorems, corollaries, etc. MathWriter provides an arbitrary supply of 
such variables.

D efining variables

To define user-variables:

1. Select Format/Variables Format. The first user-defined variable can be 
obtained by renaming the triplet of variables (User-category #, sub User- 
category #, User category reference) found at the end of the scrolling 
window in the Variables Format dialog box (Figure 4.20).

2. Scroll to and click on User-category #.

3. Click on Rename.

4. Supply a name, e.g., "Figure," in the Rename dialog box (Figure 4.21) and 
click Rename. This renames the collection of three user-defined variables 
and supplies the name to the Palettes menu icons.

5. Assign the formatting attributes for this family of variables by 
responding to the same dialog box used for the equation number variables 
shown in Figure 4.20.

Your formatting choices in Figure 4.20 (variable style button, brackets, 
numbering scheme, starting number, and label) apply throughout the docu
ment; all subsequent changes in this dialog box will be applied immediate
ly to the entire document.
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Uariables Format...

I-  footnote/endnote
re-reference footnote/endnote 

2# equation #
£  sub-equation # 

equation reference
n* User category

JU sub-User category *

U“ User category reference

O

o

New.

Example

[Category

Rename.

Uariable Style...

® 1 ,2 , 3 OH, B-flfl, BB
Ox.1,x.2 O a, b-aa, bb

O x-1 , x-2 01,11,111
O i, ii, iii

O —  ®  [— 1 O (- 
o  Other [j^ ]—  \ T

Starting Rt 11
Label
Category 1

Cancel [1—!g—1
Figure 4.20 Select the User category

Rename category...

User Category

Cancel Rename

Figure 4.21 Rename the User category

To identify variables in your document, use Format/Show Invisibles. 
Variables (but not portions of variables) can be moved using the usual cut 
and paste techniques.

6. Click OK to accept your choices.

The procedure for creating additional user-defined variables differs only 
slightly.

1. Select Format/Variables Format.

2. Click New on the Variables format dialog box.

3. Supply the name, e.g., "Table" (see Figure 4.22) and click New. This step 
adds a triplet of variables to the scrollable list.
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Neui user category...

Table

Cancel | Neui

Figure 4.22 New user category dialog box

4. Scroll to and select each of the three new variables.

5. Supply the formatting attributes and click OK.

Applying variables

If you have defined only one triplet of variables, you place these variables 
in the document in exactly the same way equation numbers are placed, but 
using the adjacent triplet of icons. If you defined two or more variables, a 
slight alteration is required. For access from the Palettes menu:

1. Select the user-category icon on the Palettes menu. Because space is 
limited on the Palettes menu, when you select the user-category icon, you 
are instructed to "Release the mouse button for a list." The list temporarily 
replaces the Palettes menu (Figure 4.23).

Palettes

Figure 4.23 Select among user-defined categories

2. Click on the appropriate category to insert the variable. 

For access from the Palettes Window:

1. Select Windows/Palettes Window if it is not already in view.

2. Place the Variables row of icons on the Palettes window by dragging to 
the name "Variables" on the Palettes pull-down menu and selecting it.

3. Press on the desired user-defined variable icon type on the Palette 
window and drag to select the desired variable from the pop-up menu 
(Figure 4.24) on this floating window.

Figure
Table n

*
k A g v £

Figure 4.24 Palettes user-category pop-up menu
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If the starting number for a variable is different from the default, such as 
occurs when a document extends beyond a single file, follow these steps to 
reset the starting variable number:

1. Select Format/Variables Format.

2. Scroll to and select the name of the variable.

3. Assign a new value in the Starting At box.

4. Click OK.

Collaborative Writing Tools

Scientific manuscripts usually involve multiple revisions and collabora
tion, among authors and between authors and editors. This communication is 
an important part of the writing process and MathWriter  provides several 
tools to make it more efficient. A document history characterizes the evolu
tion, size, and complexity of the file. Line numbers facilitate the precise 
location of proposed changes on a printed manuscript. Hidden messages 
provide a path for communication without disrupting the manuscript ap
pearance. Because of its importance and relative complexity, revision 
tracking will be discussed in a separate section.

Document history

To track the history of a MathWriter file:

1. Select File/Doc Info. This dialog box (Figure 4.25) provides nonprinting 
space for a history of the document and keywords. MathWriter  automati
cally reports various characteristics of the file—number of sessions, crea
tion date and time, date and time last modified, size on disk—and various 
characterizations of the document such as pages, paragraphs, lines, words, 
memos, etc.

2. Click OK to close the window.
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Abstract/Notes:

Se ssion s: 
Creation date: 

Modification date: 
Size on d isk :

T h is  i s  space fo r  non -prin tin g  m e ssage s and 
keg w ords

10
Sep. 2 , 19 9 0 , 5 :4 0 :2 4  PM  
Dec. 3 , 19 9 0 , 11 :53 :47  AM  
1 3 6 ,5 4 4  bg te s (1 3 3 K )

Page s: 2 2  
Paragraphs: 271  

Lines: 6 1 0  
Words: 5 5 2 2  

M em os: 3

Characters 
on base line : 3 2 ,8 3 9

in sub-expressions: 2 6
containing sub-expressions: 3

Total: 3 2 ,8 6 5

Unique ru le rs : 44  
Unique s ty le s : 3 5  

Style runs: 6 2 6

Figure 4.25 Document info dialog box

Line numbers
MathWriter provides automatic line numbering on the screen as well as on 
printed output. This is especially helpful since some journals require that 
submitted manuscripts provide line numbers for the convenience of the re
viewers. The numbering can be consecutive throughout the document or begin 
anew on each page. Even without continuous numbering throughout a docu
ment, the position of the insertion point is identified continuously in the 
status bar at the bottom of the page. Remember to provide page numbers in 
the headers or footers if you elect the per page line numbering option.

To turn on line numbering in a document:

1. Select File/Doc Preferences.

2. Click on "Line numbers" or the associated check box (Figure 4.26). This 
enables the two alternatives: per page and continuous.

^  Line numbers
O per page
(•) continuous

Figure 4.26 Line number options

3. Click on one of these alternatives.

4. Click OK to leave the dialog box.

To turn off line numbers:

1. Click the selected alternative.
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2. Select File/Doc Preferences.

3. Click OK to leave the dialog box.

Memo notes

MathWriter's electronic equivalent of yellow sticky notes provides a chan
nel of communication among authors without disrupting the page layout.

To place a nonprinting memo in a document:

1. Position the insertion point in a line of text. You can place only one memo 
on a line.

2. Select Format/Insert Memo to open a resizable, dated document window 
(Figure 4.27).

3. Type the note. Wordwrap is supported by the memo feature. If you drag 
the bottom-right comer to resize the window, the text automatically flows 
to accommodate the new boundaries.

4. Click the close-box at the top-left corner of the memo window to hide 
the note.

When you or another author creates a memo, MathWriter places a memo 
iconQ in the left margin of the document opposite the line that contained 
the insertion point when the memo was typed.

To review a memo:

1. If the gray left border of the document window is not visible, toggle 
Format/Show Messages.

2. Double-click on the memo icon D  to open the memo. The memo icon ■  
becomes highlighted when the memo is open.

3. Click the close-box at the top-left comer of the memo window to hide 
the note.
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To copy a memo:

1. If the gray left border of the document window is not visible, toggle 
Format/Show Messages.

2. Click (do not double-click) the note icon in the left margin.

3. Use Edit/Copy Other/Copy Memo or Si shift M to copy only the memo. 
The usual cut and copy commands move a memo if you also move the 
character to which the note is anchored (and possibly additional text). 
MathWriter issues a warning if Cut or delete endangers a memo.

4. Place the insertion point and use Edit/Paste Other/Paste Memo or 
Si shift N to place the memo.

To delete a memo:

1. If the gray, left border of the document window is not visible, toggle 
Format/Show Messages.

2. Click (do not double-click) the note icon in the left margin to select it.

3. Select Edit/Clear Memo or press delete.

Revision Tracking
MathWriter displays the actual additions and deletions you make to the 
text, as well as the customary "redline" mark in the left margin to flag 
changes. When revision tracking is enabled, distinctive, user-selected 
styles identify the additions (e.g., box style) and deletions (e.g., strikeout 
style). This lets you see proposed changes without having to compare every 
keystroke for differences between two versions. Multiple sets of distinctive 
styles let several authors modify a document, each in his or her own choice 
of markers.

An author can easily accept or reject the proposed changes in individual 
selections, paragraphs, or the entire document. If you accept the proposed 
changes, MathWriter removes the text marked for deletion and the 
distinctive style marking of the added text. Conversely, if you reject the 
proposed changes, Math Writer removes the additions and the distinctive 
style marking of the text marked for deletion.

Revision tracking styles

Before using revision tracking, you must accept the default styles or 
establish your own preferences. These preferences are automatically stored 
in your document, and stationery (default) files retain your choices. To 
define revision tracking styles:
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1. Select File/Doc Preferences.

2. Click the Revision styles button to access the revision styles dialog box 
(Figure 4.28).

Reuision: | Reuision 1 | Neui Rename] [Delete]

□  Font

□  Size I j □  Justif ication

K  Style [select style... □  Line spacing [s«le( t sp<>< mg,..

Dolotod text will appear like thio. Tho Font 
and Size aro taken from context.

O Added tent 

(•) Deleted teHt

Cancel

C E D
Figure 4.28 Revision styles dialog box

The revision styles dialog box is a slight extension of the Style 1 and Style 
2 dialog boxes discussed with character formatting under Formatting 
Revisited earlier in this chapter. The changes let you define, rename, and 
delete multiple pairs of revision styles. You define both added and deleted 
text here.

To set style attributes for "Revision 1":

1. Select the "Deleted Text" radio button.

2. Assign the attributes that will identify the deleted text in your 
document. The font, size, style, justification, and line spacing attributes 
were described in the Formatting Revisted section earlier in this chapter. 
To recap, if any of these categories is checked, use the pop-up menu or button 
to specify the options you want; otherwise, added or deleted text will 
assume the attributes of the text surrounding it.

When text is marked for addition or deletion, the attribute choices you 
make here temporarily override the previous attributes of that text. The 
attributes selected should be distinctive and should not conflict with the 
attributes that ordinarily appear in the text. A sample of the style you 
choose appears in the illustration box in the bottom-left corner of the 
window.
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3. Select the "Added Text" option and assign those attributes.

4. Optional: The default name, "Revision 1," (Figure 4.28) can be custom
ized.

5. Click Rename (Figure 4.28), supply a new name in the "Rename revision 
style" dialog box (Figure 4.29), and click Rename. The name in the pop-up 
menu changes accordingly.

1 Rename reuision style

m m

Cancel [( Rename
__l

Figure 4.29 Naming revisions

You can define sets of revision styles allowing several authors to show their 
comments in the same document or a sole author to show multiple versions.

To create multiple revision styles:

1. Click New (see Figure 4.28).

1 New reuision style

|Reuision 2

Cancel Neui
_ ..............

Figure 4.30 Create a new revision style

2. Supply the revision style name in the dialog box (Figure 4.30) and click 
New.

3. Assign attributes, as discussed previously.

The following feature allows you to provide a more meaningful name such 
as date, version number, or even the initials of the person making the 
revisions. To rename a revision style:

1. In the Revisions pop-up menu (Figure 4.28) or in the status bar 
(Figure 4.32), select the style you want to modify (Figure 4.31) .

2. Click Rename.
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Reulsion: ✓ JRC
ETS
NBC

Reuision: | JRC |

Figure 4.31 Named m ultiple revision styles

3. Supply the new revision style name in the dialog box and click OK.

To delete a revision style:

1. In the Revisions pop-up menu (Figure 4.28), select the style you want to 
delete.

2. Click delete.

Using revision tracking

Deleted text does not disappear, but is displayed using the revision style 
you assigned for deletion. Added text is displayed using the style for 
added text. To enable or disable revision tracking:

1. Select a revision style from the Revision style dialog box (Figure 4.31) 
pop-up menu or from the pop-up menu in the typeface box on the status bar 
at the bottom of the document window (Figure 4.32).

2 
2

Figure 4.32 Pop-up revision style selection from status bar

• JRC  

ETS 

NBC

no revisions selected

2. Click the Revision tracking box in the File/Doc Preference window or 
press 36 option R to toggle it on and off.

You can toggle revision tracking off and on as often as you wish using either 
Doc Preferences or 36 option R. The status (active or inactive) is indicated 
by square brackets "[ ]" around the typeface indicator in the status bar at 
the bottom of the document window (Figure 4.33).

Palatino 10 [Palatino 12]

Figure 4.33 Revision tracking indicator

The automatic cleanup operations add and delete precisely the text you 
mark; treat spaces as "real" characters when you mark the text. * 36

To make revisions, or, in other words, to remove text marked for deletion 
and remove style markings on added text, there are two options:

1. First disable revision tracking using either File/Doc Preferences or
36 option R.
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The absence of square brackets "[ ]" around the typeface indicator in the 
status bar at the bottom of the document window indicates that Revision 
tracking is off.

2. If you agree with the proposed changes, apply automatic cleanup to all 
or portions of the document.

• To revise the entire document, click the Cleanup button (Figure 4.?) in 
the File/Document Preferences dialog box.

• To revise a paragraph, select the paragraph by placing the insertion 
point within the paragraph or select the paragraph using the usual 
keyboard or mouse techniques and choose Edit/Revise Paragraph (ST M).

• To revise a contiguous range of text, select the text, and choose 
Edit/Revise Selection ($€ M). Note that the menu name changes according 
to the use of the command.

Automatic cleanup (Revise and UnRevise) applies to complete style runs,
i.e., a string of text having a common typeface. Even if you select only a 
portion of a contiguous string of added or deleted text, the entire run will be 
affected.

•  You can revise the entire document using Cleanup on File/Doc 
Preferences. (See Figure 4.34) Alternatively, you could select the entire 
document with Edit/Select All and use Edit/Revise Selection.

R □  Reuision tracking [cleanup...]

Figure 4.34 Global cleanup

•  More likely, however, you will choose to adapt the proposed changes. 
To remove text marked for addition or remove style markings on text tagged 
for deletion, there are several options.

• To unrevise a contiguous range of text, select the text, and choose Edit- 
/UnRevise Selection. Note that the name changes according to the selec
tion.

• To unrevise a paragraph, select the paragraph by placing the insertion 
point within the paragraph or select the paragraph using the usual 
keyboard or mouse techniques and then choose Edit/UnRevise Paragraph.

• To unrevise the entire document, select the entire document with 
Edit/Select All and use Edit/UnRevise Selection.

The revision style markings have a special status and cannot be accidental
ly removed by simply reassigning the style attributes using the Style menu. 
Of course, you can simply add or delete marked text while revision tracking 
is disabled.
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The following example shows the revisions made to a famous speech and 
illustrates the use of revision tracking. You can practice with an earlier 
draft of this speech (see Chapter 2).

Revision tracking example

lAddress delivered at the dedication of the Cemetery at Gettysburg]

Four score and seven years ago our fathers brought forth, upon this 
continent, a new nation, conceived in Liberty, and dedicated to the 
proposition that all men are created equal.

Now we are engaged in a great civil war| testing whether that nation, 
or any nation,-|so conceived,-|and so dedicated, can long endure. We 
are met hero on a great battle-field of that war. We have come to 
dedicate a portion of i-fe-|that field, las a final resting place for those who 
here gave their lives that that nation might live. It is altogether fitting 
and proper that we should do this.

Butfl in a larger sense|] we can not dedicate — we can not consecrate — 
we can not hallow this ground. The brave men, living and dead, who 
struggled here,-|have consecrated itfl far above our poor power to add or 
detract. The world will little note, nor long remember7 what we say 
here, but [t]can never forget what they did here. It is for usrjthe living, 
rather]] to be dedicated here to the unfinished work which they frvho fought] 
Ihere |have, thus far^so nobly carried onhdvancefj. It is rather for us to be 
here dedicated to the great task remaining before us — that from these 
honored dead we take increased devotion to that cause for which they 
here gave the last full measure of devotion — that we here highly 
resolve that these dead shall have not died in vain£3 that this nation[] 
lunder God] shall have a new birth of freedom^ —land that thie- 
govemment of the people, by the people, for the people, shall not perish 
from the earth.

___________________  lAbraham L in  coir]
[November 19, 1861]

See: Kunhardt, Philip B. 1983. A New Birth of Freedom: Lincoln at 
Gettysburg. Little, Brown and Company, Boston.

•To locate even the smallest revisions in order to make manual changes, 
select Format/Show Messages and a black marker appears in the left 
margin. The Print dialog provides an option for you to print these marginal 
markers with the document. Remember: Show Messages toggles with Hide 
Messages.
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The Edit/Find/Replace feature provides a search capability for systemat
ically locating and unrevising added text, deleted text, or both. To search 
for individual revisions:

1. Disable revision tracking using either 98 option R or File/Doc Prefer
ences. The absence of square brackets "[ ]" around the typeface indicator in 
the status bar at the bottom of the document window indicates that Revi
sion tracking is off.

2. Select Edit/Find/Replace (Figure 4.35).

3. Select Revision on the "Find:" pop-up menu and locate both added and 
deleted text for the current revision. (Use Added Text or Deleted Text to 
find these separately.)

4. Select "UnMark" on the "Replace with:" pop-up menu.

sni

Tent

Style
✓  Reuision 

Added Tent 
Deleted Tent 
Style Change

Tent

Style 
✓  UnMark

Match Affect

Find:
Reuision

Replace with:
UnMark |

Figure 4.35 Find/Replace revision searches

Match
All reuisions

✓  JRC
✓  ETS
✓  NBC

5. Select "All revisions" or a particular revision (Figure 4.35) on the 
"Match" pop-down menu. You can direct the search with the mouse or the 
keyboard.

To use the mouse, click to position the insertion point where the search is to 
begin.

1. Click the Find/Replace button (Figure 4.36) to initiate the search.

2. Click Replace, then Find if you wish to unrevise the located revision and 
continue the search.

3. After completing the search, click the close-box to terminate the search.

To use the keyboard, press return to hide the dialog box and initiate the 
search and press 98 Gand 98 H, the keyboard equivalents for Find Next and 
Replace Selection.
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i n -  = = m  

Match flffec l Wildcards Special Diiecliun i i

Find:

REUISIONReuision

Replace with:

UNREUISE SELECTIONUnMark |

Find §§G [ Replace, then Find ] (Replace 8§H) Replace fill]

Figure 4.36 Unrevising with Find/Replace dialog

Tables
Because simple tables are often required in technical writing, MathWriter  
treats them as a variation on a matrix and provides automatic formatting. 
MathWriter adjusts the spacing of the cells and the borders with every 
keystroke so the layout is always visible. New rows and columns can be 
added or deleted quite easily.

You prescribe the alignment of text in a table cell (left, right, center, or 
decimal), the typeface of the text, the attributes of the bounding lines and 
background, and the minimum amount of space between the contents of cells 
and the borders. Tables (Table 4.2) can contain text, mathematics, and 
graphics.

Table 4.2 Table w ith graphics

Ruler
Icons

Usage

4 paragraph indent

▲ paragraph margins

4 right align

► left align

♦ center align

❖ character align
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Tables are fully editable using the Math Editor. The self-formatting 
templates provide tables that have no boundaries, a single boundary 
enclosing the table, or boundaries for each cell. Individual cells can even 
contain a table. Tables, and sidebars discussed below, provide a side-by- 
side paragraph option. The wordwrap algorithm treats a table as a tall 
character and, therefore, does not split it across page boundaries. In 
addition MathWriter can transform a table into PICT format for pasting 
into other applications.

Create a table

Although you can use tabs to create tables, MathWriter provides a self
formatting template for this purpose. Simply select the template and, 
while you supply the contents of the cells, MathWriter handles the 
formatting. You may use the mouse or the keyboard to create a self
formatting table.

To create the table using the mouse, follow these steps:

1. Select a table template by, first, opening the Windows/Templates 
Window if it is not already accessible.

2. In the Templates Window, drag to the next-to-last template, the matrix
, or to the last, the table [•] , and release the mouse button.

|»|

The last entry on the matrix category i ‘ ‘ i is an array without visible 
borders. The table category includes a table with an overall bounding 
border and one with borders for each cell

3. Optional: Supply the contents of the first cell (row 1, column 1).

4. Press tab to create a new column and press return to create a new row. 
Repeat these steps to create a rectangular table of the desired number of 
rows and columns. When columns and rows exist to the right or below the 
current cell respectively, the tab and return keys simply advance the 
insertion point.

Table 4.3 A 3 x 3 table

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

5. Supply the contents of the cells in any order. To reposition the insertion 
point with the mouse, press option to switch from the Text Editor (I-beam 
cursor) to the Math Editor (split I-beam), and click. Click outside the table 
or click on the I-beam tool to resume text editing.
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To create the table using the keyboard:

1. With the Template window visible, press 36 and a template row number 
followed by the column number of the individual template that you want on 
that row. For example, typing 36 9 followed by 9 selects the template for an 
array without bounding lines. If you pause after typing 36 9, the matrix 
menu pops out with prompting numbers on each choice. Typing 36 0 (for the 
last row) followed by 2 selects the template for a table with bounding lines 
for each cell.

If the Template window is not visible, you must type the commands quickly 
and the prompting column numbers do not appear.

2. Optionally, supply the contents of the first cell (row 1, column 1).

3. Press tab to create a new column, and press return to create a new row. 
Repeat these steps to create the rectangular table of the desired number of 
rows and columns. The tab and return keys simply advance the insertion 
point to the next column and row, respectively.

4. Supply the cell contents in any order to the cell that currently contains 
the insertion point. Place the insertion point within a cell and press the 
option key to switch from the text editor (I-beam cursor) to the math editor 
(split I-beam), and click. Click outside the table or click on the I-beam tool 
to resume text editing. 36 shift cursor key moved the insertion point (left, 
right, up, down) among the cells.

[::] (::){::} |: :| ||: :|| <: :> [: =J M Array without * 1
bounding lines

Figure 4.37 Matrix templates

You can edit the text and mathematics of a table by working directly with 
the cells of the table. To select and edit the contents of a cell:

1. To place the insertion point J  within a cell, press the option key to get X 
and click the split I-beam within the cell. Use 36 shift cursor keys to 
navigate among the cells.

2. To edit mathematical expressions, option click the insertion point 
within the structure. Use the mouse or shift cursor to make a selection. Cut 
and paste is supported.

To add rows and columns:

1. Option click to place the insertion point in a cell adjacent to the position 
of the new row or column, e.g., row 2, column 2.

2. Select Insert and a submenu from the Edit menu or use a keyboard 
equivalent (Figure 4.38) to add a row or column (Figure 4.39).
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Insert

Row Before
Row Rfter seow
Column Before
Column After 9€0 P

Figure 4.38 Insert (Edit) submenu

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

Figure 4.39 Row before and column after, respectively

3. Supply the contents for the new cells. 

To delete rows and columns:

1. Option click to place the insertion point in a cell of the row or column to 
be deleted, e.g., row 2, column 2.

2. Select Delete and a submenu for a row or column (Figure 4.40) from the 
Edit menu or use a keyboard equivalent to obtain Figure 4.41.

Delete
J Row

Column agoK

Figure 4.40 D elete (Edit) submenu

(1,1) (1,2) (1,3)

(2,1) (2,2) (2,3)

(3,1) (3,2) (3,3)

(1,1) (1,3)

(2,1) (2,3)

(3,1) (3,3)

(1,1) (1,2) (1,3)
(3,1) (3,2) (3,3)

Figure 4.41 Row and column deleted

The table template supports a single row of text in a cell, but multiple rows 
can be added if you place a table within a cell. To place multiple rows of 
text in a cell:

1. Create a table.

2. Option click to place the insertion point in a cell.

3. Optional: Select Format/Matrix Format and adjust the row spacing of 
the table within the table by dragging the icon, as discussed below. Note 
that negative values produce an overlap.

4. Select the template for a table without boundary lines ‘ = (3€ 9 and
9 ) .



5. Supply the text. Press return for each new row; wordwrap is not 
supported.

Table format
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Cell alignment The alignment (left, right, center, and decimal alignment) 
of the entries within each cell can be set before or after you create the 
table. To set cell alignment:

1. If the table has already been created, drag to select it; otherwise, skip 
to step 2.

2. Select Format/Matrix Format and click on an alignment icon (Figure 4.42 
and Figure 4.43).

Placement Line type Justification
descend line T 0.1 100.011

below Click here to 1 1.000 10.1 J c e M e r
select

center on line

thickness and 
pattern

■...<a Cell spacing

horizontal spacing = 10 points 

vertical spacing = 5 points

□  ftSign im m

ro . i 1 0 0 .0 1 ]
11.000 10.1 J

r o .i 1 0 0 .0 1 ]
L 1.000 10.1 J

f0'1Li o
100.01 

000  10.1

le ft

r igh t

decim al

Cancel

Figure 4.42 Table (and matrix) format dialog box

Justification

r o.i 
L 1 .000

100.01] 
10.1 J center

[0-1 100.01] le ftL1 .ooo 10.1 J
r o.i 
L1.000

100.01] 
10.1 J r ight

f o  1U  ooo
100.01] 

10.1 J decimal

Figure 4.43 Cell alignm ent

Cell size Cell height automatically adjusts to the size of the largest 
element in that row and the cell width adjusts to the size of the largest 
element in that column. If you change font size or style, the table adjusts 
automatically. To change the relative size of cells you can pad elements 
with space characters.
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Cell spacing The minimum number of pixels of whitespace between rows and 
columns is specified by the user. To adjust cell spacing:

1. If the table has already been created, drag to select it; otherwise, skip 
to step 2.

2. Select Format/Matrix Format (Figure 4.42).

3. Drag the icons to set the minimum number of pixels between any element 
and its borders (Figure 4.44).

4. Click OK to leave the dialog box.

■ C3 Cell spacing

horizontal spacing = 10 points 

vortical spacing = 5 points 

Figure 4.44 Cell spacing icons

Borders and Background You can select the line thickness and pattern for 
the borders and specify a background pattern or gray scale for the entire 
table. Background patterns and gray scale can be set for individual 
elements using Text Style.

To adjust borders and background:

1. If the table has already been created, drag to select it; otherwise skip to 
step 2.

2. Select Format/Matrix Format dialog box (Figure 4.42).

3. Click in the Line type box (Figure 4.45) to line attributes (Figure 4.46).

....Line type...

Click hero to 
select

thickness and 
pattern

Figure 4.45 Line type button

4. Use the pop-up menus to select among the 9 line thicknesses, the 39 line 
patterns, and the 39 background patterns. If you select gray scale, a scroll 
box appears so that you can establish the density of dots.

5. Click OK to leave the dialog box.
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Select thickness and pattern. 
—  Outer border----------------

Thickness
Pattern

-—  inner harder-

Thickness i 
Pattern

...Background pattern

Pattern [

Cancel L-g-J
Figure 4.46 Line type dialog box

Positioning a table
The wordwrap feature treats a table as a single entity and, therefore, does 
not split it across page boundaries. Note that you must not create a table 
that is wider than the column or page! A table is treated as a single 
character in a line. You control its vertical alignment relative to the rest of 
the line and its horizontal alignment. To align a table vertically:

1. If the table has already been created, drag to select it; otherwise skip 
this step.

2. Select Format/Matrix Format.

3. Click on one of the placement icons (Figure 4.47).

...... Placement —
descend

below
line

center on line

Figure 4.47 Automatic placem ent in a line.

4. Click OK to leave the dialog box.

You can manually adjust the vertical position of any character using the 
character editor.
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1. Enable the character editor by doing one of the following:

• Click on the upward-left-pointing arrow in the Tools window.

• Select Character Editor from the Windows/Tools menu.

• Type SS shift [.

2. Click on the table or any character in the table.

3. Now you have two options:

• Drag the table (treated as a single character) vertically up or down with 
the mouse.

• Click on the upward or downward pointing triangles in the lower 
portion of the Tools window. Continued pressing repeats the 
command; the square with an "x" restores the character to its 
baseline position.

4. Select the Text Editor by clicking on the I-beam in the Tools 
window, using the Tools submenu in the Windows menu, or by 
typing & shift apostrophe.

a m

1 +
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Because Math Writer treats a table as a tall, editable character, you can 
use tabs and paragraph alignment with tables. To position a displayed 
table horizontally:

1. Place the insertion point adjacent on the left or right of the table.

2. Click on a paragraph alignment icon.

Tabs are especially useful when you must align a table that is part of a line 
of text. To use tabs with a table:

1. Place the insertion point immediately to the left of the table.

2. Click the left-align icon for the paragraph.

3. Drag a tab (left, center, or right) into the document area and release the 
mouse button when the tab reaches the desired horizontal position. This 
allows you to establish vertical alignment with other objects. When 
released, the tab automatically snaps vertically to the ruler.

4. Press tab to align the table with the tab.

5. If necessary, drag the tab to the left or right on the ruler to adjust the 
position of the table; the table automatically follows the tab.

MathWriter does not protect against an excessively wide table.
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Converting a table to PICT format

A table is an editable, self-formatting structure while within M athW riter.

Deleting a table

Other word processors and page layout programs do not support this data 
structure; so if you must export a table, transform it into a format that is 
supported, namely PICT.

1. Select a table by dragging the mouse over it.

2. Copy it with Edit/Copy Other/Copy As Picture or 96 shift C. This com
mand transforms whatever is selected, including mathematical expressions, 
text, and graphics, into the PICT format and places the transformed copy on 
the Clipboard.

3. Optional: Select Windows/Clipboard to view the contents of the 
Clipboard. The status bar reports the PICT format.

4. Paste the contents of the Clipboard into the Scrapbook or into another 
application.

M athW riter provides a more powerful approach that you will find con
venient if you need to transfer many mathematical structures or graphics 
into a Scrapbook. (See "Data Sharing" later in this chapter.) Refer to the 
discussion of Edit/Save As for the details of automatically transferring 
these into a named scrapbook when saving a file as a TEXT-only file in 
Chapter 6. In fact, this feature is intended to let you retire our expression 
editor, M athW riter™ 1.4, i.e., use MathWriter 2.0 to create and format 
mathematical expressions for transfer to other page layout programs.

To delete a table:

1. Select the table by dragging the mouse over it or moving the insertion 
point to the left or right of the table with the cursor keys and pressing the 
shift key and the right or left cursor key, respectively.

2. Press delete.

Graphics
M athW riter allows you to import, display, position, scale, and crop graph
ics. This section describes how to treat a graphic as a "ta ll"  character 
within a line of text. Refer to the discussion of sidebars later in this chapt
er, if you must place more than one line of text adjacent to a graphic.

Three types of graphics files are supported by this version of Math- 
Writer—bit-mapped images created by a paint program, object-oriented
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graphics created by a drawing program, and Encapsulated PostScript, 
created by such programs as Mathematica™ and Adobe Illustrator™, 
which combines a screen display and separate PostScript commands and 
provides high quality printed output. This feature previously has been 
available only in page layout applications. This line of text contains 
several embedded graphics w— w m-m i -*• i illustrating the simplest case. 
Very early word processors had to isolate a graphic on a separate line.

Placement of a graphic

• Use spaces, tabs, or paragraph alignment to adjust the horizontal 
position of the graphic.

• If necessary, adjust the vertical position of the graphic with the 
character editor.

To place a graphic in a line of text, M athW riter offers two techniques— 
transfer via the Clipboard and direct import from a file. To transfer a 
graphic into a line of text via the clipboard:

1. Place the graphic on the Clipboard by using the application in which 
the graphic originated or by removing it from the universal storage 
structure, the Scrapbook, which is accessible from the Apple meriu.

2. Position the insertion point in your active document to identify the 
intended destination of the graphic.

3. Select Edit/Paste Picture, the current name of that command because the 
Clipboard contains a graphic. The customary V provides the same result.

M athW riter can read three file types (MacPaint, PICT, and EPSF) without 
using the application that generated them. This has several benefits. You 
need not switch applications to transfer the files into the Scrapbook or 
have enough RAM to have both applications simultaneously in memory 
operating under MultiFinder. To transfer a graphic into a line of text 
directly: 1

1. Position the insertion point within your active document to identify the 
intended destination of the graphic.

2. Select Edit/Import Graphics File.

3. Optional: Drag the pop-up menu of file types 
(Figure 4.48) to a specific type to limit the dialog 
list to that type (and folders).

Figure 4.48 Graphics file  types

4. Select a file, changing drives and folders and scrolling as necessary.

✓  All Graphics Types 
MacPaint 
PICT 
EPSF
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5. Click Open or double-click the file name.

Whichever method you use, M athW riter places the file at the insertion 
point. Additional adjustments may be necessary.

When you place a graphic in a line of text, a default baseline posi
tion is used for vertical positioning. However, with M athW riter 
you can drag a graphic (and any text character or built-up mathe
matical expression) an arbitrary distance up or down. To vertically 
position a graphic:

1. After the graphic has been placed, select the Character Editor 
(Figure 4.49).

Figure 4.49 Character Editor

2. Select one of the following options and vertical positioning icons will 
replace the superscript/subscript icons.

• Click on the Character Editor icon (the arrow that points up and left) in 
the Tools window.

• Select Windows/Tools/Character Editor.

• Type shift [.

3. Select the graphic. A bounding frame with small squares at the comers 
appears. E _ _ _ »

d.........m

4. To move the graphic vertically use these methods:

• Place the arrow cursor within the bounding frame and drag the graphic 
up or down. The typeface box in the document status bar reports the vertical 
displacement in pixels. •

• Click on the up or down arrow in the modified Tools window for pixel 
movements. Continue pressing for repeated motion, or click on the square 
between the arrows to restore the original placement.

M odifying a graphic

Suppose you wish to mask a portion of a graphic. Clearly you could return to 
the originating application to remove a portion of the picture, but there is 
an easier way. M athW riter allows you to crop a graphic after it is 
imported:

1. Activate the Character Editor. There are three ways you can do this:

• Select the Character Editor arrow tool in the Tools window.

• Select Character Editor from the Windows/Tools submenu.

□ »
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• Type Si shift [.

Selection of the Character Editor replaces the subscript/superscript tools on 
the Tools window with vertical positioning tools, described next.

2. Click to select the graphic. Small square 
handles appear at the corners of the bounding 
frame. If you press M while the graphic is 
selected, the typeface box in the document 
status bar displays "Crop" (Figure 4.50). Press
ing Si and option reports "Crop, Proportional".

3. Press 3% and drag a handle to mask (crop) the 
lower portion of the graphic.

4. To select the Text Editor again, do one of the 
following:

• Click the I-beam icon on Tools window.

• Select Windows/Tools/Text Editor.

• Type Si shift apostrophe.

M athW riter can scale a graphic using fixed or variable proportionality for 
the width and height.

To resize a graphic:

1. To activate the Character Editor, do one of the following:

• Select the Character Editor arrow tool in the Tools window.

• Select Character Editor from the Windows/Tools submenu.

• Type Si shift [.

Selection of the Character Editor replaces the subscript/superscript tools on 
the Tools window with vertical positioning tools, described above.

2. Click to select the graphic. Small square handles (Figure 4.51) appear at 
the corners of the bounding frame. The typeface box in the document status 
bar displays "Scale." Pressing option changes this to "Scale, Proportional."

O fm ji...
D + p +

0IEi

Figure 4.50 Cropping
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3. Scale the graphic either by mouse or keyboard:

• By mouse: Drag a handle to scale the width and 
height of the graphic using separate proportionali
ty constants. Press option while you drag if you want 
to assure that the width to height ratio is pre
served.

• By keyboard: When the Character Editor is active 
and a graphic is selected, the Edit menu has a new 
command—Scale Picture.

□ m

1 +

X I
X 7

Figure 4.51 Scaling
• Select proportional or nonproportional and supply the scaling percent
age^).

4. Click OK to leave the dialog box.

5. To select the Text Editor again, do one of the following: 

• Select the I-beam icon in the Tools window.

• Select Windows/Tools/Text Editor.

• Type Si shift apostrophe.

To hide graphics for faster scrolling:

You can increase the scrolling speed somewhat for a graphics-laden 
document by suppressing the redrawing of the pictures.

♦  To suppress repeated drawing of the graphics, select Format/Hide 
Pictures.

♦  To restore graphics display, select Format/Show Pictures.

This menu command toggles between Show Pictures and Hide Pictures.

Refer to the section on sidebars for a discussion of picture placement in text 
sidebars and in picture-only sidebars.

Character Manipulation
M athW riter provides you with tools to vertically position text characters, 
as well as graphics and portions of mathematical expressions treated as 
text characters, by mouse and by keyboard. In addition, it allows you to 
stretch certain characters.
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Moving characters

In contrast with the subscript and superscript templates, which 
automatically change a character's vertical position and font size, you can 
manually move any character an arbitrary distance above or below the 
baseline.

To move a character up or down:

1. To enable the Character Editor, do one of the following:

• Click on the Character Editor icon (an arrow pointing up and to 
the left) on the Tools window.

• Select Character Editor from the Tools submenu on the Windows 
menu.

• Type shift [.

2. Click on a character to select it.

1 1

1 +

X. I
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Remember to release the mouse button before the next step.

3. Move the character by mouse or keyboard.

• By mouse: Drag the character vertically to its destination. The number of 
pixels moved is reported in the typeface box of the document status bar.

• By keyboard: Click on the up or down triangles in the Tools window to 
move in pixel increments. Press them continuously to move rapidly.

4. To reset the character to its initial position, click the square between the 
triangles.

Stretching characters

M athW riter provides numerous templates that automatically self-adjust 
in size. Some manual adjustments are possible too.

Vertical bars | and || in the Operators row of the Palettes menu can be 
stretched.

1. Use the mouse to place these symbols in your document.

2. To enable the Character Editor, do one of the following:

• Click on the Character Editor icon (an arrow pointing up and to the left) 
on the Tools window.

• Select Character Editor from the Tools submenu on the Windows menu.

• Type % shift [.
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3. Click on either the I or || character to select it.

4. Press option and the bottom portion of the Tools window reads "Stretch." 
Drag either end of the symbol to change its vertical dimension.

If you do not press option, the character is simply moved without a size 
change.

5. Optional: Option dick in the middle of the character to restore its 
original length.

Rather than always requiring a keystroke to signal the completion of the 
integrand, M athW riter requires a keystroke only when you want to stretch 
the default symbol size.

Suppose you type: r x2
J.v=0 1+sin3 x

dx, but prefer this:

~ K
x 2

J x=0 1+sin3 x
dx.

To stretch the integral:

♦  Select Format/Calc Prev J or I Size, or press 96 D, when the insertion 
point follows the integrand to adjust the size of the integral to match the 
tall integrand.

M athW riter automatically sizes the brackets enclosing the fraction if you 
have selected Auto-bracket sizing in Style/Auto Math Option and enabled 
Style/Auto Math by menu or by using 96 E.

Sidebars: Documents within Documents
M athW riter's sidebars are rectangular 
regions in a document that are isolated 
from the main body of the text. A text 
sidebar has its own rulers, wordwrap, and 
can be fully formatted. Multiple lines of 
text in the main body of text can be 
adjacent to a sidebar. When you resize the 
sidebar, the text in the sidebar and in the 
main body automatically adjusts to the 
change. A text sidebar can contain text, 
mathematical expressions, and graphics 
treated as characters. A picture sidebar 
contains only a single graphic and no text. It, too, can be resized. A 
background picture is a special case that lets you overlay the picture with 
text, creating a "watermark," for example.

This is a text sidebar which
contains equations

y = a x + b x + c [1]
z = sin x [2]
and graphics — the 0  icon 
for tab alignment on “=” 
in a line with text.
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Text sidebars

A text sidebar can be in the left margin, in the body of the paragraph 
adjacent to the left margin, in the body of the paragraph adjacent to the 
right margin, and in the right margin. To create a text sidebar:

1. Optional: If you intend to place the sidebar in the print area of the left 
or right margin, decrease the page (not paragraph) size enough for the 
sidebar by using File/Page Layout.

2. Place the insertion point within the paragraph to which the sidebar 
will be attached.

Sidebars are associated with a paragraph and move if the paragraph 
moves. Math Writer reformats any existing text in the host paragraph and 
makes it flow around the sidebar.

3. Enable the Sidebar in one of three ways:

• Click on the "+" icon in the Tools window.

• Select Sidebar Editor from the Windows/Tools submenu.

• Type Si shift ].

When the Sidebar Editor is enabled (see Figure 4.52), the main 
menu changes to provide an alternate set of tools to manage 
sidebars. For example, only when the Sidebar Editor is enabled can you 
resize a sidebar or clear a sidebar without removing the paragraph to 
which it is attached.

4. Select Edit/New Text Sidebar and a submenu for horizontal position
ing. MathWriter creates a default size sidebar.

Figure 4.52 Sidebar w ith Sidebar Editor and Text Editor

5. With the Sidebar Editor still active, drag a "handle" on a corner of the 
sidebar to resize it or select Edit/Set Size to assign precise dimensions, then 
click OK.

6. Optional: With the Sidebar Editor still active, select Edit/Borders to 
choose which sides of the sidebar will receive borders and to assign the 
number of lines in the border (1 or 2), the line thickness and pattern, and a 
background pattern as described in the discussion of paragraph borders. 7

7. Before you can type inside the sidebar, you must enable the Text Editor.

i i n m

* 1

JL I

*

l ‘ >



256 Chapter 4

To enable the Text Editor do one of the following:

• Click on the I-beam icon in the Tools window.

• Select Text Editor from the Windows/Tools submenu.

• Type 98 shift apostrophe.

As with headers, footers and footnotes, you edit sidebars in the document 
window.

8. Click within the sidebar. M athW riter places the I-beam cursor inside 
the text sidebar and you can begin typing. The Ruler adjusts for the sidebar; 
you enter text just as you would in the main body of the document, except the 
size of the sidebar remains fixed. Overflow text will not be printed. To gain 
access to overflow text, enlarge the sidebar or decrease the size of text.

When you move the cursor from the sidebar into the main body of the 
document, it changes to If the blinking insertion point is in the main 
body and you move the cursor to the sidebar, it changes to F|jP} . This lets you 
know which portion of the document you have entered if the sidebar has no 
visible borders.

Picture sidebars

A picture sidebar is a rec
tangular region isolated 
from the main body of the 
document that contains a 
graphic of one of the three 
types supported—MacPaint,
PICT, and EPSF. Unlike 
background pictures dis
cussed in the next section, a 
picture sidebar is attached 
to a paragraph, rather than 
to a specific page and con
tains exactly one graphic 
and no text. (A text sidebar can contain multiple graphics.) As with text 
sidebars, a picture sidebar must be at one of four places—in the left margin, 
in the right margin, or in the body adjacent to the paragraph.

To create a picture sidebar:

1. Optional: If you intend to place the sidebar in the print area of the left 
or right margin, decrease the page (not paragraph) size enough for the 
sidebar by using File/Page Layout.

2. Place the insertion point in the paragraph that is to be adjacent to the 
sidebar.

Diffusion
Rate
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3. To enable the Sidebar Editor, do one of the following:

• Click on the "+" icon on the Tools window |~+~|.

• Select Sidebar Editor from the Windows/Tools submenu.

• Type SS shift ].

When the Sidebar Editor is enabled the main menu changes to provide an 
alternative set of tools to manage sidebars. For example, only when the 
Sidebar Editor is enabled can you resize a sidebar or clear a sidebar without 
removing the paragraph to which it is attached.

The graphic must be placed on the Clipboard before M athW riter can use it 
to create a picture sidebar.

4. Place the graphic on the Clipboard.

• Transfer the picture from the Scrapbook or another application.

• Use File/Import Graphics File Into Clipboard to transfer the graphic 
from one of the three file types into the Clipboard. This command is only 
available if the Sidebar Editor is enabled.

5. Select Edit/New Picture Sidebar and an icon for horizontal positioning. 
MathWriter creates a default size sidebar that snugly fits the picture.

Figure 4.53 Picture Sidebar selected with Sidebar Editor

6. With the Sidebar Editor still active (Figure 4.53), drag a "handle" on a 
corner of the sidebar to resize it or select Edit/Set Size to assign precise 
dimensions and click OK. Compare with Figure 4.54. 7

7. Optional: With the Sidebar Editor still active, select Edit/Borders to 
choose which sides of the sidebar will receive borders, assign the number of 
lines in the border (1 or 2), the line thickness and pattern, and a background 
pattern as described in an earlier discussion of paragraph borders.
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Figure 4.54 Scaled sidebar with borders

8. To resume working with the text, you must return to the Text Editor. 
Enable the Text Editor in one of three ways:

• Click on the I-beam icon in the Tools window.

• Select Text Editor from the Windows/Tools submenu.

• Type 36 shift apostrophe.

Background pictures

Background pictures permit text to overlay a graphic. In contrast with 
picture sidebars, a background picture is permanently associated with a 
specific page, all pages, all left pages, or all right pages. It does not move 
with the text.

The sizing, borders, background, etc., are handled as described for picture 
sidebars. Placement on the page is independent of the text so you may wish 
to add the background picture last if you want to assure any specific 
correspondence. The gray scale option permits you to subdue the background.

To create a background picture:

1. Enable the Sidebar Editor; do one of the following:

• Click on the "+" icon on the Tools window.

• Select Sidebar Editor from the Windows/Tools submenu.

• Type 36 shift ].

When the Sidebar Editor is enabled the main menu changes to provide an 
alternate set of tools to manage sidebars. For example, only when the 
Sidebar Editor is enabled can you move or remove a background picture.

The graphic must be placed on the Clipboard before M athW riter can use it 
to create a background picture.

2. Place the graphic on the Clipboard. Using one of two methods:

• Transfer the picture from the Scrapbook or another application.

• Use File/Import Graphics File Into Clipboard to transfer the graphic
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from one of the three file types into the Clipboard. This command is only 
available if the Sidebar Editor is enabled.

3. Select Edit/New Background Picture to place the picture on the 
Clipboard at the center of the "current page." The current page is the page 
visible at the top of the active document window, even if the center of that 
page where the picture is placed is not visible on the screen.

4. With the Sidebar Editor still active, you can perform the following:

• Use the mouse to press and drag the picture to a desired location.

• Drag a "handle" on a corner of the outside frame to resize it. To preserve 
the width-to-height ratio, press option while dragging the handle. The 
typeface box on the status bar displays "Scale" or "Scale, Proportional."

• Press 96 or 96 option and drag a handle on a comer of the outside frame to 
mask a portion of it. The typeface box on the status bar displays "Crop" or 
"Crop, Proportional."

The 96 key changes the function and the option key modifies the scope.

• With the picture still selected, use Edit/Scale Picture to prescribe a 
scaling percentage for each dimension or restore the full size.

• With the picture still selected, select Edit/Set Size to assign precise, 
absolute dimensions and click OK.

6. Optional: With the picture still selected, use Edit/Borders to choose 
which sides of the sidebar will receive borders and to assign the number of 
lines in the border (1 or 2), the line thickness and pattern, and a background 
pattern or gray scale as described in the disciAsion of paragraph borders.

7. To resume working with the text, you must return to the Text Editor. To 
enable the Text Editor, do one of the following:

• Click on the I-beam icon in the Tools window.

• Select Text Editor from the Windows/Tools submenu.

• Type 96 shift apostrophe.

Mathematical Expressions
With M athW riter you can create and edit mathematical expressions 
easily. The Greek alphabet, used prominently in technical writing, 
receives special treatment.
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Mathematical expressions are frequently taller than the text, so line 
spacing receives special attention. Built-up expressions are self-formatting 
and can be created by keyboard or by mouse. Various support tasks such as 
automatic sizing of brackets and automatic italicizing of variables are 
optional. The find/replace feature is general enough to support search and 
replace on mathematical expressions.

M athW riter can be used solely as an expression editor if you must use a 
page layout program that does not have this capability. Simply create the 
equations one per line, save the M athW riter file, and save them in a 
Scrapbook by selecting M athW riter's File/Save As and choosing TEXT file 
type on the subsequent window. Alternatively, using M athW riter’s 
File/Copy As Picture you can transform individual expressions into the 
standard PICT format before placing them on the Clipboard for transfer 
into another application.

Greek letters

Since Greek characters are widely used in mathematical expressions, quick 
and convenient access to them is important. M athW riter offers several 
alternatives for accessing them: via keyboard, mouse, or the Library.

Keyboard access

To type Greek characters on the keyboard, press 96 spacebar to toggle from 
the current font to Greek and press 96 spacebar again to toggle back to the 
original font. By mouse, select Style/Greek to toggle between the fonts.

The Greek letters are taken from the Symbol font and generally have a 
mnemonic correspondence with the keyboard characters, such as "a" for 
alpha, "b" for beta, etc. Use the Apple/Key Caps desk accessory to review 
thfe keyboard assignments. The name of the current font appears in the 
typeface box of the document status bar; when Greek is active, Math Writer 
places a check beside Greek on the Style menu.

Mouse access

To select Greek characters using the mouse: 

1. Select Windows/Palettes Window.

□| ex. 7 T 7  S e ^ q 9 x K A ( j L v ^ o n p g T D ( t i x ¥ t o i > tD

T Small giay zone
Figure 4.55 Greek alphabet

2. Drag the Palettes window, if you want to reposition it, by the tiny gray 
bar immediately beneath it (see Figure 4.55).
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Library access

3. Click on Greek letters in the Palettes window to type them at the 
insertion point. As expected, pressing the sh ift key changes the Palette to 
uppercase letters (see Figure 4.56).

rri (T) E) 1 1- Z S# []# [] □« ElLU
A

UJ
B r A E z H

*
© i

ttd
K

*
A M N

* t!3
0 n p z T Y 4> X ¥ Q r ■&

Figure 4.56 Uppercase Greek (and Variables) from Palettes menu

Any combination of rows from the Palettes menu can be placed on the 
Palettes floating window for more convenient access.

Individual letters (as well as paragraphs) of any particular typeface can 
be accessed using the Library. Just assign mnemonics for Greek letters.

1. Select Windows/Library Window to display the library. This step is 
necessary only if mouse access is desired.

2. Use the Library submenu's New command to create and open an empty 
library file or use the submenu Open command to open an existing library 
file, for example Greek.Lib. The library name will appear in the pop-up 
menu at the top of the Library window (see Figure 4.57). Multiple libraries 
can be open and active via keyboard at the same time. Use the pop-up menu 
to select which library will be visible for mouse access.

U L ibrarie r

Greek.Lib | 6 entries [£ ]

\a <X o
\b P

\d s
\e e

y

\z <}
contains [X] font J^size  style information 2 ]

Figure 4.57 Library window

3. Type the specific Greek letter (or expression), set the size and style, and 
select it.

4. Type 96 N or select New Entry From Selection from the Library submenu 
of the Windows menu to open the macro dialog box (Figure 4.58). (In the 
absence of a selection this command is not enabled.)
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ED Enter/create  su b -s t ru c tu re  a fte r  past ing

®\B O H  O H  O H  o l

( Cancel ) | OK |

Figure 4.58 Library macro dialog

5. Assign a name for the macro. The name should be brief (fewer than 10 
characters), easily remembered, unique, and should contain no embedded 
spaces. Whenever the library is active, typing this character string 
followed immediately by a space character causes M athW riter to replace 
the abbreviation with its macro equivalent as you type.

Prefix the abbreviation with a distinctive or rarely used symbol, such as 
"\", to assure uniqueness. Otherwise, when you type words that end with 
an embedded macro name, you will unintentionally trigger a substitution.

To temporarily suspend and re-enable macro substitutions of library entries, 
either type 96 option spacebar for a space, which bypasses the library 
lookup, or type 96 option L (96~ST L), which toggles the Library off and on. 
MathWriter scans the input stream, rather than the edited screen display, 
to identify macro names, so an alternative technique to avoid triggering a 
substitution is to type any extra character within or immediately after the 
macro name and backspace to remove the unneeded character. 6 7 8

6. Optional: Supply a description of the macro. When you activate the 
Windows/Library Window, you can display either the abbreviation and 
the macro or the abbreviation and this description.

7. Click OK to close the dialog box.

8. Repeat the above process for additional entries.

To use the library, you must open a library file, as described above. 
However, the Library Window need not be visible. Refer to the discussion 
of the Library earlier in this chapter for additional details.

Quick typeface changes

M athW riter provides three keyboard controls ( 96 <, 96 >, and 96 \) for 
rapid typeface changes. Alternatively, the same options can be exercised
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using Style 1, Style 2, and Last Style on the Style menu. Refer to the 
discussion in the first section of this chapter.

Quick type size changes

M athW riter provides four keyboard controls command plus, command 
minus, command option plus (38 " V  +), and command option minus (38 "NT - )  
for rapid font size changes. These commands increase (38 +), or decrease (38 
-), the font size to the next size on the Text Sizes menu or by one pixel if you 
simultaneously press the option key (~\Sr). By mouse, you can exercise the 
same options by clicking Larger Size, Smaller Size, Option Larger Size, and 
Option Smaller Size on the Style menu. Command backslash ( 38 \) and 
Style/Last Style revert to the immediately previous typeface. Refer to the 
discussion in the first section of this chapter for more details.

The plus and minus can be typed from the top row of the keyboard, or from 
the numeric keypad.

Auto Math Options

Mathematical typesetting is governed by numerous conventions. To the 
extent feasible MathWriter automatically handles these details for you.

Operators are frequently preceded and followed by a space. Parentheses, 
brackets, and braces should match the size of the enclosed expression. 
Names of variables, but not numerals or names of functions, are italicized. 
The arithmetic operators in the Symbol font are considered by many to be 
more pleasing than their equivalents in other fonts. M athW riter can 
handle these operations automatically.

♦  To enable the Auto Math Options, set the Style/Auto Math Options 
(Figure 4.59) using one of the following methods.

Ruto Math Options...
(Ruailable Only LLIith Ruto Math Turned On)

38-sz 0 0  Ruto-Spacing Rround Operators 
B 0  Ruto-Bracket Sizing 
I ^  Ruto-ltalicize 

36-c G M  Italicize Greek Characters
„  Use Symbol Font For Keyboard 

"N= ^  Generated Operators find Brackets
,---------------------------s

Cancel OK

Figure 4.59 Auto Math Options dialog box
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• Select Style/Auto Math Options to choose a combination of these options 
and click OK.

• Use the keyboard commands to toggle options on or off at any time.

These commands define the set of options that are enabled/disabled by Si E 
or Style/Auto Math. Because using Auto Math slows M athW riter, you 
usually enable the Auto Math command only while forming mathematical 
expressions.

Auto Math Options merely defines the combination features you desire. You 
MUST use the Edit/Auto Math (or S€ E) to actually enable the options!!

Mathematical structures

When Auto Math is enabled, the typeface box on the status bar of the 
document appears in inverse, white on black (Figure 4.60).

Times 12

Figure 4.60 Auto Math enable-indicator

First, let's look at a few general principles. The Templates and Tools 
Windows provide self-formatting templates for key mathematical 
constructs. For convenience, these templates can be selected by mouse and by 
keyboard. M athW riter automatically handles the changes in font size and 
vertical placement using the defaults you will have established in the 
Style/Metrics menu. (A separate section later in this chapter discusses 
Metrics.)

The templates provide the structure and special symbols needed to create 
them. The template positions the insertion point for entry of the first 
expression, which can be arbitrarily complex. After you enter an 
expression, which can include several templates, press enter to position the 
cursor for the next expression. In matrices and tables, press return to advance 
the cursor to the next row and tab to advance to the next column.

Enter and return serve different purposes.

To edit in mathematical expressions you need a split I-beam cursor. When 
you click outside the structure, the traditional text I-beam editor is 
restored; to resume editing in a built-up expression, press option (~'̂ r) and 
click to position the split I-beam cursor anywhere within the expression.

Because mathematical expressions reformat continually as you type them, 
remember to use Format/Line Spacing to assign automatic spacing during 
document creation.
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Superscripts

Fixed spacing must NOT be used while composing mathematical expres
sions because the portion of the text outside the line will be clipped and is 
outside the screen refresh zone.

You can use 96 option Z to refresh the screen any time necessary.

The following examples illustrate the use of the Template and Tools 
windows.

Throughout these examples assume that the Templates Window and Tools 
Windows have been selected on the Windows menu and that Automatic 
Line Spacing has been selected using Format/Line Spacing (or 96 K).

Displayed equations are often created using a left-aligned w— paragraph 
with the equation centered using a center tab ♦  and a right-aligned tab ◄ 
positioned for the equation number near the right border. (Remember to 
center the equations with a center tab; DO NOT center-align the 
paragraph. If you used a centered paragraph, the right-aligned tab would 
not work for equation numbers, making placement uneven.) If this equation 
ruler is not compatible with the ruler for the text, use Copy Other/Copy 
Ruler & Format (command shift A, i.e., 96 OA) with Paste Other/Paste 
Ruler & Format ( 96 O  Z) to establish it quickly when needed.

Now let's look at the box below that contains instructions for you to follow 
to create superscripts. For the sake of convenience we used the Times font 
and disabled Auto Math. Use 96 E to toggle the selected combination of 
options on or off; when they are enabled, the typeface indicator in the 
status bar appears in inverse, white on black. The first row contains the 
actual characters that you type. The second row offers keyboard 
equivalents when possible. The third row, baseline, illustrates when you 
are on the baseline of an equation and when you move up or down. The 
abbreviation "sp" means press the spacebar.

To create equation [1], follow the boxed instructions.
2

y = a x + b x + c  [1]

action y sp = sp a sp X 0 2 r i sp + sp b sp X + sp c
keybd eq. cmd-] enter
baseline Base T Base
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Here are a few more tips. The same four keys used 
with 96 -O’ to obtain the four editors are used with 
96 to obtain the center above, superscript, center 
below, and subscript commands. M athW riter au
tomatically adjusts the position and font size for 
superscript. The T in the status bar indicates that 
the cursor is one level above the baseline. Pressing 
enter removes one level of nesting, in this case 
moving the insertion point from the superscript 
position back to the baseline. The status bar box 
again reports "Base." Two up arrows would in
dicate that the insertion point is in a superscript to a superscript. One up 
arrow followed by a down arrow would indicate that the insertion point is 
in a subscript to a superscript.

Notice that the spacebar was used seven times in creating equation 5; 
M athW riter could have supplied the spaces before and after operators 
automatically using the Auto Math Options (Figure 4.59). Auto Math Op
tions could also automatically italicize the variables, exempting the Ara
bic numerals and a user-supplied list of function names. Use File/Doc Pref
erences to define the italics default. An oblique font in plain style (e.g., 
Timesltalic) can replace the usual italics style, which tends to be exagger
ated on the screen, but not in LaserWriter output. Another touch is the au
tomatic replacement of the operators with the Symbol font equivalents 
taken from the Operators and Brackets rows of the Palettes menu.

Edit an equation
2

Let's change y = a x  + b x + c [2]

4
into y = a x + b x + c [3]

First, remember that editing in a built-up mathematical structure is a 
generalization of editing in ordinary text. The I-beam, text editing cursor 
must be replaced by the split I-beam, math editing cursor to edit characters 
that do not directly touch the normal text baseline.

1. Therefore, select the math editor by doing one of the following:

• Press option if the cursor is an I-beam.

• Click on the split I-beam in the Tools window.

• Select Math Editor from the Tools submenu of the Windows menu.

• Type 96 shift semicolon.

The keys for sub and 
superscripts, 

(obtained with 96 
and [ ]; ') 
correspond in 
position to the 
icons
E 0
0 0  in the Tools.
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The arrangement of the keyboard equivalents for the four editors 
(Character, Sidebar, Math, and Text) corresponds to their arrangement on 
the Tools window.

2. Click at the bottom-right corner of the superscript to position the 
insertion point after "2".

3. Press delete  to remove "2", leaving the insertion point in the superscript 
position.

4. Type "4".

5. Click outside the expression to restore the Text Editor.

Mathematical expressions are fully editable in the context of a document! 
Simply position the split I-beam cursor to add and delete. Drag to select 
expressions within "bounding rectangles," etc. Editing is not limited to 
simple replacements as in this example; you can make arbitrarily complex 
changes. The expression is automatically reformatted with each keystroke. 
If you select and change the font size of an expression containing 
superscripts, for example, M athW riter will scale all font sizes to preserve 
the size relationships established in Style/Metrics.

The insertion point movement handled by mouse in the previous exercise 
can be controlled by keyboard too.

1. Use the four cursor arrow keys to move the I-beam to the immediate 
right of the character with the exponent.

2. Type the superscript command, % ], to place the insertion point to the 
right of the superscript.

3. You could complete the exercise as in the previous example. A different 
method is to type shift left arrow to select the "2" and then type "4".

To save your work, use one of these options:

• File/Save ( 3S S) to use the existing file name, file type, and destination. 
You will be prompted if these have not been previously specified.

• File/Save As... to change the existing file name, file type, or destination. 
These changes apply to the active document and the previously active file 
is closed and left unchanged.

• File/Save A Copy to save a copy with a possibly different name, file 
type, or destination WITHOUT making this new file the active document.

M athW riter keeps the entire active document completely within RAM for 
greater speed; this makes frequent saving to a file a prudent action. Unless 
you change the default, files will be saved every fifteen minutes.
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M a t h W r i t e r  automatically saves a file if you click AutoSave in File/Doc 
Preferences. You can even indicate how often you want the program to save 
your file. The type-ahead buffer saves the keystrokes you type during the 
file saving activity, letting you continue typing. When you are composing 
an original manuscript, we recommend an additional step—keeping a copy 
of the immediately previous file version too—using the automatic backup 
feature, also enabled with File/Doc Preferences. Click the "Warn me before 
saving" option on Doc Preferences to avoid accidentally replacing a good 
file copy with one that might be in the midst of a major revision.

M a t h W r i t e r  supports several file types. The comprehensive M a t h -  
W r i t e r ™  2 . 0  format preserves the document and all the information 
required to re-establish the complete editing environment as you left it 
when the file was saved. Use Save As with the TEXT file type to save the 
text as an ASCII file without character formatting. This command also 
permits you to automatically extract the graphics and mathematical 
expressions and place them in a named scrapbook for transfer to another 
application. TEXT files can be read by many different applications.

When other translators become available, simply place them in the system 
folder or in the folder with M a t h W r i t e r  before startup and they will be 
added to the File Type pop-up menu automatically. A standard file inter
change format filter (Microsoft's RTF standard) has been written for 
M a t h W r i t e r .  This filter allows M a t h W r i t e r  to read files from all major 
Macintosh word processors and to preserve character formatting, headers, 
footers, page numbering, graphics, graphics placement and even translate 
the embedded, non-graphic mathematical expressions of Word 4 documents 
into "WYSIWYG" editable mathematics. Mathematical expressions creat
ed by traditional mathematical expression editors, including M a t h W r i t e r  
1 . 4 ,  are received as uneditable PICTs.

Fractions

We will show you how to create the fraction in equation [4] (from linear 
feedback control theory):

K 2
G ( s )  = —----------------------  [4]

s 2( 1 + 7 ^ ) ( 1 + 7 »

k2
G(s) = ---------------------------  (not italicized) [4a]

s2 (1 + Tf s)(l + Tm s)

Optional: Variables are usually italicized in typeset mathematical 
expressions. To produce [4], rather than [4a], select Auto-italicize using 
Style/Auto Math Options and then enable it, including the combination of 
features just selected, by toggling Auto Math (or 36 E). The typeface box in
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the status bar is displayed with white letters on a black background when 
the selected automatic features are active. To reduce the computational 
load, toggle Auto Math off when not needed.

The automatic italics command uses the typeface to the immediate left of 
the insertion point when enabled to establish the definition of "normal" 
when next disabled.

Figure 4.61 Fractions templates

First, here are some general comments. The Templates window provides 
three constructs for fractions on the pop-out menu (see Figure 4.61). All 
three are self-formatting, including adjustment of the length of the fraction 
bar and centering of the numerator and denominator. The first uses the cur
rent font size as the base, while the second immediately decreases the base 
font size to the next smaller menu size to reduce the display height. The 
third provides a slanted fraction bar.

To use a self-formatting template, such as the fraction: 

• Press on the category icon | T  |, and the menu pops out.

Drag to the first icon and release the mouse button.

The keyboard equivalents for steps 1 and 2 are: Press 96 1 and then 1.

The general numbering scheme is 96 row number and then the column 
number. If you pause after typing 96 row number, the menu of icons pops out 
with tiny column numbers to identify them. Type the keyboard equivalents 
quickly if you do not want this prompting menu to appear. Furthermore, if 
the Templates window is NOT displayed, type quickly or the command 
will be aborted.

Enter the numerator and the denominator, in that order. Press enter to 
advance from the numerator to the denominator or to exit the template. 
Both the numerator and denominator can be built-up expressions of 
arbitrary complexity.

To exit a built-up expression and return immediately to the baseline, press 
return, instead of enter.

To create the numerator "K2", use the instructions box that follows:
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action K E 2

keybd cm d-apostrophe enter
baseline T n T

1. The subscript icon [ 3  is located on the Tools 
window. The keyboard command for a subscript is 
$6 apostrophe. The adjustments of font size and 
vertical placement of the subscript are handled 
automatically. Use Style/Metrics to adjust these 
defaults.

2. Move the insertion point to the denominator. A 
down arrow indicates that the denominator has 
been entered.

action l'4

keybd enter

baseline i

The placement of 
keys! ] ; ' for sub 
and superscripts 
(pressed with S€) 
correspond to the 
positions of
E 0
H E  on the 
Tools window.

3. Complete the denominator.

action s 0 2 I'T sp ( ) I 'T

keybd 38 ] enter etc. enter

baseline 1 IT 1 1 Base

Parentheses, brackets, and braces

Automatic-sizing of parentheses, brackets, and braces is handled by the 
Auto Math feature, which you normally enable only while you are creating 
an equation. First, you select the options in Style/Auto Math Options 
(Figure 4.59). Then you enable them by selecting Style/Auto Math.

To create the parentheses in [5]:

C p  —  C y  —  — T ' d v '
[5]

1. With the mouse, select Style/Auto Math Options and check all options 
in the set to be enabled together. From the keyboard you can also use 
command option let ter to add/remove each option, even when the dialog 
(Figure 4.62) is not visible.
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Ruto Math Options...
(Auailable Only With Ruto Math Turned On)

§g-c 0 E3 Ruto-Spacing Around Operators 
Sg-vs B S  Ruto-Bracket Sizing 

I [X] fluto-ltalicize 

3g-c G E3 Italicize Greek Characters

_ „  Use Symbol Font For Keyboard
^  Generated Operators find Brackets

Cancel OKk . 1

Figure 4.62 Auto Math Options

2. Enable Auto Math by clicking Style/Auto Math with the mouse or typ
ing E from the keyboard. In general, toggle this feature on when creat
ing each displayed equation and toggle it off when you finish. The typeface 
indicator in the document status bar at the bottom of the document window 
uses white letters on black background while this option is activated.

3. Click Windows/Palettes Window to place the floating Palettes Wind
ow on the screen. Then click the Math/Calculus row in the Palettes menu to 
place it in the Palettes window.

A portion of this equation, Cp -  Cv = -  T, is created using the techniques of 
the previous example so only the extensions are discussed here. Follow the 
directions shown in the box below.

[6]

M athW riter automatically stretches the standard parenthesis, brace, or 
bracket to match the size of the expression. Enter the numerator and then 
the denominator. Obtain the partial derivative symbol from the 
Math/Calculus row of the Palettes menu. Frequently used palette symbols 
can be copied to the floating Palettes Window or included in an active 
Library for rapid access.

Practice

Test your skills with the following practice problems. We assume you will 
go through these sequentially, so we will not repeatedly instruct you on 
techniques already discussed. First, practice with subscripts in an
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expression that relates stomatal pore width to the pressure in the guard 
and surrounding cells.1

W = ba + bg Pg + bs Ps when W > 0 [7]

We used a center tab to position the equation, a left tab for the condition, 
and a right tab to align the equation number. We supplied the equation 
number by pressing command option E ( £).

The following example,1 2 illustrates that superscripts can be built-up 
expressions. If you create a more complex superscript, pressing enter 
eventually brings the insertion point back to the base level. With the 
mouse, select rho from the Greek alphabet on the floating Palettes 
window; or type d$ spacebar to toggle to the Symbol font which includes 
the Greek alphabet as indicated in the typeface box in the status bar. Type 
"x" for rho, and type 96 spacebar to return to the previous font.

This example also illustrates that a variable can have both a superscript 
and a subscript; they can be entered in either order.

G2 = / 2 m2li P2/3 CR [8]

In the next example,3 Auto Math supplies the spaces around the operators 
and substitutes the keyboard version with the Symbol font equivalents.

R = Rb + Rs = (a/D) {T + [ /32 In (4 / a) + Lp/521 a -  p\ 1 [9]
The next example4 illustrates the use of subequation numbers and special 
alignment. You establish the style of subequation numbers by selecting 
Format/Variables Format, clicking subequation # in the subsequent 
window, and clicking the buttons beside the style you want.

• To create equation numbers 10a through lOf, click on the subequation 
number icon [Tj on the Variables row of the Palettes menu to insert a 
subequation number in your text at the blinking insertion point. The 
variables row can also be placed on the Palettes floating window version of 
the Palettes menu for convenient access or accessed by keyboard from the 
library.

1 Cooke, J. R. et al. 1976. A finite element analysis of guard cell deformations. ASAE Transactions 19(6): 1107-1121.
2 Cooke, J. R. 1972. An interpretation of the resonant behavior of intact fruits and vegetables. ASAE Transactions 
15(6): 1075-1080.
3 Cooke, J. R. and R. H. Rand. 1980. Diffusion resistance models. Ch 5 in Predicting Photosynthesis for Ecosystem 
Models. J. D. Hesketh and J. W. Jones (ed). CRC Press 1:93-121.
4 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143:195-209.
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2 2 2 2 (a,+ a2co) -  (a3 co -  a4) (a5 ft) -  a6) = 0 [ 10]

where a l =K  [10a]

a2 = M R L  [10b]

a3 = [(n/3) + M]L2 [10c]

a4 = S + K[(p/2 + M]g L [lOd]

a5 = (7 / 5) M R2 [lOe]

a6 = M g R + K [lOf]

Ordinarily, you align equations and the steps in a derivation on the equals 
sign. MathWriter  facilitates this with a generalized decimal tab that 
allows any character to be used for alignment. After placing a user-defined 
tab on the ruler, you change its alignment character by double-clicking on 
the user-defined tab 0  to access the dialog (Figure 4.63).

The "=" on the keyboard and the "=" on the Palettes menu are different 
characters so consistently use the same one, including when using the Auto 
Math Replacement option.

Tab type Tab leaders

► O Left ®  None
♦ O Center O solid
i O Right O Gray
o (a) Rlign on: O Other

O keyboard symbol
(§) palette symbol

Se lect sym bo l from  Pa le tte s menu

—
Cancel

Figure 4.63 Tab dialog box

♦  To align an expression on the equals sign:

1. Position a character alignment tab 0  on the ruler at the intended 
horizontal position of the equals sign by dragging. The decimal is the 
default character.
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2. Double-click on the tab to access a dialog box.

3. Assign the equals sign from the palette.

4. Click OK.

5. Tab to this user-selected character tab and enter the equation. The 
equals sign plays the role of a decimal tab, i.e., the expression centers on 
the "=" character and expands to the left and right as the expression is 
created.

From the tab dialog (Figure 4.63) you can also switch tab types and 
assign tab leaders.

The volume of an apple [11] can be modeled over the entire growing season 
using bispherical coordinates.5 Geometrically, this means rotating a sphere 
about a chord.

Astonishingly, the width to height ratio changes such that both surface 
area and volume increase linearly with time.6

V= [2 7t / 3] [a / sin 0]3 [3 sin 6+  3 (it -  6) cos G - sin3 0] [11]

where Sis found from [11a].
t

\ ( 1  + C O S  G ) , 1 <  W I H  < 2
W / H  = \ [11a]

[ (1 + cos 0) / sin 0 , 0 < W / H < 1

Equation [11a] illustrates the use of a vertical grouping bracket to 
distinguish between the conditions for a dimpled apple shape and a 
spindle-like lemon shape, including a sphere. This self-formatting 
structure is a matrix without the enclosing bracket on the right. Notice the 
cross-reference to the equation in this paragraph; if MathWriter renumbers 
equation [11] as a result of the addition or deletion of equations during the 
writing process, it also automatically updates this cross-reference.

To create equation [11a]:

1. Select the template from the Templates window by dragging to row 8 
and then to icon 1 or by pressing 9$ 8 and 1 in quick succession.

2. Create row 1, column 1.

3. Press tab to create a new column and return to create a new row.

5 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143:195-209.
6 Cooke, J. R. 1970. Mathematical determination of surface area and volume for developing apple, lemon, and 
peach fruits. ASAE Paper No. 70-388. 36 pages.
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4. Supply each cell as required. The enclosing bracket expands as necessary.

5. Optional: Use Format/Matrix Format to adjust the cell spacing, align
ment within cells, line characteristics, and background characteristics.

The next example7 illustrates a parametric representation of a doubly 
elliptical toroidal shell used to perform a stress analysis of a stomate, 
which is the valve that regulates gas exchange in plants. You can type the 
Greek letters using 96 spacebar to toggle between the Symbol and the current 
font. The alignment on "=" was done with the user-selected alignment
character.

x = cos 8 {B + A ■ B [1 + sin 0] [(A cos 8)2 + (B sin 0)") [12]

y = sin 6 (A + B ■ C [1 + sin 0] [(4 cos 8)2 + (B sin 8) 2] -  ^ 2̂ } [13]

z = cos 0 [14]

where 0 < 0< n / 2, -  ji / 2 < 0 < 7t / 2 [15]

The equations of motion8 for the free vibration behavior of a three degree of 
freedom double pendulum model for the detachment of fruits make use of 
diacritical marks.

[(p/3 ) + M]L2 8+M LR  0 + S 8+ K(8-0) + [(p/2) + M] g L 8= 0 [16]

(1/5) M R2 <j>+ M L R 8+K(<p-8) + M gR  </> = 0 [17]

' (2/5) M R2ij/+ C y/= 0 [18]

♦  To use the diacritical marks:

1. With the insertion point to the immediate right of a character, select 
the double dot symbol for time derivative on the Diac menu.

2. Adjust the vertical position of the diacritical mark with the Raise (96 
R) or Lower (96 L) command. If you need to adjust the vertical position on 
repeatedly used variables, consider placing the composite character in a 
library.

The second derivative in Matheiu's equation [19] uses the fraction and 
superscript templates.

7 Cooke, J. R. et al. 1976. A finite element analysis of guard cell deformations. ASAE Transactions 19(6): 1107-1121.
8 Cooke, J. R. and R. H. Rand. 1969. Vibratory fruit harvesting: A linear theory of fruit-stem dynamics. Journal of 
Agric. Engineering Research 143: 195-209.
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d\

dtA
+ [D0 -  D\ a Q 2 cos £2t] y = 0 [19]

Equation [20] gives the radial component of velocity of a spherical seed9 

rolling along the non-radial vane of a rotating disk.

H [ ? * ' V P 0 - S ) ]
-,1 1/2

[20]

This example uses a diacritical, as discussed above, the fraction template 
for reduced font size, and self-formatting stretch brackets, braces, an 
exponent for a stretched brace, as discussed next. Remember that you choose 
the combination of formatting features using Style/Auto Math Options and 
then enable / disable all in the selected set using Style/Auto Math (or 9$ E)

♦  To enable self-sizing brackets and braces:

1. Select Auto-bracket sizing in Style/Auto Math Options.

2. Click Style/Auto Math or type 9i E to enable Auto Math.

3. Toggle this feature off (M E) when the equation has been entered.

♦  To use the reduced font size fraction template:

1. Click the second fraction template or type 9$ 1 and 2.

2. Supply the numerator.

3. Press enter to move to the denominator.

4. Supply the denominator.

5. Press enter to leave the denominator.

To achieve the effect of a magnifying glass, select text and choose a larger 
font size; the font size relationships are preserved. Edit the expression, 
select the same text again, and restore the original font size.

♦  To use a superscript with a stretched brace, the normal superscript 
procedures apply.

The following equation10 using Hankel wave functions illustrates most of 
the features used in the previous examples—alignment of multiple equa
tions, self-formatting brackets and braces, subscripts and superscripts on the 
same variable, Greek letters, equation numbering, etc.

9 Cooke, J. R and J. W. Dickens. 1971. A centrifugal gun for impaction testing of seeds. ASAE Transactions 14(1): 
147-155.
10 Scott, N. R. et al. 1982. Analysis of earth-air heat exchange. Lawrence Berkeley Laboratory Report. 72 pages.
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«(Z.0 = Tav + B exp[i (cot -  fz)] 

v(r,z,r) = Tav +A  W0(1V )  exp [(' (ft* -  £z)] 

where p  = a\j~(<p ja j

X=Va /co

7= (ma'ca'(Oa) / k s

NBi = (h a  /ks)

o  ,3/2

S=A[//O(1)03) -  — ///')(/?)]
Nr;

Ay^ o (1)(^ p i
- 3/2

V̂si

-1

[21]

[22]

[23]

[24]

[25]

[26]

[27]

[28]

The next example is taken from a paper11 that demonstrates the conditions 
that allow stomatal pore width (which regulates gas exchange between a 
plant and its environment) to undergo rhythmic opening and closing when a 
plant is subjected to a completely nonvarying environment.

+ G^ ( %  +

k2 (k] + k2) c,2 6 ( 1  +/t3)2

(1 + k 3f c\

[29]

[30]

The pressure in stomatal guard cells and the surrounding cells can be 
described by a system of second order, nonlinear ordinary differential 
equations.11 12

[b5 b6

2 Vg
where |, =  - ---- —  [31a]

L e gA2

11 Rand, R. H. et al. 1981. Hopf bifurcation in a stomatal oscillator. Journal of Mathematical Biology 12: 1-11.
12 Delwiche, M. J. and J. R. Cooke. 1977. An analytical model of the hydraulic aspects of stomatal dynamics. 
Journal of theoretical biology 69:113-141.
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h l = - [ l + ( 7 t ° / Ep ] [31b]

b2 = [l + (n°g/Es)] [31c]

h  (0  = [3 Id]

b4 = (71° -  71°) Pie]

h5 = £  V [1 + (7 t° /ep] [3 If]

h6 = -  (e V + 2eAV) [ 1 + (ti° / es)] [3 lg]

f%(0 = - e V h g [3 lh]

b9 = eV (7t°  -  7t°) + 2e4V(t|/r + 7t°) [31 i]

-  2 eAVRp
8l=  „ (cm CJ

Rt
[3 lj]

M athW riter easily handles the matrix form of this system of equations. 
Use the matrix templates ( 88 9 and 1; 88 9 and 3) to form the vectors and 
matrices. Use Format/Matrix Format to adjust the placement, line type, 
justification within element cells, cell spacing, and row alignment within
matrix equations. Tab creates new columns and return creates new rows. To 
edit within a matrix, use the Math Editor (Tools submenu of Windows) to 
position the insertion point. The cursor keys used with 88 "l> moves the 
cursor among the elements of a matrix. Use the Diac menu to apply and 
adjust the diacritical marks. Use the user-selected character alignment tab 
to align the equations on consistently use "=" from either the keyboard 
or from the Palettes menu since its placement within the Symbol font 
differs from the placement in most other fonts.

A study13 of parametric excitation of nonlinear normal mode behavior of a 
fruit-stem model for vibratory fruit harvesting reveals a strong dependence 
of resonance upon amplitude of oscillation when you want to harvest 
cherries without stems attached. Equation [32] is a matrix equation where v 
is the horizontal component of the forcing function and Tj is the vertical 
component of acceleration of the stem.

A x + B x = v [32]

where

13 Rand, R. H. and J. R. Cooke. 1970. Vibratory fruit harvesting: A non-linear theory of fruit-stem dynamics. Journal 
of Agric. Engineering Research. 15(4): 347-363.
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x  =
0

<t>
[32a]

(p/3 + M ) L 2 MLR 

MLR 7/5 M R 2

S + K + (ML/2  + ML) (g + ri) -  K

- K  K + MR(g + T))

-  (ML/2 + M L) i  '

-  M R ^

[32b]

[32c]

[32d]

Bold Greek letters, such as v, display correctly on the screen and on 
ImageWriter output, but unless you use the Symbol font supplied with 
MathWriter the boldface style will not print in boldface on a LaserWriter.

The water status in plants is often studied using a pressure chamber14 to 
force sap from the stem of an excised leaf. The results can be expressed in 
series form in equations [38] -  [40]. Two summation templates in MathWriter 
provide for displayed (9€ 4 and 1) and inline (M 4 and 2) series. These can 
also be selected from the pop-out Templates window. The insertion point 
moves immediately, when the symbol is placed, to the lower limit; when 
you finish, press enter to move to the upper limit. M athW riter 
automatically positions both limits horizontally and reduces the font size. 
Use the split I-beam, Math Editor to edit within these limits.

<Kr,t) = TW+ ---- ------ (r0) 2_
n = 1

(-!) - V  . „ , , ,------e sm [(nn/ r0) r\

Vr ( X , t )  =  - y  + 1
m =  1,3,5...

4fll----- exp ( \ i  t )  sin (A, x)
m n

P ( x , t )  =
-16 <3| A|/2 “ P(gmO . ,, ,— 3—  sin (km x)

■ 1,3,5...

[33]

[34]

[35]

14 Stroshine, R. L. et al. 1985. Analysis of resistance to water flow through wheat and tall fescue leaves during 
pressure chamber efflux experiments. Plant, Cell and Environment 8: 7-18.
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The electrostatic charge on an elliptical disk conductor is analogous to the 
diffusion from an isolated elliptical surface.15 The result [36] is expressed 
using the integral and square root templates in the elliptic integral [37].

Q =
2 n D C0 a

m
[36]

where K(e) =
rn ll

- 0=0 ^

dp
2 2-  £ sin 0

[37]

and £2 [38]

♦  To create the integral symbol with automatic spacing around the 
operators perform the steps in the table (which are summarized in the 
numbered steps 1- 4):

j.Jt/2

<f) = 0

88 5 1 <t> -
enter n sp / sp 2 enter

1. Type 8$ 5 and 1 to select the integral that has the insertion point in the 
lower limit of integration. The limits can be built-up expressions of 
arbitrary complexity.

2. Supply the lower limit and press enter.

3. Supply the upper limit of integration and press enter.

4. If necessary, option click in either limit to edit.

5. Create the integrand using the keystrokes in the following table.

dtp

\](1 - e 1 2 3 4 5) sin2 <p

9€! / / d 4> enter 88 2 1 ( 1 -  e 88 ] 2 enter ) sp s i n 88 ] 2 enter ([> enter enter

6 . After completing the integrand, press 88 D to resize the integral sign. 
Only if the integrand is tall must you adjust the integral size. If you prefer, 
you can manually stretch the integral symbol.

15 Cooke, J. R. 1966. Some theoretical considerations in stomatal diffusion: A field theory approach. Acta 
Biotheoretica 173: 95-124.
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♦  To manually stretch an integral:

1. Enable the Character Editor.

2. Click on the vertical shaft of the 
integral symbol above the midpoint.

3. Press option to enable the stretch
ing capability (see Tools window).

4. Drag upward to stretch the rec
tangular frame around the integral 
and its limits to obtain the desired 
height.

r !2 d<t>

4> = 0 Y ( 1 + e2 sin2

N d*
! H  \J(1 + s2 sin2 $

□ i m

1 +

X I

V ( 1+ S2 31jcl2 $

|X|

stretch

Figure 4.64 Integral stretching

5. Optional: To restore the default height of the symbol, option click on 
the vertical shaft of the integral symbol at the midpoint.

6 . Enable the Text Editor again.

The above procedure also applies to the stretching of | and || characters 
obtained from the Palettes menu.

This component of the classical Navier-Stokes equation [39] includes most 
of the structures of the previous examples. Notice that Times and Symbol 
fonts are the workhorses for these equations.

dv, dv,. ve dvr dv,.r 't) 'J , r '9
+ V_----- 1-------------------h v . ----

dt dr r d6 r dv,.
dp
dr

+

d_
dt

d2vr

ae2

1 Y0
2 de

d \

dzi
■ pa- r n

In order to analyze the transmission of energy through a tree subject to a 
sinusoidal oscillation, a finite element model of an assemblage of branched 
tapered columns was studied.16 To adjust the integral in [40] we used Auto 
Math Options and the Calc Prev J or | Size (Format) or (36 D) with the 
insertion point immediately following the integrand.

16 Upadhyaya, S. K. et al. Limb impact harvesting, Part I: Finite elem ent analysis. Transactions ASAE 24(4): 856-863.
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Before we adjusted the integral size and matrix row alignment:

4 . i f 1- 
2 4 ,-i

Ifi «,-]

After adjustments:

fl-t (

Uc =
l

Ifi »«,•]

y 2 1 y
E l K XG A E I

y 1

E l E l

y 2 +  1 y
E l ' K fiA E l

y 1

E l E l

I *
in

dy

dy

[40]

[41]

♦  To calculate and adjust the size of the integral symbol automatically:

1. Place the insertion point after the integrand.

2. Press 9$ D (or use the Edit menu), and M athW riter sizes the integral 
sign.

♦  To align the rows of the matrices in an equation:

1. Select the matrices.

2. Select Format/Matrix Format.

3. Check the Align rows box.

4. Click OK.

The remaining examples illustrate some typical calculus problems.

v oui = vv *in [42]

1 + x

y = l - x
[43]

d . . . vdu/dx -  udv/dx 
d x ^  = [44]

, , „ v du/dx -  u dv/dx
(m/v) = [45]

V

= 2 [46]
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oo

—— z e 7 T T  (l + - )«
r (z) 11 Lv n)n = 1

z/n
Z  <  o o

>/r(z)= z exp (yz) X,r= i [(1 + z/n) exp (-z/n)], | z | < oo

Y " 2 * 1 1

S (1/" )=^ +^  +
n = 1 l2 22 32

w - f i )  X  *
H 2/4)k

! r(v+ k-+ i)

x dx= —

J

|
J x = 0

j  u dv = 

(a x + b)n dx =

K -= 0

2 22 O2

0 2 2

UV ~ J v du

( a x  +  b f
+ 1

a ( n + 1)

f ft(c) j-"'1' 0 db
f(x,c) dx = — f ( x , c ) d x + f ( b , c ) - j-----f(a,c)

J d c )  Me)' oc dc

rm  a

y = lim |l + ^ + -j + -j + --- -In m

Use 7 and 1 to create the limit (not [T] ).

dx

[(a+bx)(c+dx)] 1/2

i~bd)

- 1

1/2
arctan

-,1/2

(~bd)

2

1/2

-d  (a+bx) 
b{c+dx)

 ̂2bdx+ad+bc  ̂
b e -a d

b d <  0

ft >0, rf < 0

(M )
1/2

In | [ftd (a+ftx) 1/2 + b(c+dx)l/2 1, bd >  0

The self-sizing bracket (5£ 5 and 2) is a matrix with 3 rows and 1 

without a closing brace.

[47]

[48]

[49]

[50]

[51]

[52]

[53]

[54]

[55]

[56]

column
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Adjusting the template metrics

MathWriter's Metrics menu lets you adjust:

• The vertical position of (a) subscripts, (b) superscripts, (c) centered above 
expressions, and (d) centered below expressions.

• The font size correspondence between the base character and subscripts 
and superscripts.

• The default size for summation symbols for inline and displayed 
equations.

Superscript and subscript sizes

To set superscript and subscript size reductions, you must supply a table of 
font size correspondences, x2 x2 are examples of 10 point Times characters 
with 8 and 10 point superscripts. The program applies these size reductions 
to future entries. Automatic size changes occur for the first two levels of 
superscripts only.

If you select an expression that has multiple levels of superscripts and 
change the size of the base character using Style/Text Sizes or by keyboard 
command, MathWriter uses this table to adjust the sizes of all the depend
ent levels automatically. However, you can select individual expressions 
and manually override these defaults. When using a small font size, you 
can use this "smart" scaling feature to magnify the screen image 
temporarily.

The Metrics dialog box (Figure 4.65) contains a lookup table (Table 4.4) for 
all sizes from 1 through 64. To adjust the steps in the automatic size 
reductions, redefine this table.

Table 4.4 Selected default subscript/superscript size reductions

selected 
base sizes

super/sub
size

9 7

10 8

12 9

14 1 1

18 14

24 18
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To redefine the superscript/subscript size change in the lookup table, do the 
following:

1. In the Metrics dialog window scroll the "Superscript/Subscript size 
reduction" scroll bar to the size font you want for the base character. 2 3

2. In the "changes to" box type the corresponding size that you want for a 
superscript/ subscript.

3. Repeat this for all base sizes (1-64).

M athW riter applies these correspondences to all newly created expres
sions.

Summation symbol sizes

To assign default sizes for the summation symbol in the box beside "display 
X:" type the point size for the summation symbol in a displayed expression 
(e.g., 24) and in the box beside "text X." type the point size for a summation 
symbol in a line of text (e.g., 14) for 12 point text. These sizes are scaled 
proportionally for different text sizes.
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Vertical position of superscripts and subscripts

Note that this feature operates separately from the Character Editor, 
which allows you to move manually any character an arbitrary vertical 
distance without font size change.

You can adjust the vertical displacement for the four
T A

positioning4-
the window called

"superscript/subscript placement." Across the top of the table of forty cells 
are the templates, including one category called "other." Down the left 
side are the four arrows. To accommodate personal preferences and variety 
of fonts, you can set the vertical position in the number of pixels above or 
below the ascent, descent, or baseline. The baseline is the imaginary line on 
which a line of text rests. The descent is the imaginary line to which 
characters, such as g, j, p, q, y, and z, extend below the baseline. The ascent 
is the imaginary line to which stems of characters, such as b, d, f, h, k, 1, t, 
extend above the baseline.

To adjust superscripts and subscripts vertically:

1. Click on one of the forty cells in the table whose rows and columns 
identify a specific combination of templates and arrows.

2. Click ascent, descent, or baseline in the box below the cells to establish a 
reference from which the vertical position is to be measured.

3. Click to choose the direction of the change (+ above, -  below).

4. Use the scroll bar below the cells to set the magnitude of the change in 
pixels.

When you click another cell, the values you have entered will be 
displayed, e.g., b+5 means five pixels up from the baseline for that 
combination in the table.

5. After making adjustments to any other cells, click OK to accept the 
changes.

These values are stored in the M athW riter Prefs file in the system folder 
and apply to all documents. To reset all the original values, move the 
MathWriter Prefs file to the trash and MathWriter will create a new copy 
as you select new settings.

Since the Metrics settings apply to all documents, not just the current file, 
we recommend that you establish your preferences early and make only 
carefully considered adjustments.
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Find/Replace for mathematical expressions

In the previous chapter we discussed the find and replace capabilities for 
locating and replacing text and text styles. Having discussed the creation of 
mathematical expressions in this chapter, we can now extend that 
discussion.

M athW riter can find and replace built-up mathematical expressions and 
portions of an expression that extend to the baseline, i.e., expressions that 
can be selected using the I-beam text editor. However, the built-up 
expression must be created within the Find/Replace (Edit) (or 96 F) dialog 
box; only text can be pasted into the Find/Replace window.

Suppose you wish to search for Ot 2 and replace it with (5 3.

1. Position the insertion point in your document where the search is to 
begin.

2. Select Edit/Find/Replace (96 F) to access the dialog box (Figure 4.66).

3. Create the expression you want to locate in the upper box opposite Find:.

4. Create the expression to replace the located expression in the lower box 
opposite Replace with:.

5. If necessary, set the search conditions: First, set the general search 
categories.

• Set "Text" on the pop-up menu beneath "Find:".

• Set "Text" on the pop-up menu beneath "Replace with:".

Then, further restrict these two general categories using the two corre
sponding subcategories.

• Set the "Match" pull-down menu to "Text".

• Set the "Affect" pull-down menu to "Text".

6 . Optional: Select a search direction in the pop-down Direction menu. The 
search begins where the insertion point is currently located.

7. Direct the search by mouse from the dialog window (Figure 4.66) or by 
keyboard.

8 . Click the Find button or type 96 G to initiate the search with the dialog 
box visible or press return to hide the dialog and initiate the search.

9. When a match is found, click Replace, then Find (or to separate the 
steps click Replace and then click Find), or type 96 FI to make the substitu
tion and then 96 G to resume the search.
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=
Match fiffec

.. Mnd/Replace —
t LUildcai ds Special Direction i

Find: a 2
Tent

Replace with:
P3

Tent |

Find 8§G Replace, then Find ] (Replace 3§H Replace Rll

Figure 4.66 Find/Replace dialog box

10. To continue the search, repeat step 8 .

When using the mouse, the Find, then Replace button combines the Find 
and Replace buttons.

If desired, use 96 F to retrieve the dialog box when using a keyboard 
directed search.

When the dialog box is visible, the "thermometer" scale to the right of the 
Direction menu indicates the starting position of the insertion point and the 
progression of the search through the document. When the dialog box is 
hidden, a larger screen area is available for viewing the document.

Wildcard searches on mathematical expressions

In the previous chapter we discussed text wildcard characters that you can 
substitute for a single character :?j or any leading or trailing string of 
characters iwordj in a match. For example than and then can both be found 
using th!?jn, with the single character wildcard. On the other hand, the 
word wildcard jwordl would allow the search "Jojwordj "to find both Jones 
and Johns, and "jwordjarch" would find both search and research, although 
the number of characters differs.

The analogous wildcards for mathematical expressions are

VS v =
The first matches any built-up mathematical expression that extends from 
the baseline, the second illustrates a category (or row) from the Template 
windows, and the third illustrates a match for any specific template 
selected from the Templates window.

The first wildcard would match all three of the following, the second
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would match the second and third, and the third would match only the 
second.

To search with a mathematical wildcard:

1. Position the insertion point in your document where the search is to 
begin.

2. Select Edit/Find/Search (or 9$ F).

3. Place the insertion point in the large Find: box.

4. Select one of the three wild cards from the Wildcards menu Structure 
(:?''!), or click on one of the ten template categories from Template Category, 
or on one of the 51 templates from Template Object and click OK.

5. Click on Find or type 9€ G to initiate the search.

6 . Click on the close-box to terminate the search.

The usual cut, copy, and paste techniques apply to mathematical expres
sions alone and those intermixed with text. However, the format used to 
represent editable mathematics is unique to M athW riter, so the usual 
techniques only allow you to cut and paste within and among M athW riter 
documents. Therefore, to transfer mathematics to the Clipboard in a stan
dard (PICT) format:

1. Select the mathematical expression.

2. Use Copy Other/Copy As Picture from the Edit menu to convert the 
selected material into the PICT format before placing the selection on the 
Clipboard.

This works for mathematics, text, and graphics. The mathematical expres
sions that originated in M athW riter can be pasted back into M athW riter 
from the Scrapbook for further modification, if necessary.

However, if the PICTs are modified in a drawing program and transferred 
back into M athW riter or into another application such as a page layout 
program, such expressions will be treated as pictures, rather than as edit
able text.

Even though M athW riter provides tools not included in a conventional 
word processor, we tried to configure the program for those who do not want 
to write mathematics as well as those who do. For example, if you do not

Mathematics and the Clipboard

Customization
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ordinarily encounter mathematics, you should not be burdened by the tools 
used only for that purpose.

M a t h W r i t e r  helps you avoid repetitive startup tasks by providing two 
levels of customization—one that applies to M a t h W r i t e r ,  regardless of the 
document, and one that is document specific. Since most of these techniques 
have been considered throughout this and the previous chapter, we give 
only a general summary here.

Global preferences

Certain configuration choices remain relatively constant from one document 
to the next and from one working session to the next. To avoid repetitively 
setting these conditions, M a t h W r i t e r  stores them in the M a t h W r i t e r  P r e f s  
file placed in your system folder during your initial session and whenever 
you choose any of the defaults. You set many of these global conditions using 
Preferences on the File menu.

To return to the original defaults, simply place the current Prefs file in the 
trash, and M a t h W r i t e r  will create a replacement. Note: Document-specific 
defaults are stored in each document or in MW Default file templates 
accessible from the New (File) submenu.

The M a t h W r i t e r  P r e f s  file contains the following categories.

• File/Preferences dialog box

Default file name and volume reference of the file opened at startup

Floating window selection and position at startup (Font Table, Tools, 
Templates, Palettes, and Library).

Combination of symbols in Palettes window at startup

File warnings at startup

Enable Library and list of libraries to open at startup 

Load Libraries at startup 

Enable Screen auto-refresh

• Windows/Font Table 

Name of last selected font

• Format/Matrix (table) form at

Placement, Line type, Justification within cells, Cell spacing, Alignment 
within rows
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• Style/Text sizes

Last used Other Font Size

• Metrics (Style)

Size changes for subscripts and superscripts, summation symbol sizes, and 
vertical positioning of subscripts and superscripts

• Edit/Check Spelling

Name and volume reference for main and user dictionaries

State of check boxes in spell-checker (Alternates, All caps, Repeated 
words)

• File/Print

Most recent choice of LaserWriter Paper motion configuration

Local preferences

The typeface and even some of the contents of various document types 
remain constant. M athW riter's primary customization technique is the 
creation of template documents as MW Default Files using the Save As 
(File) command. Math Writer files store not only the contents of a document 
but the complete specifications of the editing environment that existed 
when the file was saved. Therefore, when you open an existing file, you can 
resume work at once. MW Default Files have one additional important 
attribute—they serve as a template that you can copy to form the basis for 
a new working environment. Therefore, each combination of features and 
the initial contents of the document preserved in this form becomes a type of 
stationery. You can create such a file for each of your major tasks. The 
names of the default files appear on the New submenu for convenient 
selection if you store the master copy in the system folder or in the same 
directory as MathWriter.

If you select New, but not one of its submenu entries, you open a blank 
generic file.

Producing a list of all the features you can preset with this technique 
would be exhaustive. Instead, a few of the more important and some of the 
less important but obscure possibilities follow.

• Page Layout (margins, headers, footers, gutter, columns, column gap, 
facing pages); Printer Setup (Printer type, paper size, paper orientation, 
enlargement percentage, printer special effects) •

• Document Layout (revision styles, styles 1 & 2, footnote & endnote 
typeface, auto-italics typeface, auto-save, auto-backup, file compaction, 
smart quotes, fractional character widths, line numbers)
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• Printer options, print sides, type of LaserWriter

• Format (ruler and units, spacing before and after paragraphs, line 
spacing)

• Matrix format (row and column spacing, line type and pattern, 
justification within cells)

• Variables format (dates, time, page footnote, page, equation, figure, 
tables, etc.)

• Layout display (hidden boundaries, messages, invisible characters, 
pictures)

• Typeface (font, font size, font style in body, headers, and footers)

• Named user-defined styles (style sheets)

Default files can also store frequently used text and pictures such as logos. 
For example, a memo might contain a logo, the "To, From, Subject" 
headings, and automatic date and time stamping. The footer might contain 
variables to identify the source file, the date and time of printing, and the 
current and total number of pages in the file. Such a memo template is 
included on the distribution disks.

The Library is another powerful customization tool. You can define the 
name and content of entries. The entries can be simply abbreviations for 
special characters, entire paragraphs, or graphics and built-up 
mathematical expressions.

Data Sharing
The Macintosh user interface gives special attention to the transfer of text 
and graphics among Macintosh applications. Applications such as M ath- 
Writer that adhere to the published interface standards can be assured of a 
communications channel through the Clipboard. MultiFinder makes 
switching applications quick and easy if there is sufficient RAM. Data can 
be stored in the Scrapbook for delayed transfer into other applications. 
System 7.0 will expand the pathways.

Delayed transfer by direct reading of files from other applications is 
another, somewhat more complex, pathway for information transfer. Each 
application must use a file structure that is suited for storing of information 
peculiar to its purposes. Often the translation process does not transfer all 
of the information in a manner that can be fully recovered, so save the 
original MathWriter file before you begin a translation.
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Text files

fx-dx

Text File

Scrapbook File

Word processor files, known as ASCII files, that save only the character 
keystrokes and some minimal paragraphing information are the common 
denominator. While this is universally supported, transferring the contents 
of a file from one word processor to another loses such information as 
character formatting and graphics. M athW riter does provide an 
additional enhancement—the graphics and mathematical symbols are 
automatically extracted and stored in a named scrapbook for subsequent 
transfer into another application. M athW riter can also place a marker in 
the text file to assist in the merging of the information from the other 
application.

To save a text (ASCII) file:

1. Select File/Save As.

2. Select TEXT from the File Type pop-up menu (Figure 4.67).

3. Select a destination drive and folder.

4. Supply a file name. Never use the name of the parent file. Appending 
".txt" is a convenient way to show its relationship to the original file.

5. Click Save.

6 . Specify that a line break (Figure 4.68) not be added to preserve the 
structure of the lines. Ordinarily the line structure is preserved only if the 
receiving application cannot handle paragraphs as a continuous stream of 
arbitrary length.

Q  "Manuscript |

Demo.tut

File Type: | TEHT |

<=3HD40

[ E jest ] 

[ Driue ]

f Saue ] 

[ Cancel ]

Figure 4.67 Save As dialog

7. Check to indicate whether M athW riter should save the graphics and 
equations in a named scrapbook.
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TEHT options:
®  Tent only
OTeut with line breaks

E  Saue equations in scrapbook 

Mark location in tent with: 
Name of Scrapbook file:

(* # *)

Demo.tent.PICT

Equation parser will conuert...
O  each symbol into a separate PIC1 

®  groups of symbols into separate PICTs 
O  entire line containing symbols into a PICT

Cancel [ | _ J g u e J ]

Figure 4.68 Scrapbook file

8 . If yes, indicate a marker, if any, to locate the point of extraction for 
later re-assembly in another format. The default encloses a counter enclosed 
between parentheses and asterisks (*0*).

9. Select a grouping criterion. The middle option is the default. If you have 
created a file of only displayed equations, choose the last option.

10. Click OK.

Unless you have a desk accessory such as SmartScrap™, to open the scrap
book file you must place the scrapbook in the system folder, rename any 
existing scrapbook file, and temporarily rename the scrapbook just created 
"Scrapbook File."

Microsoft interchange format (RTF)

The so-called Rich Text Format (RTF) provides a standard for file transfer 
that preserves the character formatting and graphics intact. Depending 
upon the other features supported by each word processor, some information 
is passed as comments and not immediately restored to its original 
appearance. M athW riter's RTF filter must be placed in the folder with 
MathWriter or in the System folder in order to have its name appear in the 
File Type menu for Open17 on the File menu. Most word processors support 
this file format. M athW riter also imports Mathematica Notebooks that 
have been translated into RTF.

jxdx
RTF filter

17 Initially the RTF filter provides import only (i.e., RTF to M a t h W r i t e r ) .
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File/RTF

To read an RTF file (if the RTF filter is in the folder with M athW riter or 
in the system folder):

1. Select Open (File).

2. Select RTF from the File Type pop-up menu. Otherwise, the untranslat
ed RTF code will be read as a TEXT file.

3. Click OK. The translation process is lengthy because of MathW riter's 
rich data structure. The translation consists of two parts—translation of the 
RTF code and the formatting of the document within M athW riter. Allow 
time for the completion of both parts and then save the file.

The RTF filter does not check the code for Math Writer compatibility. 
Furthermore, this code bypasses the usual syntax checking provided by 
M athW riter during mouse and keyboard input.

4. Supply additional formatting in M athW riter as necessary, especially 
for features not supported by both word processors.

To save17 an RTF file (if the RTF filter is in the folder with M athW riter or 
in the system folder):

1. Select File/Save As.

2. Select RTF in the File Type pop-up menu.

3. Supply a file name different from the parent M athW riter file, perhaps 
by appending "/RTF" to the file name.

4. Select a folder and drive and click OK.

O ther translators

Commercial translators (filters) provide a channel among various formats 
read by both the Macintosh and IBM-PCs. The creation of a TpX translator 
for entire, "WYSIWYG"-created M athW riter documents is being consid
ered.

Importing from graphics files

M athW riter can read paint, draw, and encapsulated PostScript files 
directly without the originating application. Refer to the previous chapter 
for details.
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Modular Extensions
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Since Math Writer is a modular18 word processor, you can extend its function 
with modules that can access and process Math Writer's data structure using 
calls to MathW riter. These modules literally extend functionality. When 
modules are placed in the folder with M athW riter or in the system folder 
before startup, M athW riter locates and integrates them as a part of M ath- 
Writer.

This allows you to customize M athW riter in a fundamental manner. You 
work only with the modules relevant to your needs. This limits the com
plexity and size of M athW riter, decreasing disk space used and increasing 
the speed. Use the Windows/Modules submenu (or 8€ option number) to 
access the modules.

EnamBuilder™ 36̂ =1 |

Figure 4.69 Sample module submenu

ExamBuilder™ is the first such module to extend the function of Math- 
W riter by adding a special purpose, disk-based database for test items. 
ExamBuilder, accessed from Windows/Modules or by keyboard, provides a 
tool for the rapid generation of alternative forms of examinations from a 
collection of test items that can include text, graphics, and mathematics. 
Questions can be true/false, multiple choice, matching, essay, or a scenario 
that is sequence-dependent. The ordering of questions can be random and the 
multiple-choice options can be shuffled. Answer sheets and a log of items 
used is provided. The full formatting power of M athW riter is available for 
output.

The handling of long documents, outlining, indexing, and integrating the 
retrieval of bibliographic citations are likely candidates for modular ex
tensions. The MathWriter interface already exists.

18 M a t h W r i t e r  is believed to be the first truly extensible word processor.
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5  Summary for Experts

This chapter outlines, for the experienced Macintosh user, how to start up 
M athW riter and how to handle some common tasks. For a detailed, step- 
by-step description of technical word processing tasks, read the chapters on 
nontechnical (Chapter 3) and technical writing (Chapter 4). The Command 
Reference chapter (Chapter 6) provides a comprehensive description of 
operational commands, and the tutorial summary (Chapter 2) is provided 
as a hands-on M athW riter file. The Quick Reference Card and the online 
help provide terse summaries. All keyboard commands are listed in the 
appendix as well as in the online help.

Getting Started and Handling Text
Installing MathWriter

This summary for expert Macintosh users assumes that you have a 68020- or 
68030-based Macintosh, at least 2 megabytes of RAM, a hard disk, and can 
benefit from all the technical word processing features provided by the 
MathWriter professional version.

To install MathWriter:

• Create a folder named M athW riter f  anywhere on your hard disk, lock 
and copy the contents of all distribution disks into the folder. The support 
files must either be in the same folder as M athW riter or in the system 
folder so M athW riter can automatically locate them. Refer to the 
appendix for a discussion of the various files.

MathWriter disables a feature when its support file is not accessible.

• M athW riter requires the Times and Symbol fonts. Automatic formatting 
and mathematical templates require these fonts. Install the supplied 
versions using the Font/DA Mover. We recommend that you switch from the 
MultiFinder to the Finder and restart to use the Font/DA Mover; you should 
remove the Apple version of the Symbol font before installing the modified
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version supplied with M athW riter. (The ends of a few stretchable brackets 
are clipped in the screen display, but are still printed properly in the 
LaserWriter output. The supplied version also enables the printing of the 
boldface Greek characters.)

• If you are using MultiFinder, open the M athW riter folder and click (not 
double-click) on the M athW riter icon. Unlock the file, allocate the 
maximum available RAM for M athW riter and its open documents, relock 
the file, and close the Info window. Although M athW riter can be used 
with small documents with only 800K, we recommend 2,000K or more.

• Double-click the MathWriter icon to start the program.

M athW riter must perform various initialization tasks at startup. Since 
this is probably your first use of M athW riter on your computer, the 
program creates a M athW riter Prefs file in the System folder that contains 
a set of global defaults. Later, you can modify these defaults to customize 
the startup environment to your specific needs. M athW riter also 
automatically locates and links with any support files such as help, 
dictionaries, thesaurus, hyphenation, file translation filters, libraries, 
modules, stationery defaults, etc., that you have placed in the folder with 
MathWriter or in the System folder.

Getting help

For online information use the Help window on the Windows menu or % ? to 
access the Help file and select a specific topic. The topics are listed 
alphabetically and within several subgroups.

The online help provides an overview and probably enough detail for you 
to handle most tasks. In order to support the "What you see is what you 
get" nature of MathWriter, the program keeps open files in memory.

Therefore, when you are composing original material at the keyboard, we 
recommend that you enable the automatic save and automatic backup 
features using the File/Doc Preferences dialog.

• If a M athW riter Update file is present on the distribution disk, review it 
before you begin serious use of MathWriter. Don't skip this step!

• Select About M athW riter on the Apple menu for technical support 
information and our copyright notice.

M athW riter reports the approximate amount of RAM available by the 
thin lines in the bottom-left corner of the status bar of the active document. 
The solid line reports the fraction of RAM being essential for M athW riter 
and the open documents. The dotted line reports the actual RAM in use, 
including memory which MathWriter can release when necessary.
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Standard documents

M athW riter handles many ordinary business word processing tasks in 
addition to the more complicated processes associated with technical word 
processing. Advanced features need not be visible or otherwise require your 
attention. For example, the tools used to create mathematical expressions 
are hidden unless deliberately called up.

M athW riter provides convenient access to your personal collection of 
standard document types (sometimes called stationery) with standard page 
layout, typeface, and boilerplate contents already prepared.

To create a custom default file for memos:

1. Open the Memo default file (Figure 5.1) using the New submenu on the 
File menu.

untitled A1 D
iiiilOi i i I i i i M i i i I i i i 12, i i | , i i |5, i i | i i i |4, i . | , i , |5, i i | ,~T

* i ►
<►
♦
o

H I 3

U. Dough, President Phone ( A C * )  5 5 5 -1 2 1 2

Institution

Street

D ity , S ta te , Zip Page 1 o f 1

bate: F riday, June 1, 1990

To:

From :

Subject:

[Y ou r log o  can be placed in  the header or  as a background picture in  the bod y . ]

o

o
Base L 1 1, C79 Tim es 12 a

Figure 5.1 An example of stationery: Memo.def

The new file "Untitled Al" is a copy of the file Memo selected from the 
New submenu list. Selecting New, but not a submenu, produces a generic 
blank file.

Stationery or default files located in the folder containing M athW riter or 
in the system folder appear in this list. If none are present, only a 
traditional New command without a submenu appears.

2. Use the Save As command with File type: MW Default File selected 
from the pop-up menu to create stationery for future sessions.
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Figure 5.1 shows the document window too. The name of this open document 
appears on the Windows menu along with any others that might be open. 
When you select a document name from the Windows menu, that document 
window becomes the active window (i.e., it comes to the front for editing).

The document window

Math Writer uses a "sheet-of-paper display" with automatic pagination. 
The Memo stationery file, for example, contains a header at the top of the 
page that displays the current page number and the current total number of 
pages; M athW riter automatically updates both variables as you add 
pages. The header can also contain text or graphics, such as a logo. You 
could also use a bitmapped, a PICT, or an Encapsulated PostScript graphic 
as a background picture, creating a "watermark." The body of the document, 
below the nonprinting horizontal line, contains the standard memo entries. 
M athW riter automatically supplies the current date. You might elect to 
use the filename variable on the last row of the Palettes menu to associate 
your printed memo with its originating data file.

M athW riter provides a full "What you see is what you get" visual 
display. All editing is done in context. For example, you can edit the 
headers, footers, footnotes, mathematical expressions, and sidebars 
without moving into separate windows. Just select the appropriate editing 
tools using Tools on the Windows menu. Even if you suppress the page layout 
lines with Hide Layout on the Format menu, the cursor continues to change 
depending upon its location in your document. In order to achieve maximal 
visual feedback, M athW riter refreshes the screen often; you can initiate a 
screen refresh with 36 option Z.

Math Writer supports the usual window controls such as the close-box, zoom 
box, grow box, horizontal and vertical scroll bars, and ruler lines that 
identify this as the active window. See the Help window (Windows menu) 
for a summary of mouse and keyboard commands used to move around within 
a document. Because displayed mathematical expressions frequently span 
several lines, a click on a scroll arrow moves the document multiple lines. 
Option click on the arrow to scroll only one line.

The ruler does not scroll from the top of the document window but remains 
visible, displaying the tab settings for the selected paragraph, the 
paragraph that contains the blinking insertion point. Each time you press 
return, you create a new paragraph that inherits the ruler of the previous 
paragraph. When you change the ruler of the new paragraph, M athW riter 
adds an identifying icon in the left margin. M athW riter places various 
markers at the left border, but you can hide them by selecting Hide Markers 
from the Format menu.
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The tab supply and paragraph justification controls appear just 
above the vertical scroll bar, rather than on the horizontal portion 
of the ruler, to leave you as much vertical space as possible. This is 
especially valuable when you are writing two dimensional, 
mathematical expressions and screen size becomes critical. Drag the 
tabs onto the ruler or into the text. A rubber-band feature lets you 
drag a tab into the text to determine its exact alignment. When you 
release the tab, it snaps onto the ruler. To remove a tab, drag it off 
the right end of the ruler past the right margin marker.

Double-click on a tab positioned on the ruler to change the type of the tab 
(left-aligned ►, right-aligned 4, center-aligned ♦ , or character-aligned 0), 
to assign tab leaders1 or to change the alignment character, for example, 
from a decimal point to an equals sign. The paragraph alignment relative 
to margins includes left align fi+T right align 0 , both margins aligned 
and centered 0 .

___Solid leader Gray leader .....Dot leader (user-selected)

The two-dimensional nature of mathematical expressions requires more 
extensive line spacing control than traditional single and double spacing; 
therefore, we expanded this control and moved it to the Format menu. The 
line spacing options include automatic, mostly fixed, and fixed spacing 
with separate leading adjustments for space above and below the baseline. 
The mostly fixed option, a combination of fixed and automatic, permits 
subscripts and superscripts to protrude into the space between the lines, but 
allows displayed equations to increase line spacing automatically. Never 
use fixed line spacing while composing mathematical expressions.

a

The status bar (Figure 5.2) at the bottom of the document window provides 
advisory information. The font, font size, and font style of the character 
adjacent to the blinking insertion point appear on the right. When you open 
a file, a progress indicator appears here and you choose among existing 
revision tracking styles in the pop-up menu here. Indicators identifying the 
options you have, such as Auto Math, Revision Tracking, and User Styles 
also appear here. The panel to the left reports the line and character 
position of the cursor or the range of selected text. M athW riter supports 
type-ahead and mouse-ahead features and handles numerous off-screen 
formatting operations in the background while the keyboard is idle; a 
progress indicator also appears here. This panel, in addition, provides a 
pop-up menu to control the movement of the insertion point among the

Base O  lllili l l |  lyj L1 76 , C34 -  L1 76 , C34~ Times 12

Figure 5.2 The status bar

1 Tab leaders are frequently used in the table of contents to assure vertical alignment of text within a line. M ath -  
Writer autom atically fills the space betw een the text and the tab position w ith the designated leader character.
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various regions of the document and to scroll the window if necessary. For 
example, if you place a footnote or an endnote, you can scroll directly 
between the note itself and back to the reference point in the text using the 
insertion point menu. The "Base" panel reports the progress of various 
background tasks, RAM usage, and the position of the insertion point 
within a built-up mathematical expression or within a table. For example, 
if the insertion point is positioned for a superscript to a superscript, two 
upward arrows appear here.

Note: Use 96 right bracket and 96 apostrophe to create superscripts and 
subscripts, respectively. The font size reduction and vertical positioning 
are automatic. Press enter to cancel each subscript or superscript command.

See the online Help in the Windows menu for a discussion of the Math 
editor. The Character Editor provides arbitrary vertical positioning for 
any character.

Menu commands

Before creating a document, structure its global properties. Use Page Layout 
on the File menu for printer and paper choices, margins, header and footer 
size, number of columns, etc., and use Doc Format for placement of headers, 
footers, and footnotes within the document.

The Edit menu provides the usual undo, cut, copy, and paste commands as 
expected. In addition, M athW riter supports copying and pasting of 
paragraph formatting information. A Paste In Context command allows 
added text to assume the style of the text adjacent to its destination, rather 
than retaining its original style. Note: To transform mathematical 
expressions into PICTs for pasting into traditional applications, use the 
Copy Other submenu command Copy As Picture. Find/Replace supports 
search and replace for mathematical expressions, typeface changes, 
wildcards, hidden formatting commands, such as return markers at the end 
of paragraphs, and reverse direction searches, which are especially useful 
when you are composing as opposed to simply typing an existing 
mathematical manuscript. An additional math-science-engineering 
dictionary augments the spell-checker.

Use the Format menu to format paragraphs (borders, shading, splits at 
page breaks, etc.), set line spacing, and choose the dynamic variables for 
page numbering, paragraph numbering, footnote numbering, equation 
numbering, etc. Set starting numbers for these variables here, too. Use the 
Palettes menu to "type" these dynamic variables at the insertion point. 
(The Sequence 96 option E types the automatic equation numbering vari
able.)
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Use the Diac menu to type and to adjust diacritical and horizontal grouping 
markers. As described below, you can save repeatedly used built-up 
expressions in a library on the Windows menu for rapid recall and entry.

The Style menu supplies typeface choices for font, font size, and font style. 
An enlarged set of styles is included to support automatic revision tracking 
in Doc Preferences on the File menu for in-context marking of additions and 
deletions. Both mouse and keyboard control are provided for typeface 
changes because of the frequency of this process in mathematical 
manuscripts. Use Doc Preferences in the File menu to assign typeface 
combinations for Style 1 and Style 2 on the Style menu. Unlike these two, 
the user-defined, named User Styles in the Style menu remain linked to text 
to which you assign a custom style. Math Writer automatically updates the 
style of the linked text throughout the document.

The Library on the Windows menu is a generalized glossary-macro feature 
for rapid typing of repeatedly used text, graphics, and built-up 
mathematical expressions. In contrast to traditional glossaries, the 
substitution of an entry for its abbreviation is automatic. Because built-up, 
mathematical expressions may not have meaningful mnemonics, mouse 
selection of entries is also supported. Refer to the online Help window for a 
description.

Handling Graphics and Sidebars
Using graphics

M athW riter allows you to import graphics (bitmapped, PICT, and 
Encapsulated PostScript) directly from files, as well as through the 
Clipboard. You can treat a graphic as a large text character within a line of 
text or isolate it from the body of the manuscript in a rectangular mini
document called a graphics sidebar. You may have multiple lines of text 
adjacent to the sidebar and automatic wordwrap is still supported.

To import a graphic as a character:

With a document open and the destination identified by the position of the 
blinking insertion point, use Import Graphics File on the File menu to insert 
the graphic. Unless you select a specific file type with the pop-up menu, 
the names of all folders and all allowable file types appear in the file 
selection window. The usual cut-copy-edit commands apply to the graphic; 
therefore, you can paste into a M athW riter document a graphic placed on 
the Clipboard by another application.
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To resize and crop a graphic

1. Activate the Character Editor

□  1

using the arrow icon on the Tools
Window of the Windows menu, the Tools submenu, or type 96 shift [.

2. Click on the graphic to display the bounding rectangle with "handles" 
on the corners.

3. To resize the selected graphic with the width-to-height ratio 
preserved, either drag a handle while you press the option key or select 
the graphic and, with the Character Editor active, use the Scale command 
that appears on the Edit menu. If width and height are to have different 
scales, just drag a handle or set the actual percentages for each dimension 
using the Scale command on the sidebar Edit menu; you can also restore the 
original size here.

4. To crop (or cover) a portion of the graphic or undesired bounding white- 
space, drag a handle on the bounding rectangle while pressing the 96 key or 
use96 option to crop proportionally. When you press the key, M athW riter 
posts the permitted operation in the typeface box of the status bar.

5. To leave the Character Editor, select the normal Text (I-beam) Editor.

Using picture sidebars

This text 
m aps 
around a 

sidebar.

When you need to place multiple lines of text opposite a graphic, use a 
Picture Sidebar. The sidebar can be flush with the left or right margin or in 
the margin space adjacent to either text margin if sufficient space exists on 
the page. The rectangular sidebar can have a border with various line 
thicknesses and patterns.

To create a picture sidebar:

1. Place the graphic for the sidebar on the Clipboard. You can use the 
Windows menu to view the contents of the Clipboard. When the Sidebar 
Editor is active, you can use Import Graphics File into Clipboard to place 
the graphic on the Clipboard.

2. Activate the Sidebar Editor using the "+" icon on the Tools Window of 
the Windows menu, the Tools submenu, or type 96 shift ].
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Using text sidebars

3. Select New Picture Sidebar from the Edit menu, which will have 
changed from the normal text edit menu.

4. Click on the sidebar to display the bounding rectangle, which has 
"square handles" on the comers.

5. To resize the sidebar with the width-to-height ratio preserved, either 
drag a handle while you press option or select the sidebar and, with the 
Sidebar Editor active, use the Scale command on the Edit menu. If width 
and height are to be scaled differently, just drag a handle or set the actual 
percentages using the Scale command on the sidebar Edit menu.

6 . To reposition the picture sidebar, select a position from the sidebar Edit 
menu.

7. To leave the Sidebar Editor, select the normal Text (I-beam) Editor.

This is text 
in the main 
body of the 
document,

This is text 
within a 
text sidebar.

A text sidebar contains text, rather than graphics. The sidebar behaves as 
though it were a minidocument complete with wordwrap and the usual 
word processor controls. However, you cannot nest a sidebar within a side- 
bar.

To create a text sidebar:

1. Activate the sidebar editor using the "+" icon on the Tools Window of 
the Windows menu, the Tools submenu, or type shift ].

2. Select New Text Sidebar on the sidebar Edit menu to create and display 
the bounding rectangle with "handles" on the corners.

3. To resize the sidebar with the width-to-height ratio preserved, either 
drag a handle while you press the option key or select the sidebar and, 
with the Sidebar Editor active, use the command that appears on the Edit 
menu. If width and height are to be scaled differently, drag a handle or set 
the actual percentages using the Scale command on the sidebar Edit menu. 
You can resize the text sidebar even after you have entered text; wordwrap 
occurs automatically.

4. To reposition the text sidebar, select a position from the sidebar Edit 
menu.

5. To leave the Sidebar Editor, select the normal Text (I-beam) Editor.
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After returning to the normal Text Editor, you can click within the sidebar 
to position the insertion point and then enter text or mathematical 
expressions in the sidebar. The usual wordwrap and typeface features are 
fully supported.

Using background pictures

This is foreground
^ck grou n dtextwi

picture m
You can place a graphic behind the text either on any specific page, left or 
right facing pages, or all pages of a document. You can adjust the sizing and 
cropping of the background picture as you do a picture sidebar. In addition, 
you can position the background picture anywhere within the main body of 
text.

1. Place the graphic for the background picture on the Clipboard. You can 
use the Windows menu to view the contents of the Clipboard. If necessary, 
you can use Import Graphics File to place the graphic within the document 
and then use Cut to move it to the Clipboard.

2. Activate the Sidebar Editor using the "+" icon on the Tools Window on 
the Windows menu, the Tools submenu, or type $6 shift ].

3. Select New Background Picture from the sidebar Edit menu. The graphic 
is automatically placed at the center of the current page.

4. To reposition the picture, click on the picture to display the bounding 
rectangle that has "square handles" on the corners.

5. Drag the picture with the 4̂  cursor to the desired location.

a

6 . To resize the sidebar with the width-to-height ratio preserved, either 
drag a handle while you press the option key or select the picture and, 
with the Sidebar Editor active, use the Scale command that appears on the 
Edit menu. If width and height are to be scaled separately, drag a handle 
or set the actual percentages using the Scale command of the sidebar Edit 
menu.

7. To leave the Sidebar Editor, select the normal Text (I-beam) Editor.
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Using the Math Editor
The handling of mathematical expressions is MathWriter’s most 
distinctive and powerful feature. By reducing typesetting tedium and 
providing you with technical writing tools, we hope you can compose 
mathematical manuscripts at the keyboard, rather than transcribe hand
written drafts into print. We believe these tools empower authors of 
scientific and mathematical papers just as traditional word processors 
facilitate the process of writing prose.

MathWriter treats mathematical expressions as ordinary text, rather 
than graphics; this allows you to compose and edit built-up expressions of 
arbitrary complexity in context. You can generate nearly all input and 
commands by mouse or keyboard. "Smart" templates provide automatic 
formatting of the two-dimensional displays of mathematical expressions. 
Line spacing adjusts automatically. A Library feature lets you type 
repeatedly used, built-up expressions with a mouse click or a single 
keystroke. Various input aids expedite changing typefaces, entering 
special symbols, and italicizing the variables in mathematical 
expressions. During editing, MathWriter automatically numbers equations 
and updates the text references linked to them. Footnotes are numbered 
automatically too. The Find/Replace command applies to both text and 
mathematical expressions. Revision aids for authors include dynamic line 
numbering and in-context marking of version additions and deletions using 
automatic style changes.

Configure the floating windows

♦ To begin using the Math Editor, select the appropriate combination 
of the five floating windows from the Windows menu. Your document 
window remains active even when floating windows are present and 
active.

All of the commands on the following five floating windows, which 
are displayed using the Windows menu, can be typed (for a list of 
keyboard commands, see appendix 3), but mouse access is always an 
option.

♦  The Tools window provides access to the auto-formatting subscript 
[V] and superscript | commands (9€ ' and 3€ ] are the keyboard 
equivalents) in addition to the various editors, including Math X.

Use the enter key to complete a mathematical subexpression or 
template and move the cursor to its previous state. Use the return key 
to return immediately to the baseline for text.

♦  The Templates window has ten horizontal pop-out menus of com
mon mathematical expressions. Drag to select or type S€ and a numer

al



al simultaneously to select a category (numbered from the top) followed by 
a numeral for the specific template (numbered from the left). For example, 
if you type 1 and 1, the first fraction template appears at the insertion 
point in your document.

Note to MathWriter 1.4 Users: The Templates window behaves as a float
ing, vertical menu bar. You must drag, not just click, to select a command.

Use the enter key to advance the cursor from one placeholder to the next. 
For matrices and tables use the tab key to create new columns and the return 
key to create new rows. Most formatting is automatic.

These template structures, including subscripts and superscripts, can be nest
ed to any level; for example, a superscript can have a superscript. Within a 
template, pressing enter returns the insertion point to the previously used 
template. For example, when within the superscript of a superscript, press
ing enter once moves the insertion point back to the first level superscript.

♦  The Palettes window always contains the Greek alphabet and as many 
additional rows of symbols as you want; select a row by clicking on its name 
from the Palettes menu. MathWriter places symbols selected from this 
window in the document at the blinking insertion point. 9$ spacebar toggles 
between the current and Symbol font, which contains the Greek alphabet. A 
style menu command serves this same purpose.

♦  The Font Table is a generalized typing aid that provides access to all 
characters of all active fonts. Use the pop-up menu to select the font. You 
can reduce the portion of the table that is visible in order to preserve screen 
space.

♦  The Library window displays user-generated selections of text, graphics, 
and mathematical expressions intended for repeated use. MathWriter 
inserts items from the Library into your document at the blinking insertion 
point whenever you type the abbreviation of the item or double-click on the 
specific entry in the Library window. A type-ahead and mouse-ahead 
buffer support fast typist.

To create a library:

1. Optionally display the Library window using Library on the Windows 
menu.

2. Select New from the Library submenu of the Windows menu and supply a 
descriptive name. The Library window shows the name of this new file in 
its pop-up menu. MathWriter automatically searches any number of open 
libraries of the Library submenu; use the pop-up menu to select a particular 
open library for display.
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3. To create an entry for the new library, either drag to select and high
light material from the document or place the material on the Clipboard 
and transfer it to the Library using the Library submenu.

4. Assign a name and a brief description for this typing macro.

Two additional floating windows, Clipboard and Help, provide informa
tion, but they cannot be edited directly.

Additional keyboard commands

In addition to more than 100 keyboard commands listed in the appendix 
and those provided by the floating windows, MathWriter supports various 
other user-defined commands, or macros, to control typeface changes. You 
can increase or decrease the font size or revert to the immediately previous 
typeface on the Style menu. Additionally, using Doc Preferences on the File 
menu, you can assign two typeface combinations, from among user-selected 
categories of font, font size, font style, justification, and line spacing, to the 
style menu with 96 > or 96 <.

Additional typeface and form atting controls

The Auto Math feature provides various automatic changes in typeface 
peculiar to mathematical expressions. You select the combination of 
features in Auto Math options and enable/disable the set using Auto Math 
(with 96 E). This feature is normally disabled unless needed. When 
enabled, the typeface indicator on the status bar appears in inverse (white 
on black). Among other things, MathWriter resizes parentheses, brackets, 
and braces as the enclosed expression changes in height. The program 
automatically italicizes variable names, but not functions and other user- 
defined exceptions. You set the typeface combination for Auto-italics in Doc 
Preferences of the File menu. Because the ordinary italics attribute slants a 
character too much in ImageWriter output, you can substitute a Plain style 
of an oblique font.

When the insertion point is adjacent to an alphabetic character, you can use 
the Diac menu to supply diacritical marks. When a group of characters is 
selected, you can apply a special grouping symbol, such as a horizontal 
brace from the Diac menu.

To adjust the height of integral and absolute value symbols to match the 
expression size when the insertion point immediately follows the integrand 
or argument, use 96 D or the Calc Prev command on the Format menu. Use 
the Character Editor to make arbitrary adjustments to vertical position and 
size.

Other Format menu commands provide borders for emphasizing paragraphs 
and equations and control for line spacing (automatic is the default) and 
matrices. Changes in these settings apply to subsequent input and to text you
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designate by selecting before you change the defaults. Use the Insert and 
Delete submenus of the Edit menu to add or delete rows or columns of ma
trices when you place the insertion point within a cell using the Math Edi
tor X.

Find/Replace of the Edit menu allows you to include mathematical 
template constructs as well as specific built-up expressions within a search. 
Searches can be typeface-sensitive and direction-specific.

Other important commands

MathWriter's automatic scrapbook feature, invoked using the TEXT file 
type with Save As on the File menu, automatically extracts graphics and 
mathematical expressions, converts them into PICT form, and places them 
in a scrapbook file for use with other applications. Traditional word 
processors simply discard these graphics when making a text file and 
require that you individually transfer graphics. With MathWriter you 
also can transfer a mathematical expression into another application via 
the Clipboard by selecting the expression and using Copy As Picture from 
the Copy Other submenu on the Edit menu. This converts the editable 
expression into a PICT format recognizable by many other applications.

The Preferences command of the File menu allows you to establish a startup 
configuration suitable for mathematical work.

The revision tracking feature of Doc Preferences on the File menu provides 
automatic markings of additions and deletions made to an existing docu
ment. User-selected styles make possible multiple versions in a single 
document. Use Find/Replace of the Edit menu to locate revisions. Use Un- 
Revise of the Edit menu to manually alter individual changes, or use Clear 
in Doc Preferences on the File menu to remove all deleted text and revision 
style markings of added text.

MathWriter's  powerful automatic numbering feature in Variables Format 
on the Format menu dynamically numbers footnotes, equations, subequa
tions, and cross-references to them in the text. In addition, the user-defined 
category with cross-references can simultaneously link an arbitrary number 
of user-defined variables such as tables, figures, theorems, lemmas, etc. If 
you add equations during the editing process, MathWriter automatically 
updates all subsequent equation numbers and references to them.

To number equations, assign a format, position the insertion point with a 
tab, and then use the mouse to type the dynamic variable 2# from the Pal
ettes menu. Math Writer automatically numbers the current variable high
er than the immediately preceding variable and updates all remaining 
occurrences in the document. Subequations are handled similarly. When 
you assign a cross-reference 2# , you must establish the linkage; but Math- 
Writer dynamically updates the link after subsequent editing. Use the
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Variables Format command to set the attributes of this triplet of variables. 
You also use Variables Format to establish an arbitrary number of triplets 
for numbering figures, tables, paragraphs, theorems, etc.

Use Insert Memo of the Format menu to create a message window with an 
automatic time stamp. When the message window is closed, the only 
evidence of the memo is an icon in the left margin, and you can suppress 
even that by choosing Hide Messages on the Format menu. Double-click the 
icon to retrieve the hidden memo.
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6  Command Reference

This chapter is a detailed reference guide to Math Writer commands and is 
organized by commands, rather than by tasks.

Hardware and System Requirements
The professional version of MathWriter 2.0 requires a 68020- or 68030-based 
Macintosh with at least 2 megabytes of RAM and a hard disk. The reduced 
feature education version can be used with 1 megabyte of RAM using the 
Finder, rather than MultiFinder. The reduced version is smaller and leaves 
disk space for files. The other drive would contain your system file, the 
print driver, and limited space for file storage. A hard disk is preferred for 
serious work, especially if you use the spell-checker and thesaurus.

Use the most recent operating system consistent with your hardware, 
although any system that supports submenus will work (i.e., System 4.0 and 
Finder 6.0, or later). MathWriter works comfortably with MultiFinder, 
provided you have enough memory. MathWriter's mathematical capabili
ties utilize the Times and Symbol fonts; therefore, the screen font for at 
least one font size of Times and Symbol must be available to the system 
during writing and printing. MathWriter includes a self-check of the sys
tem version and the availability of the Symbol and Times fonts.

MathWriter's Main Screen
Figure 6.1 shows MathWriter with a single, open file displaying three of 
the floating windows (Templates, Palettes, and Tools), and the ruler, tabs, 
and scroll bar. You can remove the floating windows by clicking in their 
close-boxes or by selecting their names in the Windows menu. You can also 
drag them to more convenient locations on the main screen or to an attached 
secondary screen. This is especially useful if you have a larger monitor. If 
possible, avoid having them mask a portion of the document by resizing the
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document window. An overlap placement slows scrolling due to the extra 
screen refreshing.

With the Templates, Palettes, and Tools windows removed, the screen is 
remarkably simple (Figure 6.2). The ruler is thin and is always at the top 
of the screen, never usurping window space in the body of the text nor 
scrolling out of view. You can even remove the ruler with the Format menu 
if desired. At the bottom of Figure 6.2 is the status bar. You can resize, drag, 
close, or scroll the document window in the customary Macintosh fashion.
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The process of one-dimensional water transfer in unsaturated 
Isoil can be described by the well-known Fokker-Planck equation:
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where 0 is the volumetric water content (LVL3); z is depth (L) 
jpositive downwards; t  is time (T); K is hydraulic conductivity (L/T), a 
function of 0; D is diffusivity (L2/T) defined by D = K(0) dh/d0, where 
|h is soil suction (L) relative to atmospheric pressure; and C is the 
capacity ( 1/L) defined by C(e) s -  de/dh.|

Figure 6.1 M a t h W r i t e r  main screen configured for mathematical work
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Up to ten documents can be open at once. This is not an inherent limitation, 
but a reasonable limit since active files are RAM-resident for increased 
editing speed.
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Use Finder, rather than MultiFinder, if you have only 1 megabyte of 
memory. We strongly recommend that you use more than 1 megabyte of 
memory and use Math Writer with MultiFinder; remember to increase the 
Application Memory Size to make this additional memory available for 
larger documents. While at the MultiFinder level before activating 
MathWriter, use the Get Info command on the File menu to set this before 
activating MathWriter.

« File Edit Format Palettes Diac Style Windows

Figure 6.2 M a t h W r i t e r  main screen configured without m athematical tools

The Apple operating system 7.0 will let you increase the size of documents 
arbitrarily by supporting memory management for virtual memory. 
MathWriter retains only the necessary parts of itself in memory, obtains 
additional segments from the disk as needed, and automatically purges 
unused parts. That leaves unused RAM for your current document, which is 
memory resident. The thin lines in the "Base" panel of the status bar 
(Figure 6.1) indicate the relative utilization of RAM, as discussed later in 
this section.
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Ruler and tabs

MathWriter is paragraph-based and the Ruler refers to the 
paragraph that contains the blinking insertion point. Note that you 
end a paragraph by pressing the return key. The Ruler displays the 
tab settings for the current paragraph, the paragraph with the 
flashing insertion point. The tab wells at the right of the document 
window, just above the vertical scroll bar, contain left, right, center, and 
user-defined character alignment tabs; this placement avoids a reduction in 
the critical vertical dimension of the screen, necessary for displayed 
equations. Double-click in the Ruler to select ruler options for uniformly 
spaced tabs.

To place a tab, drag one from the well and pull it into the text area to 
decide its exact placement (or place it directly on the Ruler). When 
released, the tab icon snaps to the ruler as if attached to a rubber band. To 
remove a tab, drag it off the right end of the ruler past the print boundary 
indicated by shading Jp  on the Ruler. Double-click on a tab in the ruler to 
open a window for additional control or to choose a tab leader and 
alignment symbol. You can assign an arbitrary alignment character, such as 
an equals sign used in mathematical writing, rather than the traditional 
decimal-aligned tab.

To obtain left, right, full, and center line justification for paragraphs, p a 
locate the icons just below the tab supply and click on the one you _w 
want. Justification applies to the paragraph that contains the blink- m-m 
ing insertion point or to multiple paragraphs of selected text. The 
usual text selection techniques such as dragging, shift clicking, etc., 
apply; however, to identify a paragraph for justification or tab placement, 
you only need to place the insertion point within that paragraph.

MathWriter automatically passes the ruler settings from one paragraph to 
the next when you press the return key. If you change the ruler settings, a 
small ruler icon on the left border of the window identifies ruler changes 
unless you use Hide Messages on the Format menu to hide this and other 
message icons such as memo notes and sidebar indicators.

The status bar

♦
0

B ase O i i L I ,  CO Geneva 12 a
Figure 6.3 MathWriter status bar

The status bar at the bottom of the document window (Figure 6.1 and 
Figure 6.3) contains information about the position of the insertion point 
within a mathematical expression ("Base" in this figure) and the adjacent 
text. Figure 6.4 shows examples of the insertion point in mathematical 
expressions and in a table. With the insertion point adjacent to the "1", the 
first up arrow indicates an exponent placement and the down arrow
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The cursor

indicates that the exponent has a subscript. In the second example the 
cursor is adjacent to the subscript and the down arrow indicates this.

1,1 IE

2,1 2 ,2

to, 4. [(1,2) Base ] 0

Figure 6.4 Insertion point position within a mathematical expression

When the insertion point is in a table or matrix, the status bar gives the 
row and column number of the element you are editing (Figure 6.4). A thin 
horizontal line in the "Base" panel (Figure 6.3) shows the fraction of RAM 
in use. The solid line represents actual usage and the dotted line represents 
the additional usage that can be purged by Math Writer if necessary. As 
mentioned above, MathWriter documents are memory resident so you 
should allocate as much memory as possible to MathWriter.

Also on the status bar in Figure 6.3 are the horizontal scroll bar; the 
position of the insertion point within the document, line 1 and character 0; 
and the current font, font style, and font size, which are plain, Geneva, 12 
point. During computation-intensive operations like reformatting or 
loading a file, a progress indicator appears in the typeface indicator box 
also. MathWriter  reformats off-screen text in the background when it is 
processing no new commands; you can follow its progress in the insertion 
point locator panel. The font typeface panel appears in inverse type 
(white letters on black background) when the automatic math options on 
the Style menu are in use. Brackets enclose this typeface indicator when 
you enable automatic revision tracking.

The MathWriter cursor changes to convey 
information about operations that are possi * I X +
ble or in progress. The first row of Figure 6.5 
contains the arrow, the I-beam, the split I-

© F0 * 4(|)»

beam, and the sidebar tools cursors. The cur
sors of the second row are variations of the

% 'Q Fo ' a

sidebar cursor. Sidebars are rectangular por <5 3
tions of the page isolated from the rest of the 
page. 1 d m m

Figure 6.5
Cursors in the third row indicate when the MathWriter icons
text cursor has moved into: the main body of the manuscript, the header, 
the footer, the footnote, or the text sidebar, respectively. Because Math- 
Writer allows you to edit these different sections of text without opening
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separate windows, you need to know into which portion of the document you 
have moved the cursor.

If you have trouble identifying the region in which the insertion point is 
located, select Show Layout on the Format menu. That displays the dotted 
lines that separate the different regions of the document. In addition, a 
pop-up window on the status bar at the bottom of the screen tells you 
whether you are in the "Body," "Header," or "Footer" (Figure 6 .6 ).

0, 1 , 1 j_i_■_LLj_i_i_1

-------- Mill Shorn layout —
■ i . 12. i , 1 i i i 15, i , | , i , |4, i , | . i , 15,

\ ‘ A

Page -  1 Th is is  the header area. M V  trea ts  this a s  a m ini M V  document 

Which you can edit w ithin the sam e window. See Page Layout and Document 

Format on the File menu for controls.

j This is the text region. Show Layout displays the 
boundaries of the text body, headers, and footers using 
dotted lines. Cursor shape changes also identify the 
Regions.

IB) Body

B Header -  Every  page 

Cl Footer -  Every  page

Figure 6.6 Show layout and pop-up region locator

Floating windows

Palettes window
The floating "Palettes" window contains the Greek alphabet and any rows 
of symbols from the "Palettes" pull-down menu that you choose. You can 
modify, move, or remove the floating Palettes window (Figure 6.7). It 
responds to the shift  key for uppercase Greek letters. To place the floating 
Palettes window on the screen, select it from the Windows menu. Then click 
on the name of a row in the Palettes menu, rather than on the specific 
symbols, to copy a row of symbols to the floating window. You can remove a 
row by clicking on it again in the Palettes menu. You can reposition the 
floating Palettes window by placing the cursor just below its close-box and 
dragging it (more easily seen in Figure 6.1).

□ a JL 8 e F| 0 X K X JL V 0 a p a X V * JL t to JLill
Figure 6.7 Greek alphabet in the Palette window
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Templates window

Smart Templates, the templates on this window, supply templates for 
fractions, radicals, products, summations, integrals, set operators, special 
structures such as limits, grouping brackets, vectors and matrices, and 
tables. Each of the ten icons in the Templates window (Figure 6 .8 ) contains 
two to ten options in pop-out menu format.
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Figure 6.8 Templates window

To use the templates, click on the category icon to unfold the list and drag to 
select—just as you do with pull-down menus.

MathWriter 1.4 users:
Remember to drag to select from the new pop-out menus.

Alternatively, you can activate these menus from the keyboard. Press and 
hold command (Si) and type a numeral key (1-9, use 0 for number 10) to 
select a menu (e.g., Si 1 is the fraction menu). Then type the numeral 
displayed adjacent to the desired icon. If you do this without a pause, the 
menu does not unfold to remind you of the choices. Any invalid keystroke 
aborts the choice. (MathWriter displays tiny numerals within the specific 
icons when you use keyboard access.)



2 3
= 7_

1. The first fraction (96 1) option displays the 
numerator and denominator in the current font size.
The second option immediately decreases the font 
size for smaller in-line expressions. The third option produces a slanted 
fraction line. MathWriter automatically draws the fraction bar long 
enough to accommodate the length of both the numerator and denominator 
and automatically centers the shorter expression. Press enter to move from 
the numerator to the denominator. Press return at any time to immediately 
return to the baseline.

1 =  R
2. Three choices of radicals (96 2) are available.
The first is the usual square root, the second allows 
you to supply a root, and the third is for long 
division. Press enter to move from within the radical to the second entry, 
the root. Press enter to leave the structure.

3. The product symbol template (96 3) allows you to 
place limits above and below the product symbol or to 
the right of the product symbol to conserve vertical space 
for in-line expressions. MathWriter automatically positions the cursor in 
the lower portion and reduces the font size. Supply the lower limit, and 
press the enter key to move to the upper limit. Supply the upper limit and 
press enter to return to the baseline to enter the function. The limits can be of 
arbitrary complexity. Use the split I-beam to edit within the limits. Press 
enter to move the insertion point to the base level. 4

n

4. Like the product symbol template, the summation —
template (96 4) allows you to place the limits above and 2  2l — 
below the symbol or to the right to conserve vertical 
space for in-line expressions. MathWriter  automatically positions the 
cursor in the lower index and reduces the font size. Supply the lower limit 
and press enter to move from the lower limit to the upper limit. Supply the 
upper limit and press enter to move to the baseline to supply the function. 
The limits of integration can be of arbitrary complexity. Use the split I- 
beam to edit within the limits. Press enter to move the insertion point to 
the base level.

1 , -j : j u m *_ §
5. The integral (96 
5) can be single, 
double, or triple, 
and you can place the limits either adjacent to or above the integral sign. 
Supply the lower limit and press enter to move to the upper limit. Supply 
the upper limit and press enter to move to the baseline, and then supply the 
integrand. The limits can be of arbitrary complexity. A contour integral is 
available. Press return to move the insertion point to the base level; if de
sired, use the split I-beam tool to edit within the limits again. To resize
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the integral for larger integrands, use Calc Prev on the Format menu or Si D 
with the insertion point positioned to the immediate right of the inte
grand. Make arbitrary size adjustments and vertical positioning adjust
ments using the Character Editor.

6 . The union and intersection operators (Si 
6) also accept limits. Press enter to move 
from the lower to the upper limit and again 
to move back to the baseline. Use the split I-beam to edit the limits.

11 — 2 ---- 3 4

L iL n u  = n  =

H i 2 3 4 5 6 7 8 9 10
H det gcd inf lim  inf lim sup m ax min Pr sup

7. The 
special 
function
menu (Si 7) contains constructs that include expressions centered below the 
operator name. Press enter to return to the baseline. Use the split I-beam to 
edit the limits. Unlike m  on the Tools menu, the name remains a unit.

8 . Grouping brack
ets (Si 8) include 
multiple rows
grouped on the left or right with braces, brackets, parentheses, and angle 
symbols. Use the split I-beam to edit within the structure. Press return to 
change rows and tab to change columns.

’{  =  2= } 3[ =  4= ]  5( = 6= ) 7< =

9. Vectors,
[:]

determinants
(Si 9) can have an arbitrary number of rows and columns. MathWriter  
provides various enclosing symbols. Use the tab key to change or create 
columns. Press return to change or create rows. Math Writer automatically 
formats the matrix as you type each keystroke. Use the split I-beam from 
the Tools window to edit inside a cell or within an expression inside the 
cell. Click inside a cell to outline it with a box (Figure 6.9). Click outside 
the structure or select the I-beam tool to return to normal typing. Click on 
the appropriate box in Matrix Format on the Format menu to specify the 
placement, line thickness and pattern, justification within cells or ele
ments, and row and column spacing of cells.

To modify the format of previously typed 
expressions, simply select the expression 
before using the Matrix Format command. To 
add or delete a row or column, select a cell 
within that row or column and then use Insert 
or Delete from the Edit menu.

'> [§
3 4

Figure 6.9
Edit inside structures
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1
10. The last menu produces tables (96 0). You can box the 
entire table or each cell individually. MathWriter 
treats tables as matrices with additional horizontal and 
vertical rules. Click on the appropriate box in Matrix Format on the Format 
menu to specify the placement, line thickness and pattern, justification 
within cells or elements, and row and column spacing of cells. To modify the 
format of previously typed expressions, simply select the expression before 
using the Matrix Format command. Use the split I-beam from the Tools 
window to edit a cell (outlined with a dotted box when you click within a 
cell) or an expression within the cell. Click outside the structure to return to 
normal typing. Press option to temporarily change from an I-beam to a split 
I-beam cursor.

Also, with the Templates window you can select any mathematical 
structure and replace it with any other structure from the same row in the 
Templates window without retyping it. For example, you can convert a 
matrix into a determinant this way.

Tools window

The floating Tools window (Figure 6.10) serves multiple 
purposes. Use the split I-beam cursor to place the inser
tion point inside an existing mathematical structure.
The full I-beam allows you to place the insertion point 
in ordinary text. The small, vertical, up and down ar
rows move the insertion point above or below a symbol, 
reduce the font size, and center the subsequent input. The 
slanted up and down arrows position superscripts and 
subscripts. Clicking the bottom icon is equivalent to 
pressing the enter key and will move you out of super
script or subscript mode and back to the baseline or to the 
level on which the insertion point was before you 
clicked on the slanted up or down arrow. See appendix 3 for a table of key
board equivalents.

1 1

* +

X !
A

Figure 6.10 
Tools window

The sidebar (+) tool (Figure 6.1 and Figure 6.10) lets you create and edit 
sidebars. A sidebar is any rectangular portion of a page that is isolated 
from the rest of the text as a minidocument with separate formatting rulers 
and wordwrap. Sidebars can contain pictures or text containing 
mathematical expressions.
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The Main Menu Commands

# File Edit Format Palettes Diac Style Windows

The Apple#Menu
The Apple(tf) menu contains infor
mation about the application and 
provides access to the desk accesso
ries (Figure 6.11). Use the Font/DA 
Mover to modify the list.

About MathWriter™ 2.0

About MathUJriter™ 2.0...

Alarm Clock 
Chooser 
Control Panel 
Key Caps

Figure 6.11 The tf menu

This window displays credits, copyright, and trademark notices. The 
copyright notice is a reminder that illegal copying of this intellectual 
property constitutes theft, and that end-user technical support is provided 
by the publisher, Brooks/Cole Publishing Company, rather than Cooke 
Publications. Click to close the window.

MathWriter™ *"**2.0
Math Writer11'1 is a trademark o f  :

C ook e  Publications, Ltd.
221 Langm uir Lab
C ornell B usiness and T ech n o log y  Park 
Ithaca, N Y  14850

© 1990 Cooke Publications, Ltd. ALL RIGHTS RESERVED.

Distributed by: For service, support, and sales
BrooksfCole Publishing Company Phone: (408) 373-0728  
511 Forest Lodge Road Fax: (408) 375-6414
Pacific Grove, CA 93950 Bitnet: D2248@applelink@INTERNETt

Spell Finder® ami Word Finder'™ © 1986-90, Microlytics™, Inc., UFO Systems, Inc., ami Xerox Corp.
Hyphenation © 1985-90, Microlytics™, Inc. and Xerox Corp.

Project D irector: J. Robert Cooke 
Program m er: E. Theodore Sobel

Written with MPW Pascal, C, and Assemller

Figure 6.12 The About M a th W riter  2 .0  window
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Desk Accessories
The names of desk accessories currently available to the system also 
appear on the Apple menu (Figure 6.11). Use the Font/DA Mover1 to 
modify this list. See the Macintosh Utilities manual for a discussion of 
desk accessories. The Font/DA Mover should be used under Finder, rather 
than MultiFinder. Math Writer's Font Table in the Windows menu is a 
generalization of the Key Caps desk accessory; it allows you to "type" 
characters directly using the mouse.

The File Menu
The File menu (Figure 6.13) contains the customary Macintosh file 
management commands. A file named "Untitled 1" (or one of your 
choice in File/Preferences) opens automatically on startup or when 
you use New (but not a submenu) in the File menu. In addition, New 
opens a submenu (Figure 6.14) that displays a list of your default 
files.

New
The New command together with Preferences on this menu allows you 
to set ALL of the default settings and create custom configurations of 
MathWriter; the default fonts, font sizes, and font styles within the 
headers, footers, and main body of a document; the palette choices; 
the library files you search with the glossary; the user-defined 
styles; and the page layout and initial file contents including current 
date markers. Such startup files are called stationery or MW Default 
files.

You can create a stationery file for each distinctive type of document 
you use and designate one of the stationery files as the default, using 
Preferences on the File menu. When you choose from the submenu 
MathWriter copies that particular stationery. For example, you can 
create a standard memo form that includes your letterhead, footers, 
common text, and the current date. Math Writer automatically keeps 
the date current. If you place several stationery files in the system 
folder, their names appear on the submenu of the New command for 

convenient selection. An unused stationery file automatically closes if you 
open an existing file without making any change to the stationery file.

File
New ►
Open...
Close 9€IU
Saue 3€S
Saue Os...
Saue a Copy...
Import Graphics File...

Preferences...

Doc Info...
Page Layout...
Doc Layout...
Doc Preferences...

Oueruiew...
Print... §€T

Quit

Figure 6.13 File menu

Open... ( 960 )

Use Open... to open an existing file. Note: The three dots following the 
word "Open" indicate that you have to supply additional information to 
complete the command. When you click Open..., a dialog box appears

1 Or SuitCase™ II, for example.
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(Figure 6.15). The name of the current drive appears at the top right. If you 
press Eject, the computer ejects the disk. Pressing Drive moves you from one 
drive to another. The pull-down menu, here labeled MW 2.0/ lists folders 
on the current disk and lets you choose one. Use Open to open the file you 
selected from the window or use Cancel to abandon it.

New 1. Dissertation Title.def
2. Copyright, def
3. Abstract.def
4. Biographical Sketch.def
5. More Prelim.def
6. Chapter.def 
Ch Template.def 
cpI memo.def 
CU memo.def

Figure 6.14 Example of a New submenu showing default templates

' cpl-21

!_□ • Mill demof R S

File Type: ■ /All known types

Figure 6.15 Open dialog

cd  cpl-2

[ Eject  1

[ Driue ]

[ Open ]

[ Cancel

Press All Known Types on the pop-up menu shown in Figure 6.15, and Math- 
Writer presents a list of allowable file types. The names of files already 
opened are excluded from the list. Drag to select the file type you wish to 
have appear in the list, and the scrollable window displays only files of 
that selected type. All Known Types are the file types chat MathWriter 
can read with its present configuration. Initially, the file type, pop-up list 
includes MathWriter 2.0 files and text files. Text files are those that have 
been saved in a default font and have very limited formatting information. 
MathWriter also saves the graphics and mathematical expressions in a 
named scrapbook file when you create a Text file.
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A translator for Microsoft's Rich Text Format (RTF) for file interchange 
among various word processors appears (in italics) in the File type list too, 
when placed in the folder with MathWriter  or in the system folder.2 The 
RTF files do preserve character formatting and graphics within the file 
during import. Non-WYSIWYG, embedded text commands for generating 
mathematical expressions imported from Word® 4 RTF files are translated 
into fully editable, WYSIWYG expressions in MathWriter!

Use MathWriter 2.0 file type, MathWriter's  own format, to keep the 
formatting and configuration information you chose when you created your 
document for subsequent printing and editing sessions with MathWriter. 
MathWriter automatically restores this environment when you open the 
file later.

The preservation of font choices when a file is opened on a different 
computer is crucially, not just cosmetically, important. Unlike alphabetical 
characters, the special symbols used in technical writing do not have 
standard keyboard assignments so an unintended font change will probably 
change the content of your document. MathWriter  uses font names, rather 
than computer-specific font identification numbers, to prevent unintended 
substitutions. MathWriter  uses this checking process for both native 
MathWriter files and RTF files when opened. If you use the File Warnings 
option in the File/Preferences dialog (Figure 6.19), MathWriter issues a 
warning message if a font used in the file you open is not available to your 
system. If a PICT displays correctly in the originating MathWriter file, it 
will display correctly when opened on another computer having the 
required fonts installed. In contrast with conventional Macintosh word 
processors,Math Writer preserves file integrity, even when transmitted by 
network to a different computer, provided identical font files are used.

Close (Sew)

To close the active file, click in the close-box at the top-left corner of the 
active window or choose the Close option from the File menu. If you have 
made changes since the last save, MathWriter  gives you an opportunity to 
save a permanent copy of the document in a file. Remember the RAM- 
resident copy will be lost unless you save it as a file!

Save (9SS)

Save makes a disk copy of the active window document using the 
previously assigned file name and path. If you have not assigned a name, 
the Save As... dialog box appears so that you can assign one. If you have a 
power failure, the computer will lose the memory resident copy. Save your 
document frequently. We recommend that you click Auto save and Auto 
backup/Doc Preferences in the File menu to enable Auto save and Auto 
backup for additional protection. During a file save operation the Auto

2 The RTF filter may be shipped separately, and will initially open, but not save files.
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backup command retains the previous version of the file by appending 
".backup" to its name before making a new copy. If a ".backup" file already 
exists, MathWriter replaces it with the new ".backup" file. This approach 
assures that the two, and only two, most recent copies are preserved.

MathWriter does not compute the size of a file before executing the save 
command. Therefore, if insufficient disk space is available to save a 
complete copy, the partial file (and the older copy) will be deleted and you 
will be prompted to insert a disk with sufficient space. Save a copy 
IMMEDIATELY.

Save As...

The Save As... command is similar in function to Save except that a 
window appears on the screen in which you can type a name for the file 
(Figure 6.16). This window also offers a pop-up list of allowable file types. 
If you have already saved the active file with a different name, 
MathWriter closes it with the contents unchanged and applies the new 
name to the current file, which remains open, and creates a copy with this 
new name. Again, we recommend that you use the Auto save and Auto 
backup commands in Doc Preferences of the File menu for added safety and 
convenience, especially when you are composing original material at the 
keyboard.

Figure 6.16 Save as dialog

MathWriter™ 2.0 format

This format preserves your complete document and all document-specific 
configuration information. Always save a copy in this format; other 
formats may not preserve all the information needed to resume editing.
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MathWriter Default File

The MathWriter Default File selection saves your Math Writer document 
configuration, placing it in the New submenu (on the File Menu), and for 
potential use as a startup file. Pull down the File menu to New to reach the 
submenu and drag to the file name you want to copy. The original is not 
affected.

TEXT file

Virtually every word processor can read or translate the TEXT file type. 
When MathWriter or any other word processor reads such a file, the file 
may not look on screen as it looked originally because TEXT preserves only 
limited formatting information. In particular, the character formatting 
(font, size, and style) and graphics are not preserved.

You can save text files in two formats. Text only is the more common format 
and retains the markers for paragraphing. Text with line breaks places a 
paragraph symbol and creates a new paragraph at the end of each line.

"Save equations in scrapbook" is MathWriter's automatic scrap feature. It 
automatically extracts graphics and mathematical expressions, converts 
them into PICT form, and places them in a Scrapbook file for use with 
other applications (Figure 6.17). This lets you use them in a page layout 
program or other application without having to collect them manually. If 
you desire, you can add a numbered marker to the text file to facilitate the 
reconstruction of the document. You can edit the symbols surrounding the "#" 
symbol in the box following "mark location in text with:."

To use a named Scrapbook file with the standard Scrapbook desk accessory, 
you must temporarily rename the existing "Scrapbook File," rename the 
created file as "Scrapbook File" and place it in the system folder.3 

MathWriter stores the equations as PICTs (the object form used by 
applications such as MacDraw™) and provides three grouping levels. The 
lowest level enables you to edit each character with draw programs. The 
middle level is satisfactory for most purposes. The last level preserves 
entire lines of text that contain mathematical expressions or graphics; use 
this option to transform a file of displayed equations into a scrapbook. To 
transfer individual mathematical expressions to other applications, use 
the Copy As Picture command on the Edit menu.

3SmartScrap™  can read scrapbooks located anyw here on the disk w ith any name.
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RTF and other filters

TEHT options:
(§) Tent only
OTent with line breaks

^  Saue equations in scrapbook 

Mark location in tent with: 
Name of Scrapbook file:

(* # *)

Demo.tent.PICT

Equation parser will conuert...
O each symbol into a separate PIC1 

®  groups of symbols into separate PICTs 
O entire line containing symbols into a PICT

Cancel 11 s°ue 1

Figure 6.17 Automatic scrap saves graphics and equations to a scrapbook

The list of file types that MathWriter  can read and write will change as 
other translators (or filters, as they are also called) become available. As 
indicated above, place a translator, i.e., filter file, in the same folder with 
MathWriter or in the System folder, and MathWriter automatically 
updates the File Type list you see here to include the new filter file. You 
must save a document in the standard MathWriter format to retain all the 
information required for further editing within MathWriter. Filters can 
support one- or two-way translations4 between MathWriter  and other 
applications. Some translators may preserve only a subset of formatting 
information used by MathWriter—the minimal information required by 
the receiving application. Other file types may save all the information 
required to restore the original MathWriter file.

Save a C o p y -

Save a Copy... allows you to save a snapshot of the current file, including 
the changes since the last save, under a different name, different file type, 
and different disk. The dialog box is the same as with the Save As... 
command. In contrast with Save As..., however, neither the name, the file 
type, nor the status of the active file is affected. The pop-up list of file 
types includes MathWriter 2.0, MW Default File, Text, and the names of

4 The M athW riter RTF filter reads files from all word processors which export in this format.
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Import Graphics File...

optional translators. To use the optional types, simply place the 
MathWriter filters or translators in the folder with MathWriter or in the 
System folder, and MathWriter adds them to this list at startup. Although 
MathWriter reads text and RTF files (and eventually other formats, too), 
use the MathWriter format for documents that you intend to edit or print 
later using MathWriter.

Import Graphics File... allows MathWriter  to read graphics directly from 
a file, without the need for the application in which you created the 
graphic. Therefore, you can directly transfer MacPaint, PICT, and 
encapsulated PostScript files into a MathWriter  file even on a 1 megabyte 
Macintosh. You do not have to pass the graphics through the Scrapbook or 
switch between applications, but some cropping within MathWriter may be 
necessary with directly read graphics.

B) JRC to print 072789]

®  JRC to print...

[ EJect 1
[ Driue ]

[ Open ] 

Cancel ]

Figure 6.18 Insert Graphics dialog window

o

File Type: v/RII Graphics Types 1
MacPaint
PICT
EPSF

MathWriter displays folders in the scrolling window and the files that 
are the file type(s) designated in the pop-up menu: All Graphics Types, 
MacPaint, PICT, and EPSF. You have the usual commands for moving 
among disks or within folders on a disk, as described above for Open....

Preferences...

Preferences... on the File menu (Figure 6.19) allows you to set global 
defaults to configure Math Writer for your needs. In contrast with document- 
specific conditions set in Doc Preferences, Preferences... lets you establish a 
default configuration for the primary startup file and for the New
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command on the File menu. These startup files are called "stationery". You 
can create stationery for each distinctive type of document you use and 
designate one as the default.

First, choose any combination of the five floating windows (Templates, 
Palettes, Tools, Font Table, and Library) for MathWriter  to place on the 
screen when you start up.

Preferences...

Palettes
□  Geometry
□  Operators
□  Math/Calculus
□  Sets
□  Logic
□  Arrows
□  Misc.
□  Brackets
□  Uariables

Windows

□  Templates
□  Palettes
□  Tools
□  Font Table
□  Libraries

I—I Load 
u  Libraries

r  i

Use current libraries
L J
f
Use current window setup

[no default file]

^ 3 ^
Save copy of file /x-Jx +i /xdx

as Default File

k

/x-dx I 1. --  '
1 =

—

□  Auto Screen Aefresh
□  File Warnings

Cancel r ° o
Figure 6.19 Preferences window

Next, designate which Library files in the Windows menu you want active 
on startup. Libraries are generalized glossaries that expedite the typing of 
repeatedly used text, graphics, or mathematical expressions. You can select 
any combination of special purpose libraries.

When a library is active, MathWriter compares each word in the input 
stream (delimited by spaces) with the abbreviations in the selected 
libraries. When MathWriter finds matches, it automatically substitutes 
the library entry for that abbreviation. You can also double-click on a 
library entry to "type" it.

Use the Library submenu of the Windows pull-down menu to create or select 
libraries. After you select the combination of floating windows (Tools, 
Templates, Palettes, or Font Table) appropriate to your routine needs and 
position them on the screen according to your personal preferences and your 
hardware configuration, store these choices in the MathWriter Prefs file 
with a single click. Then use the Use current window setup button to store 
these choices in the MathWriter Prefs file.



In addition, MathWriter stores document-specific preferences in stationery 
or default files. These files contain all other configuration choices such as 
default font, font size, and font style in the body, headers, footers, and 
footnotes, as well as text and graphics common to a specific type of 
document, such as an automatically dated memo with a logo. In the Style 
menu select which font, font size, and font style you want.

Click Save copy of file as Default File (Figure 6.20). The ensuing dialog box 
gives you a chance to name the default or stationery file and save it. The 
Select Default File (Figure 6.21) button opens a box that lets you select a 
previously created stationery file.

e=>JRC-1

[ E je c l ] 

[ lUiiHi ]

[ SaL,e )

[ Cancel ]

Figure 6.20 "Save copy of file as Default File" dialog box

Default File...

Untitled A File

c=iJRC-1

□ Company Letterhead 
D Memo A File

O oJR C -1

CD misc [ 1<« * 1

□  M 1112.Of 
CD Personal A Files

[ Brii»e ]

□ Uniuersity Letterhead
[ Select ]

Cancel

None ]

The name of this default appears in the top-right comer of the Preferences 
dialog box. On startup, Math Writer retrieves a copy of the selected default

Figure 6.21 "Select Default File" dialog box
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file if one exists. To override this default, change the choice of the 
stationery file using the Select Default File button. You can manually open 
these default files, too. Click OK to accept changes made or use Cancel to 
abandon your choices.

The Auto Screen Refresh option (Figure 6.19) provides supplemental, timed 
screen refreshing. Ordinarily MathWriter redraws the screen locally and 
only as needed to minimize computational overhead. Use this option for 
additional automatic refreshing and option Z for supplemental manual 
redrawing of the entire screen.

The file warning option enables advisory messages when you open a file. A 
warning of missing fonts, discussed in connection with the Open command, is 
often crucial to assure file content integrity. The names of missing fonts are 
listed. The enable/disable status of automatic file saving and revision 
tracking are noted when files are being opened. In addition, you are 
notified if the file you are opening still contains marked revisions.

The conditions established or reported by File/Preferences apply to all 
documents. Use File/Doc Preferences to establish document-specific 
conditions.

Doc Info...

In the Doc Info... window you see that MathWriter automatically tracks 
the number of sessions, the creation date, the date last modified, and the 
size of your document file (Figure 6.22). The Abstract/Notes box lets you jot 
down notes about the file.

Abstract/Notes:

Se ssion s: 
Creation date: 

Modification date: 
Size on d isk :

Space fo r  ke yw ord s, a b stra c t,  and notes

8
Sep. 4 , 19 9 0 , 1 1 :3 4 :1 0 PM  
How. 2 7 , 1990 , 9 :2 3 :3 2  AM  
171 ,069  b y te s (1 6 7 K )

Page s: 16  
Paragraphs: 1 0 6  

Lines: 3 4 8  
Words: 3 5 0 3  

M em os: 0

Unique rulers : 1 6  
Unique s ty le s : 14  

Style runs: 104

Characters 
on base line : 2 0 ,8 0 6

in sub-expressions: 1 5 5
containing sub-expressions: 1

Total: 2 0 ,9 6 1

n n r i

Figure 6.22 Doc Info window



When you open the Doc Info... window, MathWriter  counts the number of 
pages, paragraphs, lines, words, equations, memos, characters on the 
baseline, characters in subexpressions, and characters containing 
subexpressions of your file.

Page Layout...
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The Page Layout... command on the File menu controls the page layout 
specifications for the document (Figure 6.23). The portrait at the right 
illustrates a sheet of paper. The outer rectangle is the size of the paper; 
the inner is the print area. The portrait changes to illustrate your choices of 
columns, margins, etc.

"Columns" lets you choose the number of columns on a page. You can increase 
or decrease the size of the margins by clicking in each respective box and 
changing the values. Supply units abbreviation (without punctuation) of in, 
cm, or pt according to the units set in Format/Ruler Options. Out-of-range 
values will be indicated by a "?"; invalid answers will not be accepted. 
|.250 in ? Clicking in the Max box gives a print area of 7.66 inches by
10.1 inches for an 8-1/2 by 11 inch sheet of paper. "Std" restores the 
previous values.

Page Layout. 

M a n )  [ Std

Columns O  1 ®  2 O  3 O  4

Page Setup...

Margins:

left

right

top

bottom

Header height: 

Footer height:

□  Gutter 

Column gap:

□  Facing pages

1.250 in

1.250 in

0.430 in

0.430 in

0.500 in

0.500 in

0.000 in

0.250 in
Page width: 6.00 in. Page height: 10.1 in.

Cancel ll— gg— 1

Figure 6.23 Page Layout window

MathWriter measures the margins from the physical edges of the paper, 
not the edge of the print area. The actual print area is smaller than the 
paper. For convenience, MathWriter  adds the width of the white border
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and any additional margin length excluded from the print area to get the 
margin measurements. The dimensions of the print area, including the 
headers and footers, appear just beneath the miniature portrait. You can 
add an additional binding margin (gutter) to the margin.

The gutter is the extra space in the margin needed for binding. If you choose 
"Facing pages," MathWriter reserves this binding margin on the left side of 
odd-numbered pages and on the right side of even-numbered pages.

The area with the lighter shading at the top and bottom are the headers 
and footers, respectively, and are within the print area. Headers and 
footers are always present, so set the header and footer heights to zero to 
assign this space to the main body of text. The contents of the headers and 
footers appear automatically throughout the entire document as specified 
in Doc Format of the File menu.

The column gap is the space between columns. All columns have a common 
width and a common column gap size. Click to specify the number of columns 
into which you want a page divided. MathWriter fills one column at a time 
and "snakes" to the next. The columns are editable.

Page Setup (Figure 6.23) lets you set paper size, reduction percentage, 
orientation, font substitution, text smoothing, graphics smoothing, and 
faster bitmap printing. Click the Page Setup button. Page Setup has 
ImageWriter options and LaserWriter options. Depending upon the printer 
you chose in the Apple menu, your screen shows ImageWriter (Figure 6.24) 
or LaserWriter (Figure 6.25) options.

The LaserWriter offers more controls than the ImageWriter. Click Options 
(Figure 6.25). LaserWriter Options (Figure 6.26) lets you flip the image 
horizontally or vertically, invert the image, use precision bitmaps, use a 
larger print area, or use unlimited downloadable fonts. The Larger Print 
Area option increases the print area to 8 inches by 10.7 inches. Click Help 
(LaserWriter Page Setup) (Figure 6.27) for an explanation of these terms.

ImageWriter___________________________
Paper: <D US Letter O 04 Letter

O US Legal O International Fanfold f cancel |
O Computer Paper ^ J

Orientation Special Effects: □  Tall Rdjusted
□  50 % Reduction
□  No Gaps Between Pages

Figure 6.24 ImageWriter options
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LaserWriter Page Setup_________________________ 5 2
Paper: (•) US Letter O R4 Letter O Tabloid 

O US Legal O B5 Letter
Printer Effects:
□  Font Substitution? 
^Te»t Smoothing?
^  Graphics Smoothing?
E3 Faster Bitmap Printing?

Reduce or [r 
Enlarge: Li

Orientation

©

f Cancel] 

[ Options 

( Help

Figure 6.25 LaserWriter options

LaserWriter Options V5 1 ff nv. i

la
j n  Flip Horizontal Cancel ]

□  Flip Uertical
□  Inuert Image
□  Precision Bitmap Rlignment (4% reduction)
□  Larger Print Rrea (Fewer Downloadable Fonts)

Figure 6.26 LaserWriter options

LaserWriter Page Setup Help:

Font Substitution: If selected, the LaserWriter substitutes 
for New York, Heluetica for Geneua and Courier for Monaco

Smoothing: This is a fine-tuning feature that can make some tent 
and graphic bitmaps (such as from MacPaint™) look better.

Faster Bitmap Printing: Text and graphic bitmaps print faster with 
this option selected. Howeuer, some documents may not print.

LaserWriter Options Help:

Precision Bitmap Alignment: This option eliminates the minor 
distortion you may find in printed graphic bitmaps. It also prints 
faster. Howeuer, the entire page is reduced by 47o.

Larger Print Rrea: This option uses the entra memory in the 
LaserWriter to increase the print area instead of storing more fonts.

Times

Figure 6.27 LaserWriter page setup help
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If you make layout changes to an existing document, a "thermometer" type 
indicator appears in the typeface area of the status bar at the bottom of the 
screen while MathWriter is implementing the changes. Under normal 
circumstances you should set the page layout before creating your document. 
If you change the layout after you create the document, the column or page 
width could shrink too small for certain equations or graphics.

The Print Dialog lets you set LaserWriter print options.

First, designate the number of copies or which pages of the document 
you want printed. Then, under Paper Source, designate paper 
cassette or manual feed. Click OK to confirm the options.

For manual feed, go to the printer and wait for a steady middle 
yellow light. Then insert the paper face up. The LaserWriter 
draws in the paper.
Wait for the steady yellow light and insert the next sheet of paper, 
and so forth until the job is complete.

To print enuelopes: specify Landscape in Page Setup (File Menu) 
insert the enuelope face up with its long side against the right side of 
the guide.

See the LaserWriter manual for a complete description of manual feed.

Figure 6.28 LaserW riter help from the Print dialog box

Table 6.1 M inimum margins and maximum print areas for the LaserWriter

8.5 x 11.0 inch paper Normal Max Larger Print Area

w x h print area 7.66 x 10.1 8.00x10.7

Min left & right margins 0.416 0.430

Min top & bottom margins 0.250 0 .1 1 1

L ° ^ J

Doc Layout...

Doc Layout... of the File menu allows you to specify the placement of 
headers, footers, footnotes, and endnotes throughout the document by 
clicking on icons (Figure 6.29). For example, if you click the icon in the top- 
left corner of Figure 6.29, headers will appear on every page. Headers and 
footers can appear on every page, or you can skip the first page, skip the 
last page, or skip the first and last pages. You can specify that common 
headers and footers appear on all pages, that they be common except for 
the first or the last page, or that the left and right page headers and



footers differ. Note that left pages are even-numbered pages and right 
pages are odd-numbered pages.

Layout of headers, footers, and footnote/endnotes...

Same for all pages
i r - _ : r ___ ---

nn- - ~ - - - - - —  7,

W

“ P i

1
1

T~

A

T T~

A-----

4~

Left /Right pages

First page different

Footnotes Endnotes

t.A--- h.A---
T~
2

space before space between

io i i m s 0 1 Cancel L - g  ))
Figure 6.29 Document format window

Annotations can appear on the page where cited, or be collected at the end 
of the document. If you click the icon beside Footnotes, footnotes can appear 
on every page. If you click Endnotes, annotations will appear at the end of 
the document, as endnotes. The last three icons illustrated in the line with 
the footnote and endnote icons offer three styles for separating the footnotes 
from text. Click one to choose it. By dragging the scroll bar shown at the 
bottom of Figure 6.29, you can set the spacing between the text and footnotes 
(5-30 pixels) and between footnotes (0-20 pixels).

MathWriter automatically numbers footnotes and endnotes and automati
cally renumbers them if you add or remove a footnote or endnote. Even cross- 
references within the text are updated automatically.

To insert a footnote (or endnote), position the insertion point in the text and 
then select the footnote icon on the Palettes menu (or type 36 option F). To 
type a footnote's contents, move the cursor into the footer (not a separate 
window) and type. When you move the cursor into the footnote/endnote 
region, the cursor changes shape. The space for footnotes grows 
automatically upward as needed. MathWriter  adjusts the lower boundary 
of the main text to avoid a collision with the footnote. To avoid manual 
scrolling to insert the content and to scroll back to the insertion point in the
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body of the document, use the pop-up selector in the insertion point/selec- 
tion indicator in the status bar (see Figure 6 .6).

Doc Preferences...

Doc Preferences... offers a variety of options (Figure 6.30) for your 
document. On the left side of the Document Preferences window are several 
styles: Revision styles, Style 1, Style 2, Footnote/Endnote, and Auto
italics. Each of these styles has a specific function.

Document Preferences.

Styles:

( Reuision styles...

Style 1

Style 2...

Footnote/Endnote...

Ruto-italics style..

Ruto sane 
□  (Darn me before sauing 
Ruto backup during saues

1CH 5 minutes

E3 Compact file S  Smart quotes

n = R □  Reuision tracking [cleanup.

□  Fractional character uiidths

□  Line numbers
(•> per page 
O conUnuous Cancel C__ ^ __ iJ

Figure 6.30 Document Preferences menu

User-selected revision styles mark additions and deletions to an already 
existent document with a distinctive type. Styles 1 and 2 enable you to 
create and assign style combinations with a keystroke. Footnote/Endnote 
lets you set the footnotes or endnotes default style. And finally, Auto
italics lets you select a typeface combination for italicized variables in 
mathematical expressions without italicizing the numerals or function 
names such as sin and log, which are excluded using Auto Math Options on 
the Style menu. To avoid exaggerated italics on the screen display you can 
use the plain style of an oblique font.

Since the instructions for Style 1, Style 2, Footnote/Endnote, and Auto
italics are similar, let's look at only one set of instructions. You will be able 
to apply what you learn to the others.

Click on Footnote/Endnote. The Set footnote/endnote style... window 
appears (Figure 6.31). To select the font in which you want footnotes or 
endnotes to appear, choose Font by clicking the box to the left of Font. Then 
click the box to the right of Font to get a list of font choices. Select one. Note 
that the rectangular portrait box beneath Font, Size, and Style illustrates 
your choice. In a similar manner you can select the size of the font and



whether you want footnotes right-justified, left-justified, centered, or 
aligned (i.e., simultaneously left and right justified).

Set footnote/endnote style

g] Font jPalatinol

E3 Size [ O ^  Justification | Left 1

E3 Style ^select style... ^  Line spacing select spacing

PootnotBC/'onttnntes wifi appear like this. Jwti/kation& tine spacing a  
affected.

nppiy

Cancel

IL j ^ J
Figure 6.31 Footnote/Endnote dialog box

Now click the Line spacing... box. Then click Select spacing. The Line 
spacing... window appears (Figure 6.32). Here you can choose Automatic, 
Mostly fixed, and Fixed spacing. Automatic spacing automatically spaces 
lines according to the maximum size of an expression such as a 
mathematical equation. Mostly fixed allows simple subscripts and 
superscripts to protrude into the leading between the lines. Mostly fixed is 
a combination of automatic (or flexible) spacing and fixed spacing. When 
typing tall displayed expressions, mostly fixed reverts temporarily to 
automatic. Fixed lets you set spacing with the four buttons: Single, 1-1/2, 
Double, and Other. The ascent and descent for the three fixed spacings are: 
(9,3) for Single, (14,4) for 1-1/2, and (18,6) for Double. The Other category 
lets you set the ascent and descent separately. This is the control which 
allows you to squeeze an extra line onto a page.

To accommodate personal preferences and variety of fonts, you can set the 
vertical position in the number of pixels above or below the ascent, descent, 
or baseline. The baseline is the imaginary line on which a line of text rests. 
The descent is the imaginary line to which characters, such as g, j, p, q, y, 
and z, extend below the baseline. The ascent is the imaginary line to which 
stems of characters, such as b, d, f, h, k, 1, t, extend above the baseline. 
(Refer to paragraph formatting in Chapter 4.) The displayed equation 
adjustment allows you to set space above and below equations displayed on 
a separate line.
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Line spacing...

O  Automatic
(•) Mostly fined 
O  Fined

Fixed ascent

Fixed descent + leading

m .

S in g le  (6  lines/inch ) -&0-
1 - 1 / 2  (4  lines/inch )

Double (3  lines/inch) 

Other...

..CQiawto.mtli.lixie.,
(- 1)

T + T
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e l
Displayed equation adjustment

lOT..... U ............J
£ | 3 Cancel

L  ■ * _ !

Figure 6.32 Line spacing dialog

Click OK to accept your line spacing choices.

You can use automatic line spacing while composing a manuscript when you 
do not want to be concerned with making a line spacing choice. If your 
writing includes in-line expressions, you can modify the line spacing by 
selecting or highlighting the relevant text with the mouse or keyboard and 
applying the desired line spacing. NEVER compose built-up mathematical 
expressions using fixed line spacing because a portion of the text is likely to 
be clipped and the screen refresh for the line will not erase characters 
which extend outside the specified height. There may be instances when 
you will assign fixed spacing to previously created paragraphs which 
contain mathematics, however.

Next, let's look at styles. Click the Style box in the Set footnote/endnote ... 
window. Then click Select Style. This opens the Other styles window. Here 
you have an array of choices (Figure 6.33). Most of the boxes in the left 
quadrant of the window let you choose a particular style of font. Underline 
and Low underline offer additional options. Click in the box beside 
Underline. On the right side of the window, Underline pattern and 
Underline weight are now available. Click in the box beside Underline 
Pattern. M athW riter offers numerous underlining patterns. Click in the box 
beside Underline weight. This lets you choose the width of the underline.

Sometimes combining two choices can be desirable. For example, selecting 
both Underline and Words means that M athW riter underlines the words 
but not the spaces in your document. Underline and Low underline together 
produce double underlines.
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Figure 6.33 O ther styles

The last box in the group of font choices offers UPPERCASE, lowercase, and 
Cap. First as mutually exclusive choices. That lets you choose whether you 
want text in all capitals, all lowercase, or the first letter of each word 
capitalized, regardless of the shift key. Case changes can be applied to 
existing text without retyping.

The Condense-Extend box removes or adds one pixel, respectively, after 
each character. The Gray box opens a scroll bar for setting the percentage of 
gray. Background pattern gives you a collection of possible patterns for 
backgrounds. Usually a low (1-5 percent) range is appropriate. Finally, if 
you have a color monitor, Background color and Character color let you 
choose a color for the background of your text and one for text characters.

The extra computational burden associated with a color display can be a 
heavy penalty. To avoid this penalty, use the Control Panel on the Apple 
menu to set the Monitors to Black & White.

Click OK to accept your style choices.

To set text style for Style 1, Style 2, and Auto-italics, you follow the same 
procedures that you used for Footnote/Endnote. Revision styles, used for 
revision tracking, is different in several ways, however.

Open the Revision styles window by clicking Revision styles. Notice that 
you have the same choices of Font, Style, Size, Justification, and Line 
spacing that you had with Footnote/Endnote. Follow the same procedure 
with these commands that you followed with Footnote/Endnote.

Here, however, you have additional commands: Added text, Deleted text, 
New, and Rename. If you click Added text, the portrait box to the left
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illustrates how text that you add to your document will look. You can 
change that text by choosing a different font, style, etc. Similarly, if you 
click Deleted text, the portrait shows you how deleted text will look.

The New box enables different authors of the same document to choose 
their own style of text in which to add to or delete from the document. The 
New revision style window opens, enabling you to assign a new revision 
number or name to the style of text you chose. Click New to accept the text. 
Notice that Revision 2 has now replaced Revision 1 in the box to the left of 
the New command.

Clicking Rename opens a dialog box that lets you assign a person's name to a 
particular revision style. For example, Revision 1 could be assigned your 
own name. Close the Revision 1 window by clicking in the Cancel box or in 
the OK box. This returns you to the Document Preferences... window.

The procedure you follow to update revised text follows.

1. Disable revision tracking (J€ option R). This is a toggle control that 
alternately turns it off or on each time the command sequence is pressed.

2. Manually update the revision markings using UnRevise (Edit menu) to 
remove revision markings. To locate the marked text scroll through the 
document watching for the black change markers that are present in the 
left margin (unless you have chosen Hide Messages on the Format menu). 
Use Find/Replace with the Find pop-up menu set to Revision.

3. Use Cleanup (File/Doc Preferences) for automatic deletion of text 
marked for deletion and automatic removal of the style marking for added 
text. Individual paragraphs and specific text you select can be revised or 
unrevised using those commands on the Edit menu.

Several other options remain in this window. Look at the right portion of 
the window. If you click Auto save, M athW riter saves your document at 
intervals, the length of which you determine with the horizontal scroll bar 
to the right. Click Warn me before saving if you want M athW riter to tell 
you it is about to save your document and give you a chance to decline the 
save. If you click Auto backup during saves, M athW riter automatically 
makes a backup of the previous version of your file in addition to saving the 
current file. Auto backup causes the previous copy to be retained. Compact 
file reduces the file size by eliminating data added for faster scrolling, 
which can be regenerated when needed.

Click on Smart quotes to replace the typewriter style "quote" and ’apostr
ophe’ with the curved style "quote" and 'apostrophe' some prefer. Frac
tional character widths let you control the character spacing more finely 
than the 1/72 inch resolution of the screen pixels. This option might be used 
when fine control is important, such as when using fully justified (left and 
right) text. Because this option sometimes makes the screen display less



readable, enable this option immediately prior to a final review of the 
manuscript before printing.
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NEVER use fractional widths with documents which contain mathemati
cal expressions. When using this system call, verify that the printed results 
are satisfactory.

And finally, if you click Line numbers, M athW riter numbers the lines of 
your text in the left margin—on the screen and on printed copy. You can 
choose whether you want the numbers to be continuous throughout the 
document or begin anew with each page. When you use the per page option, 
remember to supply page numbering so reviewers can refer unambiguously to 
specific passages. Note that separate numbering is not provided for 
columns.

When you have completed your preferences for the document, click OK to 
accept changes or click Cancel if you do not want to make any changes in 
this window.

Overview...
Overview on the File menu produces a collection of miniature portraits of 
the pages (Figure 6.34). M athW riter automatically calculates the number 
of pages that will fit on the screen. Use the scroll bar to select additional 
sets of pages. If you need a larger or smaller scale, drag the square handle 
on the bottom-right corner of the top-left page portrait (Figure 6.35).

There are two ways to leave Overview: click the close-box to close the 
window or double-click on the image of a page to scroll immediately to that 
page.

Note: This is a view-only option; the normal writing environment provides 
a scale suitable for editing.
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O
Figure 6.34 Overview portraits
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Figure 6.35 Overview portraits after sizing
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Print...(#D 5

Depending upon the choice of printer you made in the Chooser of the Apple 
menu, when you click Print on the File menu, an ImageWriter (Figure 6.24) 
or LaserWriter (Figure 6.25) panel appears. I f  your file has previously been 
set up for one printer and you choose the other, click Page Layout (File 
menu) and then click in the Page Setup box before printing. This sets up your 
document for the correct printer. Because the printers' requirements are 
slightly different, we recommend scrolling through the document to verify 
page layout before printing it.

In general, you should choose a printer type before composing your document 
because your choice of fonts, and sizing of graphics and equations may be 
affected.

ImageW riter: (Figure 6.36) With the dot matrix printer, you can choose the 
print quality (Best, Faster, Draft) appropriate for your purposes. Click the 
circle beside one of these to make a choice. For the Best quality, your system 
file should contain the bitmaps for the specified font sizes and the fonts of 
twice the size requested. If a particular font size is available to the system, 
that font size appears outlined on the Font size menu. The remaining 
options apply to both the ImageWriter and the LaserWriter (Figure 6.37).

Im age W r ite r  v27 [[ OK ]]

Quality: O Best (i) Faster  O Draft

Page  Range: © f i l l  Q  From: || [ To:

Copies: 11 |

Paper Feed: ®  Autom atic  O Hand Feed

□  Page  Range Refers To Actual Page  Num bers  

Print M a rk e r s  For:

□  M e m o s  D  □  Ruler Changes cm □  Reuisions |

Print Multip le  Copies: O Together (•) Separate ly

□  Print Both Sides □  Reuerse order

Figure 6.36 ImageWriter controls

C a n c e l ]

5 The M acintosh user interface standard specifies this command key. If you are accustomed to Com m and-P for 
print rather than plain, refer to appendix 5 for reassignm ent instructions using Cmd Key Switcher.
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LaserWriter “LaserWriter 11 NT” 5.2

Copies: m Pages:® fill OFrom: To:
Couer Page: ®  No O First Page O Last Page

Cancel

Help
Paper Source: ®  Paper Cassette O Manual Feed
□  Page Range Refers To Page Uariable Numbers 
Print Markers For:

□  Memos Q  □  Ruler Changes ra □  Reuisions |
Print Multiple Copies: ®  Uncollated O Collated
□  Print Both Sides □  Reuerse order 
Paper Motion Configuration:

MAN. MAN.

LWII LWII

Figure 6.37 LaserWriter controls

Copies: In the box beside Copies, type the number of copies you want. This 
is the default location of the insertion point and the default number of 
copies is one.

Pages: The default is Print All. To print only a portion of the active 
document, specify the beginning and ending pages in the boxes beside From: 
and To:. To print a single page, type the same number in each box. If you 
supply no value for To:, the end of the document is assumed.

If your file is part of a larger document, the page numbers in the headers 
may differ from the physical page numbers. Check Page Range Refers to 
Actual Page Numbers on the dialog box just below the paper feed option if 
you prefer using the page numbers from the document header or footer. [The 
header page numbers are set using Starting at in the Variables Format... 
(Format menu).] Alternatively, M athW riter will calculate and display 
the translated values for you. The number in the vertical scroll bar is the 
physical page number which always ranges from 1 to the maximum number 
of pages in the document. When you press on the scroll box the page 
variable page number for that page is displayed in the status bar.

Cover Page: (LaserWriter only) If you share a LaserWriter with someone 
else and want to identify your document after it prints, click First Page or 
Last Page. Then the LaserWriter prints a first or last page with your name, 
the name of your document, the date, the time, and the printer name.

Paper Feed/Paper Source: The ImageWriter options are Automatic and 
Hand Feed; the LaserWriter options are Paper Cassette and Manual Feed.
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With the manual options, M athW riter prompts you for single sheet paper 
feed. If you select Print Both Sides or Reverse Order, you will be given 
instructions. For these two options to work properly with a LaserWriter, 
you must specify the paper-feed configuration for your particular printer. 
The icons depict the path from tray or manual feed to output. To avoid 
making this choice repeatedly, create stationery (MW Default file) with 
this choice preserved for you.

Page Range Refers to Actual Page (Page Variable) Numbers: Click this 
option to use the page numbers from the document header or footer, rather 
than the number displayed in the scroll bar. To set the starting header page 
numbers click Variables Format... on the Format menu. That opens the 
Variables Format window. Move down to “page #" and click. That opens 
another window on the right under Variable Style. Find the box beside 
"starting at" and type the page number at which you want to start printing.

Print Markers for Memos, Ruler Changes, Revisions: Select any of these 
options to print markers in the left margin of the document to help you 
locate these changes.

Print Multiple Copies: When printing multiple copies you can either print 
all copies of each page before advancing to the next page (Uncollated) or 
print all pages of the file before beginning another set (Collated). 
Uncollated is faster, especially if the file is graphics-laden, because the 
printer has to compose each page only once.

Print Both Sides: This option causes the printer to print the odd- and even- 
numbered pages separately. You must identify the specific Paper Motion 
Configuration of your LaserWriter for this to work properly and reposition 
the paper as instructed (after all pages from one side have been printed). 
The first and second icons correspond to the older LaserWriter Plus.

Reverse Order: Check this option to print the pages in reverse order, i.e, 
reverse order in the output tray. When this option is not checked, the 
LaserWriter uses your Paper Motion Configuration so that the pages will 
appear in the output tray in the normal reading order. The actual printing 
sequence depends upon the hardware.

Quit (XQ)

This is the standard last menu item on the Macintosh File menu. Use this 
command or its command key equivalent X Q to terminate the application. 
M athW riter reminds you to save modified files of any type (document, 
library, etc.) before terminating the program.
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The Edit Menu

Edit
Undo Typing XZ

Cut 36H
Copy XC
Paste Tent XU
Clear
Select All Xft
Copy Other ►
Paste Other ►
Shotu Selection
Reuise Selection 3SM
UnReuise Selection

Find/Replace Xf
Find Newt XG
Replace Selection mu

Check Spelling...
▼

Figure 6.38 Edit menu

Edit
▲
Clear
Select Rll XU
Copy Other ►
Paste Other ►
Show Selection
Reuise Selection XM
UnReuise Selection

Find/Replace Xf
Find Newt
Replace Selection XH

Check Spelling...
Thesaurus...
Hyphenation ►

Insert ►
Delete ►

(with scrolling arrows)

The Edit menu transfers formatted 
text and graphics, rulers, paragraph 
formats, styles, memos, and text 
converted to PICTs from one location 
to another. Edit also provides a gen
eralized find and replace facility 
that searches both mathematical 
expressions and text. Spell-checking, 
thesaurus, and hyphenation appear 
on this menu.6 To access the entire 
Edit menu on a small screen, move the 
mouse to the small, triangular arrow 
at the bottom of the first portion of 
the menu and drag.

Undo ( X Z )

The Undo command restores the 
document to its status prior to the 
most recently executed command. 
Undo lets you explore alternatives 
as well as correct mistakes. Undo is 
not available for a few situations 
(such as global replace, within 
mathematical expressions, and 
revision tracking).

Cut ( X X ) ,  Copy ( X C )

The Cut and Copy commands are dimmed and disabled until you select the 
portion of text you want to act upon. This is consistent with the Macintosh 
convention that an object must be selected before a command is issued. The 
Cut command removes the selected material from the document and places 
it on the Clipboard for subsequent transfer to another location, while the 
Copy command simply copies the selected material to the Clipboard 
without disturbing the original. To view the contents of the Clipboard, pull 
down the Windows menu at the top of the screen until you reach Clipboard 
and then release the mouse. The Clipboard stores material from only one 
Cut or Copy operation at a time. Clear removes a selection, but does not 
affect the Clipboard. The Clipboard remains intact even after you exit 
Math Writer, allowing you to transfer material to another application.

6 MathWriter uses spell-checker, thesaurus, and hyphenation code from Microlytics.
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Paste ( X V )

Paste inserts into the document material previously cut or copied to the 
Clipboard. Click the I-beam at the place in the document where you want 
to paste material. Then pull down the Edit menu to Paste and release the 
mouse. The pasted material appears in the document. If you select or 
highlight a portion of text and then use the Paste command, M athW riter 
replaces the highlighted portion with the contents of the Clipboard. 
Unlike Cut or Copy, Paste does not remove material from the Clipboard; 
instead, you can paste Clipboard material into another document or even 
into a document of another application. (See Table 6.2 for a summary of 
these commands.)

Clear

Clear removes a selection of a document without placing a copy of that 
selection on the Clipboard. It is equivalent to pressing the delete  key. Use 
this command to remove large blocks of text when memory is limited.

Table 6.2 Editing summary

Action
Affects

document
Affects

Clipboard
Cut yes yes

Copy no yes

Paste yes no
Clear yes no

Delete yes no

Select A ll ( X A )

Select All selects all of the material in the portion of your document (body, 
header, etc., identified in the pop-up menu at the insertion point locator in 
the status bar) that contains the insertion point. From the keyboard you can 
also select everything by clicking just before the first item and then shift 
clicking at the end. Various cursor key combinations also provide selection 
capabilities (see appendix 3).

Copy Other

Cut, Copy, and Paste apply to the combination of types of textual and 
graphic material within a selection. However, you can choose various 
types of formatting information such as Ruler, Format, Ruler and Format, 
Style, Memo, and Picture and copy them using Copy Other (see Figure 6.39 
and Figure 6.40). Copy Ruler, Copy Format, and Copy Ruler and Format 
relate to the paragraph containing the blinking insertion point.
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Copy Ruler (98 shift R) copies only the ruler and associated tab settings. 
Copy Format (98 shift F) copies only the values you set using the Paragraph 
Format... and Line spacing... of the Format menu. Copy Ruler & Format (98 
shift A) combines these two commands. Copy Style (96 sh ift S) relates to 
text you select or highlight and copies all the information prescribed in the 
Style menu. Copy Memo (98 sh ift M) copies memo notes created with the 
Insert Memo command (Format menu). Copy As Picture (96shift [ )  turns the 
selected material into a PICT format graphic element and places it on the 
clipboard. Use this command if you wish to transfer an equation to another
application or to the Library (Windows menu).

Copy Other ► Copy Ruler *O R
Copy Format
Copy Ruler & Format aeofl
Copy Style 3€OS
Copy Memo *-l>M
Copy fls Picture

Figure 6.39 Copy Other from the Edit menu

Paste Other

Paste Other (Figure 6.40), which complements Copy Other, pastes the 
information you retrieved with Copy Other into the document at the 
location of the insertion point. Paste Other includes: Paste Ruler (98 shift 
D, Paste Format (98 sh ift G), Paste Ruler and Format (98 sh ift  Z), Paste 
Style (98 sh ift D), Paste Memo (98 sh ift N), and Paste In Context (98 shift 
V). When you use the additional command, Paste In Context, pasted text 
assumes the type characteristics of its new context, rather than preserving 
its original.

I Paste Other ► Paste Ruler
Paste Format
Paste Ruler & Format
Paste Style 3€t>D
Paste Memo §gt>N
Paste In Content 3€0 U

Figure 6.40 Paste Other from the Edit menu

Show Selection

Show Selection scrolls to the paragraph containing the blinking insertion 
point of the active window.

Revise Selection ( 9 6  M) and UnRevise Selection

You can revise (remove text marked for deletion and remove style marking 
for added text) and unrevise (remove text marked for addition and remove



the style marking for deleted text) text that has been marked for revisions. 
UnRevise restores the original state of the text of any selection or 
paragraph marked for addition or deletion.

To unrevise, first disable revision tracking. Highlight or select the revised 
text. UnRevise automatically extends the selection to the end of a revision 
style run. (Simply clicking the insertion point within a paragraph 
identifies the paragraph uniquely and the menu then reads Paragraph, 
rather than Selection.) Then click UnRevise Paragraph/Selection. Text 
marked for deletion is unmarked and left intact while text marked for 
addition is removed.

You can also use the Find/Replace command described below to make style 
changes.

Find/Replace... { 9 S F )

Find/Replace... is a generalized, substantially enhanced search utility 
(Figure 6.41). One of the consequences of M athW riter's total integration of 
mathematical expressions into text is its ability to search for such expres
sions. You can replace portions of mathematical expressions provided you 
can select the unit with the I-beam cursor. In other words, Math Writer only 
locates portions of expressions that extend to the baseline.
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=1 1= = = =  

Match flffec
.. Hnd/Rep|a c e ....... ...
t Wildcards Special Direction |--------------------------- 1

Find:
Tent

Replace with:
Tent

Find 3€F ] ( Replace, then Find ] (Replace <£H [Replace Rll]

Figure 6.41 Find/Replace window

In the Find/Replace window locate Find:. The pop-up menu includes Text in 
one group and Style, Revision, Added Text, Deleted Text, and Style Change 
in the other. If you choose Text, the program seeks groups of letters in the 
document. If you choose Style, use the Match pull-down menu to select 
attribute categories and then pick specific values for the selected categories 
from the Style menu at the top of the screen. It then seeks any text that fits 
the Style you chose, regardless of the particular text characters. If you 
choose Revision, the program seeks all text that you have marked for
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revision. If you choose Added text, the program seeks all the text marked 
as added text. If you choose Deleted Text, the program seeks all text 
marked for deletion. If you choose Change Style in Text, the program seeks 
all the places in the document where the revision style of text selected in 
the Match menu changes.

Next, locate Replace with.... The rectangular box underneath is a pull
down menu that includes Text in one group and Style and UnMark in the 
other. If you choose Text, the program replaces occurrences of the text in the 
dialog box beside Find: with whatever text you type in the dialog box 
beside Replace with:. If you choose Style, the program changes the style 
categories selected in the Affect pull-down menu to the specific values set 
using the usual Style submenu. If you choose UnMark, the program removes 
markings for both added and deleted text without making any deletions.

The Find: and Replace with categories are completed by the more specific 
by choices in Match and Affect, respectively. The match can be on text, or on 
any combination of style, revision, added text, deleted text, or style change. 
Style refers to the typeface attributes; the remaining apply to revisions. 
The Affect list includes text only, font, size, and style.

Find Next ( 9 6 G )

The Find Next menu command (or the Find dialog button) searches for the 
next match.

Replace Selection ( S S H )

Replace Selection replaces the selected text with the previously specified 
contents of the Replace window.

After specifying the search and replace contents and search filter, you 
have the option of controlling the search from the keyboard. Press return to 
remove the Find/Replace window and initiate the search from the inser
tion point. Use Find Next ( G) and Replace Selection (#  H) to control the 
substitutions from the keyboard. If you leave the Find/Replace window in 
view, you can use the mouse to activate Find; Replace, then Find; Replace; 
and Replace All buttons.

The Find/Replace feature illustrates one of the primary design goals of 
M athW riter; to extend the scope and power of virtually every feature of 
traditional word processors without making tasks more difficult to 
perform. For example, using the defaults which exist when you activate 
M athW riter (find text, match text only, replace with text, affect text only 
the commands) Find; Replace, then Find; Replace; and Replace All perform 
in the customary manner. In particular, suppose you type a text string in the 
large Find: text box and another text string in the large Replace with: text 
box. When you click the Find button, the search starts from the location of
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the blinking insertion point and advances through the file until it finds a 
substring match or reaches the end of the file. If it finds a match, you can 
abandon the search; click the Replace button to make the substitution; click 
the Replace, then Find button to make the substitution and search for 
another match; or click Replace All to automatically replace all other 
matches without your intervention.

Warning: Use Replace All with caution because Undo does not apply to 
this command. Unless you have made a backup before using this command, 
you may be unable to easily restore your document if unanticipated changes 
result.

Find/Replace
Match Affect Special Direction ^

Find:
Text |

Replace with: 
Text

Word 
Symbol 
Structure
Template Category... 
Template Object...

Find 3SF ) ( Replace, then FintT) [Replace §€H) [Replace fill]

Figure 6.42 Find/Replace window has seven menus

M athW riter provides two pop-up and five pull-down menus as part of its 
very powerful search capability. Using these menus (Figure 6.42 and 
Figure 6.44) it is possible to define very complex search and replace strate
gies quite easily.

Use the Find: and Replace with: pop-up menus to establish the basic struc
ture of the search. You can search on text strings, typeface, or any combina
tion of these using combinations from the Find: and Match menus. For exam
ple, to search for a text string, regardless of the combination of font, size, or 
style, the combination of upper and lowercases, or whether it is a whole 
word or embedded string, you set Find to Text and set Match to Text only. 
Any combination of the Match menu items can replace Text only to allow 
you to locate text having those qualifying attributes, too. On the other 
hand, if you set Find to Style, you can set Match to any combination of font, 
size, and style without regard for the actual text. M athW riter handles as 
special cases the particular styles you assign to denote additions and dele
tions for revision tracking (Doc Preferences on Edit menu), and automatical
ly passes those definitions on to the Find/Replace function.
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Special
Tab
Line Break 
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End of Paragraph 
Character Code... * •
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Figure 6.44 Find/Replace menus

MathWriter supports five types of wildcards (Figure 6.43):

• word represents any leading or trailing string of zero or more characters, 
comparable to the in MS-DOS.

• ? matches any single character in a string, comparable to the "?" in MS- 
DOS.

• ?A represents a mathematical structure.

• You can use any of the ten classes or rows of mathematical structures on 
the floating Templates window in a search. Any template icon at the 
beginning of a row in the Template window is the Template Category 
(Figure 6.45) of that row and is used to match any template within that 
row.



• You can locate specific templates using the Template Objects list 
(Figure 6.46).

Figure 6.45 Template categories
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Figure 6.46 Template objects
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You can also search for invisible formatting characters (Tab, Line Break, 
Column Break, Page Break, and End of Paragraph) by name (Figure 6.47) or 
ASCII number (Figure 6.48).

♦
P
a  
D 
<n

Figure 6.47 Invisible formatting commands and display characters

Special
Tab
Line Break 
Column Break 
Page Break 
End of Paragraph 
Character Code...

Enter character code:

<•) Hen 

O Decimal

QIZ

Cancel I C ° Q
Figure 6.48 Search for individual characters by A SC II code

A search begins wherever you place the blinking insertion point whose 
relative position within the file is indicated in the box to the right of the 
direction menu (Figure 6.42). You may direct the search to the end or 
beginning of the file or wrap from the end to the beginning for a complete 
search of the document.

Check Spelling...

When you began Math Writer, you should have placed the main dictionary 
and the Math-Science-Engineering7 dictionary files in the same folder 
with M athW riter or in the System folder. Otherwise, you must locate 
those files by clicking Check Spelling in the Edit menu and then the 
corresponding buttons Main Dictionary and User Dictionary in the Spell 
Finder window (Figure 6.49). Only one User dictionary can be open at any 
time.

7The dictionary for engineers, mathematicians, and scientists was created with the assistance of the Departments 
of Agricultural and Biological Engineering, Civil Engineering, M athematics, Electrical Engineering, and 
M echanical and Aerospace Engineering at Cornell University. See the acknowledgments for more specific 
com m ents.
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Main Dictionary: ] MathWriter Diction ary

[ User Dictionary: ] MW User Dictionary

Status: ▼
i ~  ' : ~  i
S  RIternatesI

£3 Skip capitalized words □  Check for repeated words

Change to:

Check Replace Skip Learn Cancel

Figure 6.49 Check Spelling options

If you want Math Writer to offer possible spelling alternatives, before you 
begin checking spelling, check the Alternates box. Check Skip capitalized 
words if you do not want to check them, and click on Check for repeated 
words if you want the program to look for words that have accidentally 
been typed twice. Click Check to start the spell-checking at the insertion 
point. Misspelled words appear in the rectangular box under Status. A bar 
chart to the right indicates where in the document spell-checking began 
and how far the search has gone. A dialog box appears to let you choose 
Continue Checking or Stop Checking.

If the spell-checker finds a misspelled word and the Alternatives box is 
checked, Math Writer pauses to generate a list of suggested spellings. If you 
recognize the word being examined as correct, clicking the mouse aborts the 
alternatives-search process. If the alternatives listed in the pop-up menu 
include the correctly spelled word, click on the word to transfer it into the 
Change to field. Otherwise, you must type the correct word in the Change 
to box. Click Replace to replace the misspelled word in your document with 
the correctly spelled one.

Warning: Because careless use of revision tracking may result in the loss of 
separating spaces between revised words, the spell-checker leaves the 
suspect word or words in the dialog box. Therefore, the presence of a word in 
the dialog box does not necessarily imply a suggested spelling.

The Skip choice tells M athW riter to ignore a possible misspelling. Click 
on Learn to add the word to your user dictionary. You can also return to the 
document window, edit the text, open the Check Spelling window once 
more, and click Check to resume checking. Anytime after you return control 
to the spell-checker, you can terminate checking by clicking Cancel.



Command Reference 259

When two identical, consecutive words are found, a message is placed after 
the inconspicuous word Status: and you either click Replace to delete it 
(and a space character) or click Check to retain the repeated words and 
resume checking.

When the checker encounters an unknown, but correctly spelled word that 
you are likely to encounter in the future, click Learn to add it to the User 
Dictionary. To remove a word from the User Dictionary, click Edit in the 
dialog box; M athW riter opens a window that lets you edit the User 
Dictionary. Select a word in the scrollable list. If you want to delete that 
word, click Delete Word.

Thesaurus...

To find synonyms for a word, first select the word and then select Thesaurus 
on the Edit menu. Math Writer locates a list of words that could replace the 
selected word (Figure 6.50). If you find a more appropriate word on the list, 
click on the new word to copy it into the Find box. Then you can Lookup 
synonyms for this new word, return to a previous listing of synonyms with 
Last Word, replace the word you selected in the document with your new 
word using Replace, or click Cancel to return to the document.

....  lllord Finder® from Microlytics™
S y n o n y m s  f o r : dog

B
noun canine, hound, mongrel, mutt, pooch, pup, puppy.

O

o

Find: dog | Lookup ]|( Last lllord ] ( Cancel ]( Replace ]

Figure 6.50 Thesaurus window

Hyphenation...

The Hyphenation selection lets you hyphenate words throughout the 
entire document or only in a specific selection (Figure 6.51). If you do not 
highlight or select specific text first, M athW riter hyphenates the entire 
document. Use UnHyphenate to remove the hyphenation.

Hyphenation Hyphenate Selection 
Unhyphenate Selection

Figure 6.51 Hyphenation submenu
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Insert and Delete

Insert and Delete (Edit) extend the cut and paste commands to apply to 
rows and columns of matrices or tables. To enable these commands, first 
create a matrix or table and then select a cell using the split I-beam.

1,1 IE

2,1 2,2

[(1,2) Base ] 0

Figure 6.52 Select a cell of an array

With the Insert command (Figure 6.53) you can create a new row before or 
after the row of the selected cell or create a new column before or after the 
selected cell (Figure 6.52). Use the split I-beam to edit within the newly 
created cells.

Insert
| Delete

Figure 6.53 Insert row or column of an array or table

Rout Before 3§OQ
Rout Rfter 9€OUJ
Column Before
Column Rfter as-o-p

When you click Delete (Figure 6.54), M athW riter deletes the row or 
column passing through the selected cell.

Figure 6.54 D elete row or column of an array or table
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The Format Menu
The Format menu (Figure 6.55) contains such selections as para
graph formatting, matrix formatting, footnotes, and inserting 
memos. The basic unit of organization in M athW riter is the 
paragraph—created when you press the return key. The Ruler 
(Figure 6.56) displays the formatting information for the para
graph that contains the blinking insertion point. The Ruler always 
remains at the top of the window and never scrolls out of view. If 
desired, you can hide the Ruler. The Ruler units can be inches, 
centimeters, or picas and can begin at the left of each column or at 
the left boundary of the window.

Hide Ruler/Show Ruler (#£ ')

The first command, Hide Ruler, toggles with Show Ruler. When 
you click on the Hide Ruler command, the tab and justification 
controls from the vertical scroll bar disappear too (Figure 6.56).

Figure 6.55 Format menu

Format
Hide Ruler 38'
Ruler Options ►

Paragraph Format... 38J
Line Spacing... 38K
Matrin Format...
Uariables Format...

Insert Memo 
Insert Column Break 
Insert Page Break

Calc Preu J or I Size 38D

Hide Layout 
Hide Messages 
Shorn Inuisibles 
Hide Pictures

6  File Edit Format Palettes Diac Style Windows

untitled 1
JP> l > I > l ■ lb  l i I i i i I2 t j i | , i i |3, i i | i i ! |4, i , | i i , 15, i ! | , i i J6, O

16 File Edit Format Palettes Diac Style Windows

untitled 1

Figure 6.56 Show/Hide Ruler command

Ruler Options

Ruler Options (Figure 6.57) lets you choose from a pop-up menu, a ruler 
measured in Inches, Centimeters, and Points (Figure 6.58) that correspond to
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the V 72 inch pixels on the Macintosh screen. Page Ruler on that menu 
toggles with Column Ruler and each measures from the left border of the 
page or from each column boundary, respectively. Set the number of columns 
using Page Layout on the File menu.

Ruler Options f l in c h e s
Centimeters
Points

Page Ruler

Figure 6.57 Ruler Options

Inches: I Ip 1 1 ■ l 11 i. H ■ 1 ■ 1 . 1 ■ 12. 1 . 1 , 1
*  i.

Centimeters: I IQ. . .  M.. . .  13. . .  1 5 . . .  14 . . .  15 . . .  1 6 . . .  15 . ■
__ *  A

Points: l |Q.................HQQ.............. .. I2qo,~T~
__A 1

Page Ruler: I ^ .................. .................... I30Q.

Figure 6.58 Ruler units

Paragraph Format... ( 9 6  J )

To change the format of a paragraph, place the cursor within that 
paragraph to select it. Now, click on Paragraph Format.... Within the 
Paragraph Format... window, you can set the vertical spacing before and 
after paragraphs from 0 to 40 pixels by scrolling within the arrows under 
"Spacing". This eliminates the need to type more than one return at the end 
of a paragraph, regardless of the spacing you desire. In this window you 
can also tell M athW riter to link paragraphs, begin a new column or a new 
page with a particular paragraph, or not split a paragraph over a page 
break. Use the Page break before option to force the text which 
immediately follows the insertion point to appear on the first line of the 
following page.

No icon is associated with Page break before. Use this dialog (Figure 6.59) 
to verify its existence or to remove it.
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Paragraph format... 
.............. Spacing

Before SI [p f 
After SI g j

£ | 0  

3  0

Borders

.....*..... Attributes .............
□  Link to nent SI
□  Column break before
□  Page break before
□  Can't split ouer page break

Whitespace &

Click above for thickness and pattern
Cancel

Figure 6.59 Paragraph format window

...........Borders.......................
*  vrryvv— yvyvyv-

d m i l
t

Click above for thickness and pattern 

Figure 6.60 Paragraph borders

Click at the center of the shaded paragraph icon at the bottom-left corner 
of the window to place borders on all four sides of the paragraph 
(Figure 6.59 and Figure 6.60). Click on or near individual sides to select or 
"deselect" each of the four borders separately. A paragraph portrait just to 
the right displays the borders selected. Borders consist of one or two lines; 
you can assign the line thicknesses and patterns as well as the background 
pattern for the entire paragraph. Whitespace (Figure 6.59) refers to the 
space between the paragraph and the inner border measured in pixels. 
Click in the paragraph portrait to open a window that assigns Outer 
borders, Inner borders, Background pattern, and Space between borders 
(Figure 6.61).

Use the pop-up menus available when you click the rectangles beside 
Thickness and Pattern to set line thickness, line pattern, and background 
pattern for each. (Figure 6.62 and Figure 6.63) Drag to select from among 
the choices. The line thickness choices range from hairline to 8 point in one 
point increments (Figure 6.62). Math Writer has a No inner border option for 
the inner border. When you choose "gray" from the bottom-right corner of 
the pattern pop-up menu shown in Figure 6.63, a scroll bar for setting the 
percentage appears on the right. "Space between the inner and outer 
borders" has a scroll bar that lets you set the space between inner and outer 
borders of a paragraph box.
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Select thickness and pattern. 
....Outer border..................

Thickness
Pattern

Inner b

Thickness
Pattern

.... Backgrc

Pattern

Space betu

: : : : :  >t<m
22&Z+ W S !  OXOW 
iBBBB

X//Z EEEEi m m
v *v » ' 
4444- 
gray

M  2

Cancel
i  “K 1

Figure 6.61 Pop-up menus for border lines and patterns

No inner border
Hairline Hairline
1 point 1 point
2 2
3 3
4 4
5 5
6 6
7 7
8 8

Figure 6.62 Border line thicknesses
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Line Spacing... (96K)

m M  m m  s m
: ■ » »  m t i  

6 6 6 6  - 3 f f i
rannc

y / / y  b :::e e  r r r r
.aaa* a* aa

5656:
Sgjgj® >#■•##■•# gray

Pattern Gray scale | 0 ]_! =y |C> 50

Space between borders & .1... •■•...•.•.v;.:...:.-.....•... : K> 2

Figure 6.63 Pattern palette

With Automatic line spacing enabled, M athW riter automatically spaces 
lines to include the maximum size of such expressions as mathematical 
equations (Figure 6.64). Mostly fixed means that M athW riter allows 
simple subscripts and superscripts to protrude into the "leading" between 
the lines. Fixed lets you set the spacing using four buttons: Single, l- 1/2, 
Double, and Other. Samples appear at the right, as in Figure 6.64. The 
default ascent and descent plus leading values for the three fixed spacings 
are: (9,3) for Single, (14,4) for l- 1/2, and (18,6) for Double. The Other 
category lets you set the ascent and descent separately. Ascent is the height 
provided for the characters above the baseline on which the letters rest. 
Descent plus leading is the space allowed for the character below the 
baseline.

You can use automatic line spacing while composing a manuscript when you 
do not want to be concerned with making a choice. If your writing includes 
in-line expressions, you may wish to modify the line spacing subsequently to 
achieve greater uniformity. To modify the spacing, select the relevant text 
using the mouse or keyboard and apply the desired line spacing. Never 
compose variable-height mathematical expressions with fixed line 
spacing because portions of the line may be displayed improperly and 
inadequately refreshed.



266 Chapter 6

Line spacing...
O Automatic
®  Mostly fined
0  Fined

; S in g le  (6 lines/inch)

1 1 - 1 / 2  (4 lines/inch) 

: Double (3 lines/inch) 

| Other...

..../ ... ..........................

& ) * .* +  l )

Fixed ascent

o r  i i  £  9

Fixed descent + leading

3

Displayed equation adjustment

s r z 3 M 6
Cancel C DK.  1

Figure 6.64 Line spacing dialog

Matrix Format...

This window (Figure 6.65) controls matrix and table formatting. Under 
Placement, click on "descend below line" to place a matrix below a line of 
type. "Center on line" centers it within a line of text.

Click in the box below Line type. This opens a window that lets you choose 
the thickness and pattern of the outer border of a matrix (Figure 6 .66). 
Select an outer border pattern by clicking in the box beside Pattern. Since 
matrices use single line borders, the inner border is not enabled. Select a 
background pattern by clicking the box beside Pattern. Click OK to accept 
changes or Cancel to reject them.
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Placement
descend line

below

center line

Line type

Click here to 
select

thickness and 
pattern

■...S3 Cell spacing

horizontal spacing = 10 points 

vertical spacing = 5 points

□  fllign r<m»*

Justification

0.1 100.01
1.000 10.1

ro.i 1 0 0 .0 1 ]
L 1.000 10.1 J

r o.i 1 0 0 .0 1 ]
[ 1.000 1 o.i J

[0.1 100.01] 
L 1.000 10.1 J

center

Cancel

le ft

r igh t

decim al

t— " ^ J l

Figure 6.65 Matrix format window

Select thickness and pattern... 
...  Outer border..................

Thickness
Pattern

Inner border

Thickness j 
Pattern j

...Background pattern

Pattern

------------ \ r m a
Cancel 0K

J

Figure 6.66 Line type window

The alignment of elements within the matrix can be centered (most often 
used for symbolic expressions), positioned to the left or right, or decimal 
justified. Under Justification, click on center, left, right, or decimal to align 
elements within the matrix. M athW riter automatically handles the 
spacing of rows and columns. It reformats a matrix with each input 
keystroke. Changes made while a matrix is selected apply only to that 
matrix; changes made with none selected apply to all subsequent matrices.
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Cell spacing affects the size of the cells of a matrix. Drag the vertical and 
horizontal arrow icons to change the size of the cells vertically or 
horizontally (Figure 6.65).

Variables Format-

Variables Format... on the Format menu (Figure 6.55) lets you select 
formatting options for such variables as the date, time, page number, and 
footnote marker. These variables automatically appear in the text in the 
form that you choose here. Show Invisibles (Format menu) displays a 
dotted box around these dynamic variables.

Click on Variables Format.... Then click in the box, Variable Style:. To the 
left of this window is a Variable Style box. Click in that box. A window 
opens that lets you choose Font, Size, Style, Justification, and Line spacing 
for each of the variables in the Variables Format window. For a discussion 
of these, go to Doc Preferences...(File menu). Click Cancel. You are back in 
the Variables Format... window. If you do not select Variable Style, the 
typeface matches the adjacent text. Alternatively, whatever style type 
you assign here overrides the style of the surrounding text as far as the 
variable is concerned.

Creation date
group of variables at the left. (See Figure 6.67 and Figure 6 .6 8 .) In the rec
tangular box to the right of the Variables Format window are various 
choices such as month/date/year (m/d/y) and date/month/year (d/m/y). 
Click in the button beside m/d/y. An illustration of your choice appears in 
the box labeled "example" in the lower-left corner of the window. Click 
"leading zeros," and a zero appears before single-digit numbers. Click 
"short year," and the year appears in two digits rather than four. Click 
"month, date, year," and the month appears as a word rather than a 
number. Click "day, month, date, year," and the day and month appear as 
words rather than numbers. Click "abbrev. month" and "abbrev. day," and 
the month and day are abbreviated. Click OK to accept your choices or 
click Cancel to reject them.

and current date : Select "creation date" from the

Click "current date." Note that the choices here are the same as those for 
"creation date."

Creation time IDG © Click "creation time." (Seeand current time
Figure 6.69.) To the right of the Variables Format window are various 
choices such as hr:min:sec and hr:min. Click hr:min:sec. An illustration of 
your choice appears in the box labeled "example" in the lower-left corner of 
the window. Click hr:min, and only the hours and minutes appear. Click 12 
hr., and AM and PM appear beside the time. Click 24 hr, and hours are 
numbered from 1 to 24.
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Click "current time." Note that the choices here are the same as those for 
"creation time."

Uariables Format...

[l] creation date
^  current date 

Hg creation time 

©  current time 

0  page #
$  # of pages in document 
r~ footnote/endnote 

rr  re-reference footnote/endnote

RSI

o

Nem. Renam e..,

Example

Uariable Stgle.

(D M/D/V 

O M-D-V
o  D/M/V 

o  D-M-V

Leading Zeros 
Short Vear

O Month, Date, Vear 
O Day, Month, Date, Vear

□  Rbbren, Month 

0  Rbbreu. Ray

12/04/90

Cancel 1[ZD
Figure 6.67 Creation date format

Set style for current date uariable...

□  Font j |

□  Size i___| □  Justification

□  Style select style... □  Line spacing 8eie< t spacing...

The current date variable appears like this. The Font, Size and 
Style are taken from context.

Cancel

[1— gg— 1

Figure 6.68 Style assignment for variables
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Page number iMl and number of pages ILitU : Click "page #." (See Figure 6.70.)A
Depending on which type of numbering you want, choose Roman numerals 
(i,ii,iii,...), uppercase Roman numerals (1,11,111,...), or traditional Arabic 
numerals (1,2,3,...) from the left side of the window. In the box labeled 
"leading text" you can type "Page" and in the box "trailing text," you can 
type "of 25" and produce an entry such as "Page 3 of 25" if this is the 
complete document. If this file is a continuation of a previous file and you 
want the page numbers of this file to pick up where the other left off, type 
the correct beginning page number for this file in the "starting at" box, but 
omit the total pages variable.

Footnote/endnote L_J and re-reference footnote/endnote LilJ : M athW riter
formats footnotes and endnotes alike. It offers five automatic numbering 
styles: example1, example!2!, example^3!, example[4], and example(5) as 
well as a collection of symbols (see Figure 6.71). Click in the buttons at the 
right to choose which type you prefer. If you need at most six footnotes, you 
can define and use symbols of up to three characters. If this file is a 
continuation of a previous file, you can assign a starting footnote number 
where the numbering for the previous file ended.

Uariables Format...

[2 creation date 

[j] current date
iod creation time
©  current time 

0  Pa 9 e #
$  # of pages in document 
I-  footnote/endnote 

FT re-reference footnote/endnote

O

O

Uariable Style.

(•) Hr:Min:Sec 

O Hr:Min

<D 12 Hr.
O 24 Hr.

New. Wvmmn?...

Example

1:45:18 PM

Cancel L j ?c J]
Figure 6.69 Creation time format



Command Reference 271

Uariables Format...

[T] creation date 

[T] current date 

HQg creation time 

0 current time

0  page #

O

$  # of pages in document 
r~ footnote/endnote 

rr  re-reference footnote/endnote O

Neui... Renam e,

Example

Uariable Style.

O i, ", iii 
O I, II, III
®  1 ,  2 ,  3

Leading Tent 

Trailing Tent

Starting Rt

Cancel

Figure 6.70 Page number format

t— gg .. )]

Uariables Format...

O[l] creation date 

[T] current date 

Q1 creation time 

©  current time 

0  page #
$  # of pages in document
i footnote/endnote
i*  re-reference footnote/endnote ^

New... Rename.

Example

T ~

Uariable Style.

<•) example1 Starting Rt
.hiO example 

O example1*̂  

O exampleM ] 

O exampleU)

I

O Use Symbols

* * * * * * t f t •

Cancel L g - J
Figure 6.71 Footnote format
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Equation number 2 * reference ^5 You can format equationand equation
numbers and references to equations within the text (Figure 6.72) in several 
standard styles: with or without a descriptive text label; with Arabic or 
Roman numerals; with parentheses, brackets, braces; or with a user-defined 
symbol. You can, of course, assign the starting number. Here are some 
illustrative examples: 10, 5.10, 5-10, J, j, X, x, [eq. 10], 15.10]. Click in the 
buttons at the right to choose which type you prefer. The example box 
illustrates your choices.

Subequation #l*kJ: A subequation variable automatically numbers groups of 
equations that are subsidiary to other equations. MathWriter (Figure6.73) 
offers five numbering styles: lowercase and uppercase Roman alphabet, 
Arabic numerals, and lower and uppercase Roman numerals. You can 
separate these from the equation number by a dash, period, or no space. 
Here are some illustrative examples: [la], lb, lc, [1A], 1.1, 1.2, 1.3, 1-1, 1-i, 
5.10.1, and 5.10.2. Subequations inherit the label and enclosing symbols 
assigned to the equation numbers. Click in the buttons at the right to choose 
which type you prefer.

Uariables Format...

0  Page #
$  # of pages in document 
T~ footnote/endnote

re-reference footnote/endnote

Z# equation #
£  sub-equation # 

equation reference
N# User category *

O

o

[ Uariable Style^T

New...

Enample

Renam e,.,

® 1 ,2 , 3 O n , B-flfl, BB
O k.1,«.2 O  a, b-aa, bb

O h- 1 , h-2 01,11,111
O  i, ii, iii

O — <§>[- 
o  Other p(

_] Ot—) 

] - □

Starting Rt 1| 1
Label

Cancel II "K II

Figure 6.72 Equation number format
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Figure 6.73 Subequation number format

User category sub-User category IALI, User category reference : User-
defined variables (Figure 6.74 and Figure 6.75) are a generalization of the 
equation numbering variable described above. The formatting options are 
the same. However, you can create as many user-defined variables as 
needed: paragraph, figure, table, theorem, lemma, etc.

In the dialog box shown in Figure 6.74, click New, and Math Writer asks you 
to name the new category (Figure 6.76). MathWriter  adds to the list box 
three new entries analogous to the user-defined three. Supply formatting 
information. You can edit the default label Category 1, which initially is 
the same as the category name you assigned.
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Uariables Format...

T~ footnote/endnote
re-reference footnote/endnote 

s« equation # 

sub-equation # 

equation reference
n# User category

JU sub-User category *  

u* User category reference

O

o

Neuj... Rename...

Example

[Category 1

Uariable Style...

(8)1,2, 3 O fl, B-nn, BB
O h.1,h.2 O a. b-aa, bb

O h-1 ,h-2 Ol. l l . m 
O i, ii, iii

O —  <•>[—] 0 (— ) 
O Other|{ |—  [}“

Starting Rt ^  

Label
Category 1

Cancel I
Figure 6.74 User-defined category format

If you require only one user-defined variable, just rename the User 
Category, and MathWriter transfers its name to the Palettes window. Use 
New to create additional variables. If you have two or more user-defined 
variables, select the generic, user-defined variable from the Palettes pull
down menu. The custom pop-down menu (Figure 6.77) temporarily replaces 
the standard Palettes menu until you make a selection.

MathWriter numbers the entries consecutively when you select the 
variable. Even if you intersperse additional entries among existing 
variables, MathWriter automatically updates the higher numbered 
variables. If you insert a reference to one of these variables into the text 
using the re-reference command from Palettes, MathWriter  automatically 
updates those textual references also.

Computer-supplied variables in the document remain linked to the defini
tion and conditions established in Variables Format. If you make changes in 
the Variables Format dialog, the implementation throughout the document 
is immediate. Similarly, format changes must be made here, rather than in 
the document.
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Uariables Format...

I~  footnote/endnote
re-reference footnote/endnote 

I# equation #
2, sub-equation # 

equation reference 

[]# User category *

iu sub-User category *

n* User category reference

O

_

M

Uariable Style...

New... Rename.

Example

[Category 1 la]

®  a, b c-aa, bb, cc
O R, b C-flfl, BB, CC
0 1 ,2 3

O  1, II IN
O  i, ii, iii

O - h O - h

Cancel [I 0K 1

Figure 6.75 User-defined sub-category format

Rename category.

User category

Cancel | Rename j
Figure 6.76 Name user-defined variable

Palettes

F'9
Table

Figure 6.77 Custom palette menu for user-defined variables
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Insert Memo

If you want to leave yourself (or a colleague) a memo that is not part of the 
text, place the cursor within a line of text and click Insert Memo to open a 
window. Math Writer inserts a note marker at the left margin of your 
document to mark the location of the memo. If you select Show Messages 
from the Format menu, you can see the memo markers. When you create a 
memo,MathW riter  automatically places a date and time stamp in the 
header of the memo. Type what you want in the memo and click in the 
close-box of the memo window to hide it.

This is normal text which contains a memo.

Figure 6.78 An automatically time-stamped memo note window

The presence of a note is indicated by the marker in the left margin, but not 
in the text (Figure 6.78 and Figure 6.79). Double-click on the marker to open 
the note window. If the Templates window is open on the screen at the far 
left, it may cover the memo marker. Click in the gray portion of the 
Template window and drag to move it.

Q  This is normal text which contains a memo.

Figure 6.79 A memo note indicator (at left)

Insert Column Break, Insert Page Break

Click on Insert Column Break and Insert Page Break to move the text that is 
beyond the blinking insertion point to the top of the next column or next 
page, respectively. When you use Show Invisibles (Format menu), these 
commands appear as B) O, respectively. These markers do not terminate 
the paragraph; return provides that control so press return if the alignment, 
line spacing, tabs, etc., are to be different for the two parts.

CalcPrevjor I Size (9SD)

Use this command to automatically size the J or I symbols. For example, 
after you enter the integrand, press f  D to resize the integral sign. To 
manually adjust the size, use the Character Editor.
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Show Layout/Hide Layout

Show Layout toggles with Hide Layout to reveal the boundaries of the 
headers, footers, margins, etc. Without these boundaries you obtain an 
uncluttered view, but with them you can tell where various regions are on 
the page (Figure 6.80 and Figure 6.81).

2

The mathematical derivation o f  the com plete equation is com plex  and can he found in 

Parlange et al. (1985). Here "we shall instead provide an intuitive and v ery  sim ple derivation 

o f  a m ore practical equation "which is alm ost identical. W e start from  R ichards' equation 

Figure 6.80 Page without margin indicators

1
i:

................................ 2...............................|
•u•
T
•

Kl

The mathematical derivation o f  the com plete equation is com plex  and can he foun d ini 

Parlange et al. (1 9 8 5 ). Here "we shall instead provide an intuitive and very  sim ple derivation 

o f  a m ore practical equation "which is alm ost identical. W e start from  R ichards' equation

Figure 6.81 Page with margin indicators

Hide Messages/Show M essages

{

i
c
u

Hide Messages toggles with Show Messages, and they display the markers 
that tell the existence of hidden memo notes, changes in paragraph rulers, 
sidebars, etc. Use Print on File menu to print markers for memos, ruler 
changes, and revisions.

Show Invisibles/Hide Invisibles

Show Invisibles toggles with Hide Invisibles and provides access to the 
hidden formatting characters (Figure 6.82), such as tabs, line breaks, 
column breaks, page breaks, end of paragraphs, and spaces. To remove 
these markers, click just before the next character (NOT just after the 
marker) and press delete.

♦ ?  g) Q  H
Figure 6.82 Hidden character sym bols



278 Chapter 6

Hide Pictures/Show Pictures

Hide Pictures toggles with Show Pictures and suppresses the display of 
pasted graphics in order to produce faster scrolling. A rectangular 
placeholder preserves the page layout (Figure 6.83).

Mill Shorn layout
I . i . 12, I ■ I ; I , 15, I , I , I , 14, I , I , I , J 5 , ! ■ I ; I ■ |6

Rage -  1 This is the header area. M V  treats this as a mini M V  document 
Vhich you can edit within the same window. See Page Layout and Document 
format on the File menu for controls.

j This is the text region. Show Layout displays the 
boundaries of the text body, headers, and footers using 
Idotted lines. Cursor shape changes also identify the 
regions.

This line contains a memo note.

This line contains a hidden picture

\Q\
i

O
Base K M iflU lillfl L6, C40 Geneva 12 a

Figure 6.83 Hide pictures for faster scrolling

The Palettes Menu

Palettes
Geometry Z L i II 0 O

y-v
□ □ £ 7 0 = ~ a

Operators + - X e ~ = 2 < > CK ± * T j u
Math/Calculus f n T 1 A □ T «■ -> ✓

Sets u n 3 c Z> C <x S * 0 © 0
Logic A V ~ 1 V 3 3

Rrrotus < - T — 1 c= => ft U J
Misc. 71 3 sp X « • T T ■ £ § 8 T

# 7 .
r w

Brackets ( ) J_ 1 { } T j _ 1 < >

Dariables m on m
m

f V .
£ T- s# 2 []* []na [ i

gradient, div erg<?nce ,  curl 1
Figure 6.84 Palettes menu
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The Palettes menu (Figure 6.84) displays all of the symbols from the 
Symbol font except the Greek alphabet, which is available when you click 
on the Palettes window (Windows menu). In addition, the Greek alphabet 
is immediately accessible from the keyboard. Press spacebar to toggle 
between the current font and the Greek alphabet. Pull down the Palettes 
menu and move the cursor among the items in the window. Note that the 
name of the character on which you place the cursor appears in the row at 
the bottom of the window. Click on a character to insert it into your 
document.

You can copy each row of this Palettes menu to the Palettes window. First 
select the Palettes window (Windows menu). This places the Greek 
alphabet at the bottom of the screen. Then pull down the Palettes menu 
and select Geometry. The Geometry row of characters appears at the 
bottom of the screen with the Greek alphabet. To remove Geometry from 
the screen, select it again from the Palettes menu. MathWriter marks each 
row that you copy to the Palettes window with a check.

Refer to the discussion of formatting user-defined variables (Variables 
Format... on Format menu) for the handling of multiple user-defined cate
gories.

The Diac Menu

amanE0SESEES
S is £ m

Raise <&R
Lower 3€L
Remoue
umlaut or dieresis

Figure 6.85 
Diacritical menu

When you place the cursor immediately to the right of an alphabetical 
character, the diacritics on the top row of the Diac menu (Figure 6.85) 
become available. Note that the name of the diacritic on which you place 
the cursor appears in the row at the bottom of the window. Click to 
associate a diacritical mark with a character. Use the Raise and Lower 
commands to adjust the height of these diacritical marks. Use Remove to 
remove a diacritic. If you repeatedly require a spacing different from the 
default, use the Library macro capability (Windows menu) to save and type 
the adjusted combination quickly.

When you highlight a group of characters, the remaining commands on 
rows two, three, and four become available. MathWriter automatically 
stretches these overbars, underbars, grouping brackets, etc., as needed. Use 
the split I-beam to edit within the structure. The Raise, Lower, and 
Remove commands apply to the structures while selected. As with the 
diacritics, repeatedly used combinations can be stored in the "Library" for 
convenient typing.
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The Style Menu
The Style menu contains menus for assigning fonts (typefaces), 
sizes, and styles as well as such items as Auto Math Options that 
let you automatically italicize certain variables in mathematical 
expressions and user-named style combinations.

Text Fonts

Pull down the Style menu (Figure 6 .8 6) until you reach Text Fonts. 
A menu pops out containing a list of fonts (Figure 6.87). The list 
depends upon those fonts currently available to the system. (Use 
the Font/DA Mover to change the list. Refer to the Macintosh 
User's Manual for a discussion.) The laser fonts available to the 
LaserWriter Plus are underlined. If you press the option key while 
selecting text fonts, each font name appears in its respective style 
(Figure 6 .88).

Because mathematical writing necessarily involves many nonal- 
phabetic, special characters, making global font changes could 
significantly change the document content because special symbols 
are not assigned to the same ASCII code throughout all fonts. To 
guard against this pitfall, MathWriter  identifies the fonts by 
name, not just ID numbers. When you open a file, MathWriter  
warns you if the entire set of fonts used in the document is unavail

able to the operating system. MathWriter  extends this machine indepen
dence to include the PICT pasted into a MathWriter document. Because the 
font identification number is not a unique identifier, conventional word 
processors allow the font name to be lost and hence a loss of assurance that 
the document is unchanged. Because mathematical symbols have no univer
sal ASCII position, a font change can have serious, not just cosmetic, conse
quences. If a MathWriter  document has the correct appearance, including 
imported PICTs on your computer, it will have the same appearance on any 
other Macintosh which has the correct set of fonts installed—even if they 
have different font identification numbers. Use the File Warnings option on 
the Preferences command of the File menu to warn you if the document being 
loaded requires additional fonts to match those of the originating comput
er. MathWriter's font identification procedures allow you to share a docu
ment by electronic mail, provided the recipient is using the identical set of 
fonts.

Style
Tent Fonts ►
Tent Sizes ►
Tent Style ►
Greek 36
Larger Size 36+
Smaller Size 36-
Style 1 36<
Style 2 36>
Last Style 36\

Huto Math 36E
Ruto Math Options..
Italics Exceptions List...

Metrics...

User Styles...

Figure 6.86 Style menu
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Chicago Chicago
Courier Courier

yGeneua G eneva
Heluetica H e lve tica
Monaco Monaco
New Centurg Schlbk New Century Schlbk
New Vork N e w  Y o r k
Sgmbol Si+r pipoA
Times Time3
Uenice knncc

Figure 6.87 Font submenu Figure 6.88 Fonts listed using own

Text Sizes

Text Style

When you drag to Text Sizes (Figure 6 .86), a menu (Figure 6.89) pops out 
that contains various standard font sizes. The outlined sizes identify the 
fonts with actual bitmaps available to the system. The system must create 
the other sizes, which will appear ragged on the screen and on Image- 
Writer output, but not on LaserWriter output. System 7.0 addresses this 
problem.

Select font size...

Cancel

Figure 6.89 Select other font sizes

With the Other (64)... command (Figure 6.89) you can select sizes not 
included in the submenu list. Enter the desired integer font size and click 
OK. This new size is displayed in the Other ( )  command.

The standard Text Styles (Plain, Bold, Italic, Underline, Outline, Shadow, 
Condense, and Extend) are available from the submenu (Figure 6.90). When 
you select Plain, all other styles are overridden. Uppercase and Condense 
appear dimmed until you check them. Then each has a pull-down menu. 
The pull-down menu for Uppercase provides all uppercase letters, all 
lowercase, or Caps First, which capitalizes the first letter of each word. 
Condense and Extend alter the spacing of any group of selected characters 
by removing or adding a pixel between characters. You can apply a limited 
form of kerning to letter combinations throughout the document using the 
style-sensitive feature of Find/Replace (Edit menu). See Chapter 3 for 
instructions on how to do this.



✓ Plain mp
Bold m
Ita lic :#l
Underline #U
(DmGOOmQ
a a a a a E )
Condense
Eh tend
Other Styles... sev

Figure 6.90 Text Style menu

Click Other Styles... (Figure 6.90). This opens an Other styles window 
(Figure 6.91) that supplements the standard choices. The first column 
repeats the standard styles of Plain, Bold, Italic, etc. If you select 
Underline or Low underline, Underline pattern and Underline weight 
options become available. Click in the rectangular box beside Underline 
pattern (or on the name) for a choice of patterns and Underline weight for a 
choice of weights. When you check Gray, a scroll bar for setting the gray 
scale appears. Seven of the options (UPPERCASE, Condense, Underline 
pattern, Underline weight, Background pattern, Background color, and 
Character color) provide alternative choices using pop-up menus. To use the 
pop-up menus, press on a choice and drag to make a new selection. See 
Figure 6.92 for examples.

Use Words only to make other choices apply to the words, but not the 
spaces between the words. Use Strikeout to indicate deleted text. Use 
Overbar for vectors and complex conjugates in mathematical manuscripts. 
Use Box to denote added text, and use Underline and Low underline, 
individually or together, to identify new text or to place special emphasis 
on certain sections.

Without retyping, you can change text to lowercase, uppercase, or make the 
first letter of a word uppercase. First highlight the text you want to 
change. Then open the Other Styles window of Text Style (Style menu) and 
click on the style change you want. MathWriter preserves the original 
style information and allows you to restore it without retyping.

Background pattern, Background color, and Character color provide pop-up 
menus that offer a variety of choices. You need a color monitor to benefit 
from the Background color and Character color choices.

The shading styles may also be useful to mark added text or make blocks of 
text more prominent. If you have a color monitor, you can enable color from 
the Control Panel (Apple menu) and assign a background and character 
color for display on a color monitor.
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Other styles...

□  Plain 

0  Bold
□  / to/ic

□  Underline

□  EmQOQms
□ aoiacacDEg

□  UJords only
□  Strikeout
□  Ouerbar

□  Lom underline
UP PI: fiOfiSI

□  I i: omiense j
□  Gray

Underline pattern[

Underline weight

Background pattern 

Background color 

Character color

White | 

Black | Cancel G O
Figure 6.91 O ther Styles

When processing the additional information needed for a color monitor, 
MathWriter will perform more slowly. For additional details refer to the 
discussion of the Other Styles in connection with Doc Preferences (File 
menu). When you finish changing styles in the Other styles window, click 
OK to accept your choices, or click Cancel to reject them.

WideMme^pattenJI 
Background pattern

Character color 
Background color

Black 
✓  White 

Red 
Green 
Blue 
Cyan 
Magenta 
Vellow

Underline weight
hairline 

✓  1 point
2
3
4

0

0

✓ UPPERCASE 
lowercase 
Cap. First

✓ Condense
Extend

0  Gray [Qf l i s a  a  so %

Figure 6.92 Other Styles pop-up choices
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Greek (96 spacebar)

Because the Greek alphabet is so widely used in mathematics, science, and 
engineering, a dedicated menu command and key command for rapid access 
are provided. The Greek command is disabled by a selection from the text 
font submenu. For rapid changes, both the mouse and keyboard commands 
toggle between Greek (on the Symbol font) and the last font in use. The Last 
Style command on this menu plays the same role for all other fonts.

Larger Size (96 +), Smaller Size (96 -)

Because you change font size so frequently when typing mathematics, 
MathWriter  supplies special menu and keyboard commands for changing 
font size. You can easily step through the font sizes on the font size menu 
using these keyboard commands. When used with the option key (96 option 
+ and 96 option -), these commands make smaller changes—one point steps, 
rather than cycling through the sizes on the menu.

Style 1 (96 <), Style 2 (96 >)

Style 1 and Style 2 let you compose two of your own style combinations. 
First, open Doc Preferences... (File menu). Click on Style 1. This opens the 
Set style number 1... window where you can choose the styles you want to 
use. Click OK to accept the styles and close the window. Click OK to close 
the Doc Preferences... window. Now select or highlight a portion of text. 
Pull down the Style menu to Style 1 and release the mouse. The selected 
text should appear in the style you chose for Style 1. These style 
combinations are merely a typing aid. MathWriter  does not preserve any 
linkage with the text you type using these styles. However, you can use 
Find/Replace (Edit menu) to make local or global style substitutions 
without altering the text.

Last Style (96 \)

The Last Style command provides a quick return to the immediate past 
style. This feature is especially useful when you must toggle between two 
styles, such as the frequent use of boldface notation for vectors and scalars.

Auto Math (96 E), Auto Math Options...
The next group of commands provides for automatic handling of several 
routine tasks associated with typing mathematics. Click Auto Math Op
tions... and select the options you want from the open window. Then, click
ing Auto Math (not just their inclusion in the combination) enables those 
choices. While composing a manuscript, use 96 E to toggle on and off the 
combination of features selected using Auto Math Options (Figure 6.93).

Auto Math Options include: Auto-spacing around operators, Auto-bracket 
sizing, Auto-italicize, Italicize Greek characters, and automatic replace-
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merit of arithmetic operators with the corresponding, better-formed char
acters from the Symbol font. For example, the plus sign in the Times font is 
larger than the Symbol plus sign.

As a typing aid, you can specify that MathWriter automatically pad the 
arithmetic operators (+, - ,  etc.) with leading and trailing spaces. When 
Auto Math is enabled, MathWriter automatically sizes brackets as you 
form an expression (Figure 6.94). If Auto Math is inactive while you create 
an expression, you can select an existing expression and then choose Auto 
Math, E, to size the expression automatically.

Ruto Math Options...
(Ruailable Only LUith Ruto Math Turned On)

3g-s= 0 [3 Ruto-Spacing Rround Operators 
%%-̂ z B ^  Ruto-Bracket Sizing 

36^=1 ^  fluto-ltalicize
G S  Italicize Greek Characters

_. Use Symbol Font For Keyboard 
^  Generated Operators find Brackets

Cancel OK )|

Figure 6.93 Auto Math options

1 — x2

' l + r '
T ^ 2

Figure 6.94 Parentheses typed without and with Auto-sizing

Variables in mathematical expressions are normally italicized. Because 
the standard italics style slants too much on the screen, some users may 
prefer to switch to a font that is slightly slanted with the Plain style, e.g., 
Timesltalic. Certain functions such as sin, cos, and the numerals should not 
be italicized. Refer to the Italics Exception List below for a discussion of 
this feature.

If you click Use Symbol Font for keyboard-generated operators and brack
ets, MathWriter substitutes the Symbol font for other, less attractive font 
characters. You can select these options using the mouse or type the appro
priate 3€ option letter (&’ option with the first letters O, B, I, G, S), but 
they are not enabled until you use Auto Math E).

The typeface indicator in the status bar at the bottom-right corner of the 
document window appears in inverse when Auto Math is active. If you turn 
this feature off, MathWriter runs faster.
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Italics Exception List...

Use the Italics Exception List... command of the Style menu to keep certain 
names, such as trigonometric functions, from being italicized automatically. 
A Don't italicize window lets you add words to and delete words from the 
list (Figure 6.95). To add a word, click New. A window opens to allow you to 
type the added word. Click OK to place it in the list or click Cancel to 
cancel.

Don't italicize these words.
Words are case-sensitiue.
Corr ‘C>

Pr
New...

Prob |j? --------------- •.
Var D e l e t e

arccos
arcsin E<»1_
arctan
atan
const Cancel
constant
C O S i 1 OK
cosh C> 1 — J

Figure 6.95 Italics exception list

To remove a word from the list, select or highlight the word. This enables 
the Delete and Edit buttons. Edit opens a window to let you edit the word. 
Delete removes the word from the list. Click OK to accept or Cancel to 
cancel.

Place the names of mathematical functions that should not be italicized in 
this exclusion list (Figure 6.95). The list is case-sensitive. When you hit the 
spacebar as you type, MathWriter compares each word with those in the 
list. Since numerals are never italicized, they are automatically excluded 
and need not be placed in the list.

M etrics...

The Metrics... window lets you reduce the size of and vertical position of 
superscripts and subscripts as well as center expressions above or below a 
character. The Metrics window provides access to the defaults for size 
reductions of subscripts and superscripts, for the vertical positioning of 
subscripts and superscripts, and for expressions centered above or below a 
character. In addition, you can set the default size of the summation 
symbol for display and in-line use here.
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The scroll bar at the top of the Metrics dialog box allows you to establish a 
table of subscript and superscript size reductions. Characters of the base 
size have subscripts and superscripts of the size you specify in the changes 
to box. To establish a table of size reductions, select a base size with the 
scroll bar and edit the changes to box if needed. To establish the size of the 
sigma, edit the boxes for displayed (equation on separate line) and in-line 
(equation embedded within a line of text) summations.

To set defaults for vertical placement of subscripts and superscripts, click in 
the grid to select a combination of template class (e.g., integral) and the 
superscript, subscript, center above, or center below commands. Then for 
each class select a button corresponding to the basis of the measurement 
(ascent, descent, and baseline), click to indicate if the change is positive or 
negative, and assign the default positioning (number of pixels) in the scroll 
bar at the bottom.

User Styles...

Because you make frequent and repetitive use of certain typeface 
combinations (font, style, and size), line spacing and justification for body 
text, section and subsection headings, figure captions, etc., MathWriter 
permits you to name combinations of these attributes and add them to the 
Styles menu. User Styles improve speed of text formatting and promotes 
consistency of style.



Neui Style...

Delete Style 

Edit Style,..

Cancel

Figure 6.97 User styles window

User Styles...

Click User Styles.... A window opens (Figure 6.97). Now click New Style. 
Another window opens to let you choose font, size, style, justification, and 
line spacing for your new style (Figure 6.98).

User style name: New style

[3 Font Palatino]

n o  i ^Justification Left |

Select style... Line spacing select spacing...

The use* style "New style" appeals like this. Justification & 
line spacingaie affected.

Cancel

L-g-J
Figure 6.98 Assign style using the Style menu

Click in the square box to the left of Font. Then click in the rectangular box 
to the right. A pop-up menu offers a variety of fonts. Choose one. The 
rectangular portrait below illustrates your choice. Continue making your 
choices in a similar manner until you have selected all the attributes you 
want for the new style. At the top of the window beside User style name, 
type the name you want to assign the style. Click OK to accept your choice. 
The name of your new style appears in the User Styles... window.
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To edit your new style, click on its name in the User Styles... window. This 
enables the Delete Style button to delete the style and the Edit Style 
button to edit it. Click the Edit Style button. A window opens to let you edit 
your new style. Click OK to accept your editing or Cancel to reject it. That 
brings you again to the User Styles... window. Click OK to accept your new 
style. Now pull down the Style menu at the top of the screen. The name of 
your new style appears at the bottom of the menu (in alphabetical order).

User styles maintain a linkage between the style definition and the text to 
which this user-named style combination has been assigned so that 
MathWriter applies any subsequent modification of the definition to text 
throughout the document. This feature allows you to explore alternative 
style assignments quickly and easily.

To assign a User Style, select the text, and then select the desired User 
Style from the bottom of the Style menu. This assignment supersedes the 
existing style assignment for all of the selected text. To reassign a portion of 
a User Style run, select the text, and assign different attributes. To remove 
the linkage with a User Style run for an entire paragraph, click four times 
to select the paragraph, and then assign a single style attribute such as text 
size. Reassigning the existing size is sufficient.

The Windows Menu
The Windows menu provides access to various windows—Tools, Templates, 
Palettes, Font Table, Library, Modules, Clipboard, Help, and any open 
document window. You can arrange the windows of the open documents for 
convenient access. The use of the Tools, Templates, and Palettes windows is 
discussed in detail at the beginning of this chapter. The Font Table and 
Library Windows provide tools for increased typing speed.
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Clean Up Windows

Clean Up Windows "stacks" the document windows with a slight offset 
that makes the multiple file names partially visible and allows you to 
make any file active by clicking within its window. Math Writer brings 
the active file to the front. Up to ten files can be open at once.

MathWriter provides five floating windows: Templates, Palettes, 
Tools, Font Table, and Library (Figure 6.80 through Figure 6.83). You can 
place these on the screen by clicking on them in the "Windows" menu. If 
you do not like their position on the screen, place the mouse in the gray 
area of a window and drag the window where you want it. Math Writer 
remembers the locations of the floating windows when you retrieve the 
file later. To completely remove these windows, either click their close- 
boxes or reselect the window from the Windows menu. Scrolling will be 
faster if the floating windows do not obscure the document window, 
which would require the screen to be redrawn more often.

Tools Window

The Tools Window selection (36 A, i.e., command tab) displays or hides
the floating Tools window (Figure 6.99). If you reposition the Tools

 ̂ , window, MathWriter retains the new location of the window even if vou
Figure 6.99 W mdowsmenu J°  temporarily remove the window.

Type 96 tab (96 A) to bring the Tools window (Figure 6.100) to the fore
ground. We use D to denote the fab key.

n »t—  J l-XvXvX-

* +

X 1
/*

l'"T

Figure 6.100 Tools Window

Windows
Clean Up Windows

Tools Window 36A 
Tools ►

Templates Window 
Palettes Window 
Font Table Window

Library Window 
Library ►

Modules

Clipboard
Help 3§?

✓ untitled 1

Tools

The Tools submenu provides menu access to the four editors:

✓ Tent Editor 360' Tools
Math Editor
Character Editor *-01
Sidebar Editor

Figure 6.101 Editor selection menu
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• Text Editor, identified by the traditional I-beam cursor

• Math Editor, identified by a split I-beam cursor and used for editing 
within mathematical expressions

• Character Editor, identified by an arrow cursor and used for moving 
characters

• Sidebar Editor, identified by the "+" cursor and used for editing sidebars

You can reach these tools from the Tools window or from the keyboard using 
the commands shown in Figure 6.101.

Templates Window

Palettes W indow

Click the Templates window selection on the Windows menu. A col
umn of mathematical templates appears on the left of the screen 
(Figure 6.102). These include fractions, radicals, products, summa
tions, integrals, set operators, special structures such as limits, group
ing brackets, vectors and matrices, and tables. Click on the first tem
plate, the fraction template. A pop-out menu provides three types of 
fraction templates. Move the arrow cursor to the one you want and 
release the mouse. This places that choice in your document at the 
location of the blinking cursor. To type a fraction, type the numerator, 
press the enter, type the denominator, and press return. The other 
templates operate in a similar fashion. (For a more detailed discus
sion, see Chapter 4.)

Figure 6.102 Tem plates Window

□ 1

IClick the Palettes Window on the Windows menu. A row containing 
the Greek alphabet appears (Figure 6.103) at the bottom of the 
screen. Click one of the letters of the alphabet. The letter appears in 
your text at the location of the blinking insertion point. You can add 
palettes from the Palettes menu at the top of the screen. Pull down the 
Palettes menu to Geometry and release. This places the row of Geometry 
symbols at the bottom of the screen for easier access. To remove Geometry, 
pull down the Palettes menu and click on Geometry again.

+ - X + ~ = X < > CX ± * II

f n 2 l A V a CO / / /

u n z> <z C <2 e e 0 © 0
A V “I V 3 3

a JLJL 6 c 5 JL 0 X K A JL V L 0^ o n . p g T ' U f r X .  ip oj n> CO

Figure 6.103 Palettes Window
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Font Table Window

The Font Table (Figure 6.104) is an especially useful window to have open if 
you must type rarely used symbols or symbols that do not correspond to 
easily remembered keys. You can type characters directly from the Font 
Table, unlike the Key Caps desk accessory. This is especially useful for 
symbols that may have little mnemonic correspondence with the keyboard. 
Special mathematical symbol fonts such as Machais are prime candidates 
for use here. To gain access to other fonts, click on the name of the font in the 
window. A pop-up menu gives you a list of possible fonts. Select a different 
font by dragging to the name of the font you want and releasing the mouse. 
Resize the font window, if screen space is at a premium, by clicking in the 
boxes at the lower-left corner and dragging.

Monaco

! N Helvetica Narrow 

• New Century Schlbk 

New York 

Palatino 

Symbol

E l

e ± _ oo L - «

C e o + _ L — ■ 6
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Figure 6.104 Font Table

Library/Library W indow

The Library and Library Window selections operate together. A library is 
an expression or group of words and symbols that you use frequently. By 
putting them into a library, you can place the entire expression into a docu
ment with two keystrokes. See Chapter 4 to learn how to create a library. 
Click the Library command. A floating window appears that says "No 
Libraries Open" (Figure 6.105).
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□ Librai - □

L tb rerres  Open

Q

Figure 6.105 Library window with no files open

To open a library, pull the Windows menu down to the Library command. A 
pop-out menu appears that enables you to create a library (Figure 6.106). 
Drag to New on that menu. This opens another window (Figure 6.107). At 
the bottom of this window under the words New Library is a box into which 
you type the name for this library.

Neui...
Open...
Close
Saue

Library ►
New Entry From Clipboard...
New Entry From Selection... 36N
Delete Entry
Edit...

Preferences...

Show Descriptions

Figure 6.106 Library submenu

To create new entries for a library, first open or create the library file as 
above. In your document window create and select the expression you wish 
to store. After creating and selecting the entry on the screen, select New 
Entry From Selection N) to obtain (Figure 6.108) the Define macro win
dow. Assign a short, easily remembered name to the macro and record a de
scription. You can instruct MathWriter to follow the pasted expression 
with a command from the Tool window or to enter a matrix structure. You 
can also ask MathWriter to execute an additional command after it pastes 
the macro. Refer to Chapter 4 for the detailed steps to create and save a 
library.
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Figure 6.107 New library dialog

^  Enter/create sub-structure after pasting
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Figure 6.108 D efine a macro entry for a library

MathWriter places a library item into your text whenever you type the 
abbreviation you assigned the item and hit the spacebar, unless you disable 
it using option L on the Preferences dialog box or type option spacebar 
for a space character that does not trigger a library substitution.

Because creating and recalling meaningful mnemonic names for each library 
can be difficult, MathWriter also provides a library window (Figure 6.109). 
Simply double-click on the desired abbreviation in the Library window, 
and MathWriter automatically types into your document the mathemati
cal expression, regardless of its complexity.

Figure 6.109 Visual access to a library
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Select Library Window to display an existing library file. The library 
need not be visible for you to use it from the keyboard. You can select other 
loaded libraries using the pop-up menu. In Figure 6.110, the active library 
is named "New Library File 1." MathWriter can search multiple libraries 
automatically, so you can create subject-specific collections. You control 
whether the substitutions are context-sensitive (see the last line of 
Figure 6.110 and style of the Preferences command on the Library submenu).

Figure 6.110 Display one of the open library files

The Library submenu (Figure 6.106) provides access to an environment to 
create, edit, save, or specify operating procedures for libraries. Libraries, 
which you save on disk, have a bookshelf icon, and this submenu treats 
them in a manner analogous to document files using New..., Open..., Close, 
and Save on the File menu.

Use the Open... command to access an existing library from your collection 
(Figure 6.111) or use the New... command to create another library. Use the 
Preferences command (Library submenu) to select defaults.

S I  MW2.0 f

D Math Library <> OataFrame...

f Eject )

[ Driue ]

[ Open ]

<> Cancel ]

Figure 6.111 Open a library
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Modules

To delete a selected entry use Delete entry on the submenu. To modify the 
name or description of a selected entry use Edit....

Use Preferences... (Figure 6.112) on the Library submenu to enable or disable 
a library lookup, to specify which libraries MathWriter  searches, and to 
tell MathWriter to expand the macro using the assigned or the context 
styles when it inserts the macro into the document. You can control whether 
the pasted text receives the style attributes of the context or retains the 
characteristics assigned when you created the macro.

Library preferences 

L [x] Library enable 

Macro enpansion...

O is content sensitiue if <Shift> pressed
(§) is content sensitiue if <Shift> is not pressed

' '
Cancels

Figure 6.112 Library preferences window

The last library submenu command sets the default display for the macros. 
You can decide whether MathWriter  shows the macro name and assigned 
description or the macro name and a WYSIWYG display of the expression 
in the scrollable list. The small button on the right end of the title bar of 
the library file (Figure 6.109) provides an alternative toggle between the 
description and equation views. "No Macro" shows on the last line of the 
submenu (Figure 6.106) if no library is currently open.

The Modules submenu provides access to the modular extensions to Math- 
Writer. You can extend the scope of MathWriter by adding modules, or you 
can remove unneeded features for disk space. The first module is a disk- 
based database that can interact with the data structure of MathWriter  
and use MathWriter for formatting and output.

To add a module, simply place it in the system folder or in the same folder 
with MathWriter. MathWriter locates and incorporates such modules 
when you next open the application. To remove a module, exit from Math- 
Writer and remove the module from its folder.

The Modules feature allows you to customize Math Writer with ease. Read 
the "Read Me" file on the distribution disk for additional information and 
the section on modules at the end of Chapter 4.
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Clipboard

%

Help (#  ?)

The Clipboard command on the Windows menu provides diagnostic access to 
the contents of the clipboard used to transfer text and graphics between 
applications or from one location to another within a document. The 
mathematical expression in Figure 6.113 is shown as a PICT file because it 
was placed there using Copy As Picture (Copy Other submenu) on the Edit 
menu. To copy text to the Clipboard, select or highlight the text and then 
select Copy (Edit menu). To copy a picture, select Copy as Picture (Copy 
Other, Edit menu).

Figure 6.113 Clipboard window

The Help window supplies online hints on the use of Math Writer features. 
Scroll through the list or select a topic to go directly to a specific topic.

Document names

The final entries on the Windows menu are the names of open documents. 
Either click on an exposed portion of a document window or select it here by 
name to make it the front window on the screen.



298 Chapter 6

Sidebars

Undo %z

Cut Text Sidebar
Copg Text S idebar 3€C
Paste §eu
Clear Text Sidebar

New Text Sidebar ►
New  Picture S idebar ►
New  Background Picture

✓

1 3 a ,

1 3 a,D~

Left M arg in

Left

M Right

New Tent S idebar ^
New Picture S idebar ^
New  Background  Picture

✓ D:=

1 3 a,
^ir

Left M arg in

Left

Right

IgA.
Right M arg in

Borders... 
Scale Picture. 
Set Size...

Figure 6.114 Text sidebar edit menu

A sidebar is a rectangular region 
on a page that is isolated from 
the rest of the page to convey 
special emphasis. MathWriter 
attaches a sidebar to a para
graph and if the paragraph 
moves so does the sidebar. Side- 
bars can contain text, 
mathematical expressions, and 
graphics just as in the rest of the 
document. Text in the main body 
of the document outside of the 
sidebar wraps automatically 
around the sidebar and behaves 
as if the margins have been 
reduced locally. Text within a 
sidebar also wraps automatical
ly, and all the typeface and 
paragraph formatting resources 
are available.

When you resize a text sidebar, 
MathWriter  automatically up
dates the wordwrap. You can re

size graphics sidebars, which can contain bitmapped graphics, object- 
oriented graphics, or encapsulated PostScript. Proportional resizing pre
serves the width-to-height ratio and nonproportional resizing permits 
each dimension to have a different proportionality factor. MathWriter 
supports cropping; you can mask portions along each side of the graphic. 
You can restore the original graphic at any time. Sidebars cannot be placed 
within sidebars.

Finally, you can use any graphic as background, with the normal document 
contents superimposed, on individual pages or on every page of the docu
ment. You can use this feature for logos and other special effects.

To gain access to the sidebar tools, click on the "+" icon of the Tools 
window, select Sidebar Editor from the Tools command of the Windows 
menu, or type Si shift ]. The menus change to reflect this new status 
(Figure 6.115).

* File Edit W indow s

Figure 6.115 Menu bar for sidebar tools



Cut Text Sidebar ( X X ) ,
Copy Text Sidebar ( X C ) ,
Paste Text Sidebar ( X V ) ,
Clear Text Sidebar

These commands (and the equivalents for picture sidebars and background 
pictures) are analogous to the usual editing commands but apply to sidebars 
only. The usual cut-copy-paste-clear commands apply to sidebars embedded 
within text; these sidebar-specific commands allow you to focus on a side- 
bar. Recall that you must select a sidebar using the "+" cursor before you can 
cut, copy, or clear it. To paste into your document a sidebar previously 
placed on the clipboard, you must first use the I-beam cursor of the text 
editor to select a destination paragraph.

The cursor icons MathWriter uses for sidebars are shown in Figure 6.116.

©  F0  4 * ♦  FE)
Figure 6.116 Sidebar cursor icons

New Text Sidebar

To create a text sidebar, position the insertion point within your document 
using the I-beam cursor to identify the vertical position then use the New 
Text Sidebar submenu command to select one of the four horizontal posi
tions—outside the left margin, adjacent to the left margin, adjacent to the 
right margin, or outside the right margin (Figure 6.117). A check mark ad
jacent to the menu icon identifies your choice. If desired, use the menu icons 
to reposition an existing sidebar after first selecting it using the "+" cursor. 
If necessary, use X  option Z to refresh the screen.
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New Tent Sidebar ►  ■
Left Margin

Left

Right

Right Margin

Figure 6.117 Text sidebar placement

New Picture Sidebar

To create a graphics sidebar, you must first place on the clipboard a graphic 
you intend to paste. Position the insertion point in the document for the 
vertical placement, and then use the New Picture Sidebar command to 
create and horizontally position the sidebar (Figure 6.118). To horizontally
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reposition an existing sidebar, select the appropriate icon command on the 
sidebar Edit menu.

Figure 6.118 Picture sidebar Edit menu

If necessary to fit the available space, MathWriter will resize the 
graphic. Should you need to resize, reposition, or mask part of the graphic, 
the sidebar must be selected. If the surrounding frame with "handles" at 
the corners is not visible, click within the sidebar to select it. Either use the 
Set Size command (Figure 6.124) or use the mouse to drag a corner of the 
selection frame. To preserve the width-to-height (aspect) ratio of a 
graphic when using the mouse, press the option while dragging. 
Alternatively, you can use the Scale Picture... dialog box (Figure 6.122 and 
Figure 6.123) to set a proportionality factor. Click Set Full Size to restore 
the original size.

New Background Picture

To create a graphics background (Figure 6.119), you must first place on the 
clipboard the graphic you intend to paste, and then use the New 
Background Picture command to create the transparent background. The 
picture will be placed at the center of the page whose number is displayed 
in the vertical scroll bar (even if not in view). If necessary, scroll and then 
drag the picture to a different location on that page. In contrast with text 
and picture sidebars, background pictures can be placed in headers and 
footers. Use the sidebar Edit menu to assign the background picture to the
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current page, to all pages, to all left pages, or to all right pages. The odd- 
numbered pages are the right pages.

m i
Undo 3§Z

Cut Background Picture 9gR
Copy Background Picture 36C
Paste 3§U
Clear Background Picture

Neui Tent Sidebar ►
Neui Picture Sidebar ►
New Background Picture

Rll Pages 
yThis Page 

Left Pages 
Right Pages

Borders...
Scale Picture...
Set Size..._________________

Figure 6.119 Background Picture sidebar Edit menu

Left Margin, Left, Right, and Right Margin 
All Pages, This Page, Left Pages, Right Pages

To reposition an existing sidebar or background picture, select it using the 
mouse and then use one of these commands. MathWriter  will automatically 
reformat the surrounding text as required. If necessary, use Si option Z to 
refresh the screen display.

Borders...

The Borders... command (Figure 6.120) allows you to remove any or all sides 
of the border, change the line thickness and pattern of the border, choose 
single or double lines, and adjust the whitespace around the border.
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♦ Whitespace |Qj|

Click above for thickness and pattern
Cancel
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Figure 6.120 Text sidebar borders dialog box

Click in the indicated space (a miniature portrait of a sidebar) on the Text 
Sidebar Format dialog box (Figure 6.120) to access the box for setting border 
line thicknesses, spacing between border lines, line patterns, and sidebar 
background pattern (Figure 6.121). Refer to the discussion of the Paragraph 
Format command for additional details.

Select thickness and pattern... 
—  Outer border-------------------

Thickness 
Pattern

—  Inner border

Thickness 
Pattern

...Background pattern

Pattern IGraq scale I

Space between borders

<3 ........ 50 %

£ 3

Cancel
l  0K )l

Figure 6.121 Sidebar style

To enter text in a text sidebar, you must select the normal (I-beam) Text 
Editor from the Tools window (or you can select it from the Windows menu 
or use Si shift apostrophe) and click within the text sidebar for in-context 
editing. A text sidebar can contain text, graphics, and mathematics, but a 
picture sidebar can contain only a graphic. To copy a picture from a picture 
sidebar, enable the Sidebar Editor, hold option while you select Copy 
from the sidebar menu. To cut, copy, or paste a sidebar (without surrounding 
text), you must use the Sidebar Editor.
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Scale Picture

Set Size

= L l
When MathWriter creates a rectangular sidebar, it leaves it 0  
selected, i.e., with an enclosing frame and "handles" at the 
corners. Any adjacent text is automatically repositioned. The square sidebar 
cursor appears when you move the cursor into the sidebar while it is 
selected; the "+" cursor appears if the sidebar is not selected. You can also 
specify a proportional reduction percentage (Figure 6.122) or scale the
width and height separately (Figure 6.123).

1 Scale picture...

®  Proportional scale |100 ]%

O  Non-proportional scale

Set Full Size Cancel [[— gg— Ij

Figure 6.122 Proportional scale picture dialog box

Scale picture...

O Proportional scale

®  Non-proportional scale width
height 100

%
%

Set Full Size Cancel |I °K )1
II----------------------------------------------------------------------II

Figure 6.123 Nonproportional scale picture dialog

To resize the sidebar, use the Set Size... menu (Figure 6.124) on the sidebar 
Edit menu or drag one of the handles. Press the option key while dragging 
to preserve the width-to-height ratio when resizing. Otherwise you can 
independently vary the dimensions. To precisely assign a size, use the Set 
Size command (Figure 6.124).
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Set size...

width
height

2.000 in
2.000 in

Cancel 0 3
Figure 6.124 The Set Size dialog box

Summary

Sidebars can be edited in-context, repositioned, resized, and supplied with 
borders and background patterns using the sidebar editor tools.
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1
JL  Interface Fundamentals

The Macintosh interface embodies three qualities—responsiveness, 
permissiveness, and consistency. Responsiveness means that commands are 
intuitive and results are direct. Permissiveness means that you can perform 
reasonable tasks at any time. Consistency means that all applications have 
similar interface standards. This shared interface makes your transition to 
MathWriter much easier. In fact, experienced word processor users probably 
can use many of the MathWriter enhancements without reading the 
manual. Although we have extended the scope of Math Writer well beyond 
traditional word processors, we believe MathWriter's  interface makes the 
use of this greatly expanded functionality intuitive.

MathWriter's hallmark is its visual orientation. Whenever possible, 
MathWriter provides a visual means for selecting commands such as 
scrolling lists and palettes. Generally, when you make a choice by clicking, 
your choice is highlighted by a reversal of its black and white pixels. 
Because the primary purpose of a word processor is the preparation of 
printed output, an immediate and faithful visual representation of the 
document on the screen expedites the process. This characteristic is called 
"What you see is what you get" (pronounced "wizy-wig"). MathWriter 
updates its screen display after each keystroke. Even the editing of the 
various components on the displayed page (header, footer, footnotes, 
sidebars, and equations) is handled in-context.

Keyboard and Mouse
The standard keyboards contain two types of keys—character and modifier 
keys. The character keys produce letters, numbers, symbols, and spaces. 
Other character keys (enter, tab, return, delete,  and clear) provide 
formatting and other control and may be context-dependent.

MathWriter uses the return and enter keys for different tasks when you edit 
mathematical expressions. The enter key moves the cursor to the next lower 
hierarchical level in an expression, but the return key immediately moves 
the cursor to the baseline of ordinary text. For example, if you position the 
insertion point at a superscript to a superscript, pressing enter moves the 
insertion point down to the first superscript, but pressing return



immediately moves it to the baseline. In this example, pressing enter twice 
is equivalent to pressing return once.

Tab advances the insertion point to the next field or tab marker. Enter 
signals that text or data in an input field is complete. Return signals 
movement to the leftmost field one step down; during text entry it signals a 
new paragraph. Both return and enter close dialog boxes. When creating a 
table in Math Writer, use tab to create a new column and return to create a 
new row.

Pressed modifier keys [shift, caps lock, option, control, and command (3£)] 
change the interpretation of keystrokes and mouse actions. Shift and option 
change the character set associated with the character keys. Press the 
shift  key to select the upper character on keys with two symbols. Caps lock 
latches the shift  key only for alphabetic keys. You can use caps lock and 
option in combination on alphabetic keys. Use shift return to force a new 
line while still in the current paragraph, such as for a mathematical 
expression that needs to be continued on another line. Use option spacebar to 
toggle between the current and Greek alphabets. Character keys that you 
select while you press the command key usually produce commands. You can 
execute many menu commands using combinations of command, option, and 
shift  keys. See appendix 3 for a list of these combinations and scrolling 
commands.

If the Macintosh is busy executing previous commands, MathWriter  saves 
the keyboard and mouse commands in a queue for subsequent processing. If 
you hold a character key down longer than the time you specified in the 
Control Panel, the computer types the key repeatedly. The arrow keys 
control the movement of the cursor.

There are both mouse and keyboard controls for the blinking insertion point. 
Most mouse actions involve positioning of the cursor "hot spot", e.g., the tip 
of the arrow, over an object and pressing the mouse button. The cursor shape 
changes to indicate the nature of its current use. With an I-beam you edit 
within the body of the text, the header, or the footer. Use the arrow for 
selecting. Use the split I-beam to position the insertion point in 
mathematical structures.

Mouse actions include clicking, pressing, and dragging. To click, position the 
pointer with the mouse and then press and release the mouse button. To 
press, position the pointer with the mouse, then hold the mouse button 
down without moving the mouse. To drag, position the pointer with the 
mouse, hold the mouse button down while you reposition the pointer, and 
then release the mouse button. To accommodate even the fastest typist, 
mouse actions ("mouse-ahead") and keyboard commands ("type-ahead") 
made during the normal execution of other commands are saved in a buffer 
for subsequent execution.
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MathWriter provides several composite operations. Click to position the 
insertion point where you want to add new text in a Math Writer document. 
Double-click to select a whole word and triple-click to select an entire line 
of text. Use the Control Panel to adjust the double-click speed and the 
sensitivity of the cursor to mouse movement. To make an extended, 
contiguous selection of text, click at one end of the selection and either drag 
to the other end or shift click to establish the other end. The status bar 
reports the line and character of the beginning and ending of the selection.

To scroll the active document window in MathWriter by mouse: 1) click in 
the scroll arrows to scroll a few lines, 2 ) option click in the scroll arrows to 
scroll a single line, 3) press in the scroll arrows to repeatedly scroll in 
multiple line increments, 4) option press to repeatedly scroll in single line 
increments, 5) drag the scroll box to move larger distances (the position of 
the scroll box indicates the relative position of the current screen within 
the entire document, and the page number1 is displayed here), and 6) click 
in the scroll bar above or below the scroll box to scroll the height of the 
current window. See appendix 3 for a table of commands.

TouseMof/i Writer for screen presentations, option click in the scroll bar to 
advance to the top of the header of the next or previous page or command 
option click to advance to the top of the text body of the next or previous 
page. With a screen image projector, MathWriter doubles as an overhead 
projector.

MathWriter lets you open multiple windows at the same time. Up to ten 
documents can be open, but only one can be active at any time. MathWriter  
identifies the active document with lines in the title bar and a scroll box in 
the vertical scroll bar, and it is the front-most document window. Click 
anywhere within an uncovered portion of a window or select it from the 
Windows menu to make it the active window.

MathWriter also provides floating windows, selectable from the Windows 
menu that can be active while a document window is active. These windows 
contain tools and information you use to modify the document in the active 
window. You control the placement of all windows by dragging the title 
bar. You cannot drag it completely off the screen. Click in the close-box at 
the top-left comer to close or remove a window. You can enlarge or reduce 
the size of a window by dragging its size box at the bottom-right corner of 
the window. The zoom box at the top-right comer toggles the window 
between its current size and placement to full-screen utilization. The 
horizontal scroll bar allows you to select the horizontal portion of the 
document you want to see if the document is wider than the window.

1 The page number of the page number variable in the header or footer is displayed in the status bar when you 
press on the vertical scroll box.



308 Appendix

MathWriter handles some scrolling automatically. If you drag the cursor 
above or below the active window when selecting text, the document wind
ow scrolls. If a selection is not currently showing in the window when you 
perform an operation, the window scrolls automatically. Some operations, 
such as Find/Replace or Check Spelling, automatically scroll the selection 
into view. Show Selection on the Edit menu scrolls the document such that 
the insertion point becomes visible.

Menus and Commands
Commands either perform operations on the entire document or the current 
selection or specify the attributes of an object. Attributes apply to the 
current selection and to subsequent input until you change the attributes. 
When you place the insertion point adjacent to existing text, the typeface of 
the new text will match the typeface of the character immediately before 
the insertion point. Many commands apply only to the current selection; 
such commands remain unavailable and, therefore, dimmed unless you 
make a selection. You must identify the object first and then give the 
command. Gray lines group related commands on a menu.

The MathWriter menu bar lists commands grouped by function. Drag to 
select an item from a pull-down menu list, which remains hidden until 
needed. Menu items marked with the three dot ellipsis (...) produce a 
dialog box in which you make choices or type information. Some menu items 
provide additional alternatives in submenus. Drag to select the menu item; 
when the submenu appears, continue dragging to select the command. 
MathWriter's  extended command set benefits from this organizational 
hierarchy. Check marks indicate the current choice among mutually 
exclusive choices such as the active document window and the current font 
name. In a selected portion of text MathWriter identifies a common font 
with a check mark; but if you include multiple fonts within a selection, 
MathWriter identifies the fonts in the selection with a bullet adjacent to 
each font included. If multiple attributes such as bold, italic, etc., are in 
effect at one time, a bullet identifies the selected attributes. In all cases, 
Plain cancels all other style attributes.

Some menu lists change to reflect the current status. For example, some 
commands toggle between two choices such as Show Layout and Hide 
Layout. MathWriter dims currently unavailable menu commands. It 
displays the user-created styles and file names on the Style and Windows 
menus, respectively.

Finally, those menu commands that you can execute from the keyboard use 
the key combinations of command, shift,  and option shown on the menu. See 
appendix 3 for a list of these commands. The command to abort the current 
operation, command period, has no menu equivalent.
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MathWriter has eight menus. The Apple menu provides information about 
MathWriter  and access to the desk accessories. The File menu provides 
access to the file handling capabilities, various global defaults, printing, 
and session termination. The Edit menu provides tools for modifying the 
text content. The Edit menu adapts according to the current choice of 
editor—character, sidebar, text, and math. The Format menu handles the 
various formatting functions. Palettes and Diac provide rapid access to 
special symbols. Style provides controls for the manual and automatic 
typeface changes. Windows provides control of the document and floating 
window choices.

Dialog and Alert Boxes
When a command is incomplete or ambiguous you must supply additional 
information before MathWriter can complete the command. You can make 
multiple choices within a single dialog box and even revise your choices 
before you accept the entire combination. This approach is easier for the 
user than responding to a series of prompts presented individually. Click on 
the Cancel button or the close-box to abandon a dialog box without making 
any changes. Click on the OK button when you are ready to implement the 
choices you have made. The default or preferred choice is boldly outlined. 
Pressing return is equivalent to clicking on the default button.

MathWriter uses more than two dozen dialog boxes that include scroll 
windows, circular radio buttons for mutually exclusive choices, square check 
boxes for non-exclusive choices, text boxes for text input, buttons to issue 
commands and select alternatives, pop-up menus for mutually exclusive 
choices, and scroll bars. Alerts warn you when unusual situations occur. For 
example, if you attempt to close a file that you have modified since you 
last saved it, MathWriter  alerts you to the potential loss of information 
and allows you to take corrective action.
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2  MathWriter Files
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TÊ I
fx 4 x

MW document

M athW riter™  Pre f Default file Math Library Italics Exceptions

MathWriter Help A  Sample Filter A  Sample Module

Fig A .l M a t h W r i t e r  file  icons

The MathWriter 2.0 file icon is a variation of the older MathWriter 1.4 
icon. Some lines of text have been added to illustrate that you can combine 
mathematical expressions with text.

This is a MathWriter document file created using Save on the File menu. 
Save your manuscript in this format if you expect to edit or print it with 
MathWriter later. In addition to text, graphics, mathematics, and format
ting information, MathWriter  saves all the configuration information; 
when you subsequently open the document, the previously defined writing 
environment is restored.

MathWriter can also create standard ASCII text files for export to other 
applications. A text file preserves the text characters. MathWriter 
optionally creates consecutively numbered place holders to identify the 
placement of mathematical expressions and graphics stripped from the file 
and automatically stores them in a user-named scrapbook file. Unless you 
use a utility such as SmartScrap, you must place the Scrapbook in the 
System folder and rename it "Scrapbook File" to access its contents.
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When you create a text file, MathWriter's AutoScrap feature automatical
ly stores the mathematical expressions and graphics in a scrapbook file for 
subsequent transfer into other applications. MathWriter optionally adds 
place holders to the text file.

The Math Library or a collection of libraries provides a powerful typing 
aid—a collection of glossaries of user-defined text, graphics, and built-up 
mathematical expressions in any combination that you use repeatedly in 
your manuscripts. When you type an assigned abbreviation as a word 
(delimited by spaces), MathWriter automatically transfers the corre
sponding library entry into your document. In keeping with MathWriter's 
visual character, you can also double-click an entry in the Library window, 
and MathWriter "types" the entry at the insertion point in the active 
window.

By typographic convention, the variables in mathematical expressions, but 
not the numbers or the function names, are italicized. MathWriter's italics 
exception file (created using the Edit Exception List... on the Style menu) 
contains the user-defined list of names, such as sin, cos, and log, that should 
not be italicized. When you enable the Auto-italicize option of the Auto 
Math Options... command and use Auto Math on the Style menu, Math- 
Writer suppresses the italics style for words you included in the list. Note 
that because MathWriter exaggerates the screen display for the italics 
style, MathWriter allows you to select the plain style of an oblique font to 
represent the italics style.

High-end word processors provide various editing aids, e.g., a spell
checker. In addition to a large, general purpose MathWriter Dictionary2, 
MathWriter provides a Math-Science-Engineering User Dictionary to 
reduce the number of specialized words you must individually verify during 
spell-checking. The spell-checker also identifies repeated words, a 
frequent typing error.

You can apply hyphenation control2 to the entire document or to selected 
text. This feature is especially useful when you use narrow columns with 
line justification at both margins.

MathWriter provides a thesaurus to suggest alternative word choices. The 
spell-checker, thesaurus,2 and hyphenation utilities are licensed from Mi- 
crolytics. The Math-Science-Engineering Dictionary was created by Cooke 
Publications, Ltd. and may be used only in conjunction with MathWriter.

MathWriter automatically saves the default configuration applicable to 
all documents in a preferences file ( MathWriter Prefs) in the System 
folder. The MathWriter application should remain locked to reduce the 
risk of a computer virus infection. The defaults retrieved when you open a 
document supersede these global preferences.

2 T o  u se  the su p p lie d  U K  vers ion s , rep lace  these files w ith  the U K  v ers ion s , a n d  ren am e th em  w ith  "U K  "  rem ov ed .
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J x 4 x

Default File

A Sam ple F ilte r

A Sam ple  Module

Jx4x

M a th V r it e r  Help

Stationery files or default files are templates for frequently used document 
types that you create using Preferences on the File menu. A list of user- 
created default files is available (when you subsequently restart Math- 
Writer) as a submenu of the New command on the File menu. When you 
select New, a copy of a stationery file, including the Math Writer configu
ration, layout, typeface, content, etc., becomes the basis for a new document. 
The stationery file remains unchanged. MathWriter  automatically loads a 
user-designated default file on startup; use Preferences on the File menu to 
designate the startup file.

An anticipated family of file filters or translators allows you interchange 
files with other applications. To the extent feasible, MathWriter saves 
the formatting as well as text with these filters. Simply place these filters 
in the same folder with MathWriter  or in the System folder, and 
MathWriter automatically recognizes them during startup, adding them to 
the pop-up list of file types in the file dialogs. This modular design allows 
you to customize MathWriter easily. A MathWriter filter for Microsoft's 
Rich Text Format (RTF for file transfer) is supplied with MathWriter. 
Most word processors can create RTF files.

MathWriter modules extend the functionality of MathWriter, the first 
word processor to provide modular extensions. Simply place a Math Writer 
module in the folder with MathWriter or in the System folder, and 
MathWriter will automatically link it to the main program and provide 
access to the enhanced features via the Modules submenu of the Windows 
menu. This feature lets you customize MathWriter  to your specific needs 
and make enhancements without awaiting a new release of MathWriter.

Online help is retrieved from this file using the Windows menu. Help 
provides general information, a summary of keyboard commands, descrip
tions of menu commands, and steps to complete common tasks.

United Kingdom versions of the dictionary, thesaurus, and hyphenation 
files are supplied with MathWriter. To use them, replace the United 
States versions in the System folder with the UK versions, and rename 
them to match the US versions, i.e., remove the three characters "UK " 
from their names.
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i
C / Keyboard Commands

Arrow Key Usage
(<—, —», T, or 1 with key combination)
Command Option S h ift Result

Moves insertion point a line or a character*

Cmd Scrolls window large amount

Option Begin/end line; top/bottom page, then doc.

Shift Extends Selection small amount

Cmd Option Scrolls window small amount**

Cmd Shift Move between cells in a matrix/table

Option Shift Extends Selection large amount

Cmd Option Shift <NotUsed>

* Arrow keys (<---- > 1 ) alone
** Cmd Option i  scrolls document window down approximately 1 line

Vertical Scroll Bar Usage
Key Mouse Result

Drag Scroll Box Scroll arbitrary amounts
Click Arrow Scroll large amount (approx 8 lines)

Option Click Arrow Scroll small amount (approx 1 line)

Click Scroll Bar Scroll 1 screen
Cmd Click Scroll Bar Top of Next/Prev Page*

Option Click Scroll Bar Top Next/Prev Header*
Cmd Option Click Scroll Bar Advance to top of Next/Prev Page Body*

*To scroll through lecture note screens
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Keyboard Commands
K ey C om m an d  (99) C om m an d  S h ift C o m m a n d  O p tio n

A Select A ll C o p y  R u ler &  Form at
B B o ld A u to  B racket
C C o p y C o p y  A s  P icture
D C a lc  P rev  J o r  1 S ize Paste Style
E A u to  M ath N u m b e r  eq u a t io n
F F in d  /R e p la c e C o p y  F orm at Insert fo o tn o te
G Find N ex t P aste F orm a t Ita lic ize  G reek
H R e p la ce  S e le ct ion
I Ita lic

J P a ra g rap h  F orm at D e le te  R o w
K L in e  S p a c in g D e le te  C o lu m n
L L o w e r  D iacritica l

M N e w  E ntry F rom  C lip b o a rd C o p y  M e m o
N N e w  E ntry F rom  S election P aste M e m o
O O p e n C o lu m n  B efore A u to  O p e ra to r  S p acin g
P Plain C o lu m n  A fte r

Q Q uit R o w  B efore
R R aise  D ia critica l C o p y  R u ler R e v is io n  T rack in g
S S ave C o p y  Style A u to  U se  S y m b o l Font
T Print P aste R u ler
U U n d e r lin e
V P aste Paste In  C on tex t

W C lo s e R o w  A fter
X C u t
Y O th er  Styles
Z U n d o Paste R u ler &  F orm at

1-9,0 • T em p late  C a teg ories
' ( - ) H id e /S h o w  R uler

=  (+) L arger S ize  (o n  m en u ) 1 Pt. L arger S ize

- o Sm aller S ize  (o n  m en u ) 1 Pt. Sm aller S ize
, (< ) Preset Style 1
• (>) Preset Style 2
/ ( ? ) H e lp
Ml) Last Style

; ( : ) •C enter S u bscrip t M ath  E d itor

TO •R ight S u bscrip t N o rm a l E ditor

[(1) • C enter S u p erscrip t C h aracter E d itor

10) • R ight S u perscrip t S id eb ar  E d itor
T a b T o o ls  W in d o w

R etu rn •Sam e as E nter k ey
S p a c e b a r • T og g le  G reek
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Special Key Combinations3

Command +

Option + [^] + stretchable char4

Option + scroll up/down 
Command + [ ] ; ' .

Option

Option + drag tab 
Command + drag left margin 

Option + | symbol in palettes.

Can't select sublines.

Enables stretching (noted by the word stretch in the 
bottom of the Tools window). Clicking and dragging in 
bottom or top of symbol stretches symbol. Clicking in 
center of symbol causes a reset to standard size.
10  pixel scroll, as opposed to 80 pixel scroll.
Corresponds to superscripting/subscripting tools as 
follows:
§g[ = [ t ]  m] = [y\

3€; =  [T|  3g ' =  Q7]

Toggles between

Smooth drag.
Doesn't move indent marker.

Vertical bar; always extends to the limits of the line.

3 Command =

4 Stretchable characters include any of the brackets and the integral symbol.
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4 Speed Enhancement

Graphical Representation
MathWriter is remarkably easy to learn and use because it is very visual. 
Within the limits of the technology, the screen image is a faithful 
representation of the document to be printed. MathWriter uses all of the 
currently available information to format the screen, even when you are 
creating complicated mathematical expressions. To the maximum extent 
possible MathWriter  assumes responsibility for the complex formatting 
details, freeing you to concentrate on the substance of your document. With 
this approach MathWriter caters to the needs of the scientist-authors, 
while also making the task of the technical typists and desktop publishing 
professionals easier.

This high level of interactive visual support requires considerable compu
tational power—even more than most explicitly numerical Macintosh 
programs such as our MacPoisson™ and MacElastic™ for solving partial 
differential equations using the finite element method. We recommend 
using MathWriter with the more powerful Macintosh models which utilize 
the 68020 and 68030 CPU.

Because of the computational requirements we also designed MathWriter to 
retain the open documents in RAM for quicker access. However, portions of 
MathWriter itself are RAM-resident as needed. When your document 
approaches the RAM limitations, the additional disk activity required to 
retrieve code will slow MathWriter.

MathWriter's  data structure is necessarily more complex than those for 
conventional word processors. In particular, the editable mathematical 
expressions which inherently contain multiple fonts, font sizes, and font 
styles and characters displaced from the baseline require a richer data 
structure.

Approximately one third of MathWriter's  100,000 lines of code were 
written in the C language for increased performance.
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Speed Improvement
Here are some possibilities.

H ardware

• Use the most powerful Macintosh available to you

• Install more RAM

Operation

• Use existing RAM effectively.

a) Set Application Memory Size to utilize the available memory using Get 
Info on the File menu at the MultiFinder level. The memory allocated is 
used by MathWriter and your open documents. Allocate at least 2 Mega
bytes, although minimal configuration is 800 Kilobytes.

b) With severe RAM limitations, operate under Finder, rather than using 
MultiFinder.

• Disable features not currently needed.

Many of MathWriter's features can be individually enabled and disabled.

a) Use the Black & White setting for the Monitor using the Control Panel. 
Color is marginally useful and significantly impacts speed.

b) Toggle the Auto Math features off (2£E) when not entering a mathemati
cal expression.

c) Reduce screen refreshing by hiding the graphics, hiding the layout lines, 
hiding invisible formatting characters, and hiding the message icons in the 
left margin using the Format menu.

• Use multiple, smaller documents if the memory utilization indicator on the 
status bar exceeds 90%. Also have only necessary documents open 
simultaneously when RAM is limiting.

• Configure the document window and floating windows to minimize overlap, 
thereby reducing complicated screen refreshing.

• Use the typing aids (Style 1, Style 2, User Styles, Library, Font Table, Auto 
Math, keyboard command equivalents for mouse actions, etc.) effectively.

• Use configuration and stationery files to reduce startup time.

• When possible, add text at the end of paragraphs to reduce screen refresh
ing time. •

• Multiple columns impose an additional computational load so create using a
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single column, remembering to restrict the width of lines that contain 
graphics and equations appropriately, and then assign multiple columns 
just before final editing and printing. •

• Because encapsulated PostScript files contain dual representations and 
therefore are larger, import them as late as possible.
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K
L /  Command Key Switcher

Swap Command Keys
MathWriter uses 98 P to select plain text and 98 T to print (type) output as 
specified in the Macintosh interface standards. Many have become 
accustomed to swapped roles for these commands so we have included a 
simple utility which will make this change.

A special-purpose utility

1. Verify that MathWriter is available and that neither 
the disk on which it resides nor MathWriter is locked.

2. Double click the Command key switcher icon.

3. Click a radio button to select the preferred assign option (Figure A.2).

Cmd Key Switcher

MathWriter Command Key Utility

This utility sets MathWriter's command key equivalents 
for print and plain to one of two different configurations. 
Select a configuration below and click in the button to 
locate MathWriter and change its configuration.

®  36T = Print | 3€P = Plain 

O &P = Print I 3§T = Plain

9 " i
Set Key Equiualents Quit

Fig A.2 Command key utility dialog box

4. Click the Set Key Equivalents button, locate the MathWriter applica
tion using the usual file opening dialog box, and click to save the change.
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6  MathWriter Versions5

Educational Version
Math Wn'fer/Educational Version is a subset of the Professional Version of 
MathWriter and is intended for use by authors who do not require the 
advanced features and who do not have access to the more powerful 
Macintoshes.

You should use the Professional Version if you have a Mac II or an SE/30 
with two Megabytes or more of RAM and a hard disk. If you have a 
Macintosh Plus or SE (68000-based CPUs) with only one Megabyte of 
memory and two disk drives, use the Educational Version.

Both versions fully support the creation and editing of mathematical 
expressions within the document, as well as traditional word processing 
functions. Math Writer is a completely new and powerful technical word 
processor designed specifically to address the demanding requirements of 
creating scientific manuscripts. The educational version retains the core 
features of the professional version, including its mathematical expression 
editor, and maintains file compatibility with the larger version.

Features removed

Color, Thesaurus, Hyphenation, Math-Science-Engineering dictionary, 
Revision tracking, Library, Memo notes, Sidebars, Background pictures, 
User styles, Adjustment for some defaults, Overview, Multiple columns, 
Auto-italics in mathematical expressions  ̂ Tab on user-selected character, 
and line numbering.

Features restricted

Character Editor retains cropping and sizing of graphics, up to one user- 
defined variable allowed, Find/Replace limited to traditional character 
searches, no more than one modular extension can be used at a time, and no 
more than four documents can be open at once.

5 The specifications for the various versions are subject to change without notice.
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Features retained

Retained are within the same document window editing of mathematical 
expressions, headers, footers, footnotes, etc., dynamic variables for 
automatic numbering of pages, equations, figures, tables, theorems, 
paragraphs, etc. and cross-references to them in the text, Font Table for 
mouse access to all characters in all fonts, direct importation of graphics 
(bitmapped, object, encapsulated Postscript), resizing and cropping of 
graphics, easy typeface changing, automatic transfer of mathematical 
expressions and graphics to a scrapbook file, automatic numbering of 
footnotes, automatic pagination, automatic line spacing, easy to access to 
multiple stationery files, and easy customization.

Demo Version
The Math Writer/D em o version is a virtually complete working version, 
but code has been removed to make it unusable for productive purposes, 
except to permit evaluation. All productive uses, except evaluation to make 
a licensing decision, are legally prohibited by the license agreement 
governing the use o f this copy.

• Document saving capabilities have been removed.

Math Writer can open files created by a working version. All the document- 
creating tools are enabled in the Demo, so documents can be created, but 
cannot be saved for later use.

• All cut and paste features have been removed.

Output cannot be transferred into other applications via the Clipboard.

• The Spell-checker, Thesaurus, and Hyphenation code segments have 
been removed.

• Printed output is limited.

Randomly selected lines are truncated on each page.

Module Version
This minimal version provides formatting and printing for MW modules. 
This version is available only as a host for a module. Modules, however, 
are compatible with the larger versions of MathWriter.
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Professional Education Module Ver
Math *s ✓

User category numbering limit (1) X

Revision tracking X X

Library X X

Auto Math limit (2) limit (2)
Font Table ✓ X

Tables s/ ✓
Char editor limit (3) x (#0)

Color X X

Auto Scrap ✓ X

Math/Sci/Engr Diet X X

Spell-Checking ✓ X

Thesaurus X X

Hyphenation X X

Sidebars X  (#1) X  ( # 1 )

Headers/Footers ✓ ✓
Footnotes ✓ X

Auto-pagination ✓ ✓
Find/Replace limit (4) X

Line spacing ✓ ✓
Import Graphics ✓ ✓

Stationery ✓ ✓
Ruler ✓ ✓

User-selected Tab X X

Para borders X X

Metrics cmd X X

Typeface changes ✓ Limit (5)
Modules Limit (6) limit (7)

Customization ✓ ✓
User Styles X X

Line numbering X X

Memos X X

Multiple columns X X

Overview X X

Fract. Char Width X X

Doc. Open at once T 1
RTF ✓ X

Online help ✓ ✓
Documentation limit (8) limit (9)

RAM >1 Meg >1 Meg
Storage 2 Floppies 2 Floppies

a) Maintain core mathematics features, b) Maintain 
[upward] file compatibility.

Limit (1) Disable New Variable, i.e., allow only one 
variable in addition to equation numbers.

Limit (2) Keep only auto bracket sizing.

Limit (3) Retain sizing and cropping of graphics.

Limit (4) Retain only traditional text search and replace 
(remove style only and revision style searches).

Limit (5) Remove Other Styles dialog.

Limit (6) Allow one Module at a time.

Limit (7) Restrict to a specific Module.

Limit (8) Delete material pertaining to deleted features; 
include Quick Summary.

Limit (9) Module manual will contain a terse summary; 
include Quick Summary.

(#0) Will retain sizing and cropping info assigned by 
larger versions; otherwise will require exact size from 
paint/draw program.

(#1) Discards contents of sidebars if included from full 
version doc.

These specifications are subject to change without notice.
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7
/  Other Software by the Authors * •

The authors collaborated with others in the creation of the following:

Macintosh Software

• M athW riter™  1.4 The mathematical expression editor predecessor of 
MathWriter™ 2.0—The Scientific Word Processor for the Macintosh.

• M W 2T e X™ 1.0 A translator of MathWriter 1.2-1.4 files into TgX.

• MacPoisson™ 1.0 and M acElastic™  1.0 Instructional finite element 
analysis programs for two-dimensional and axisymmetric problems in 
steady heat conduction, electrostatics, ideal fluid flow, seepage, etc. and 
classical elasticity, respectively. Both are available in student and 
professional versions. MacPoisson was selected for "The Best Engineering 
Software" in Higher Education in 1989 by EDUCOM.

• M acRegistrar™  1.03 A specialized database for managing class records.

• Stom ateTutor™  2.0 A HyperCard presentation of original research on gas 
exchange in higher plants (includes two Pascal computational/graphics 
modules).

• Exam Builder™  1.0 A MathWriter™2.0 database module for exam items.

IBM -PC Software

PC-Poisson and PC -Elastic Instructional finite element analysis programs 
for two-dimensional and axisymmetric problems in steady heat conduction, 
electrostatics, ideal fluid flow, seepage, etc. and classical elasticity, 
respectively. Both are available in student and professional versions.

DiskM anagerPC™  1.1 A hard disk security and disk management program.

PC-Registrar™  2.0 A specialized database for managing class records.

Q uikBase™  1.0 A pull-down menu, flat file database program with 
template editing and report generating support.
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Key to page number type styles: 
bold italics represent general topics; 
bold, commands; italics, figures.

1-1/2 spacing 100

About MathWriter™ 2.0 223,223
About the Exercises 9
Absolute value sign size 276
Abstract 233
Added text style 134, 242
Adjusting metrics 184
Adobe Illustrator 24
Affect (in replace) 82, 252, 255 •
Alignment

Character 152 
Graphic 149 
Paragraph 11 
Sidebar 301 

All Pages 301 
Alternate spelling 87 
Apple Menu 223 
AppleTalk 91 
Applying variables 129 
Arbitrary font size selection 72 
Arrow Key Usage 313 
Ascent 101,287
Assignment of user variable 275 
Auto backup 168 
Auto file warnings 231,233,239 
Auto italics default style 239 
Auto Math 284

Enable indicator 164 
Example 170
Italics Exceptions List 286 
Options 163,171,284,285 

Auto
Save 23,168, 239 
Save warning 239 
Scrap 168
Screen refresh 231,233 
Sizing 35
Sizing example 285  

Automatic
Line spacing 67,266 
Numbering 38,124,210 
Scrapbook 210 
Screen refresh 231,233

Background 
Color 73,283 
Pattern 73, 283 
Picture 26
Picture edit menu 301 
Printing 91 

Backup
Document (see Auto save) 
MathWriter 8 

Basic
Editing 51 
Features 10 

Bold 72,283 
Borders 301

Line spacing 66 
Line thickness 264  
Paragraph 63,103, 263 
Pattern 66 
Sidebar 155, 301 
Thickness 66 

Bottom margin 106 
Box style 73, 283 
Braces 34

Calculate Prev J or I Size 180, 276 
Can't split over page break 103,263 
Cancel 87
Caps first letter 72, 283 
Center

Align paragraph 63 
Align tab 60 
Equation 39 

Centimeters 262 
Changing printers 53,54 
Character

Color 73,283 
Drag 153 
Manipulation 152 
Stretch 153 
Vertical position 152 

Check 87
Spelling 257 

Chooser 53,91 
Clean Up Windows 290 
Clear 250
Clear Text Sidebar 299 
Clipboard 249,297 

Window 297 
Close 226
Collaborative writing tools 130

Collated 93,246,247 
Color 242

Background 73,283 
Character 73, 283 

Column 98,99,234 
Break 64
Break before paragraph 103, 263 
Gap 99
Insert Break 276 
Ruler 262 

Command Key 
Swap 319 
Switcher 246, 319 
Combinations 308 

Command Reference 213 
Commands Other 210 
Compact file 239 
Condense 72,242,283 
Configuration preferences 19 
Copies 246, 247,
Copy 11,249

As Picture 79,251 
Format 79,251 
Memo 79,251 
Other 79,250 
Paragraph format 17 
Ruler & Format 79, 249 
Ruler 79, 251 
Style 79,251 
Text Sidebar 299 

Counter (see Variables)
Cover page 93,247 
Create

Footnotes 109 
Library 120 
Text 46 

Creation
Date format 112, 268, 269 
Time format 112,268,270 

Cross references 126 
Assignment 226 

Current
Date format 112,268 
Time format 112,268 

Cursor 217 
Changes 10 
Icons 217

Customization 190 
Cut 11,249
Cut and Paste Footnotes (or
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endnotes) 110 
Cut Text Sidebar 299

Data Sharing 1 9 2
Date (see Creation and Current)
Decimal align tab 60
Default

Documents 18 
File 232 
Settings 19 

Define
User style 2 8 8  
Variables 127 

Delete 52, 260 
Column 260 
Row 260

Deleted text style 134, 242 
Demo Version 321 
Descent 101,287 
Design and Features in Brief 3 
Desk Accessories 224 
Diac menu 20,116,279,279 
Diacritical marks 104, 116 
Dialog and Alert Boxes 309 
Dictionary 88,257, 310 
Direction (of search) 252, 255 
DiskManagerPC 323 
Doc info 131,233,233 
Doc Layout 57,107,237,2 3 8  
Doc Preferences 239 
Document 199

Creation date 131 
Environment 200 
Example 9 
History 130 
Layout 5 7 ,2 3 8  
Modification date 131 
Open 45,297 
Organization 46,53 
Preferences 239 
RAM resident 167 
Size on disk 131 
Window 200

Double aligned paragraph 63 
Double spacing 100 
Dynamic variables 123

Edit 51, 77 
Footer 11 
Math 28,164

Menu 249 
Sidebars 298 

Editor
Keyboard equivalents 167 
Mathematics 28 
S e le c tio n  2 9 0  
Tools 290

Educational Version 320
EPSF 230
Endnote

Format 111 
Placement 109 

Enlargement 236 
Enter 

Key 52 
Text 45  
Math 159

Enter vs. return 52,164 
Equation 150

Number format 128,272 
Numbering 38 

Even numbered pages 108 
ExamBuilder 196,323 
Examine multiple pages 12 
Exercises 29

Reviewing a Short Memo 9 
Reviewing a Manuscript 13 
Input Tools 16 
Graphics and Sidebars 24 
Mathematics 2 8  

Extend 72,283

Facing pages 99 
Faster bitmap printing 95 
Features 2,3,10 

Removed 320 
Restricted 320 
Retained 321 

File
Characterization 233 
Menu 224 
Size 233 
Translators 195 
Types 310 

Filters 229
RTF 168,194,226 

Find 82,252
And replace 82 
Next 253
Replace 14, 82, 8 2 ,252, 252

Revision 83 
Style 83 
Style only 83, 55 
Text 83
Mathematical expressions 187 
Replace Style 14 
Replace Text 14 
Replace with wildcards 254 

Finder 7
First line indent 60 
Fixed line spacing 67, 266 
Fixed tabs 62 
Floating Window 20, 218 

Configure 207 
Font

Change protection 280 
Greek 284 
Identification 280 
Substitution 95 
Substitution protection 71 

Font Size 
Larger 284 
Smaller 284 

Font Style
Last Style 284 
Style 1 284 
Style 2 284 
User Style 2 2 ,1 1 3 , 287 

Font submenu 281 
Font Table 74,117 

Window 292,292 
Footer 106 

Edit 11,108 
Every page 107 
Height 99 
Placement 57,108 
Size 106
Skip first & last pages 107 
Skip first page 107 
Skip last page 107 

Footnote
Create 109
Cross reference format 111,112 
Cut and paste 110 
Default style 239 
Format 111, 112,270-271 
Placement 57,107,109 
Spacing 57 
Style 1 1 3 ,2 4 0  

Footnotes and Endnotes 1 0 9
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Format 52,97
Character 6 8 ,1 0 4  
Controls 209 
Document 53,98  
Matrix 266 
Menu 261,261 
Paragraph 58,1 0 0 , 262 
Variables 268 

Fractional widths 239, 244 
Fractions 32,168

Gap between columns 106 
Getting help 198 
Getting Started 1 9 7  
Gettysburg Address 15,138 
Global preferences 190 
Graphic 24,1 4 8  

Bitmapped 148 
Crop 150,204
Encapsulated PostScript 148 
Import 203 
In a line of text 24 
Modify 150 
PICT 148 
Placement 149 
Resize 204 
Scaling 152 
Smoothing 95 
Vertical position 150 

Graphical Representation 316 
Graphics and Sidebars 203 
Gray scale 66,73,265,283 
Greek 74,160, 284 
Group Horizontal 116 
Guided Tour 7 
Gutter size 99

Hanging indent 60 
Hardware and System Requirements 

213,317 
Header 1 0 6

And Footer 106  
Edit 108 
Every page 107 
Height 99,234 
Placement 57,108 
Size 106
Skip first & last pages 107 
Skip last pages 107 
Skip first page 107

Help 6,43,44198,297 
Hidden character symbols 277 
Hide

Invisibles 277 
Layout 277
Messages/Show Messages 277 
Pictures 278
Pictures/Show Pictures 278 
Ruler/Show Ruler 261 

Horizontal grouping 105,116 
How to Begin 5 
Hyphenate 14,89,259 

Selection 259

IBM-PC Software 323 
Icons 10,217,310 
ImageWriter 91 

Options 235,246 
Page Setup 55, 95 
Print dialog 92 

Import Graphics File 195, 230 
Inches 262 
Input Tools 16 
Insert 260 

Column 260 
Column Break 276 
Graphics File 230 
Memo 276 
Page Break 276 
Row 260 

Insertion point 
Location 217 
Math 31 

Install
MathWriter 8, 197,198 
Print driver 90 
Files 310 
Font 8,281 

Integral 33 
Size 276

Interface Fundamentals 305 
Invisibles 39, 52, 257 
Italic 72,283
Italics Exceptions List 286, 286

Key Combinations 
Special 315 
General 49 

Keyboard 
Access 160

Commands 209,313,314 
Style changes 17 
Use 305

Larger Size 284 
LaserWriter 91 

Controls 247 
Options 236 
Page Setup 54,95237 
Print 93 

Last Style 284 
Last word 259 
Layout 

Doc 237 
Page 234

Leader 61,173, 201 
Learn 87 
Left 301 
Left

Align paragraph 62 
Align tab 60 
Margin 106,301 
Numbered pages 26 
Pages 108,301 

Library 40,118, 292 
Access 161 
Changing 122 
Creating 118,120 
Macro 1 2 1 ,162 
Macro defined 294 
Mathematical 40 
Preferences 122,123,296 
Submenu 293 
Transfer to and from 118 
Using 208,123 
Window 292,293 
With style selection 295 

Limit 34
Line numbers 15,131,239 
Line spacing 67,100,100,241, 265, 

266
Automatic 100 
Fixed 100 
Mostly fixed 100 

Link to next paragraph 103, 263 
Local preferences 191 
Locate insertion point 251 
Locate revisions 251 
Lookup 259 
Low underline 73,283
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Lowercase 72,242,283

MacElastic 323 
Macintosh Software 323 
MacPoisson 323 
MacRegistrar 323 
Main Dictionary 87 
Main Menu 223 
Main Screen 2 1 4 ,215 
Manuscript 13 
Margins 99,234 
Match (in search) 82, 252, 255 
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Technical writing — and more!
With MathWriter 2.0. technical writing 
has never been easier! The complete 
"what you see is what you get 
scientific word-processing program 
treats mathematical expressions as 
self-formatting text that can be edited, 
rather than as imported graphics.
Using MathWriter 2.0, you can edit 
headers, footers, footnotes, sidebars, and mathematical 
expressions within the document window! Available in both a 
Professional Version and an Educational Version, the Profes
sional Version is suited for 
writing research papers, 
dissertations, and 
exams, while the 
Educational Version is 
suitable for writing 
undergraduate papers 
or high school tests.

File Edit Fo rm at

Etch integral on the tight has the form (8), vlth -  coj 2 .rand
-  sin 2 x  Thus

g\(f) “  _2 sin 2x and ^ ( j )  -  2  cos 2x 
Then are get from (9)

■ V i  +cosa 2x  • ( - 2 sta2J) -  

V* +st«, 2 x  2 cos 2x

g f " ♦ - * t ± r

Ifi n

E ? l i u

V

!  !

-

I ' H -
I | a B A z e K M 2 n  | p  l x I t  I t  U l x k l o l r  U

@1 by anUdifferenOaOon

PaaJtmrnt*/ Theorem a f  Ca/cm/mr. Pair2  Suppose 
that f is continuous on an open /containing [ a, Aj If P a  any 
anndenvaove of f on [*. A), then

(i0) f(j) dr-At~A4

Both versions feature:
• A spelling checker
• Automatic on

screen numbering 
of equations and 
figures and their 
cross-references

• Ability to import, 
size, and crop 
encapsulated 
PostScript', bit
mapped, and 
object graphics

• Automatic line 
spacing and line 
numbering

• Both mouse and 
keyboard entry for 
nearly all commands

• Palette and Font Table for mouse entry of all symbols
• Automatic sizing and centering of mathematical 

expressions

Proof Let £7be defined by Equattm (I):

( l )

Then Theorem 4 1 says dmt <7is an anndenvaove of f on [*. A| 
By Theorem 9 2 of Chapcr 3. if P a  ^^anndenvaove of f on 
(«, A), then

44-44+f 
for some constant C  Therefore

e -  M4 * <-i - cie - <wl
B a g ' 1 L26.CS0 |'*  rinUTia

SCMMAR NOTES Square-Integrable Representations (v.10/24/90) P*9<

m iOkJ1!)
for an h ,,h j  «  A and k ,,k j  ■ H Note, In paiucular, that if k «  H, k * 0 ,  then

on - jjjj- ( -  |A_

a formula for q that b  parncularly nice vhen |k| -  1 From (Tt) His evident that 

q(h,Ji2) is coniogate-hnear in h ,, linear in h j, and q(h,h) > 0 if h * 0  Thus q is a 

densely-defined (on AXA) positive sesquihnear form on die Hilbert space H

Key Lemma The positive sesqtnlmear form q AXA a  closed in the sense 

that If h j a A . h j - M i i n H ,  and q O ^h ^-h*) -a 0 , then h a  A and qOyh.hj-h) -» 0 

Proof To be filled in lacr

M echanics o f Stom otes Tjzzn

When the pore opens, the vidtii W is 
described by a multilinear function [Eq 1 ] of 
the internal pressure Pf  and the external 
pressure P,

f h, ♦ b J> ♦ b, P , , W > 0
111 W"l7 /*.(0 , othervise

The coefficient bf represents the change m pore sndth for a unit increase m P if P, 
remains consmnt Like vise, the coefficient b, represents the change m pore vidtii for a 
unit increase in Ps, if Pg remains constant

~F5T~ ~ra~

System Requirements
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